Contents

1 Tekla Structures drawings.................................................................................................................. 13
1.1 Main features in Tekla Structures drawings.................................................................................13
1.2 Drawing mode screen layout........................................................................................................14
1.3 Drawing layout and views..............................................................................................................16
1.4 Drawing objects............................................................................................................................17
1.5 Basic principles of drawings.........................................................................................................18
   Drawings integrated with models..................................................................................................18
   How drawings are updated.........................................................................................................19
   Drawing associativity..................................................................................................................20
   Associativity symbol...................................................................................................................21
   Different levels of changing drawing properties......................................................................22

2 Creating drawings............................................................................................................................ 25
2.1 Drawing types..............................................................................................................................26
   General arrangement drawings.................................................................................................27
      Example: Foundation plan........................................................................................................28
      Example: Slab plan....................................................................................................................29
      Example: Framing plan............................................................................................................30
      Example: Deck plan................................................................................................................31
      Example: Erection elevation drawing.....................................................................................32
      Example: 3D isometric drawing..............................................................................................33
      Example: Anchor bolt plan......................................................................................................34
   Single-part drawings....................................................................................................................34
      Example: Anchor bolt...............................................................................................................35
      Example: Embed.......................................................................................................................36
      Example: Plate..........................................................................................................................37
   Assembly drawings......................................................................................................................40
      Example: Beam........................................................................................................................40
      Example: Stairs........................................................................................................................41
      Example: Rail...........................................................................................................................42
   Cast unit drawings.......................................................................................................................42
      Example: Beam........................................................................................................................43
      Example: Column.....................................................................................................................44
      Example: Stairs.........................................................................................................................45
   Multidrawings...............................................................................................................................45

2.2 Before creating drawings.............................................................................................................46
2.3 Creating general arrangement drawings.....................................................................................47
2.4 Creating single-part, assembly, or cast unit drawings.................................................................48
2.5 Creating multidrawings.................................................................................................................49
   Creating empty multidrawings and linking or copying views..................................................50
   Creating multidrawings of the selected drawings.....................................................................51
   Creating multidrawings of the selected parts...........................................................................51
<table>
<thead>
<tr>
<th>2.6 Master Drawing Catalog</th>
<th>52</th>
</tr>
</thead>
<tbody>
<tr>
<td>Master drawing types</td>
<td>53</td>
</tr>
<tr>
<td>Cloning templates</td>
<td>54</td>
</tr>
<tr>
<td>Saved settings</td>
<td>54</td>
</tr>
<tr>
<td>Rule sets</td>
<td>56</td>
</tr>
<tr>
<td>Wizards</td>
<td>57</td>
</tr>
<tr>
<td>Creating drawings using saved settings in Master Drawing Catalog</td>
<td>57</td>
</tr>
<tr>
<td>Applying detailed object level settings in saved settings</td>
<td>57</td>
</tr>
<tr>
<td>Creating general arrangement drawings using saved settings in Master Drawing Catalog</td>
<td>58</td>
</tr>
<tr>
<td>Creating anchor bolt plans using saved settings</td>
<td>59</td>
</tr>
<tr>
<td>Objects included in the anchor bolt plan</td>
<td>61</td>
</tr>
<tr>
<td>Defining the anchor bolt plan parts using drawing filters</td>
<td>61</td>
</tr>
<tr>
<td>Including assemblies in anchor bolt plans</td>
<td>62</td>
</tr>
<tr>
<td>Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog</td>
<td>63</td>
</tr>
<tr>
<td>Example: Creating cast unit drawings one by one</td>
<td>64</td>
</tr>
<tr>
<td>Example: Creating assembly drawings from groups of similar parts</td>
<td>67</td>
</tr>
<tr>
<td>Creating drawings using rule sets or wizards in Master Drawing Catalog</td>
<td>69</td>
</tr>
<tr>
<td>Example - Creating a new rule set and drawings for all parts</td>
<td>70</td>
</tr>
<tr>
<td>Creating multiple drawing sheets of the same part</td>
<td>74</td>
</tr>
<tr>
<td>Creating multiple drawing sheets using wizards</td>
<td>75</td>
</tr>
<tr>
<td>Creating multiple drawing sheets using drawing properties</td>
<td>75</td>
</tr>
<tr>
<td>Searching for master drawings in Master Drawing Catalog</td>
<td>76</td>
</tr>
<tr>
<td>Customizing Master Drawing Catalog</td>
<td>77</td>
</tr>
<tr>
<td>Adding master drawings in Master Drawing Catalog</td>
<td>77</td>
</tr>
<tr>
<td>Adding saved settings</td>
<td>77</td>
</tr>
<tr>
<td>Adding a rule set</td>
<td>78</td>
</tr>
<tr>
<td>Adding a cloning template</td>
<td>80</td>
</tr>
<tr>
<td>Removing master drawings from the Master Drawing Catalog</td>
<td>81</td>
</tr>
<tr>
<td>Modifying master drawing properties</td>
<td>81</td>
</tr>
<tr>
<td>Modifying properties of saved settings</td>
<td>82</td>
</tr>
<tr>
<td>Modifying rule set properties</td>
<td>83</td>
</tr>
<tr>
<td>Modifying properties and contents of wizard files</td>
<td>84</td>
</tr>
<tr>
<td>Wizard file contents</td>
<td>84</td>
</tr>
<tr>
<td>Modifying cloning template properties</td>
<td>85</td>
</tr>
<tr>
<td>Managing Master Drawing Catalog folders</td>
<td>86</td>
</tr>
<tr>
<td>Example: Adding, renaming, and moving folders</td>
<td>88</td>
</tr>
<tr>
<td>Copying master drawings to another folder</td>
<td>88</td>
</tr>
<tr>
<td>Removing master drawings from a folder</td>
<td>89</td>
</tr>
<tr>
<td>Sample images of drawings</td>
<td>89</td>
</tr>
<tr>
<td>Creating sample images</td>
<td>89</td>
</tr>
<tr>
<td>Adding sample and thumbnail images to master drawings</td>
<td>90</td>
</tr>
<tr>
<td>Viewing sample images of drawing templates</td>
<td>91</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>2.7 Cloning drawings</th>
<th>91</th>
</tr>
</thead>
<tbody>
<tr>
<td>Creating drawings using cloning templates in Master Drawing Catalog</td>
<td>92</td>
</tr>
<tr>
<td>Cloning by using cloning templates located in other models</td>
<td>93</td>
</tr>
<tr>
<td>Cloning from the Drawing List</td>
<td>94</td>
</tr>
<tr>
<td>Example: Cloning a general arrangement drawing</td>
<td>96</td>
</tr>
<tr>
<td>View-specific dimension cloning</td>
<td>97</td>
</tr>
<tr>
<td>Cloned objects</td>
<td>98</td>
</tr>
<tr>
<td>Checking and modifying cloned drawings</td>
<td>98</td>
</tr>
<tr>
<td>Refreshing drawing associativity</td>
<td>99</td>
</tr>
<tr>
<td>Copying a drawing to a new sheet</td>
<td>100</td>
</tr>
<tr>
<td>Cloning using drawing templates in template library</td>
<td>101</td>
</tr>
</tbody>
</table>
4.11 Welds in drawings................................................................................................................203
4.8 Building objects in drawings............................................................................................... 195
4.6 Independent annotation objects.........................................................................................186
4.5 Associative annotation objects........................................................................................175
4.7 Shapes....................................................................................................................................194

4.5 Associative annotation objects........................................................................................175
Adding part marks..................................................................................................................175
Adding level marks................................................................................................................176
Adding associative notes.......................................................................................................177
Modifying associative annotation object properties...........................................................178
Updating marks.......................................................................................................................179
Change symbols....................................................................................................................180
Removing change symbols....................................................................................................180
Removing all change symbols (RemoveChangeClouds).........................................................181
Merging marks.......................................................................................................................183
Merging reinforcement marks manually..............................................................................183
Dragging the mark and associative note leader line base point...........................................184
Creating and using customized leader line arrows...............................................................184

4.6 Independent annotation objects........................................................................................186
Adding text.............................................................................................................................186
Using superscript in text........................................................................................................188
Adding links to text files.......................................................................................................188
Adding links to other drawings.............................................................................................189
Adding hyperlinks................................................................................................................190
Adding links to DWG and DXF files......................................................................................191
Adding revision marks.........................................................................................................192
Modifying the properties of independent annotation objects............................................193

4.7 Shapes....................................................................................................................................194
Creating a shape in a drawing..............................................................................................194

4.8 Building objects in drawings............................................................................................195
Modifying building objects..................................................................................................196
Shortening parts view by view...............................................................................................197
Hiding building object outlines using cover-up tools............................................................198
Showing a single reinforcing bar in a group ..........................................................................199
Adjusting the location of a single reinforcing bar.................................................................200
Showing layer information on reinforcing bars (RebarLayeringMarker)..............................200

4.9 Custom presentations in drawings....................................................................................201

4.10 Exploding drawing plug-ins.............................................................................................202

4.11 Welds in drawings.............................................................................................................203
Weld concepts.......................................................................................................................203
Examples: Model welds in drawings ............................................................................................................................ 205
Modifying model weld mark visibility and appearance in a drawing .................................................................................. 211
Modifying model weld appearance .................................................................................................................................. 213
Dragging weld marks ............................................................................................................................................................. 213
Adding weld marks .................................................................................................................................................................. 215
Example: Weld marks added in drawings ........................................................................................................................................... 216
Merging weld marks ................................................................................................................................................................... 218

4.12 Edge chamfers in drawings ........................................................................................................................................... 220
Displaying edge chamfers in a drawing ............................................................................................................................... 220
Defining default line color and type for edge chamfers ......................................................................................................... 221
Changing edge chamfer line color and type manually .......................................................................................................... 222
Creating edge chamfer marks .................................................................................................................................................. 222
Example: Edge chamfers .......................................................................................................................................................... 223

4.13 Pours in drawings .............................................................................................................................................................. 225
Showing pours and pour breaks in drawings ..................................................................................................................... 229
Modifying pour breaks in drawings ............................................................................................................................................. 229
Changing the pour break symbol ............................................................................................................................................... 229

4.14 Reference models in drawings ........................................................................................................................................ 230
Setting automatic reference model properties in drawings .................................................................................................. 230
Modifying properties of hidden lines in reference models using advanced options ......................................................... 231

4.15 Grids in drawings ............................................................................................................................................................... 233
Modifying grid and grid line properties .................................................................................................................................. 234
Dragging grid labels ................................................................................................................................................................... 235
Hiding grids or grid lines ............................................................................................................................................................ 235

4.16 Symbols in drawings ............................................................................................................................................................ 235
Creating and modifying symbol files ........................................................................................................................................... 236
- Viewing and modifying symbol file contents .......................................................................................................................... 237
- Creating a new symbol file ...................................................................................................................................................... 237
- Changing the symbol file in use .............................................................................................................................................. 238
Adding symbols in drawings ..................................................................................................................................................... 238
Modifying symbol properties .................................................................................................................................................... 239
Managing moment connection symbols ................................................................................................................................. 239
- Creating moment connection symbols (Drawing tools) ...................................................................................................... 239
- Updating moment connection symbols (Drawing tools) .................................................................................................... 241
- Deleting moment connection symbols (Drawing tools) ..................................................................................................... 241
Adding surface treatment symbols in drawings (AddSurfaceSymbols) ..................................................................................... 242

4.17 Changing drawing objects ............................................................................................................................................... 243
Dragging, reshaping and resizing drawing objects ................................................................................................................ 243
Copying with offsets ................................................................................................................................................................... 245
Arranging drawing objects ....................................................................................................................................................... 247
Hiding and showing objects in drawings and drawing views .............................................................................................. 247
- Listing hidden parts in drawings ............................................................................................................................................ 250
- Trimming .................................................................................................................................................................................. 251
- Splitting .................................................................................................................................................................................. 253
- Dividing ................................................................................................................................................................................ 254
- Modifying the shape of leader lines ...................................................................................................................................... 254
- Aligning drawing objects ...................................................................................................................................................... 255
- Creating fillets (Drawing tools) ............................................................................................................................................ 256
- Creating chamfers (Drawing tools) ..................................................................................................................................... 257
- Managing cut lines (Drawing tools) ...................................................................................................................................... 259
- Creating cut lines ................................................................................................................................................................. 260
- Updating cut lines ............................................................................................................................................................... 260
- Deleting cut lines ............................................................................................................................................................... 261
7  Modifying drawing settings................................................................. 307

7.1  Modifying and saving automatic drawing properties before creating drawings........312
7.2  Modifying drawing properties of an existing drawing..................................................313
7.3  Modifying view-level drawing properties.................................................................... 315
7.4  Settings affecting the recreation of drawings..................................................................315
7.5  Preventing automatic drawing updates and recreation..................................................316
7.6  Modifying and saving drawing object properties..........................................................317

7.7  Detailed object level settings..................................................................................... 318

7.8  How Tekla Structures applies drawing properties........................................................326

7.9  Drawing layout......................................................................................................... 326

7.10 Drawing size and drawing view scale........................................................................... 340

7.11 Object protection and placement settings in drawings.................................................... 343

7.12 Automatic drawing views............................................................................................ 350
7.14 Automatic mark settings........................................................................................................461
Adding automatic marks...............................................................................................................462
Setting the visibility of marks........................................................................................................464
Setting the appearance of mark text, frames and leader line ......................................................465
  Additional ways for modifying part mark leader lines..............................................................466
  Placing the base point of the reinforcement mark leader line automatically..........................467
Mark location..................................................................................................................................468
  Setting a predefined location for beam, bracing and column marks.........................................468
  Part mark and surface treatment mark leader line types and mark location..............................469
  Leader line types and mark location for reinforcing bar group marks.......................................469
  Reinforcement leader line types and mark location.................................................................471
Merging marks automatically........................................................................................................471
  Merged part marks.....................................................................................................................471
  Merging part marks...................................................................................................................473
  Merged reinforcement marks....................................................................................................474
Merging reinforcement marks automatically............................................................................474
Showing mark frames and leader lines for hidden parts............................................................475
Unit settings for marks..................................................................................................................476
Adding level attributes in part marks..........................................................................................478
Adding user-defined attributes and template attributes in marks ............................................480
  Example 1: Creating a mark template containing separate value fields and text elements.........481
  Example 2: Creating a mark template containing a formula in the value field.........................483
Adding templates in marks..........................................................................................................484
Adding symbols in marks............................................................................................................486
Defining contents of bolt mark Size element using advanced options.........................................487
Adding pull-out pictures in reinforcement marks........................................................................489

7.15 Automatic grid settings in drawings................................................................................492
Setting automatic grid properties.................................................................................................493

7.16 Automatic part and neighbor part settings in drawings..................................................493
Setting automatic drawing part properties..................................................................................494
Example: Part representations......................................................................................................495
Setting automatic neighbor part properties................................................................................496
Indicating part orientation............................................................................................................497
  Using part mark as an orientation mark in general arrangement drawings..............................497
  Displaying compass direction in part marks.............................................................................499
  Displaying orientation marks (north marks).............................................................................500
  Displaying connecting side marks.........................................................................................502

7.17 Automatic bolt settings in drawings................................................................................503
Setting automatic bolt properties in drawings..........................................................................503
Creating user-defined bolt symbols............................................................................................504
Example: Bolt representations.....................................................................................................505

7.18 Automatic hatch patterns in drawings..............................................................................506
Adding automatic hatch patterns on drawing objects.................................................................507
7.19 **Automatic surface treatment in drawings** .......................................................... 510
Adding automatic surface treatment in drawings .................................................. 510
7.20 **Automatic weld settings in drawings** .............................................................. 511
Setting automatic weld properties in drawings ..................................................... 511
7.21 **Automatic reinforcement and mesh settings in drawings** .............................. 512
Setting automatic reinforcement and reinforcement mesh properties .................. 512
Example: Hiding reinforcing bar lines in drawings .............................................. 514
Example: Reinforcement representations ............................................................. 515
7.22 **User-defined attributes in drawings** ............................................................... 516
Modifying automatic user-defined drawing attributes ....................................... 517
Creating new user-defined drawing attributes ................................................. 517
7.23 **Defining a firm folder for images and symbols** ............................................... 520
7.24 **Defining customized line types** ................................................................. 521

8 **Drawing settings** .......................................................................................... 523
8.1 **General arrangement drawing properties** .................................................... 524
8.2 **Single-part, assembly and cast unit drawing properties** ............................... 526
8.3 **Layout properties** ........................................................................................ 527
8.4 **View properties in drawings** ........................................................................ 529
8.5 **Section view properties** ............................................................................... 532
8.6 **Dimension and dimensioning properties** ...................................................... 533
General dimension properties ........................................................................... 534
Dimension format, precision and unit properties ................................................. 536
Dimension appearance properties ....................................................................... 537
Dimension mark and dimension tag properties .................................................. 538
General dimensioning properties ...................................................................... 540
Position dimensioning properties ...................................................................... 542
Part dimensioning properties ............................................................................ 544
Bolt dimensioning properties ........................................................................... 545
Dimension grouping properties ......................................................................... 546
Sub-assembly dimensioning properties ............................................................. 547
Reinforcement dimensioning properties ............................................................. 548
Grid and overall dimensioning properties (GA drawings) .................................. 548
Part dimensioning properties (GA drawings) ..................................................... 549
8.7 **Mark properties** .......................................................................................... 550
Mark appearance and merging properties .......................................................... 551
Leader line types .................................................................................................. 554
Positioning properties of view label, section and detail marks ............................ 555
Drawing weld mark properties ............................................................................ 555
Model weld mark visibility and appearance properties in drawings ...................... 557
Level mark properties ......................................................................................... 559
8.8 **Mark elements** ............................................................................................ 560
Common elements in marks ............................................................................... 560
Part mark elements .............................................................................................. 561
Bolt mark elements ............................................................................................. 563
Reinforcement and neighbor reinforcement mark elements .................................. 564
Reinforcement and neighbor reinforcement mesh mark elements ....................... 565
Elements in merged reinforcement marks .......................................................... 565
Connection mark elements .................................................................................. 566
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Surface treatment mark elements</td>
<td>567</td>
</tr>
<tr>
<td>Section and detail mark elements</td>
<td>567</td>
</tr>
<tr>
<td>View, section view and detail view label mark elements</td>
<td>568</td>
</tr>
<tr>
<td>8.9 Part and neighbor part properties in drawings</td>
<td>568</td>
</tr>
<tr>
<td>8.10 Bolt content and appearance properties in drawings</td>
<td>571</td>
</tr>
<tr>
<td>8.11 Surface treatment visibility and content properties in drawings</td>
<td>573</td>
</tr>
<tr>
<td>8.12 Surface treatment hatch pattern properties (surfacing.htc)</td>
<td>573</td>
</tr>
<tr>
<td>8.13 Part and shape hatch pattern properties (.htc)</td>
<td>575</td>
</tr>
<tr>
<td>8.14 Reinforcement/Neighbor reinforcement and mesh properties in drawings</td>
<td>577</td>
</tr>
<tr>
<td>8.15 Reinforcement settings for drawings (rebar_config.inp)</td>
<td>579</td>
</tr>
<tr>
<td>8.16 Placement properties for annotation objects</td>
<td>586</td>
</tr>
<tr>
<td>8.17 Welding properties</td>
<td>587</td>
</tr>
<tr>
<td>8.18 Drawing shape properties</td>
<td>588</td>
</tr>
<tr>
<td>8.19 Drawing grid properties</td>
<td>589</td>
</tr>
<tr>
<td>8.20 Orientation settings</td>
<td>590</td>
</tr>
<tr>
<td>9 Disclaimer</td>
<td>592</td>
</tr>
</tbody>
</table>
1 Tekla Structures drawings

Tekla Structures drawings contain a large variety of features that help you to create and manage your drawings efficiently. The drawings consist of three main types of elements: drawing layout, drawing views, and drawing objects. You can select what to include in the drawing before you create it, and also add necessary objects in an existing drawing.

See also
- Main features in Tekla Structures drawings on page 13
- Drawing layout and views on page 15
- Drawing objects on page 17
- Drawing mode screen layout on page 14
- Basic principles of drawings on page 18

1.1 Main features in Tekla Structures drawings

Tekla Structures includes the following features for drawings:

- All information comes directly from the model, which minimizes the work you have to do. In many cases all you need to do is to check the predefined settings or do some minor editing.
- Up-to-date drawings. The drawings are actually a part of the model. If you revise the model, Tekla Structures also updates the drawings, so they are always up to date.
- Master Drawing Catalog, which is a fast, efficient and controlled way of creating drawings in one centralized location using master drawings.
- Automatic workshop single-part and assembly drawings, and cast unit drawings of selected parts with predefined settings for layout, views, dimensions, marks, and building objects. View properties are defined separately for each view before a drawing is created.
- Automatic general arrangement drawings and anchor bolt plans of selected views.
- Drawing cloning capabilities.
- Drawing management. Revision control, locking freezing, and issuing drawings.
• Interactive editing tools that you can use for adding dimensions, various drawing shapes, texts, additional annotations, symbols, and links in the drawings.

• Standard and customized drawing layouts. Tekla Structures contains many ready-to-use standard drawing layouts. You can also create your own.

• Export capabilities.

• Printing to paper, file and PDF.

See also
- Basic principles of drawings on page 18
- Modifying drawing settings on page 307
- Automatic drawing views on page 350
- Creating drawings on page 25
- Cloning drawings on page 91
- Editing drawings on page 114
- Working with drawings on page 272
- Printing drawings on page 280
- Exporting a drawing to a 2D DWG or DXF file...

1.2 Drawing mode screen layout

When you open a drawing, Tekla Structures activates the drawing mode. The menus and icons for the modeling mode are replaced by those of the drawing mode. The model views
remain on the screen behind the drawing. The following image identifies the various areas of the drawing window:

1. Menus contain all commands available in the drawing mode.
2. Basic tools for working with drawings.
3. Commands for creating dimensions and objects.
4. Select switches determine the selectable objects.
5. Snap settings control which points you can snap to and pick.

See also  Filtering in drawings
             Interface overview
             Snap switches
             Selection switches
1.3 Drawing layout and views

A Tekla Structures drawing consists of two types of basic elements:

- A drawing *layout* defines the drawing size and the included tables, such as revision tables, title blocks, material lists, bills of material, general notes, key plans and DWG files. Tekla Structures has a range of predefined layouts, and you can also create layouts of your own.

- Drawing *views* are views to the whole model, to a part of the model or to individual parts in the model. Views can show building objects from different directions (top, front, back, bottom) and cross sections. Drawing views act as containers for the building objects or areas in the model that you have selected to be included in the drawing.

Below is an example of the drawing layout and views in a workshop drawing.

1. Top view to a part
2. Front view to a part
3. Material list
4. Drawing title block

See also  
Tekla Structures drawings on page 13  
Drawing layout on page 326  
Automatic drawing views on page 350
1.4 Drawing objects

Drawing views may contain several types of objects. Some of them come from the model and represent something that will exist in the real building or will be closely related to it. Others are objects that represent information that is only relevant in the drawing, or that add extra information to the information in the model. Drawings may include the following object types:

- **Building objects**: parts, bolts, welds, chamfers, reinforcing bars, surface treatment, etc.
- ** Associative annotation objects**: dimensions, marks, associative notes
- **Independent annotation objects** that are not linked to the model: text, text files, symbols, link, hyperlinks, DWG/DXF files, and reference models
- **Shapes**: drawing shapes used for highlighting parts of the drawing (clouds, lines, rectangles, etc.)

![Diagram showing drawing objects]

1. Shapes: clouds and rectangles
2. Dimensions
3. Marks, associative notes
1.5 Basic principles of drawings

There are a couple of basic principles in Tekla Structures that you need to understand before you start creating or modifying drawings:

- The model is the single source of information for drawings. The drawing is just another view to the model, usually a 2D view. This ensures that the information in drawings and reports is always up-to-date.
- Tekla Structures integrates the drawings with the model.
- Drawing objects are associated with model objects, and updated when the model changes.
- Changing some of the properties requires the recreation of the drawings.
- If there are several identical parts, cast units or assemblies in the model, Tekla Structures creates only one drawing.
- You can modify drawing properties on three levels; drawing, view and object level, depending on the drawing type and the desired results.

See also

- Drawings integrated with models on page 18
- Drawing associativity on page 20
- How drawings are updated on page 19
- Different levels of changing drawing properties on page 21
- Settings affecting the recreation of drawings on page 315

Drawings integrated with models

Tekla Structures integrates the drawings with the model. A drawing is a window to the model presenting 3D structures in 2D. The building objects shown in the drawing are model objects you create in the model. You can change their representation in the drawing but you cannot change the geometry or the location of the building object, or delete building objects; all changes to building objects are made in the model. That is why the drawings are always up-to-date. For example, dimensions and marks in drawings are always correct. You can filter
out parts and bolts in drawings using the filtering tools, or make them invisible by hiding them.

You can create drawings at any stage of the project. Creating single-part, assembly and cast unit drawings requires that the model is numbered, so you need to plan and perform the numbering before creating drawings.

If the model changes, Tekla Structures notifies in the Drawing List that you need to update the related drawings. You cannot open a drawing that is not up-to-date.

See also  Basic principles of drawings on page 18
Numbering the model
Updating drawings when the model changes on page 272

How drawings are updated

When a model changes, the related drawings need to be updated. Tekla Structures takes care of updating and notifies you if updating is needed.

When you start using a newer version of Tekla Structures, updating drawings created with the older version may cause problems. We recommend that you complete any drawings you have started using the older version, or recreate the drawings using your new version of Tekla Structures.

Updating is necessary, when:

- The geometry of a model object changes.
- Some other model object properties, for example, material and class change.
- Model objects are added or deleted.
- The number of identical model objects changes.

Tekla Structures automatically updates drawings each time you number the model. If you have not numbered the model, you are prompted to do so when you create a drawing. Furthermore, if you have changed the model and go to the Drawing List to open drawings, Tekla Structures has marked the outdated drawings, and you need to update them before you can open them.

General arrangement drawings are always updated when you open them if the model has changed. You do not need to number the model to update general arrangement drawings.

See also  Basic principles of drawings on page 18
Updating drawings when the model changes on page 272
Settings affecting the recreation of drawings on page 315
Numbering the model
Drawing associativity

Tekla Structures drawings are associative. The objects in the drawing are linked to model objects, which means that most objects in the drawing are automatically updated when the model changes. For example, if a model object is resized, dimension points move with the corresponding object in the drawing, and the dimensions are recalculated. Still, you do not lose any manual changes that you have made in the drawing. This applies to all drawing types.

Tekla Structures updates the following drawing objects to reflect the changes in the model:

• Parts
• Marks
• Dimensions
• Welds
• Views
• Section marks
• Detail marks
• Associative notes
• Lines and other shapes
• Tables

Tekla Structures retains the following manual changes made to drawings:

• Base points of objects; for example, if you drag an object to a new location
• Object properties; for example, color, font, and line type

See also  Basic principles of drawings on page 18

Associativity symbol on page 20
**Associativity symbol**

In drawings, the associativity symbol indicates which drawing objects are associative and automatically updated. Associativity symbols are shown only when you select a drawing object, for example, a dimension.

![Diagram of associativity symbol]

Objects that do not have valid association get a ghost associativity symbol and a question mark. These symbols are shown constantly, even though the drawing object is not selected. This makes it easier to find objects that need attention.

![Diagram of ghost associativity symbol]

The associativity symbols are not shown in printed drawings.

💡 To hide associativity symbols in drawing views, click **Tools --> Options --> Associative Symbol (Shift+A)**.

**See also**  [Drawing associativity on page 20](#)
**Different levels of changing drawing properties**

In Tekla Structures, you can change drawings on different levels, depending on how permanent and extensive changes are needed.

- **On the highest level**, you can define drawing properties on *drawing level*. Some of the drawing-specific properties that you define in the [Drawing Properties](#) dialog box apply to the whole drawing: protection settings, user-defined attributes for the drawing, detail view start number/letter, drawing-specific section view settings, some drawing-specific view attributes, drawing titles and drawing layout settings. On the drawing level, you can also select the views that you want to create, and set view, dimensioning, building object and mark settings *separately for each view* by going further to the [View Properties](#) dialog box for the selected view. For example, you can define that all marks have blue frame in one view, or that model weld marks are shown in another view. It is very important to save the view-level properties files in the [View Properties](#) dialog box to be able to connect the desired view properties to the views that you select to create. You can modify the drawing level properties before you create the drawing and also change them in the created drawing.

- **You can also change drawing properties on *view level* by double-clicking a view frame in an open drawing, which opens the [View Properties](#) dialog box. The changes take place only in the views that you have selected in an open drawing. Settings propagate to all objects in the selected views.**

- **Finally, you can change drawing properties on *object level* by double-clicking the object in an open drawing, which opens an object-specific property dialog box. Properties change for the selected object only. The properties changed on the object level are no longer affected by any property changes on higher levels.**

- The recommended way of working is to work from top to bottom, from drawing level to object level. Set your drawing and automatic drawing view properties as close as possible to what you want by first attempting this on the drawing level. Then modify anything else that needs to be changed on the view level, and finally, if any further cleanup is necessary, you can make changes on the individual object level. The modifications made on the drawing level remain when the drawing is recreated due to a model change. Once you change properties on the view level you should not go to the drawing level properties and modify drawing properties there. Once you have change something at one level, changing something else on the level above may negate the changes you have just made.

- **On the highest level**, you can change drawing properties on *drawing level*. This is done in the [Drawing Properties](#) dialog box and its subdialog boxes. This way you can change the properties of all building objects, marks, dimensions, and views in the drawing at the same time. For example, you can define that all marks have blue frame. You can modify the drawing properties before you create the drawing and also change them in the created drawing. Property changes propagate to all views and objects in that drawing, except new views that you create after the drawing is created.

- **You can also change drawing properties on *view level* by double-clicking a view frame in an open drawing, which opens the [View Properties](#) dialog box. The changes take place only in the views that you have selected in an open drawing. Settings propagate to all objects in the selected views.**
Finally, you can change drawing properties on object level by double-clicking the object in an open drawing, which opens an object-specific property dialog box. Properties change for the selected object only. The properties changed on the object level are no longer affected by any property changes on higher levels.

The recommended way of working is to work from top to bottom, from drawing level to object level. Get your drawing as close as possible to what you want by first attempting this on the drawing level. Then modify anything else that needs to be changed on the view level, and finally, if any further cleanup is necessary, you can make changes on the individual object level. The modifications made on the drawing level remain when the drawing is recreated due to a model change. Once you change properties on the view level you should not go to the drawing level properties and modify drawing properties there. Once you have change something at one level, changing something else on the level above may negate the changes you have just made.

**Detailed object level properties**

By saving the object property settings and combining them with drawing or view filters and drawing object types into detailed object level settings, you can also apply the object level properties on the drawing and view level. Note that detailed object levels properties on drawing level are available only in general arrangement drawings. Object level settings are a powerful tool: you can use the same property file for creating drawings and quickly change a particular property before you create drawings, for example, reinforcement color or mark frame shape. The object level settings override the property settings in the view and drawing property dialog boxes. Changes in the object level settings applied on the drawing level are inherited to the view level if there are no object level settings defined on the view level. If you apply object level settings on the view level, they override the drawing level settings.

**Example workflow**

The following image illustrates the idea of the three property levels. The frame color and the shape of the mark are used as an example.

1. You change the mark frame color and shape for the whole drawing on the drawing level. The changes propagate to the view level and to the object level.

2. You change the mark frame color and shape in the selected views. The changes take place in the selected views only. The properties do not change in the whole drawing.

Note that if you change the frame color and shape on the drawing level after changing them on the view level for some of the views, the drawing level changes override the view level changes in all views. In this case, only view settings are not overridden, for example, the view scale stays as you have set it for individual views.
3. You change the mark frame color and shape in the selected marks. The properties do not change anywhere else. If you try to change the mark frame color and shape on the view or drawing level, the properties do not change in the marks that you changed separately.

See also

- Modifying and saving automatic drawing properties before creating drawings on page 312
- Modifying drawing properties of an existing drawing on page 313
- Basic principles of drawings on page 18
- Modifying view-level drawing properties on page 314
- Modifying and saving drawing object properties on page 317
- Creating detailed object level settings in a general arrangement drawing on page 318
- Example: Applying detailed object level settings on drawing level on page 319
- Creating detailed object level settings in cast unit drawings on page 322
- Example: Applying detailed object level settings on view level on page 323
Creating drawings

Drawing creation is always based on drawing properties, no matter which way you use to create them. Planning and implementing drawing settings carefully is very important.

You can create drawings one by one, in groups, or you can create all drawings automatically.

There are many different ways to create drawings:

- Creating drawings using menu, toolbar and pop-up menu commands.
- Creating drawings using the various master drawing types in the Master Drawing Catalog. Using Rule sets is a highly automated process of creating drawings.
• Cloning drawings on the basis of cloning templates in the current model or in the cloning template models. You can clone drawings in the Master Drawing Catalog and in the Drawing List.

• You can increase the level of automation even more by applying detailed object level settings to all of the above mentioned methods. When the level of automation increases, the need for manual modifications decreases. We recommend that you put extra effort to making the automated settings as effective as possible.

Click the links below to find out more:

• Drawing types on page 26
• Before creating drawings on page 46
• Creating general arrangement drawings on page 47
• Creating single-part, assembly, or cast unit drawings on page 48
• Creating multidrawings on page 49
• Master Drawing Catalog on page 51
• Example: Creating cast unit drawings one by one on page 64
• Example: Creating assembly drawings from groups of similar parts on page 67
• Example - Creating a new rule set and drawings for all parts on page 69
• Cloning drawings on page 91
• Creating multiple drawing sheets of the same part on page 74
• Modifying and saving automatic drawing properties before creating drawings on page 312

2.1 Drawing types

You can create many types of drawings in Tekla Structures according to your needs.

Click the links below to find out more:

• General arrangement drawings on page 26
• Single-part drawings on page 34
• Assembly drawings on page 39
• Cast unit drawings on page 42
• Multidrawings on page 45
General arrangement drawings

Create general arrangement (GA) drawings when you need

- Several views in one drawing, including the entire model or a part of it
- Plan drawings (foundation, floor, deck layout, and anchor bolt plans)
- Erection elevation drawings
- Information from model views, including 3D views

General arrangement drawings show the model from the most suitable direction. For example, in plan drawings, you are looking from the top of a building or floor down towards the ground. In elevation drawings you are looking from one of the sides of the building, like along a grid line. General arrangement drawings often contain enlarged views of complex areas or details, and other additional information that helps in the approval process and during the installation phase.

You can create general arrangement drawings using menu, toolbar or pop-up menu commands, or in the Master Drawing Catalog.

See also

- Drawing types on page 26
- Example: Foundation plan on page 27
- Example: Slab plan on page 28
- Example: Framing plan on page 29
- Example: Deck plan on page 30
- Example: Erection elevation drawing on page 31
- Example: 3D isometric drawing on page 32
- Example: Anchor bolt plan on page 33
- Master Drawing Catalog on page 51
- Creating general arrangement drawings on page 47
- Creating general arrangement drawings using saved settings in Master Drawing Catalog on page 58
Example: Foundation plan

See below for an example of a foundation plan.

See also General arrangement drawings on page 26
Example: Slab plan

See below for an example of a slab plan.

See also  General arrangement drawings on page 26
Example: Framing plan

See below for an example of a basement level framing plan.

See also General arrangement drawings on page 26
Example: Deck plan

See below for an example of a deck plan.

See also  General arrangement drawings on page 26
Example: Erection elevation drawing

See below for an example of an elevation erection elevation drawing.

See also General arrangement drawings on page 26
Example: 3D isometric drawing

See below for an example of an isometric drawing.

See also  General arrangement drawings on page 26
**Example: Anchor bolt plan**

See below for an example of an anchor bolt plan.

---

**See also**  General arrangement drawings on page 26

---

**Single-part drawings**

Single-part drawings are workshop drawings that show the fabrication information for one part (usually without welds).

Single-part drawings usually use small sheet sizes, for example, A4 or imperial standard size 8.5" x 11.5".

You can create single-part drawings using menu, toolbar and pop-up menu commands, or in the Master Drawing Catalog.

---

**See also**  Drawing types on page 26

Example: Anchor bolt on page 35

Example: Embed on page 35

Example: Plate on page 36

Master Drawing Catalog on page 51

Creating single-part, assembly, or cast unit drawings on page 48
Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog on page 62

Creating drawings using rule sets or wizards in Master Drawing Catalog on page 68

**Example: Anchor bolt**

See below for an example of a single-part drawing presenting an anchor bolt.

See also  Single-part drawings on page 34
**Example: Embed**

See below for an example of a single-part drawing presenting an embed.

See also  **Single-part drawings on page 34**
Example: Plate

See below for examples of single-part drawings presenting plates.
### Table

<table>
<thead>
<tr>
<th>No</th>
<th>In assembly</th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>2</td>
<td>1.00000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0.00000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>4</td>
<td>0.00000</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>0.00000</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

### Dimensions

- Width: 2.5
- Height: 5.0
- Scale: 1/4

### Material List for Workshop

<table>
<thead>
<tr>
<th>MARK</th>
<th>SIZE</th>
<th>GRADE</th>
<th>No.</th>
<th>LENGTH</th>
<th>AREA</th>
<th>WEIGHT</th>
</tr>
</thead>
<tbody>
<tr>
<td>W</td>
<td>1.00000</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Drawing Number:** W  
**Contract No.:** 01-2005  
**Description:** Plate  
**Issue No.:** 002000000  
**Revision No.:** 000000000  
**Issue Date:** 00/00/0000  
**Revision Date:**  

**Total:** 5555.57  
**Weight:** 177.3
See also  Single-part drawings on page 34
Assembly drawings

Assembly drawings are typically workshop drawings showing fabrication information for one assembly. In most cases, an assembly consists of a main part and secondary parts. The secondary parts are either welded or bolted to a main part.

Assembly drawings usually use larger sheet sizes than single-part drawings, for example, A3 or imperial standard size 11” x 17”.

See also Drawing types on page 26
Example: Beam on page 40
Example: Stairs on page 40
Example: Rail on page 41
Creating single-part, assembly, or cast unit drawings on page 48
Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog on page 62
Creating drawings using rule sets or wizards in Master Drawing Catalog on page 68

Example: Beam

See below for an example of an assembly drawing presenting a beam assembly.
Example: Stairs

See below for an assembly drawing presenting stairs.

See also  Assembly drawings on page 39
**Example: Rail**

See below for an example of a rail assembly drawing.

---

**Cast unit drawings**

Cast unit drawings are dimensional, formwork, or reinforcement drawings used in concrete design and construction. They show cast-in embeds, edge chamfers, and hard and soft insulation.

You can only create cast unit drawings of concrete parts and cast-in embeds (steel parts or assemblies added to a cast unit). Cast unit drawings also show the bolts and welds in steel parts. Edge chamfers can also be shown. The volume and weight information of the cast unit remains accurate even if there are cuts inside the cast unit.

Cast units have the cast unit type part property - they are set either **Cast in place** or **Precast**. It is important to use the correct cast unit type, because some functionalities, for example numbering and continuous concrete are based partly on the cast unit type. In the Cast in Place configuration, you can create cast unit drawings of cast-in-place cast units only.

Cast unit drawings that show cast-in-place concrete structures usually use large sheet sizes, for example, A1 or imperial standard size 24" x 36". Drawings that show precast structures usually use smaller sheet sizes, for example, A3 or imperial standard size 11" x 17".

---

**See also**  
Assembly drawings on page 39

Drawing types on page 26

Example: Beam on page 43
Example: Column on page 43
Example: Stairs on page 44
Creating single-part, assembly, or cast unit drawings on page 48
Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog on page 62
Creating drawings using rule sets or wizards in Master Drawing Catalog on page 68
Pours in drawings on page 225
Showing pours and pour breaks in drawings on page 228

**Example: Beam**

See below for an example of a combined form and reinforcing bar drawing of an inverted tee beam.

See also  Cast unit drawings on page 42
Example: Column

See below for an example of a combined form and reinforcing bar drawing of an exterior column with no corbels or plats for beams.

See also  Cast unit drawings on page 42
**Example: Stairs**

See below for an example of a combined form and reinforcing bar drawing of stairs with landings.

See also  [Cast unit drawings on page 42](#)

**Multidrawings**

Multidrawings are workshop drawings that gather several single-part or assembly drawings on one sheet.

Create multidrawings when you want to:

- Have more than one assembly on a sheet
- Collect multiple single-part drawings on a large sheet

Multidrawings usually demand large sheet sizes such as A1 or imperial standard size 24” x 36”.

Below is an example of a multidrawing with several assemblies included.
2.2 Before creating drawings

The list below contains some things that you may need to do before you create or clone drawings in Tekla Structures:

- The model needs to be numbered. If the model changes, the numbering needs to be updated. This applies to assembly, single-part, cast unit and multidrawings only; model does not need to be numbered before creating general arrangement drawings. Numbering ensures that Tekla Structures connects the right objects to the right drawings. If you try to create drawings without numbering the model, Tekla Structures prompts you to do so. You can also number general arrangement drawings, because then parts and marks will have numbers instead of question marks if you have included part position in part marks.

- Check that the piece is detailed correctly.

- You may want to create test drawings of different types of parts to see how well the predefined drawing properties, layouts, rule sets (wizards) or cloning templates suit your needs.

- You may want to modify drawing properties, layouts, or rule sets and save the modified settings for future usage. If you are going to use a drawing as a cloning template, check that it contains all the necessary elements for this purpose.

See also Drawing types on page 26
Creating multidrawings on page 49
2.3 Creating general arrangement drawings

Before you create general arrangement drawings, create the model views that you need and ensure that the views are as you want them to be in drawings. The drawing views will have the same orientation and content as the model view you select. Fit work area using two points to select the area that you want to show in the general arrangement drawing.

General arrangement drawings get overwritten if you recreate them. If you want to create another general arrangement drawing of the same model view, give another name to the drawing in drawing properties.

To create general arrangement drawings:

1. Create the model views you need.
   
   If you want to switch between 3D view and plane view in the created view, press Ctrl+P.

2. Click Drawings & Reports --> Drawing Settings --> General Arrangement Drawing... and select the appropriate predefined drawing properties (saved settings) from the list, and then click Load.
   
   Always load predefined properties when you are creating a drawing. When you need to modify drawing properties, save the new changes to the properties file when necessary.

3. If needed, modify drawing properties and, if necessary, apply object-level settings.

4. Click Apply or OK.

5. Click Drawings & Reports --> Create General Arrangement Drawing, or the corresponding toolbar command.
   
   Alternatively, you can select the model views from the model (selected views get a red frame), right-click and select Create General Arrangement Drawing from the pop-up menu.

6. If you have not selected the views yet, select them from the displayed list.
   
   You can use the Shift and Ctrl buttons for selecting several views.

7. In the Options list, select if you want to create one drawing for each selected view or add all selected views in one drawing.

   By selecting Empty, you can create an empty drawing and add drawing views in it afterwards.
8. If you want to open the created drawings, select Open drawing.
9. Click Create.

Tekla Structures creates the drawings and adds them in the Drawing List.

See also
- Modifying drawing settings on page 307
- General arrangement drawings on page 26
- Creating general arrangement drawings using saved settings in Master Drawing Catalog on page 58
- Creating views
- General arrangement drawing properties on page 523
- Pours in drawings on page 225

### 2.4 Creating single-part, assembly, or cast unit drawings

Cast units have the cast unit type part property setting in the model – they are set either **Cast in place** or **Precast**. It is important to use the correct cast unit type, because some functionalities, for example numbering, are based on the cast unit type. In the **Cast in Place** configuration, you can create cast unit drawings of cast-in-place cast units only.

To create single-part, assembly, or cast unit drawings:

1. Click **Drawings & Reports** --> Drawing Settings and select the drawing type.
2. In the drawing properties dialog box, load the appropriate predefined drawing properties (saved settings).
   - Always load predefined properties when you are creating a drawing. When you need to modify drawing properties, save the changes to a new properties file when necessary.

   Ensure that for cast unit drawings, you use a property file that contains the desired **Cast unit creation method**:
   - **By cast unit position**: A drawing will be created from each cast unit. If there are identical cast units, one of them will serve as the base cast unit for the drawing. This is the most common method for creating cast unit drawings.
   - **By cast unit ID**: Each part in the model includes a unique ID number. You can create drawings by using cast unit ID numbers. The ID number determines the marking of the drawing. You can create several drawings from identical cast units.

3. Click View creation, select the view and the properties that you want to change, and click View properties.
   - If you do not have any views defined yet, first add the views and then select the view properties for the views.

4. If needed, modify the view properties including view, building object, dimensioning and mark settings and apply detailed object-level settings.
5. Click **Save** to save the view properties.
6. Click **OK** to return to drawing properties.
7. Click **Apply** or **OK**.
8. Select the objects, or use an appropriate selection filter to select the objects you want to create drawings from and select the entire model.
   Activate only **Select parts** on the **Select switches** toolbar when selecting parts. Otherwise selection could take a long time in large models.
9. Do one of the following:
   - Click the desired drawing command on the **Drawings & Reports** menu.
   - Click the corresponding toolbar command.
   - If you selected individual objects, right-click and select the appropriate drawing creation command from the pop-up menu.
     If you press down Ctrl+Shift while you select the command from the pop-up menu, Tekla Structures opens the created drawing.
10. Number the model if you are prompted to do so.

Tekla Structures creates the drawings. The created drawings are listed in the **Drawing List**. If you already have a drawing with the same type and mark, Tekla Structures will not create a new one.

To automatically open any drawing after the drawing has been created, hold down Ctrl + Shift while you create the drawing.

**See also**  
Modifying drawing settings on page 307  
Pours in drawings on page 225  
Showing pours and pour breaks in drawings on page 228  
Single-part, assembly and cast unit drawing properties on page 526  
View properties in drawings on page 529

### 2.5 Creating multidrawings

You can create multidrawings of selected parts and of selected drawings. You can also create empty multidrawings and copy or link views in them from other drawings.

If you create multidrawings from existing drawings, you can choose to include their individual drawing layouts. If you want to have separate lists, tables, and call-offs for each part or assembly, you should include the individual drawing layouts. You can also include lists and tables for all parts or assemblies in the multidrawing.
Before creating a multidrawing, check the original assembly or single-part drawing, and clean it up, if necessary. Do not do the modifications in the multidrawing that links to the original.

Before you start, you can set `XS_MULTIDRAWING_REMOVE_VIEW_LABEL_GAP` to `TRUE` through `Tools --> Options --> Advanced Options --> Drawing Properties` to remove extra space between drawing view labels and drawing views.

See also
- Multidrawings on page 45
- `XS_MULTIDRAWING_REMOVE_VIEW_LABEL_GAP`
- Modifying drawing settings on page 307
- Creating empty multidrawings and linking or copying views on page 50
- Creating multidrawings of the selected drawings on page 50
- Creating multidrawings of the selected parts on page 51

Creating empty multidrawings and linking or copying views

You can create empty multidrawings in which you can link or copy views in other drawings with or without layout.

To create an empty multidrawing and link views:

1. Click `Drawings & Reports --> Create Multidrawing --> Empty Drawing`.
2. Open the empty multidrawing from the `Drawing List`.
3. From the `Drawing List`, select the drawings that you want to link to the multidrawing.
4. Click `Views --> Add Views from Other Drawing` and select one of the copying or linking commands.

The views are placed in the multidrawing.

5. Arrange the views if they are on top of each other.

When you update multidrawings, also the linked drawings are updated.

See also
- Creating multidrawings on page 49
Creating multidrawings of the selected drawings

You can create multidrawings of the drawings you select. You can also keep the layout of the selected drawing in the new multidrawing.

To create a multidrawing of selected drawings:
1. Select the drawings from the Drawing List.
2. Click Drawings & Reports --> Create Multidrawing and select one of the following commands:
   • Selected Drawings: Create multidrawings of the selected drawings without the drawing layout.
   • Selected Drawings with Layout: Create multidrawings of the selected drawings, keeping the layout of each selected drawing.

See also Creating multidrawings on page 49

Creating multidrawings of the selected parts

Create single-part and assembly drawings of the parts that you select and place the drawings in a multidrawing. You can also keep the layout of the selected single-part or assembly drawings.

To create a multidrawing of selected parts:
1. Select the parts using appropriate selection filters.
2. Click Drawings & Reports --> Create Multidrawing and select one of the following commands depending on the desired result:
   • New Single-Part Drawings of Selected Parts: Create single-part drawings of the selected parts and place the drawings in a multidrawing
   • New Single-Part Drawings of Selected Parts with Layout: Create single-part drawings of the selected part, keeping the layout of each drawing, and place the drawings in a multidrawing.
   • New Assembly Drawings of Selected Parts: Create assembly drawings of the selected parts and place the drawings in a multidrawing.
   • New Assembly Drawings of Selected Parts with Layout: Create assembly drawings of the selected parts, keeping the layout of each drawing, and place the drawings in a multidrawing.

See also Creating multidrawings on page 49
2.6 Master Drawing Catalog

The Master Drawing Catalog is a fast, efficient and controlled way of creating drawings using master drawings. In the Master Drawing Catalog, all drawing creation commands are available in one centralized location.

A master drawing is a Tekla Structures drawing or a set of drawing properties that is used for creating new drawings that look the same as the master drawing. There are several types of master drawings: cloning templates, saved settings and rule sets. You can also use the existing AutoDrawings wizard files as master drawings.

The example below shows the search view of the Master Drawing Catalog as a thumbnail list.

The Master Drawing Catalog has a toolbar containing commands for creating drawings, selecting the view type and the master drawing list type, displaying master drawing descriptions, selecting the models from which you want to use cloning templates, creating rule sets, displaying the Drawing List, and for keeping the Master Drawing Catalog window always on top.

Tekla Structures populates the catalog by looking for items in the Tekla Structures default folder search order: first from the firm folder, then from the project folder, and then from the
system folder and so on. Cloning templates in the folder defined for the advanced option
XS_CLONING TEMPLATE_DIRECTORY are shown in the catalog.

See also
Creating drawings on page 25
Master drawing types on page 53
Searching for master drawings in Master Drawing Catalog on page 76
Customizing Master Drawing Catalog on page 77
XS_CLONING TEMPLATE_DIRECTORY

Folder search order

Master drawing types

The master drawing type you should use depends on the type of the drawing that you want
to create:

• You can create single-part drawings, assembly drawings or cast unit drawings using
saved settings, rule sets, or cloning templates.

• You can create general arrangement drawings using saved settings.

• You can create multidrawings using wizards (old file-based rule sets)
Cloning templates

Cloning templates are Tekla Structures drawings that are used as templates for creating new drawings. You can select a drawing from the Drawing List and add it to the Master Drawing Catalog to be used as a template.

You can also use cloning templates that are located in other models. When you have similar parts in several projects, you can maintain a set of cloning template models and then take the cloning templates in the cloning template models in use when necessary.

Saved settings

The saved settings in Master Drawing Catalog are drawing properties files that have been created and saved in the drawing properties dialog boxes for different drawing types. There are many predefined drawing property files, and you can also create your own in the drawing properties dialog boxes.

Each drawing type has its own property files. Default saved settings are located in the environment (.\Tekla Structures<version>\environments\<environment>\system). When you save your own settings, they are saved under the current model directory.

Below some examples how the saved settings are show in the Master Drawing Catalog dialog box.
Creating drawings

Master Drawing Catalog
**Rule sets**

Rule sets are sets of rules on how to create drawings for different object types. A rule set is a combination of object groups (model selection filters) and master drawing settings (cloning templates, saved settings) that define which objects to include in the drawing, and which drawing settings to use. You can use the existing AutoDrawings wizard files or create your own rule sets.

The order of sets is important, as Tekla Structures by default creates only one drawing for each object. For example, a rule set creates an assembly drawing for an object that fulfills the selection filter criteria in one set. Tekla Structures will not create another assembly drawing for that object, even if it matches the criteria of the selection filter in later sets in the same rule set file.

See also Master drawing types on page 53
Creating drawings using saved settings in Master Drawing Catalog on page 57

See also Master drawing types on page 53
Creating drawings using rule sets or wizards in Master Drawing Catalog on page 68
Adding a rule set on page 78
Wizards

A wizard file is a file-based wizard consisting of several sets of drawing requests containing drawing, attribute and part settings to apply to selected objects, as well as a selection filter. The order of sets is important, as Tekla Structures by default creates only one drawing for each object. You can edit the files in the Master Drawing Catalog. However, creating new wizard files is not possible in the Master Drawing Catalog. Instead, you can create a rule set, which is basically the same thing as a wizard: It applies drawing properties to objects selected by filters, but in a dialog box, not in a text file like a wizard.

In the Master Drawing Catalog, the only way to create multidrawings is to use the wizard files.

See also
- Master drawing types on page 53
- Creating drawings using rule sets or wizards in Master Drawing Catalog on page 68
- Wizard file contents on page 84

Creating drawings using saved settings in Master Drawing Catalog

In Master Drawing Catalog, you can create single-part drawings, assembly drawings, cast unit drawings and general arrangement drawings using saved settings (drawing property files). You can edit the drawing properties of saved settings and apply object level settings.

See also
- Applying detailed object level settings in saved settings on page 57
- Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog on page 62
- Creating general arrangement drawings using saved settings in Master Drawing Catalog on page 58
- Adding saved settings on page 77

Applying detailed object level settings in saved settings

You can apply drawing object level settings in the drawings that you create in Master Drawing Catalog for the saved settings type of master drawings. This way you can use the same saved settings for many drawings and only apply some specific object level settings at the point when you create the drawing, for example, use different kind of marks or change the reinforcement color.

To apply detailed object level settings in saved settings for a general arrangement drawing:
1. In the **Master Drawing Catalog**, double-click the saved setting you want to use for creating drawings.

2. In the **Master Drawing Properties** dialog box, click **Edit drawing properties**

3. Click the toggle button at the bottom to empty the check boxes.

4. In the **Drawing Properties** dialog box, select only the **Use detailed object level settings** check box and ensure that the **Yes** button next to it is selected.

5. Click **Edit settings**.

6. Select the filter to be used, the drawing object type and the drawing object property file to be used.

7. Click **OK**.

8. Click **Save** on the top of the dialog box to save the changes in the saved settings file (property file).

9. Click **OK** in the **Master Drawing Properties** dialog box.

10. Create the drawings.

---

In single-part, assembly and cast unit drawings, you need to go from the **Drawing Properties** dialog box further to the view properties of the view where you want apply detailed object level settings.

---

**See also**

- Modifying properties of saved settings on page 82
- Creating detailed object level settings in a general arrangement drawing on page 318
- Example: Applying detailed object level settings on drawing level on page 319
- Creating detailed object level settings in cast unit drawings on page 322
- Example: Applying detailed object level settings on view level on page 323

---

**Creating general arrangement drawings using saved settings in Master Drawing Catalog**

Before you create general arrangement drawings, create the model views that you need and ensure that the views are as you want them to be. The drawing views will have the same orientation and content as the model view you select. Fit work area using two points to select the area that you want to show in the general arrangement drawing.

To create general arrangement drawings using saved settings:

1. In the model, click **Drawings & Reports --> Create Drawings**.

2. Select the set of saved settings (drawing properties file) from the list.
3. If needed, modify the drawing properties by double-clicking the saved setting and clicking **Edit drawing properties**.
   Remember to save the changes in the properties file.

4. Click **Create drawings** (Alt+C).

5. In the **Create General Arrangement Drawing** dialog box, select the views that you want to create and the desired option from the **Options** list.
   If you select **Empty**, you can create an empty drawing and add drawing views in it afterwards.

6. Click **Create** to create the drawings.

Tekla Structures creates the drawings and adds them in the **Drawing List**. Click in the **Master Drawing Catalog** toolbar to open the **Drawing List**.

General arrangement drawings get overwritten if you recreate them. If you want to create another general arrangement drawing of the same model view, give another name to the new drawing in drawing properties.

For more information about creating cast in place general arrangement drawings, see **Pours in drawings** on page 225

**See also**
- **Saved settings** on page 54
- **Creating drawings using saved settings in Master Drawing Catalog** on page 57
- **Creating general arrangement drawings** on page 47

**Creating anchor bolt plans using saved settings**

Anchor bolt plans are general arrangement drawings showing the anchor bolt layout. You can create anchor bolt plans in **Master Drawing Catalog** or using menu, pop-up menu and toolbar commands. Here we will create an anchor bolt plan using the **Master Drawing Catalog**.

Define the drawing as an anchor bolt plan when you are creating the drawing. You cannot convert a general arrangement drawing to an anchor bolt plan afterwards.

Before creating the anchor bolt plan, create a model view that is in the xy-plane.

To create an anchor bolt plan:

1. Click **Drawings & Reports --> Create Drawings**.
2. Double-click a saved setting that has been created for anchor bolt plans, for example, **anchor_bolt_plan**.
3. Open the General Arrangement Drawing Properties dialog box by clicking Edit drawing properties.

4. Click View.

5. Click the Anchor bolt plan tab and ensure that the option Show as anchor bolt plan is set to Yes.

6. Modify the enlarged part view scale, if necessary.

7. If needed, set the option Create detail views to Yes to create separate detail views.
   If you select No, Tekla Structures dimensions the anchor bolts in the enlarged view. Tekla Structures groups similar detail views so that similar details are drawn only once.

8. Set the Detail view scale.

9. Click Save to save the changes in the saved settings file (drawing properties file).

10. Click OK to close the Master Drawing Catalog Properties dialog box.

11. Select Create drawings.

12. In the Create General Arrangement Drawing dialog box, click Create.

13. Select one view in the xy-plane.
   If you select some other type of view or several views, Tekla Structures displays a warning message and the anchor bolt plan is not created.

14. Click Create.
   Tekla Structures creates the anchor bolt plan.
   Tekla Structures creates the bolt dimensions in an anchor bolt plan in the directions of the bolt group coordinate system. If the angle between the bolt group and the view coordinate systems is not orthogonal, Tekla Structures adds angle dimensions to the detail view. Use the advanced option XS_ANCHOR_BOLT_PLAN_USE_VIEW_COORDSYS_FOR_BOLT_DIMENSIONS to create the dimensions in the x and y directions of the main view.

When details are compared, the following aspects are taken into account:

- bolt dimensions
- column profile
- column orientation (coordinate system)
- plate profile

In the final drawing, check that the Ghost Outline is selected and Drawing Color Mode is set to Color in Tools --> Options. In color drawings with white background, hidden objects are shown as ghost outlines, if this setting is selected. In gray scale and black and white drawings, hidden objects are not shown even if Ghost Outline is selected.

See also XS_ANCHOR_BOLT_PLAN_USE_VIEW_COORDSYS_FOR_BOLT_DIMENSIONS
Objects included in the anchor bolt plan

Tekla Structures selects the objects that are included in the anchor bolt plan based on the following default rules:

- The part is a column or an almost vertical beam.
- The part is the main part of an assembly.
- A base plate is included in the assembly, and it is located lower than the main part. If there is more than one part in the column assembly that fulfills the rules, the lowest part of them is considered to be the base plate.
- Bolts are attached to the base plate.
- The assembly is cut by the view plane.
- The boundary box of the base plate in the xy-direction intersects the boundary box of the column.

See also Creating anchor bolt plans using saved settings on page 59

Defining the anchor bolt plan parts using drawing filters

You can use general arrangement drawing filters and advanced options to define the parts to be included in the anchor bolt plan.

To define the included parts using general arrangement drawing filters:

1. Create the necessary general arrangement drawing filters in the Filter Properties subdialog box of the general arrangement drawing properties dialog box.
2. Click Tools > Options > Advanced Options > Drawing Properties.
3. Enter the following values for the following advanced options:
   - XS_ANCHOR_BOLT_PLAN_COLUMN_FILTER: <the name of the drawing filter for columns>
   - XS_ANCHOR_BOLT_PLAN_BOLT_FILTER: <the name of the drawing filter for bolts>
• XS_ANCHOR_BOLT_PLAN_BASEPLATE_FILTER: <the name of the drawing filter for base plates>

• XS_ANCHOR_BOLT_PLAN_ADDITIONAL_PARTS_FILTER: <the name of the drawing filter for additional parts>

If you do not use these advanced options, the default rules are used to determine columns, baseplates, and anchor bolts to be included in the anchor bolt plan.

Using these advanced options only affects the creation of new anchor bolt plan drawings, and do not affect the already created ones.

See also

XS_ANCHOR_BOLT_PLAN_BASEPLATE_FILTER

XS_ANCHOR_BOLT_PLAN_BOLT_FILTER

XS_ANCHOR_BOLT_PLAN_COLUMN_FILTER

XS_ANCHOR_BOLT_PLAN_ADDITIONAL_PARTS_FILTER

Creating drawing filters

Creating anchor bolt plans using saved settings on page 59

Including assemblies in anchor bolt plans

If you have anchor bolts at varying elevations, you can create the general arrangement drawing at the level of the top-most base plate/anchor bolt. The anchor bolt plan view extrema only looks downwards. If the lowest level anchor bolt is not shown, adjust the advanced option XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE.

To specify the distance:

1. Click Tools --> Options --> Advanced Options --> Drawing Properties.

2. Set a value for the advanced option

   XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE.

   Define the distance in millimeters. The default value is 200 mm.

See also

XS_ANCHOR_BOLT_PLAN_DRAWING_TOLERANCE

Creating anchor bolt plans on page 59
Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog

- Cast units have the cast unit type part property setting in the model – they are set either **Cast in place** or **Precast**. It is important to use the correct cast unit type, because some functionalities, for example numbering, are based on the cast unit type. In the Cast in Place configuration, you can create cast unit drawings of cast-in-place cast units only.

- For prerequisites for and more information about creating cast in place cast unit drawings, see **Pours in drawings on page 225**

To create single-part, assembly or cast unit drawings using saved settings type of master drawings:

1. In the model, click **Drawings & Reports --> Create Drawings**.
2. Select the desired set of saved settings (drawing properties file) on the list. For cast unit drawings, select a file that contains the desired **Cast unit creation method**:
   - **By cast unit position**: A drawing will be created from each cast unit. If there are identical cast units, one of them will serve as the base cast unit for the drawing. This is the most common method for creating cast unit drawings.
   - **By cast unit ID**: Each part in the model includes a unique ID number. You can create drawings by using cast unit ID numbers. The ID number determines the marking of the drawing. You can create several drawings from identical cast units.
3. If needed, modify the drawing properties and, if necessary, apply object-level settings. To do this, double-click the saved setting and click **Edit drawing properties**. Remember to save your changes in the property file.
4. If you are creating a drawing only for selected objects, select the objects. You can also use an appropriate selection filter and select the whole model. Activate only the **Select parts** selection switch when you select objects, otherwise the selection may take a long time.
5. Click **Create drawings (Alt+C)** or **Create drawings for all parts (Alt+A)**.
6. Number the model if you are prompted to do so.

Tekla Structures creates the drawings and adds them in the **Drawing List**. Click the button in the **Master Drawing Catalog** toolbar to open the **Drawing List**.

If you already have a drawing with the same type and mark, Tekla Structures will not create a new one.

See also  **Example: Creating cast unit drawings one by one on page 64**
Example: Creating assembly drawings from groups of similar parts on page 67
Saved settings on page 54
Creating drawings using saved settings in Master Drawing Catalog on page 57
XS_DRAW_CAST_UNIT_INTERNAL_LINES
XS_DRAW_CAST_PHASE_INTERNAL_LINES

Example: Creating cast unit drawings one by one

In this example, you will create a drawing of a cast unit using saved settings called Column_with_BOM.

To create a drawing of a cast unit:

1. In the model, right-click the concrete column and select Cast Unit --> Set Top in Form Face, and select the cast unit face that will face upwards in the form.

When you right-click the column and select Cast Unit --> Show Top in Form Face, the selected face is shown red, see the image below.

The top-in-form face will be displayed in the front view of a drawing.
2. Still in the model, double-click the column and select Precast as the **Cast unit type**. It is important to use the correct cast unit type, because some functionalities, for example, numbering, are based on the cast unit type.

3. Select **Drawings & Reports --> Drawing Settings --> Cast Unit Drawing**.

4. In the properties dialog box, load the appropriate predefined drawing properties (saved settings). In this example, **Column_with_BOM** is loaded.

5. Ensure that the **Column_with_BOM** settings contain the desired **Cast unit creation method**:
   - **By cast unit position**: A drawing will be created from each cast unit. If there are identical cast units, one of them will serve as the base cast unit for the drawing. This is the most common method for creating cast unit drawings.
   - **By cast unit ID**: Each part in the model has a unique ID number. You can create drawings by using cast unit ID numbers. The ID number determines the marking of the drawing. You can create several drawings from identical cast units.

6. If you made any changes in **Column_with_BOM**, save the changes and close the dialog box.

7. Select the column in the model.

8. Click **Drawings & Reports --> Create Drawings**.

9. Select the saved settings **Column_with_BOM (C)** under **Cast-unit drawings**.
10. Click **Create drawings**.

Tekla Structures creates the drawing.

You can open the **Drawing List** by clicking the **Drawing List** button on the toolbar and open the drawing to view it.

**See also**  Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog on page 62
Example: Creating assembly drawings from groups of similar parts

Creating drawings one by one may take a lot of time. You can automate the creation process a bit more by selecting groups of items and then create the drawings. For example, you can define the needed properties for the beams and then run all the beam drawings at once by using the Tekla Structures model selection filters. In this example, you are going to use saved settings named Beam_with_BOM and create assembly drawings from all beams.

To create assembly drawings in groups:

1. Define a selection filter that selects only one type of items, in this case beams.
   a. Click Edit --> Selection Filter in the model.
   b. Create a selection filter that selects all objects named BEAM and save it using the name BEAM.

2. Activate the BEAM filter from the list of selection filters and use area selection to select all beams in the model.
3. Open the **Master Drawing Catalog** by clicking **Drawings & Reports --> Create Drawings**.

4. Under **Assembly drawings**, select the saved settings master drawing. In this example, **Beam_with_BOM (A)** is selected.

5. Click **Create drawings**.

Tekla Structures creates the beam assembly drawings.

**See also**  [Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog on page 62](#)
Creating drawings using rule sets or wizards in Master Drawing Catalog

In the Master Drawing Catalog, you can create single-part, assembly and cast unit drawings using rule sets, and multidrawings using wizards. You can use the file-based wizards, use the existing rule sets or create your own.

To create drawings using a rule set or wizard:

1. In the model, click **Drawings & Reports --> Create Drawings**.
2. Select a rule set or a wizard file from the list.
3. If needed, modify rule set properties or wizard file contents by double-clicking the rule set or wizard.
4. If needed, edit the drawing properties of the master drawing connected to the rule set. To do this double-click the rule set, select the master drawing from the list and click **Properties --> Edit drawing properties**. Remember to save your changes.
5. Select the whole model or desired parts.
6. Do one of the following:
   - If you selected parts, click **Create drawings** (Alt+C).
   - If you selected the whole model, click **Create drawings for all parts** (Alt+A).
7. Number the model if prompted to do so.

Tekla Structures creates the drawings and adds them in the Drawing List. Click the drawing list icon on the Master Drawing Catalog toolbar to open the Drawing List.

If you already have a drawing with the same type and mark, Tekla Structures will not create a new one.

Limitations

- In the Master Drawing Catalog, you can create multidrawings only by using the wizards. You cannot create rule sets for multidrawings.
- You cannot create general arrangement drawings in the Master Drawing Catalog using rule sets or wizards. General arrangement drawings can only be created using saved settings.

See also

- Rule sets on page 56
- Wizards on page 57
- Master Drawing Catalog on page 51
- Adding a rule set on page 78
- Example - Creating a new rule set and drawings for all parts on page 69
Example – Creating a new rule set and drawings for all parts

The following example will go through creating a basic rule set that will create assembly and single part drawings based on the names of the parts in the model.

The model used here is a very simple model consisting of two columns with a beam in between, base plates and end plates. The parts are named **BEAM**, **COLUMN** and **PLATE**.

Before setting up a rule set in the **Master Drawing Catalog**, you need to have some saved settings (drawing properties) and some selection filters that link the drawing properties to the parts in the model.

You need to have filters that select the beams, columns and plates.

To create the selection filters:

1. In the model, select **Edit --> Selection Filter**.
2. Click **Add row** and add a selection filter for the beams as shown below, saving it as **DRAWING_BEAM**.

   ![Object Group - Selection Filter](image)

   Objects with matching properties can be selected

<table>
<thead>
<tr>
<th></th>
<th>Category</th>
<th>Property</th>
<th>Condition</th>
<th>Value</th>
</tr>
</thead>
<tbody>
<tr>
<td>✓</td>
<td>Part</td>
<td>Name</td>
<td>Contains</td>
<td>BEAM</td>
</tr>
<tr>
<td>✓</td>
<td>Object</td>
<td>Object type</td>
<td>Equals</td>
<td>Part</td>
</tr>
</tbody>
</table>

3. In the same way, create selection filters for columns and plates, saving them as **DRAWING_COLUMN** and **DRAWING_PLATE**.

   The new filters are displayed in the selection filter list.
4. Close the Selection Filter dialog box by clicking Cancel.

The new filters will be saved in the model folder. If necessary, copy them to the necessary folders, for example, to the firm or project folders.

Next you need to modify the drawing properties and save them so that they are displayed as saved settings in the Master Drawing Catalog. The saved settings are created separately for single-part drawings and assembly drawings.

To create saved settings:

1. Click Drawings & Reports --> Drawing Settings --> Assembly Drawing and create properties for a beam and a column drawing.

2. Give a descriptive name for the drawing in the Name box, for example, BEAM for the beam properties and COLUMN for the column properties.

3. Save the properties as DRAWING_BEAM and DRAWING_COLUMN.

4. Click Drawings & Reports Drawing Settings Single-part Drawing and create some single-part drawing settings for a beam shaft, column shaft and plates.
5. Give a descriptive name for the drawing in the Name box, for example, BEAM SHAFT for the beam shaft properties, COLUMN SHAFT for the column shaft properties and PLATE for the plate properties.

6. Save the settings as DRAWING_BEAM_SHAFT, DRAWING_PLATES and DRAWING_COLUMN_SHAFT.

Creating a rule set  

Now that you have created the necessary selection filters and saved settings, you can create a rule set that automatically creates single-part and assembly drawings for beams, columns and plates.

To create a rule set:

1. Click Drawings & Reports --> Create Drawings.

2. Click Define rule set icon on the toolbar.

3. In the Define Rules for Creating Drawings dialog box, select the drawing types you want to create with the rule set and click Next.

   In this example, select Single-part drawings and Assembly drawings.

4. In the Define Rules - Single-part Drawings dialog box, click Add group and select the filters and the corresponding single-part drawing saved settings.

5. Under Object group select the three new filters, and under Master drawing, select the three new saved settings.

   The (S) after the master drawing name indicates that its type is saved setting.

6. Click Next.
7. In the Define Rules – Assembly Drawings dialog box, click Add group and select the filters and the corresponding assembly drawing saved settings.

8. Under Object group select the two new filters, and under Master drawing, select the two new saved settings.

9. Click Next.

10. Give the rule set a name (Rule Set: Column+Beam+Plate), description and keywords.

11. Use Browse next to Preview image and add a sample image for the master drawing.

12. Click Finish when you are done.

Now you can create drawings using the new rule set.

To create the drawings:
1. In the **Master Drawing Catalog Search** view, enter your search criteria in the box next to the **Search** button and click the button.

   In this example, column beam plate is entered. Tekla Structures finds the newly created rule set.

2. Right-click the rule set and select **Create drawings for all parts**.

   Tekla Structures starts creating the drawings. When the drawings have been created, the following message is displayed pointing to the **Drawing List** icon on the toolbar: "6 drawings created. Open the **Drawing List** to see the results". This is a correct amount of drawings.

3. To check which drawings have been created, click the **Drawing List** toolbar icon.

   ![Drawing List Icon](image)

   13.03.2013 00.00.0000 410* 287 A [E.1] BEAM
   13.03.2013 00.00.0000 410* 287 A [C.1] COLUMN
   13.03.2013 00.00.0000 410* 287 W [F.1] PLATE
   13.03.2013 00.00.0000 287* 210 W [F.2] PLATE
   13.03.2013 00.00.0000 410* 287 W [M.1] COLUMN SHAFT
   13.03.2013 00.00.0000 287* 210 W [M.2] BEAM SHAFT

See also **Creating single-part, assembly and cast unit drawings using saved settings in Master Drawing Catalog on page 62**

---

**Creating multiple drawing sheets of the same part**

You can create several drawings from the same part as multiple drawing sheets. The number of sheets is not limited, and each drawing can have its own properties. This is useful when you need extra sheets for details and section views, and especially when you want to have several drawings of an assembly with different presentation options: one with a large 3D image of the assembly, one with additional section views, and one where only certain parts or sub-assemblies of the assembly are marked and dimensioned.

You can create multiple drawing sheets of the same part in the **Master Drawing Catalog** using rule sets or wizards, or using the drawing properties dialog box.

See also **Creating drawings on page 25**

**Creating multiple drawing sheets using wizards on page 74**

**Creating multiple drawing sheets using drawing properties on page 75**

**Copying a drawing to a new sheet on page 100**
Creating multiple drawing sheets using wizards

Before you start, ensure that you have created drawing property files (saved settings) for creating multiple sheets for the same part, each file containing the desired settings for a specific purpose and individual sheet numbers.

To create several drawing sheets of the same part using drawing wizards in the Master Drawing Catalog:

1. Click Drawings & Reports --> Create Drawings to open the Create Drawings – Master Drawing Catalog dialog box.
2. Double-click the desired wizard file in the list to open the Master Drawing Properties dialog box.
3. Click Edit drawing properties to open the wizard file.
4. In the file, give the names of the drawing properties files that you want to use to create the multiple drawing sheets.
   Give the file names in parenthesis on the set_drawing_attributes row as shown below:
   set_drawing_type(cast_unit)
   set_drawing_attributes(sheet1, sheet2, sheet3)
   set_filter(column_filter)
   create_drawings()
5. Save the wizard file with a new name.
6. In the model, select the parts you want to create the drawings from.
7. Click the newly created wizard file in the Master Drawing Catalog and click Create Drawings. Tekla Structures creates the drawings.

See also
Creating multiple drawing sheets of the same part on page 74
Wizards on page 57
Wizard file contents on page 84

Creating multiple drawing sheets using drawing properties

To create multiple drawing sheets through the drawing properties dialog box:

1. Open the drawing properties dialog box by double-clicking the background of an open drawing.
2. Adjust the drawing properties and change the name so that it refers to the type of drawing you want to create, for example, FRAME 3D.
   Do not touch the Sheet number.
3. Click Apply to keep the changes and leave the dialog box open.
4. Create a drawing of the object by selecting the appropriate command from the Drawings & Reports menu.

5. In the drawing properties dialog box, adjust the drawing properties again and change the name to match the type of the new drawing, for example, FRAME FRONT.

6. Change the sheet number in the Sheet number box to get another drawing of the same assembly with a different sheet number.

7. Click Apply and create a new drawing of the same object with different properties.

8. Continue making all the sheets you need in the same way as in steps 5 - 7.

**Example** An example how the **Drawing List** shows the multiple drawings:

<table>
<thead>
<tr>
<th>Date</th>
<th>Number</th>
<th>Size</th>
<th>Drawing Format</th>
<th>Name</th>
</tr>
</thead>
<tbody>
<tr>
<td>02.01.2012</td>
<td>1179</td>
<td>A</td>
<td>[FRAME.1 - 1]</td>
<td>FRAME FRONT</td>
</tr>
<tr>
<td>02.01.2012</td>
<td>830</td>
<td>A</td>
<td>[FRAME.1 - 2]</td>
<td>FRAME DETAILS</td>
</tr>
<tr>
<td>02.01.2012</td>
<td>1179</td>
<td>A</td>
<td>[FRAME.1]</td>
<td>FRAME 3D</td>
</tr>
</tbody>
</table>

**See also** Creating multiple drawing sheets of the same part on page 74

---

**Searching for master drawings in Master Drawing Catalog**

In the **Master Drawing Catalog** search view, you can search for master drawings on the basis of the text that has been entered in the name, description and keyword boxes in the **Master Drawing Properties** dialog box and save your search results. In the folder view, you can copy master drawings from a search results folder to another folder to make it easier for you to locate the master drawings you need.

Make sure to always add all important information for each master drawing in the **Master Drawing Properties** dialog box. This makes it a lot easier to find the master drawings you are looking for.

To search for master drawings and save the search results:

1. Enter the search criteria in the box next to the **Search** button.

   Tekla Structures remembers search strings. When you start typing a string, it suggests previous strings starting with the same characters.

2. Click **Search**. The results are listed.

3. To save the search results, click **Store**, type a name for the search, and click **OK**.

   The search results are added in the category list in the search view.

   The search results are also displayed as a folder in the folder view. There you can rename the saved search results, and copy the found drawings to the folders of your choice.

**See also** Master Drawing Catalog on page 51

Modifying master drawing properties on page 81
Customizing Master Drawing Catalog

You can customize the Master Drawing Catalog according to your needs. Keeping the Master Drawing Catalog up to date and well organized is essential if you want to create drawings fast and efficiently. Having good master drawings saves time and effort. Add only the necessary master drawings, remove obsolete ones, organize the master drawings in folders, add proper preview images, and keep the properties, descriptions and keywords up to date.

See also
- Adding master drawings in Master Drawing Catalog on page 77
- Removing master drawings from the Master Drawing Catalog on page 80
- Modifying master drawing properties on page 81
- Managing Master Drawing Catalog folders on page 86
- Adding sample and thumbnail images to master drawings on page 90
- Master Drawing Catalog on page 51
- Sample images of drawings on page 89

Adding master drawings in Master Drawing Catalog

Depending on your environment, the Master Drawing Catalog usually contains some master drawings when you start using it, at least the predefined saved settings (drawing property files) are displayed there. You can also add new saved settings, rule sets and cloning templates.

See also
- Adding saved settings on page 77
- Adding a rule set on page 78
- Adding a cloning template on page 80

Adding saved settings

All predefined drawing properties files are shown as saved settings in the Master Drawing Catalog. When you save a new drawing properties file, Tekla Structures shows it in the Master Drawing Catalog.

To add saved settings to the Master Drawing Catalog:

1. Modify the drawing properties in the Single-part Drawing Properties, Cast Unit Drawing Properties, Assembly Drawing Properties or General Arrangement Drawing Properties dialog box.

2. Give a name to the property file in the box next to the Save as button and click Save as.

The new property file is automatically added to the Master Drawing Catalog. If it is not displayed in the list, press F5 to refresh the view.
3. Modify master drawing properties: give the master drawing a name, add a sample image, and enter a description and keywords.

See also
Adding master drawings in Master Drawing Catalog on page 77
Saved settings on page 54
Adding sample and thumbnail images to master drawings on page 90
Creating drawings using saved settings in Master Drawing Catalog on page 57

Adding a rule set

To add a rule set in the Master Drawing Catalog:

1. Click the Add rule set toolbar command button.

2. In the Define Rules for Creating Drawings dialog box, select the drawing types you want to create with the rule set.
   You can select several drawing types with the same rule set. For example, you can use the same rule set to create single-part drawings and assembly drawings.

3. Click Next.
4. In the next dialog box, click **Add group** and select the object groups for which you want to create drawings, and a master drawing for each group.

Only those master drawing types are listed that can be used for the drawing types that you selected in the previous dialog box. Saved settings are marked with an S and cloning templates with T.

You can use the buttons in the dialog box to do the following:

- Use **Move up** and **Move down** to move a rule upwards and downwards in the list.

  If a rule that is higher in the list creates a drawing of an object, another rule lower in the list that would create a drawing of the same object will not do it again.

- Use **Properties** to view or modify the properties of a master drawing that you have selected in the list.

- Use **Preview** to display a sample image of the selected master drawing.

5. Click **Next**.

6. If you have selected several drawing types, repeat steps 4 and 5 for all drawing types that you have selected.

7. Modify master drawing properties of the rule set: give a name to the rule set, add a sample image, and enter a description and keywords.

8. Click **Finish**. The rule set is added in the **Master Drawing Catalog**.
Adding a cloning template

You can add drawings in the **Master Drawing Catalog** from the **Drawing List**.

Before you add a cloning template in the **Master Drawing Catalog**, create a drawing with the desired properties and contents and save it.

Limitations: You cannot add general arrangement drawings or multidrawings to the **Master Drawing Catalog** from the **Drawing List**. You can clone general arrangement drawings using the **Clone** command in the **Drawing List** dialog box.

To add a new cloning template:

1. Open the **Drawing List** by clicking **Drawings & Reports --> Drawing List**.
2. Select the drawing, right-click and select **Add to Master Drawing Catalog** (Ctrl + M).
3. Modify the master drawing properties of the cloning template. On the **General** tab, enter a name for the cloning template, and a short description and keywords.
4. Tekla Structures adds a preliminary thumbnail image for the cloning template. If necessary, click **Change Image** and browse for a new image. The same image will then be displayed when you right-click the thumbnail and select **Preview**.
5. Go to the **Drawing creation** tab and specify how dimensions and marks are created, and select the objects to be cloned from the master drawing.
6. Click **OK**.

The new cloning template is added in the **Master Drawing Catalog**. The icon is displayed in the **Master** column of the **Drawing List** next to the drawing you added.

See also

- Adding master drawings in Master Drawing Catalog on page 77
- Cloning templates on page 54
- Creating drawings using cloning templates in Master Drawing Catalog on page 92
- Adding sample and thumbnail images to master drawings on page 90
Removing master drawings from the Master Drawing Catalog

Limitations: In the folder view, you cannot remove master drawings from the Master Drawing Catalog through the folders that you have created yourself. Use the Saved searches folders to display the desired master drawings and then remove the extra ones.

To remove master drawings from the Master Drawing Catalog:
1. In the Master Drawing Catalog, select the master drawings you want to remove.
2. Right-click and select Remove from Catalog.
3. Confirm the removal.

Tekla Structures removes the master drawing(s) from the catalog. Any created drawings that are based on removed master drawings remain in the Drawing List. The catalog properties that you have entered for the master drawing are not deleted. They are still available for the master drawing if you decide to add the master drawing back to the catalog.

See also Customizing Master Drawing Catalog on page 77

Modifying master drawing properties

Each master drawing in the Master Drawing Catalog has its own properties. You can search for master drawings based on the master drawing name, description and keywords. A sample image can also be added for each master drawing (Change image button). The sample image is also shown as a thumbnail in the thumbnail view of the Master Drawing Catalog. You can access drawing properties (Edit drawing properties button) and you can, for example, apply object level settings.

Make sure to always add all important information for each master drawing in the Master Drawing Properties dialog box. This makes it a lot easier to find the master drawings you are looking for.
Adding sample and thumbnail images to master drawings on page 90

Modifying rule set properties on page 83
Modifying properties of saved settings on page 82
Modifying properties and contents of wizard files on page 83
Wizard file contents on page 84
Modifying cloning template properties on page 85
Master Drawing Catalog on page 51
Customizing Master Drawing Catalog on page 77

**Modifying properties of saved settings**

To modify the master drawing properties of saved settings:

1. In the **Master Drawing Catalog**, double-click a master drawing of the desired type.
2. Modify the name of the drawing in the **Name** box.
3. Enter or modify the description of the master drawing. You can search master drawings on the basis of data that you enter here.
4. Enter or modify keywords for the master drawing. Use spaces between words. You can search master drawings on the basis of data that you enter here.
5. To add or change the sample image, click **Change image** and select the image. You can use `.bmp`, `.jpg`, `.jpeg`, or `.png` images. We recommend that you use `.png` images.
6. If needed, modify the drawing properties of the master drawing by clicking Edit drawing properties... to display the drawing properties dialog box. This also allows you to apply object level settings.

   Edit the properties and save them. Ensure that you have the correct drawing property file name at the top.

7. Click OK.

See also: 
- Modifying master drawing properties on page 81
- Applying detailed object level settings in saved settings on page 57
- Saved settings on page 54

**Modifying rule set properties**

To modify the master drawing properties of rule sets:

1. In the Master Drawing Catalog, double-click a master drawing of the desired type.
2. In the Edit Rules dialog box, modify the drawing type selections if necessary.
3. Click Next.
4. Add or remove object groups and select the appropriate master drawing type.
5. Click Next and do the same for all the selected drawing types.
6. Modify the name of the drawing in the Name box.
7. Enter or modify the description of the master drawing.
   You can search for master drawings based on the data you enter here.
8. Enter of modify keywords of the master drawing.
   Use spaces between words. You can search master drawings on the basis of data you enter here.
9. To add or change the sample image, click Change image and select the image.
   You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you use .png images.
   The same image is used in the thumbnail view of the Master Drawing Catalog.
10. Click Save to save your changes.

See also: 
- Modifying master drawing properties on page 81
- Rule sets on page 56
**Modifying properties and contents of wizard files**

You can modify wizard files using a text editor through the Master Drawing Properties dialog box. In previous versions of Tekla Structures, you could only edit and use wizard files through the AutoDrawings dialog box.

To modify the master drawing properties of wizard files and the wizard file contents:

1. In the Master Drawing Catalog, double-click a wizard file.
2. Modify the name of the drawing in the Name box.
3. Enter or modify the description of the master drawing.
   You can search for master drawings based on the data you enter here.
4. Enter of modify keywords of the master drawing.
   Use spaces between words. You can search for master drawings based on the data you enter here.
5. To add or change the sample image, click Change image and select the image.
   You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you use .png images.
   The sample image will also be used as the thumbnail image of the master drawing in the thumbnail view of the Master Drawing Catalog.
6. To edit the contents of the wizard file, click Edit drawing properties.
   The wizard file is opened in a text editor. Modify the contents of the file, and save and close it.
7. Click OK.

See also  [Modifying master drawing properties on page 81](#)

Wizards on page 57

**Wizard file contents**

Wizard files consist of the following entries. Notice the use of parentheses.

`set_drawing_type(assembly)`

This line defines the type of drawing the wizard creates. The drawing type appears in parentheses. The options are:

<table>
<thead>
<tr>
<th>Option</th>
<th>Creates</th>
</tr>
</thead>
<tbody>
<tr>
<td>single</td>
<td>single-part drawings</td>
</tr>
<tr>
<td>assembly</td>
<td>assembly drawings</td>
</tr>
<tr>
<td>multi_single</td>
<td>single-part multidrawings</td>
</tr>
<tr>
<td>multi_single_with_layout</td>
<td>single-part multidrawings with layout</td>
</tr>
<tr>
<td>Option</td>
<td>Creates</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------</td>
</tr>
<tr>
<td>multi_assembly</td>
<td>assembly multidrawings</td>
</tr>
<tr>
<td>multi_assembly_with_layout</td>
<td>assembly multidrawings with layout</td>
</tr>
<tr>
<td>cast_unit</td>
<td>cast unit drawings</td>
</tr>
</tbody>
</table>

set_drawing_attributes(column)
This line tells Tekla Structures which drawing properties to use when creating the drawings. The name of the saved drawing properties appears in parentheses.

set_template_drawing
This line tells Tekla Structures to use the defined drawing as a template when creating a new drawing. This line is used instead of the line set_drawing_attributes. The path and the name of the drawing template are given in parenthesis like in the following example:

set_template_drawing("C:\TSModels\AngleModel":"[A.2]"")

set_filter(column_filter)
This line tells Tekla Structures which selection filter to use to select the parts from which to create drawings. The filter name appears in parentheses.

create_drawings()
Tekla Structures starts creating the drawings. This line should always appear immediately after the lines set_drawing_type, set_drawing_attributes and set_filter.

See also
- Wizards on page 57
- Creating drawings using rule sets or wizards in Master Drawing Catalog on page 68
- Modifying properties and contents of wizard files on page 83

**Modifying cloning template properties**
To modify the master drawing properties of cloning templates:
1. In the Master Drawing Catalog, double-click a master drawing of the desired type.
2. Modify the name of the drawing in the Name box.
3. Enter or modify the description of the master drawing.
   You can search for master drawings based on the data you enter here.
4. Enter or modify keywords of the master drawing.
   Use spaces between words. You can search for master drawings based on the data you enter here.
5. To add or change the sample image, click Change image and select the image.
You can use .bmp, .jpg, .jpeg, or .png images. We recommend that you use .png images.

The sample image will also be used as the thumbnail image of the master drawing in the thumbnail view of the Master Drawing Catalog.

6. Go to the Drawing creation tab.
   a. For the Dimensions, Marks, and Marks for welds in model, define whether you want to Clone them, recreate them automatically when you clone a drawing (Create) or Ignore them in cloning.
   b. Select the objects to be cloned from the master drawing: Drawing welds, Level marks, DWG/DXF, Text files, Texts, Symbols, Graphics, and Hyperlinks).

7. Click OK.

See also
- Modifying master drawing properties on page 81
- Cloning templates on page 54
- Creating drawings using cloning templates in Master Drawing Catalog on page 92

Managing Master Drawing Catalog folders

In the folder view of the Master Drawing Catalog you can manage the folders in the following ways:

- Add new, rename, and delete folders
- Copy master drawings to another folder
- Delete master drawings from folders
- Change the folder location in the tree
Deleting master drawings from a folder or copying them to another folder in the folder view does not affect the catalog contents in any way. The folder view is just another way to help you to keep your master drawings well organized.

See also
- Example: Adding, renaming, and moving folders on page 87
- Copying master drawings to another folder on page 88
- Removing master drawings from a folder on page 89
- Customizing Master Drawing Catalog on page 77
Example: Adding, renaming, and moving folders

This is an example of how you can add, rename and move folders in the Master Drawing Catalog:

1. In the Master Drawing Catalog, click the folder view button to go to the folder view.
2. To add a folder: Right-click the tree area in the upper part of the folder view, select Create new folder and enter a name for the new folder.
   For example, enter PROJECT_XYZ.
3. To add a subfolder: Right-click folder, in this case PROJECT_XYZ, and select Create new subfolder.
4. Enter a name for the folder.
   For example, enter Site12.
5. Create another subfolder Site10 following the steps 3 - 4.
6. To rename a folder: Right-click the folder, select Rename (F2) and enter a new name.
   For example, rename Site10 to Site11.
7. To move a folder upwards: Right-click the folder and select Move up. In this case, we move Site11 one step up.

See also Managing Master Drawing Catalog folders on page 86

Copying master drawings to another folder

To copy drawings to another folder:

1. In the Master Drawing Catalog, click the folder view button to go to the folder view.
2. Open the folder containing the master drawings that you want to copy to another folder, and select the drawings.
3. Right-click and select Add to and then select the desired folder.

The master drawings are copied. They are not removed from the original folder.

Use the following keys and key combinations for selecting drawings:

- Select all displayed drawings: Ctrl + A
- Select consecutive drawings: Click the first drawing, hold down Shift and select the last drawing.
Select several drawings: Click the first drawing, hold down Ctrl and select the rest of the drawings.

See also Managing Master Drawing Catalog folders on page 86

Removing master drawings from a folder

You may want to remove master drawings from a folder in the folder view, for example, when you have added the master drawings in another folder and do not need them in the original folder anymore.

To remove drawings from a folder:

1. In the Master Drawing Catalog, click the folder view button 🏛️ to go to the folder view.
2. In the upper part of the folder view, click the folder from which you want to remove drawings.
   The master drawings in the folder are shown in the lower part of the view.
3. Select the master drawings to be deleted, right-click and select Remove from folder.
   The master drawings are removed from the folder. The master drawings are not removed from the catalog, just from the folder.

See also Managing Master Drawing Catalog folders on page 86

Sample images of drawings

You can create sample or preview images of the drawings. These screenshots are saved by default in the \drawings folder under the model folder as .png files.

The sample images can be viewed by selecting Preview from the master drawing's pop-up menu. They can also be used as thumbnail images for master drawings in the Master Drawing Catalog views. They can also be viewed through the Clone Drawings dialog box, when you start cloning from the Drawing List.

See also Creating sample images on page 89
Adding sample and thumbnail images to master drawings on page 90
Viewing sample images of drawing templates on page 90

Creating sample images

You may want to add a sample image for a master drawing in the Master Drawing Catalog. Before you can create a sample image, you must first create the drawing.

To create a sample image:
1. Open the drawing you want to use.

2. Clean up the drawing from unnecessary objects, for example, associativity symbols.

3. Click **Tools > Create Preview Image**.

   The image is saved in the \drawings folder under the model folder in .png format with the same name as the drawing.

**See also**  Sample images of drawings on page 89

---

**Adding sample and thumbnail images to master drawings**

Before you can add a sample image or a preview image to a master drawing, you must have it somewhere ready.

The same image that you add as a sample image is used as the thumbnail image for the particular master drawing in the **Master Drawing Catalog**.

---

Sample images are just samples, they are not real drawings, and they do not update when the drawing changes.

---

To add a sample and thumbnail image to a master drawing in the **Master Drawing Catalog**:

1. Open the **Master Drawing Catalog** by clicking **Drawings & Reports --> Create Drawings**.

2. Locate the desired master drawing and double-click it to open the **Master Drawing Properties** dialog box.

3. Add the image you created:
   - For the master drawings of the type saved settings, cloning templates, and wizard files, click **Change image** and browse for the preview image. Click **OK** to save the image as a sample image.
   - For rule sets, click **Next** until you get to the page where you can add the preview image. Click **Browse** and browse for the preview image. Click **Save** to save the image as a sample image.

Now you can display the sample image by selecting the master drawing on the catalog list, right-clicking and selecting **Preview**. The thumbnail image in the **Master Drawing Catalog** thumbnail view is a smaller version of the same sample image.

**See also**  Creating sample images on page 89  
Sample images of drawings on page 89
Viewing sample images of drawing templates

You can create sample images of the drawing templates that you have in your template library (model folder). You can later browse through the sample images easily through the Clone Drawings dialog box, and quickly find the drawing template you are looking for. The Clone Drawings dialog box is displayed when you are cloning through the Drawing List using drawing templates in the template library.

To view preview images that you have created for drawing templates:

1. Open the Drawing List.
2. Open the Clone Drawing dialog box by clicking Clone in the Drawing List.
3. Select Other model and browse for the template library.
4. Click the Select template button to open the list of drawings that the selected model has. On the list, there is a small icon in the Preview column if the drawing has a preview image.
5. Double-click the drawing to open the sample image.

See also Cloning using drawing templates in template library on page 101

2.7 Cloning drawings

You should consider cloning drawings when:

- There are several similar parts, assemblies, or cast units in the model.
- You want to ease editing work when there are several similar parts that have different position numbers. You may have separate drawings of these similar parts.
- The drawings need a lot of manual editing

If cloning does not produce a satisfactory result, you need to modify the cloned drawing manually. For example, you can create a drawing for one truss, modify the drawing, and then clone it for similar trusses. Sometimes you need to modify the cloned drawings where the trusses differ.

The cloned drawing may contain more or less parts than the original drawing. Part properties, marks, associative notes and related text objects are cloned from a similar part in the original drawing.

You can clone drawings using the cloning templates added in the Master Drawing Catalog in the existing model and in other models, using a drawing in the Drawing List, and using the cloning templates in the template library.

See also Creating drawings using cloning templates in Master Drawing Catalog on page 92
Cloning by using cloning templates located in other models on page 93
Cloning from the Drawing List on page 94
View-specific dimension cloning on page 97
Cloning using drawing templates in template library on page 101
Cloned objects on page 98
Checking and modifying cloned drawings on page 98
Refreshing drawing associativity on page 99
Creating drawings on page 25

Creating drawings using cloning templates in Master Drawing Catalog

In the Master Drawing Catalog, you can create single-part, assembly and cast unit drawings using cloning templates in the Master Drawing Catalog. You can add new cloning templates from the Drawing List. Note that only the cloning templates located in the folder that is set for the advanced option XS_CLONING_TEMPLATE_DIRECTORY are displayed in the Master Drawing Catalog.

Limitations:
• You cannot clone general arrangement drawings through the Master Drawing Catalog. You can clone general arrangement drawings only by using the Clone command in the Drawing List dialog box.
• You cannot clone multidrawings.
• The drawing properties of cloning templates cannot be modified through the Master Drawing Catalog.

To create drawings using a cloning template:
1. In the model, click Drawings & Reports --> Create Drawings.
2. Double-click the cloning template that you want to use.
3. Go to the Drawing creation tab and specify how dimensions and marks are cloned.
   You can select to ignore the dimensions and marks, clone them, or recreate them.
   The Marks option controls revision marks and all marks for model objects.

   Selecting Create in the Dimensions and Other marks box is useful if cloning the dimensions or other marks does not produce satisfactory results. Using this option does not create any new views.

4. On the same tab, select which object types you want to clone.
5. If you want to create a drawing only for certain parts, select the parts from the model. You can also use an appropriate selection filter and select the whole model. Activate only the Select parts selection switch when you select objects, otherwise the selection may take a long time.

6. Click Create drawings (Alt + C) or Create drawings for all parts (Alt + A).

7. Number the model if prompted to do so.

Tekla Structures creates the drawings and adds them in the Drawing List. In the Drawing List, cloned drawings are marked with text Cloned in the Changes column.

8. Check the cloned drawing and modify it, if necessary.

If you have cloning templates that you have created using an older Tekla Structures version and want to utilize the better associativity of a newer Tekla Structures version, refresh the drawing associativity by using the Refresh Associativity command, which you can add to the User menu in the Customize dialog box (Tools --> Customize).

---

**See also**

- Cloning drawings on page 91
- Cloned objects on page 98
- Checking and modifying cloned drawings on page 98
- Refreshing drawing associativity on page 99
- Cloning templates on page 54
- Adding a cloning template on page 80
- XS_CLONING_TEMPLATE_DIRECTORY
- XS_INTELLIGENT_CLONING_ADD_DIMENSIONS

**Cloning by using cloning templates located in other models**

You can show cloning templates located in other models in the Master Drawing Catalog and create drawings using them.

Limitations: You can use only cloning templates from other models, not other types of master drawings, such as saved settings or rule sets.

To use cloning templates from other models:

1. In the Master Drawing Catalog, click 🔄 to open the Models Containing Master Drawings dialog box.

2. Click Add model and browse to the desired model.

3. Click OK.

4. Select the cloning template from the Master Drawing Catalog and create a drawing using the selected template.
When you have similar parts in several projects, you can maintain a set of cloning models and then take the cloning templates in the cloning models in use when necessary.

See also  
Master Drawing Catalog on page 51
Creating drawings using cloning templates in Master Drawing Catalog on page 92

Cloning from the Drawing List

In addition to cloning drawings using cloning templates in Master Drawing Catalog, you can clone single-part, cast unit, assembly and general arrangement drawings from the Drawing List.

- When you clone drawings of assemblies or cast units, they must have the same type of main part as the assembly or cast unit from which the original drawing was created. For example, the upper chords of the original and the cloned truss could be main parts.
- Section and detail views are not cloned in general arrangement drawings, and only one view is cloned.

Before cloning, finalize, save, and close the drawing you want to use as a cloning template.

To clone a drawing from the Drawing List:

1. In the model, select what to include in the drawing:
   - If you are cloning a single-part drawings, cast unit drawing or assembly drawing, select parts, assemblies or cast units.
• If you are cloning a general arrangement drawing, select a model view. To do this, click the desired model view so that the view gets a red frame around it.

2. Click Drawings & Reports > Drawing List.

3. In the Drawing List, select the drawing that you want to use as a cloning template.

4. Click Clone.

5. In the Clone Drawing dialog box, select the drawing object types you want to clone into the new drawing, and the actions for each object type.
   
   • For Dimensions and Other marks (all marks for model objects), select whether you want to Clone them, recreate them automatically when you clone a drawing (Create) or Ignore them in cloning.

   Selecting Create in the Dimensions and Other marks box is useful if cloning the dimensions or other marks does not produce satisfactory results. Using this option does not create any new views.

   • For other objects, select to Clone or Ignore them.

6. Click Clone selected.

Tekla Structures clones the drawing. In the Drawing List, cloned drawings are marked with text Cloned in the Changes column.

See also  Cloning drawings on page 91

Example: Cloning a general arrangement drawing on page 96

Creating drawings using cloning templates in Master Drawing Catalog on page 92
Example: Cloning a general arrangement drawing

In this example, we first created a general arrangement drawing of the first floor of a building, then edited the drawing and the cloned the general arrangement drawing of the second floor.

The first floor and second floor have some differences:

We edited the general arrangement drawing of the first floor slightly.

We selected the model view that represents the second floor and then cloned the drawing using the general arrangement drawing of the first floor as a template.
In the cloned drawing:

- The drawing view plane has been moved to match the model view PLAN 2nd Floor plane.
- If there are parts in matching places, the marks have been cloned to the new location and the content has been updated.
- Dimensions are cloned.
- All model object marks and notes are cloned.

See also [Cloning from the Drawing List on page 94](#)

**View-specific dimension cloning**

The dimension cloning options in the Clone Drawing dialog box affect all views, whereas with Dimension creation method in this view in the View Properties dialog box you can set the dimension creation method for the selected view only. With this feature you can create automatic dimensions in the front view and clone the dimensions in section and end view, for example.

To clone dimensions in the selected view:

1. Double-click the drawing view frame to open the View Properties dialog box.
2. Select Dimension creation method in this view --> Clone on the Attributes 2 tab.
3. Click Modify.
4. Save and close the drawing.
5. Open the **Drawing List**, select the drawing and click **Clone**.

6. In the **Clone Drawing** dialog box, select the objects to be cloned and the dimension cloning option (**Ignore**, **Clone**, **Create**).
   - If you select **Dimension > Ignore**, the dimensions will be cloned only for those views that have **Dimension creation method in this view** set to **Clone**.
   - If you select **Dimension > Clone**, the dimensions will be cloned for all views.
   - If you select **Dimension > Create**, the dimensions will be created for all views except for those that have **Dimension creation method in this view** set to **Do not create**.

7. Click **Clone selected**.

See also  **Cloning drawings on page 91**

---

**Cloned objects**

The following objects can be cloned:

- Dimensions
- Marks for welds added in the drawing
- Marks for welds added in the model
- Level marks
- Revision marks
- Annotation objects
- All user-defined attributes of a drawing
- Texts
- Symbols
- Graphical drawing objects (shapes)
- Text files
- DWG/DXF files
- Hyperlinks
- Manually created section and detail views
- When you clone an assembly drawing that includes single-part drawings, Tekla Structures includes the single-part drawings in the cloned assembly drawing by default.

See also  **Cloning drawings on page 91**

---

**Checking and modifying cloned drawings**

Always check the cloned drawing to make sure that the drawing contents meet your needs.
You should go through the cloned drawings and check that everything is correct. Below is a checklist for this purpose.

<table>
<thead>
<tr>
<th>Object</th>
<th>Check and modify</th>
</tr>
</thead>
</table>
| Marks  | • In general, mark contents are correct in cloned drawings, but sometimes you may need to modify the location of the marks.  
• Tekla Structures clones only marks that can be mapped to the original drawing. To create marks to a cloned drawing also for parts that could not be mapped to the template drawing, set the advanced option `XS_CREATE_MISSING_MARKS_IN_INTELLIGENT_CLONING` to TRUE through Tools > Options > Advanced Options> Marking: General. |
| Views  | • Ensure that the view sizes and view orientation are correct, and that the views are placed correctly in the cloned drawing. The size of the views is updated according to the parts included in the views. |
| Dimensions | • If the cloned drawing contains less parts than the original drawing, the dimensions to the missing parts are automatically removed.  
• If the cloned drawing contains more parts than the original drawing, Tekla Structures dimensions the additional parts using automatic dimensioning, if you have set the advanced option `XS_INTELLIGENT_CLONING_ADD_DIMENSIONS` to TRUE. Because Tekla Structures uses automatic dimensioning for creating dimensions for new parts, you may have to check and correct the created dimensions.  
• Add missing dimensions and remove the incorrect ones. |

See also

- Cloning drawings on page 91
- Cloned objects on page 98

**Refreshing drawing associativity**

Often improvements in cloning and associativity require that the associative rules have to be recreated. This can be done by using the **Refresh Associativity** command. When you use this command, you do not need to recreate the drawing.

For example, this command is very useful if you have a cloning template you have created using an older Tekla Structures version and want to utilize the better associativity of a newer Tekla Structures version.
**Refresh Associativity** is available in the Customize dialog box, and you may want to add it in one of the toolbars or in the User menu.

To add the command in the User menu and refresh the associativity:

1. Click **Tools** --> **Customize...**.
2. Enter a part of the command name in the Filter box, for example, refr. The command is displayed in the list of commands.
3. Open the Menu tab.
4. Double-click the **Refresh Associativity** command to add it in the User menu.
5. If you have not added the User menu on the menu bar before, restart Tekla Structures to activate the menu. The menu name is always User.
6. Open a cloning template the associativity of which you want to refresh from the Drawing List.
7. Click **User** --> **Refresh Associativity**.
8. Save the cloning template.

See also  
Drawing associativity on page 20  
Cloning drawings on page 91

### Copying a drawing to a new sheet

You can copy a drawing to a new sheet. This is useful, for example, if you want to have the same layout and views as in the original drawing, but highlight something else on the new drawing sheet.

To copy a drawing to a new sheet:

1. In the Drawing List, select the drawing that you want to use as the original for copying.
2. Right-click and select **Create Drawings** --> **Copy to new sheet**.
   
   Tekla Structures copies the original drawing to a new sheet and gives the copied drawing a new sheet number.

   ![Cloned drawings](image)

3. Open the new drawing sheet, make the necessary changes and save it.
If you use the **Recreate (Shift+R)** command for the copied drawing, Tekla Structures asks if you want to copy the drawing again from the original drawing. If you answer yes, the previously copied drawing sheet will be replaced by a new copy of the previously selected original drawing.

See also  Creating multiple drawing sheets of the same part on page 74

**Cloning using drawing templates in template library**

This is a more manual way of cloning drawings: you can create drawings using drawing templates located in the template library. The template library is a model folder that contains the drawings you want to use as drawing templates. You can select a drawing in the current model folder or in another model folder.

To clone using a drawing template:

1. Create a drawing you want to use as a drawing template.
2. Save the model.
3. In the model, select the objects to be included in the new drawing.
4. To open the **Clone Drawing** dialog box, click **Clone** in the drawing list dialog box.
5. Use the **Objects and actions in cloning** options to define the drawing objects to be cloned and the actions for each cloned object.
6. Select the current model or click **Other model**.

You can use **Browse** to browse to another model folder containing the drawing templates that you want.

7. Click **Select template**.
8. In the **Drawing Templates** dialog box, select a drawing template indicated by an icon on the left.

9. Leave the list open and clone the drawing by clicking **Clone selected**.

Tekla Structures clones the drawing. In the **Drawing List**, cloned drawings are marked with text **Cloned** in the **Changes** column.

You can specify that a certain model folder is always used as a template library using the advanced option **XS_DRAWING_TEMPLATES_LIBRARY**.
See also  XS_DRAWINGTEMPLATESLIBRARY

Cloning drawings on page 91
Finding and opening drawings

All drawings in a Tekla Structures model are displayed in the Drawing List dialog box. You can search, sort, select, and display drawings according to different criteria, and open the drawings displayed in the list. You can take snapshots of the drawings, and locate the drawing parts in the model, and to find out if a part is included in any of the drawings.

See also
- Opening the Drawing List on page 104
- What is displayed in the Drawing List on page 104
- Drawing status flags on page 105
- Modifying Drawing List contents on page 107
- Searching drawings and saving the search results on page 108
- Selecting drawings in the Drawing List on page 108
- Checking whether parts have drawings on page 109
3.1 Opening the Drawing List

To open the Drawing List dialog box, do one of the following:

- Click the Open Drawing List button.
- In the model, select Drawings & Reports > Drawing List (Ctrl + L).
- In an open drawing, select Drawing File > Open (Ctrl + O).

See also
- Working with drawings on page 272
- Finding and opening drawings on page 103
- Opening drawings from the model on page 109
- Opening a new drawing when a drawing is already open on page 110

3.2 What is displayed in the Drawing List

The Drawing List contains the following columns.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Issue, Lock, Freeze, Master, and Up to date</td>
<td>These columns contain flags that are graphical symbols indicating status.</td>
</tr>
<tr>
<td>Changes</td>
<td>Textual information about the changes in the drawing.</td>
</tr>
<tr>
<td>Created</td>
<td>The creation date of the drawing.</td>
</tr>
<tr>
<td>Modified</td>
<td>The latest modification date of the drawing.</td>
</tr>
<tr>
<td>Revision</td>
<td>The revision number or revision mark of the drawing. By default, Tekla Structures shows revision numbers. To show revision marks instead, set the advanced option XS_SHOW_REVISION_MARK_ON_DRAWING_LIST to TRUE.</td>
</tr>
<tr>
<td>Type</td>
<td>The drawing types are identified by the following letters:</td>
</tr>
<tr>
<td></td>
<td>• W for single-part drawings.</td>
</tr>
<tr>
<td></td>
<td>• A for assembly drawings.</td>
</tr>
<tr>
<td></td>
<td>• C for cast unit drawings.</td>
</tr>
</tbody>
</table>
### Option Description

- **G** for general arrangement drawings.
- **M** for multidrawings.

U (unknown) means that an error has occurred, and you need to delete the drawing.

**Size**

The paper size the drawing uses.

**Mark**

In a single-part drawing mark is the part position, and in an assembly drawing the assembly position from which the drawing was created. You cannot change drawing marks.

Mark contains the sheet number as well, if it is not zero (0).

You can choose to have Tekla Structures base the mark of cast unit drawings on the position number or the ID of the cast unit.

**Name**

The name given for the drawing in the drawing properties dialog box.

**Title 1, Title 2, and Title 3**

Extra drawing titles added in the drawing properties dialog box.

**Locked by**

The Locked by column shows who locked the drawing. If you have logged in to your Tekla account, the account name is shown. Otherwise the user name is shown.

**User-defined attributes**

You can show up to 20 user-defined attributes in the Drawing List. These user-defined attributes must be added in the User-defined Attributes subdialog box in drawing properties. To include a user-defined attribute in drawing lists, the user-defined attribute must have the option `special_flag` set to `yes` in the `objects.inp` file.

---

**See also**

- Working with drawings on page 272
- Finding and opening drawings on page 103
- User-defined attributes in drawings on page 515
- Checking multi-user databases
- Location of certain files in hidden folders
- `XS_SHOW_REVISION_MARK_ON_DRAWING_LIST`

---

### 3.3 Drawing status flags

Tekla Structures uses certain symbols called **flags**, to indicate the status of the drawings. The columns **Issue**, **Lock**, **Freeze**, **Master** and **Up to date** contain the flags, and the potential
additional information is displayed in the Changes column. If a drawing does not have any flag symbol, it is up to date.

<table>
<thead>
<tr>
<th>Issue</th>
<th>Lock</th>
<th>Freeze</th>
<th>Master</th>
<th>Up to date</th>
<th>Changes</th>
<th>Created</th>
<th>Modified</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Drawing updated</td>
<td>24.05.2007</td>
<td>02.10.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Parts modified</td>
<td>24.05.2007</td>
<td>23.09.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Drawing updated</td>
<td>24.05.2007</td>
<td>02.10.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Parts modified</td>
<td>24.05.2007</td>
<td>06.08.2008</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Drawing updated</td>
<td>24.05.2007</td>
<td>02.10.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Parts modified</td>
<td>24.05.2007</td>
<td>18.09.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Parts modified</td>
<td>24.05.2007</td>
<td>20.09.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>02.10.2009</td>
<td>08.10.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>23.09.2009</td>
<td>03.10.2009</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>06.10.2009</td>
<td>00.00.0000</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td>Drawing updated</td>
<td>24.05.2007</td>
<td>06.10.2009</td>
</tr>
</tbody>
</table>

See also Working with drawings on page 272

How to read the drawing status information on page 106
Finding and opening drawings on page 103

How to read the drawing status information

The table below explains the meaning of the status flags and information about the status of a drawing in the Drawing List.

<table>
<thead>
<tr>
<th>Flag</th>
<th>Column where shown</th>
<th>Information in the Changes column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![ ]</td>
<td>Up to date</td>
<td>Parts modified</td>
<td>The parts in the drawing have changed, for example, parts have been added or deleted, or part properties have changed.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Quantity increased or Quantity decreased</td>
<td></td>
<td>The actual drawing is up to date, but the number of identical parts has changed.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Up to date</td>
<td>All parts deleted</td>
<td>All the parts related to the drawing have been deleted.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Lock</td>
<td></td>
<td>The drawing is locked and you cannot open it for editing.</td>
</tr>
<tr>
<td>![ ]</td>
<td>Freeze</td>
<td></td>
<td>The drawing is frozen. Changes made to the model objects, which have drawing objects associated with them, are no longer available in the drawing.</td>
</tr>
<tr>
<td>Flag</td>
<td>Column where shown</td>
<td>Information in the Changes column</td>
<td>Description</td>
</tr>
<tr>
<td>------</td>
<td>--------------------</td>
<td>-----------------------------------</td>
<td>-------------</td>
</tr>
<tr>
<td>📜</td>
<td>Master</td>
<td>The drawing has been added as a master drawing in the Master Drawing Catalog.</td>
<td></td>
</tr>
<tr>
<td>🔄</td>
<td>Up to date</td>
<td>Linked drawing changed</td>
<td>You have a linked drawing in this drawing and the linked drawing has been modified.</td>
</tr>
<tr>
<td>🔄</td>
<td>Up to date</td>
<td>Copied view changed</td>
<td>A copied drawing has been modified.</td>
</tr>
<tr>
<td>🔄</td>
<td>Drawing updated</td>
<td></td>
<td>A frozen drawing has been updated.</td>
</tr>
<tr>
<td>🔄</td>
<td>Cloned</td>
<td></td>
<td>The drawing is a cloned drawing. The flag disappears when you save and close the drawing.</td>
</tr>
<tr>
<td>📩</td>
<td>Issue</td>
<td></td>
<td>The drawing has been issued. For example, you might re-issue drawings that have been sent to site.</td>
</tr>
<tr>
<td>📩</td>
<td>Issue</td>
<td>Issued drawing changed</td>
<td>The issued drawing has been edited or otherwise changed.</td>
</tr>
</tbody>
</table>

See also Finding and opening drawings on page 103

### 3.4 Modifying Drawing List contents

In addition to using search, you can select which drawings you want to see in the list and in which order.

To filter the Drawing List contents, do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Display a predefined set of drawings</td>
<td>Select a set of drawings from the select drawing set list. Saved search results are also displayed in this list.</td>
</tr>
<tr>
<td>List all drawings</td>
<td>Click Show all.</td>
</tr>
<tr>
<td>Invert the contents of the current list</td>
<td>Click Invert. This feature allows you to list the opposite of the current content. For example, if you had selected to display Locked drawings, clicking Invert shows all drawings except the locked ones.</td>
</tr>
<tr>
<td>List selected drawings only</td>
<td>Select the drawings and click Selected.</td>
</tr>
<tr>
<td>List up-to-date drawings only</td>
<td>Click Up to date.</td>
</tr>
<tr>
<td>List drawings that need to be updated</td>
<td>1. Click Up to date.</td>
</tr>
</tbody>
</table>
To Do this

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Click <strong>Invert</strong>.</td>
<td>1. Select objects in the model.</td>
</tr>
<tr>
<td>Lists only drawings associated with the objects you have selected in the model.</td>
<td>2. Click <strong>By parts</strong>. This is an easy way to identify the drawings associated with a specific part, assembly or cast unit.</td>
</tr>
<tr>
<td>Sort the list according to <strong>Column name</strong></td>
<td>Click the column name.</td>
</tr>
</tbody>
</table>

See also  Working with drawings on page 272  
Finding and opening drawings on page 103

### 3.5 Searching drawings and saving the search results

You can search for drawings in the **Drawing List**.

To search for drawings and save the results:

1. In the **Drawing List**, enter the search criteria in **Enter search criteria**.
2. If needed, you can limit the search so that it addresses only information in a certain column by selecting a column from the **Search in** list.
3. If needed, you can also limit the search to the currently visible drawings by selecting **Search within the currently visible drawings**.
4. Click **Search**.
5. Click **Store** to save the search results.
6. Enter a name for the search results in the **Store Search Result** dialog box and click **OK**. The search results are saved in the **DrawingListSearches** folder, which is created in the model folder.

You can move the saved search results to your environment, company or project folder. After you have saved the search results, they will be visible in the predefined drawing sets list in the **Drawing List** dialog box.

See also  Working with drawings on page 272  
Finding and opening drawings on page 103
3.6 Selecting drawings in the Drawing List

The Drawing List allows you to select one or several drawings at a time. Selecting several drawings is useful, for example, if you want to lock or freeze several drawings at a time.

To select drawings in the Drawing List:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select one drawing</td>
<td>Click the drawing in the list.</td>
</tr>
<tr>
<td>Select several consecutive drawings</td>
<td>Click the first drawing, then hold down the Shift key and click the last drawing.</td>
</tr>
<tr>
<td>Select several non-consecutive drawings</td>
<td>Click the first drawing, then hold down the Ctrl key and click the other drawings you want to select.</td>
</tr>
<tr>
<td>Select all drawings in the list</td>
<td>Press Ctrl+A.</td>
</tr>
</tbody>
</table>

See also  Working with drawings on page 272
Finding and opening drawings on page 103

3.7 Checking whether parts have drawings

You can use the Drawing List to identify parts in the model that have associated drawings.

Before you start, ensure that you have only the Select parts selection switch active on the Selection toolbar. Otherwise selecting objects can take a long time in large models.

1. Open a model view where all parts are clearly visible.
2. In the Drawing List, press Ctrl + A to select all drawings.
3. To highlight the parts that have drawings, click Select objects.
   To see the found parts easier, right-click the model and select Show only selected to show only the parts that Select objects has found and hide the others.
4. After completing the previous step you can highlight the parts that do not have drawings by holding down the Ctrl key and selecting the entire model (hold down the left mouse button and drag all the way from left to right).

See also  Working with drawings on page 272
Finding and opening drawings on page 103
### 3.8 Opening drawings from the model

You can open drawings from the **Drawing List**. You can only have one drawing open at a time.

To open a drawing:

1. Click **Drawings & Reports --> Drawing List...** or the button on the toolbar.
2. Double-click the drawing to open it.

- To always open the drawings maximized, set the advanced option `XS_OPEN_DRAWINGS_MAXIMIZED` to `TRUE`.
- Shortcut for opening the **Drawing List**: `Ctrl + L`.

**See also**  
- Finding and opening drawings on page 103  
- Working with drawings on page 272

### 3.9 Opening a new drawing when a drawing is already open

You can also open another drawing when you already have a drawing open. If you have made some changes in the open drawing, Tekla Structures asks you if you want to save the changes before opening another drawing.

Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open a drawing using the <strong>Drawing List</strong>.</td>
<td>1. Click <strong>Drawing File --&gt; Open...</strong> or the button on the toolbar.</td>
</tr>
<tr>
<td></td>
<td>2. Double-click the drawing to open it.</td>
</tr>
<tr>
<td>Open the next drawing in the <strong>Drawing List</strong>.</td>
<td>Press <code>Ctrl + Page Down</code>.</td>
</tr>
<tr>
<td>Open the previous drawing in the <strong>Drawing List</strong>.</td>
<td>Press <code>Ctrl + Page Up</code>.</td>
</tr>
</tbody>
</table>

**Shortcut for opening the **Drawing List** when a drawing is open:** `Ctrl + O`.

**See also**  
- Finding and opening drawings on page 103
3.10 Creating and viewing drawing snapshots

With snapshots you can take a quick look at any drawings without opening the drawing. Use this tool when you just want to check but not edit a drawing, or take a look at several drawings while trying to find the one you are looking for, for example, a certain drawing revision. You can take snapshots of all types of drawings.

A snapshot is automatically taken when you open and save a drawing. The snapshot represents the situation when the drawing was last saved, so any newer changes to the model are not reflected in the snapshot.

If you have made changes in the drawing and close it by selecting the **Close** button in the upper-right corner, a message box is displayed where you can select if you want to save the drawing and also if you want to create a snapshot of the drawing when the drawing is saved.

To create and view snapshots:

1. Select a drawing and open it from the **Drawing List**.
2. Save the drawing by selecting **Drawing File --> Save**.
3. Select the drawing from the **Drawing List**.
4. Click the **Snapshot** at the bottom of the **Drawing List** to display the snapshot.
Below is an example of a snapshot.

If you have selected from the Drawing List a drawing that does not have a snapshot and click Snapshots, an instructional view is displayed prompting you to open the drawing and save it to create the snapshot.

### 3.11 Taking screenshots in drawings

A drawing screenshot is an image of a dialog box, view, or the entire Tekla Structures main software window. By default, the screenshots are saved in the \screenshots folder under the current model folder with the name snap_xx.png.

To print the screenshot after taking it, switch on Tools --> Screenshot --> Print Screenshot. This works for all screenshot commands.

To take a screenshot, do any of the following:
<table>
<thead>
<tr>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>To take a screenshot of the Tekla Structures main software window</td>
</tr>
<tr>
<td>containing everything shown in the window</td>
</tr>
<tr>
<td>Do this</td>
</tr>
<tr>
<td>In an open drawing, click Tools --&gt; Screenshot --&gt; Main Frame or press F9. If you wish show more of the drawing and less of the other window parts, enlarge the drawing window before taking the screenshot.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>To take a screenshot of an active dialog box</td>
</tr>
<tr>
<td>Do this</td>
</tr>
<tr>
<td>Click a drawing dialog box and click Tools --&gt; Screenshot --&gt; Dialog or press F10.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>To take a screenshot of an open drawing with window borders</td>
</tr>
<tr>
<td>Do this</td>
</tr>
<tr>
<td>In an open drawing, click Tools --&gt; Screenshot --&gt; View or press F11.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>To take a screenshot of an open drawing without window borders</td>
</tr>
<tr>
<td>Do this</td>
</tr>
<tr>
<td>In an open drawing, click Tools --&gt; Screenshot --&gt; View without Borders or press F12.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>To</th>
</tr>
</thead>
<tbody>
<tr>
<td>To take a screenshot of a drawing with file name that you specify, in the location that you specify, and show the screenshot with an associated viewer</td>
</tr>
<tr>
<td>Do this</td>
</tr>
<tr>
<td>1. In an open drawing, click Tools --&gt; Screenshot --&gt; Custom. 2. Do one of the following:</td>
</tr>
<tr>
<td>• Select View to take a screenshot of the active drawing with window borders</td>
</tr>
<tr>
<td>• Select View without borders to take a screenshot of the open drawing without window borders.</td>
</tr>
<tr>
<td>3. Under the preselected Print to file option enter a descriptive name for the screenshot in the File name box. You can also change the whole path. If you do not want to do this, you can keep the default values for the path and file name.</td>
</tr>
<tr>
<td>4. Click Show with associated viewer to show the screenshot in an application that is by default associated with this file type.</td>
</tr>
<tr>
<td>5. Click Capture.</td>
</tr>
</tbody>
</table>
This section explains how to edit the drawings that you have created.

After you have created a drawing, you can modify properties of the layout and the views, building objects, and associative annotation objects already included in the drawing. You can also add more views, associative and independent annotation objects, and shapes. You can also change drawing colors.

Click the links below to find out more:

- Renaming drawings on page 115
- Giving titles to drawings on page 115
- Drawing views on page 116
- Dimensions on page 141
- Associative annotation objects on page 175
- Independent annotation objects on page 186
- Shapes on page 194
- Building objects in drawings on page 195
- Custom presentations in drawings on page 201
- Exploding drawing plug-ins on page 202
- Welds in drawings on page 203
- Edge chamfers in drawings on page 220
- Pours in drawings on page 225
- Reference models in drawings on page 230
- Grids in drawings on page 233
- Symbols in drawings on page 235
- Changing drawing objects on page 242
- Colors in drawings on page 261
- User coordinate system (UCS) on page 266
- Saving drawings on page 269
4.1 Renaming drawings

Tekla Structures names the drawings according to the name given in the drawing properties. The drawing name is displayed in the Drawing List and in drawing templates.

To rename a drawing:
1. In the Drawing List, right-click the drawing and select Properties.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
3. Select the check box next to the Name box.
4. Enter the new name in the Name box.
5. Click Modify.

See also Editing drawings on page 114
Modifying drawing settings on page 307

4.2 Giving titles to drawings

In addition to the drawing name, you can give titles for your drawings. Tekla Structures shows the title in the Drawing List and in drawing and report templates. You can define up to three titles to use in drawing templates.

To give a title to a drawing:
1. In the Drawing List, right-click the drawing and select Properties.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
   Select the check boxes next to the Title boxes you want to use.
3. Enter the titles.
4. Click Modify.
If you want to customize your print file names and use title values instead of drawing names in them, you can define that the title entered in this dialog box is used in the print file name. To do this, enter the value %TPL:TITLE1% (or %TPL:TITLE2% or %TPL:TITLE3%) for an advanced option XS_DRAWING_PLOT_FILE_NAME_G (or _W, _A, _M or _C depending on the drawing type) through Tools --> Options --> Advanced Options --> Printing.

See also Editing drawings on page 114
Modifying drawing settings on page 307
Customizing print file names on page 293

4.3 Drawing views

Drawing views contain the selected parts of Tekla Structures objects, and marks, dimensions and other objects that have selected to add. The drawing view is another way of looking at the model. Drawings may include several views.

You can have different types of views in Tekla Structures drawings:

- Main views: front, top, back and bottom views
- Section views
- End views
- Single-part views
- 3D views
- Detail views
- Key plan views
- Views along grid lines
- Elevation views
- Plan views

In addition to the views Tekla Structures creates automatically in a drawing based on the drawing properties, you can also add new ones in the open drawing.

See also Editing drawings on page 114
Adding views in drawings manually on page 117
Copying drawing views from another drawing on page 130
Linking views from another drawing on page 132
Moving views to another drawing on page 130
Modifying drawing views on page 133
Adding views in drawings manually

Once you have created drawings, you can add more views to them manually. You can create drawing views of:

- Entire model
- Selected areas in a model
- Views in the same drawing
- Single parts in an assembly
- Objects in 3D
- Sections in a drawing
- Details in a drawing
- Reinforcement meshes

See also
- Creating a section view on page 117
- Creating a detail view on page 121
- Creating a curved section view on page 120
- Creating additional views of parts on page 123
- Creating a drawing view of an entire model view on page 124
- Creating a drawing view of a selected area in a model view on page 125
- Creating a drawing view of a selected area in a drawing view on page 126
- Adding single-part views in assembly drawings on page 129
- Creating a drawing view for a reinforcement mesh (RebarMeshViewCreator) on page 126

Creating a section view

You can create section views of the parts in a drawing view in an open drawing that contains at least one view.

To modify the properties and create the section view:

1. Click Annotating --> Properties --> Section Mark.
2. Modify the cutting line, section mark, and section view label properties in the Section symbol properties dialog box.
3. Click **OK** or **Apply**.

4. Hold down **Shift** and click **View --> Create Drawing View --> Section View** .

5. Modify the view properties as required.

6. Click **OK** or **Apply**.

7. Pick two points to define the position of the section plane.
   
   It is easier to pick the points if you activate orthogonal snapping by clicking **Tools --> Ortho** or pressing **O**.

   For beams, you can also try picking the top line of the beam and then the bottom line of the beam using the snap switch **Snap to perpendicular points**.

8. Pick two points to define the direction of the cut box and the section view depth.
   
   When you pick the cut box, exaggerate a little. You can adjust the view depth and the view boundary also later on.

   The direction of the section is the direction where the section mark arrows are pointing.

9. Pick the position for the section view.
   
   A view symbol follows the mouse pointer allowing you to see where you are about to place the section view.

   The depth to the opposite direction is zero (0).

Tekla Structures creates the section view using the current properties in the **View Properties** and **Section Symbol Properties** dialog boxes and adds a section mark in the original view. You can change the properties after creating the view.

- The view boundary of the created section view remains selected, and you can adjust the depth and the height of the view boundary by dragging it.

- If necessary, change the view scale of the section view: Double-click the view frame, clear all other selections using the toggle switch at the bottom, select only the **Scale** option, and adjust the scale.

- If you want to create another view, start the **Section View** command again.
1. The first two picked points indicate the position of the section plane.

2. The third picked point indicates the direction of the cut box and the depth of the section view. Here you can exaggerate a little.
3. The fourth pick finalizes the cut box.

4. A view symbol follows the mouse pointer while you are placing the section view. The section view is placed in the selected location. The section view remains selected and the view boundary highlighted right after the view creation.

   The section mark is drawn in the original view. The view boundary of the section view is also highlighted in the original view right after the view creation.

See also
- Adding views in drawings manually on page 117
- Modifying section properties on page 138
- Defining view labels and view label marks on page 352
- Section view properties on page 532
- View properties in drawings on page 529
- Modifying drawing view properties on page 138

**Creating a curved section view**

You can create a curved section view of an existing drawing view. This tool is useful when you want to visualize an unfolded face of a building or to manage cladding.

1. Open a drawing.
2. Click **Annotating --> Properties --> Section Mark**.
3. Modify the cutting line, section mark, and section view label properties.
4. Click **OK** or **Apply**.
5. Hold down **Shift** and click **View --> Create Drawing View --> Curved Section View**.
6. Modify the view properties as required.
7. Click **OK** or **Apply**.
8. Pick three points on the cut plane.
9. Pick two points to indicate the cut box.
10. Pick a point to indicate the location of the curved section view.

   A symbol follows the cursor allowing you to see where you are about to place the curved section view.

Tekla Structures creates the curved section view using the current properties in the **View Properties** and **Section Symbol Properties** dialog boxes and adds a section mark in the original view. You can change the properties after creating the view.

See also
- Adding views in drawings manually on page 117
- Modifying section properties on page 138
- Defining view labels and view label marks on page 352
Creating a detail view

You can create a detail view from a selected area in an existing drawing view in another view. The scale of the detail view is by default the same as that of the main view, but in some environments the detail view is scaled up. The direction of the detail view is the same as that of the original view.

1. Open a drawing.
2. Click Annotating --> Properties --> Detail Mark.
3. Enter a name for the detail, and modify the detail view label, detail boundary and detail mark properties in the Detail Symbol Properties dialog box.
   The shape of the detail boundary you select affects the way you select the area for your detail.
4. Click OK or Apply.
5. Hold down Shift and click View --> Create Drawing View --> Detail View.
6. Modify the view properties as required.
7. Click OK or Apply.
8. Depending on the selected detail boundary shape, do one of the following:
   - If the shape is Circle, pick the center point of the circle and then pick a point on the circle.
   - If the shape is Rectangle, pick corner points for the rectangle.
9. Pick a position for the detail mark.
10. Pick a position for the detail view.

Tekla Structures creates the detail view using the current properties in the View Properties dialog box and Detail Symbol Properties dialog box. However, the detail view takes the view
depth from the original view even if you try to change it. You can change the properties after creating the view.

1. Detail boundary is set to **Circle**
2. Detail mark
3. Detail view
4. Detail view label

You can change the detail symbol size using the handle on the detail boundary.
Defining start number or letter for detail view label and mark

Before creating the detail view label and detail mark define a start number or letter in the drawing properties.

To define the start number or letter:
1. Double-click an open drawing.
2. Click the check box toggle selection button at the bottom of the dialog box, and select only the check box next to the Detail view button.
3. Click Detail View.
4. Enter the start number or letter.
5. Click Modify.

See also Creating a detail view on page 121

Creating additional views of parts

You can create additional views of a part within a single-part, cast unit or assembly drawing. You can select the part plane (front, top, back, bottom) to use or create a 3D view.

1. Open a drawing.
2. Click View --> Create Drawing View --> Of Parts in Drawing and select one of the commands Front, Top, Back, Bottom, 3D.

   Tekla Structures creates the view using the current properties in the View Properties dialog box.

   Tekla Structures will not create views on planes that already have a view in the drawing.
3. Double-click the view frame to open the View Properties dialog box and modify the properties as required.

   For 3D views, you may want to modify the view angle.

4. Click Modify.
In the example below, the drawing originally contained only the front view. A 3D view and a top view were added. The angle of the 3D view was modified in the View Properties dialog box.

See also
- Adding views in drawings manually on page 117
- Modifying drawing view properties on page 138
- View properties in drawings on page 529

Creating a drawing view of an entire model view

You can create a drawing view of an entire model view and add it in the drawing.

To create a view of the entire model view:

1. Open a drawing.
2. Open a model view list by clicking Views --> Model Views --> Model View List...
4. Modify the view properties, for example the view scale, and click OK or Apply.
5. Open a model view from the model view list.
6. Click the open model view.
Tekla Structures creates the drawing view using the current properties in the View Properties dialog box. It calculates the boundaries of the view to fit the entire model view into the drawing view, and places the view in the lower left corner of the drawing.

Change the view scale in the view properties if the view is too big.

See also

Adding views in drawings manually on page 117
Modifying drawing view properties on page 138
View properties in drawings on page 529

Creating a drawing view of a selected area in a model view

You can create a drawing view of a selected area in the model and add it in the drawing.

To create a drawing view of a selected area in the model and add it in your drawing:

1. Open a drawing.
2. Open a model view list by clicking Views --> Model Views --> Model View List...
3. Hold down Shift and click View --> Create Drawing View --> Of Selected Area in Model.
4. Modify the view properties as required and click OK or Apply.
5. Open a model view from the model view list.
6. Pick two corners in the model to define the x and y dimensions of the drawing view. The x and y directions use the coordinate system of the model view. The view depth of the drawing view is the same as the depth of the model view.

Tekla Structures creates the drawing view using the current properties in the **View Properties** dialog box. Tekla Structures places the view in the lower left corner of the drawing.

**See also** Adding views in drawings manually on page 117
Modifying drawing view properties on page 138
View properties in drawings on page 529

**Creating a drawing view of a selected area in a drawing view**

You can create a new drawing view of an area in an existing drawing view.

To create a new drawing view of an area in the existing drawing view:
1. Open a drawing.
2. Hold down **Shift** and click **View --> Create Drawing View --> Of Selected Area in Drawing View**.
3. Modify the view label color.
   Other view properties are inherited from the original drawing view.
4. Click **OK** or **Apply**.
5. Select the area in the drawing view of which you want to make a new view.
6. Select a position for the new view.

   A symbol representing the view that you are about to place follows the mouse pointer, so it is easier for you to see where to place the view.

Tekla Structures creates the drawing view using the view properties of the original view.

**See also** Adding views in drawings manually on page 117
Modifying drawing view properties on page 138
View properties in drawings on page 529
Creating a drawing view for a reinforcement mesh (RebarMeshViewCreator)

You can create drawing views each containing one reinforcement mesh by using the macro \texttt{RebarMeshViewCreator}. You can create mesh views in general arrangement and cast unit drawings.

The mesh view contains the overall mesh length and width dimensions, and dimension lines for wire spacing in horizontal and vertical directions. Also the wire sizes are displayed.

To create a reinforcement mesh view:

1. Open the drawing.
2. Select the meshes.
   
   If you want to create views for all meshes in the drawing, you do not need to select them.
3. Click Tools $\rightarrow$ Options to go to the Macros dialog box.
4. Start the macro by selecting \texttt{RebarMeshViewCreator} and clicking Run.

5. You have the following options for creating mesh views:
   
   - If you want to create a mesh view for each separate mesh in the current drawing, select \texttt{Create mesh view for all meshes in the drawing}.
   
   - If you want to create a view for the selected meshes only, select \texttt{Create view for selected meshes}. Here you must select the meshes before running the macro.
• If you have already created the mesh views and just want to add dimension lines and diameters in the views, select Create annotations for selected meshes. Here you must select the meshes before running the macro.

6. Select the view, dimension, text, line, and unbent wire line property files that you want to use in the new mesh view.

7. Select the wire annotation type in Text content type.

   The choices are $12 \times 8$ and $12 \times 8 L=2.50m$.

8. Click Create.

   Tekla Structures creates or updates the views based on your selections and the property files.

**Example** Below is an example of a mesh view.

The drawing below contains a 3D view of a wall with two bent meshes, and a separate unbent mesh view of both of the meshes.
Adding views in drawings manually on page 117

Adding single-part views in assembly drawings

In addition to automatically including single-part views in assembly drawings, you can also add single-part drawing views in a final assembly drawing.

1. Open the assembly drawing.
2. In the drawing view, select the parts of which you want to create a single-part view.
3. Right-click and select Create single-part views.

Tekla Structures adds the single-part views to the assembly drawing using the current properties in the Assembly Drawing Properties dialog box (Assembly Drawing Properties -- > Layout -- > Other -- > Single-part attributes).

See also XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS

Including single-part drawings in assembly drawings on page 355
Copying drawing views from another drawing

You can copy drawing views from other drawings.

To copy a drawing view from another drawing:

1. Open a drawing.
2. Open the Drawing List by pressing Ctrl + O.
3. Select the drawing containing the view you want to copy. You can select several drawings.
4. Click View --> Add Views from Other Drawing and select Copy or Copy with Layout:
   - Copy copies the views from the selected drawings as such to the open drawing. Tekla Structures does not copy the drawing layout.
   - Copy with Layout copies the views and layout from the selected drawings as such to the open drawing.

Copied drawing views do not update when the original views change.

Moving views to another drawing

You can move section and detail views to another drawing through the drawing list. When you move views to another drawing, the source drawing and the target drawing will contain references to each other.

General arrangement drawings are often quite full of information. You may want to create empty general arrangement drawings and move detail or section views from the original general arrangement drawings to an empty drawing.

To move a drawing view to another drawing:

1. In an open drawing, select the frame of the drawing view you want to move.
2. Right-click and select Move to drawing from the pop-up menu.
3. Select the target drawing from the Drawing List.
4. Click Move in the Move view to drawing dialog box.
5. Close and save the source drawing.
   Tekla Structures moves the selected view to the target drawing and creates references between the source and target drawings.

6. Open the target drawing from the Drawing List.
   The Drawing List indicates that the drawing has been updated.

7. Arrange the drawing views, if necessary.

8. Save the target drawing.

You can select additional drawing views after you have started the Move to drawing command and move multiple drawing views in one go. If you have multiple drawing views selected before starting the Move to drawing command, the command will not be available.

**Example**

In this example, we have two drawings on the Drawing List: BEAM1 and BEAM2.

<table>
<thead>
<tr>
<th>Date</th>
<th>Date</th>
<th>Width</th>
<th>Depth</th>
<th>Type</th>
<th>View Name</th>
<th>Drawing</th>
</tr>
</thead>
<tbody>
<tr>
<td>02.10.2009</td>
<td>06.10.2009</td>
<td>584</td>
<td>410</td>
<td>A</td>
<td>BEAM1</td>
<td>BEAM1</td>
</tr>
<tr>
<td>23.09.2009</td>
<td>06.10.2009</td>
<td>584</td>
<td>410</td>
<td>A</td>
<td>BEAM2</td>
<td>BEAM2</td>
</tr>
</tbody>
</table>

We move section view C-C from drawing BEAM1 to BEAM2. Below is the original section view in the source drawing BEAM1.

We move this view to drawing BEAM2 according to the instructions above. Below is the moved section view in the target drawing BEAM2. The view label name contains the name of the source drawing BEAM1.
In the source drawing BEAM1, the section mark of the moved section view contains a reference to the target drawing BEAM2.

See also
- Defining automatic free or fixed placement of drawing views on page 349
- Arranging drawing views on page 137
- Adding views in drawings manually on page 117
- Modifying drawing views on page 133
- XS_SECTION_VIEW_REFERENCE
- XS_SECTION_SYMBOL_REFERENCE
- XS_DETAIL_VIEW_REFERENCE
- XS_DETAIL_SYMBOL_REFERENCE
Linking views from another drawing

You can link drawing views from other drawings.
Linked drawing views update when the original views change.
To link drawing views:
1. Open a drawing.
2. Open the Drawing List by pressing Ctrl + O.
3. Select the drawing containing the view you want to link. You can select several drawings.
4. Click View --> Add Views from Other Drawing and select Link or Link with Layout:
   - **Link** displays the views of the selected drawings in the open drawing. Tekla Structures does not copy the drawing layout.
   - **Link with Layout** displays the views and the layout of the selected drawings in the open drawing.

See also Adding views in drawings manually on page 117

Modifying drawing views

Once you have added the necessary views in your drawing, you may want to modify the view contents, appearance, size, location and rotation.

See also Drawing views on page 116
   - Resizing the drawing view boundary on page 133
   - Moving drawing views on page 135
   - Aligning drawing views on page 136
   - Rotating drawing views on page 137
   - Arranging drawing views on page 137
   - Modifying drawing view properties on page 138
   - Modifying detail properties on page 140
   - Modifying section properties on page 138

Resizing the drawing view boundary

The view boundary or view restriction box is the dashed frame around the contents of a drawing view, which becomes visible when you click the view frame. You can resize the view boundary, for example, to show just a specific part of the view contents.

When you select a view, the view boundary is highlighted also in other views. When you change the selected view’s boundary in the other views using view boundary handles, the
change can be seen in the view boundary of the selected view. This way you can easily adjust the section view plane and view depth, and you do not need to go to the view properties dialog box to do this.

To resize the view boundary:

1. Click the view frame.
2. Click one of the handles on the view boundary.
3. Drag the handles along the x or y axis of the view.

When the view boundary changes size, the view frame adjusts with the new boundary size.
Example In the example below, the section view in the bottom-left corner has been selected, and the view boundary is highlighted in two other views. You can change the view boundary of the selected view in the other views by dragging the view boundary handles, to change the section view depth, for example.

See also Modifying drawing views on page 133

Moving drawing views
You can move drawing views by dragging.
1. Click the view frame.
2. Hold down the left mouse button and drag the view to a new location.
   The view follows the cursor while you drag the view, which makes it easier to follow the view movement.

When you drag a view, its placing setting may change to fixed depending on what is set for the advanced option XS_CHANGE_DRAGGED_VIEWS_TO_FIXED. This advanced option is by default set to TRUE, which means that the placing setting changes to fixed when the view is dragged.

See also  Modifying drawing views on page 133

XS_CHANGE_DRAGGED_VIEWS_TO_FIXED

**Aligning drawing views**

You can align views vertically or horizontally.

To align views vertically:
1. Select a drawing view in an open drawing, then right-click to display the pop-up menu.
2. Select **Align vertically** from the pop-up menu.
3. Pick a point in the selected view.
4. Pick a point in the view with which you want to align the selected view.
Rotating drawing views

You can rotate the views in drawings.

1. Click the frame of the view you want to rotate.
2. Click View --> Rotate Drawing View...
3. Enter the angle in degrees, for example, 90 or -90, in the displayed dialog box and click Rotate.

See also  Modifying drawing views on page 133

Arranging drawing views

You can fit the drawing views so that they include all the connected objects, and rearrange the drawing views using the current properties in the Layout Properties properties dialog box.

To fit and arrange drawing views:

- Click View --> Arrange Drawing Views.
• **Arrange Drawing Views** only affects views where the **Place** is set to **Free** in the view properties. **Fixed** views are not moved.

• If you have set `XS_CHANGE_DRAGGED_VIEWS_TO_FIXED` to **TRUE** (default) and drag a view in a drawing, the view becomes fixed, and the **Arrange Drawing Views** command does not work.

• **Arrange Drawing Views** may change the drawing size if you have used automatic scaling of drawing views.

---

**See also**  
*Modifying drawing views on page 133*

---

**Modifying drawing view properties**

You can modify view properties in the final drawing view by view or in selected views.

To modify view properties:

1. Do one of the following:
   - If you want to modify the properties in several views, hold down **Ctrl** and click the view frames of the views you want to modify and click **View --> Drawing View Properties**.
   - To modify the properties of one view, double-click the view frame.

2. Clear all the check boxes in the dialog box by clicking the on/off switch at the bottom of the dialog box.

3. Select the check boxes next to the properties you want to modify.

4. Modify the view properties as required.
   - For example, change the view **Scale**.

5. Click **Modify** in each of the subdialog boxes where you change the properties.

6. If there are some object level settings that you want to apply, click the **Edit settings** button and load the object settings that you want to use. Click **Modify**.

---

**See also**  
*View properties in drawings on page 529*

*Modifying drawing views on page 133*

*Modifying view-level drawing properties on page 314*
**Modifying section properties**

You can modify the section mark, section view label and section view cutting line properties in an open drawing.

To modify section properties:

1. Double-click the section mark.

2. Clear all the check boxes in the dialog box by clicking the on/off switch at the bottom of the dialog box.

3. Select only the check boxes next to the properties you want to modify.

4. On the Cutting line tab, set the section mark line length and offset (distance between the mark and the section).

5. On the Section mark tab, click the ... button next to A1 – A5 to open the Mark Contents dialog box and select the elements to be included in the section mark.

6. If needed, select an element from the list, click Add frame and select the frame Type and Color. You can set these individually for each element.

7. If needed, select an element from the list and select the text Color, Font and Height. You can set these individually for each element.

8. On the Position tab of the Mark Contents dialog box, set the side to show the text, the text position, the horizontal and vertical offset, and the text rotation. Text positioning depends on whether you use a symbol or not.

9. Click Modify.

10. In the Symbol area, define the section mark symbols. You can select from a list of predefined arrow symbols or use your own custom symbol. The symbol properties can be given separately for both the left and the right section mark symbols. Also set the color, size and position of section mark symbols.

11. On the View label tab, click the ... button next to A1 – A5 to open the Mark Contents dialog box, and select the elements to be included in the section view label.

12. Modify the element appearance and mark position as described above.

13. Click Modify.
14. Select the view label Symbol to be used in the label. You can also set the color, size, and the line length of the section view label line and symbol.

15. Set the label position and whether you want to center it according to the view frame or view boundary (view restriction box)

16. Click Modify.

See also  View, section view and detail view label mark elements on page 567
Section and detail mark elements on page 567
Positioning properties of view label, section and detail marks on page 554
Modifying drawing views on page 133
Section view properties on page 532

**Modifying detail properties**

You can modify the properties of detail marks, detail view labels and detail mark boundaries in an open drawing.

To modify detail properties:

1. Double-click a detail mark to display the **Detail Symbol Properties** dialog box.

2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.

3. Select only the check boxes next to the properties you want to modify.

4. Modify the detail name in the **Detail name** box.

5. On the **View Label** tab, click the ... button next to A1 - A5 to open the **Mark Contents** dialog box, and select the elements to be included in the detail view label.

6. If needed, select an element from the list, click **Add frame** and select the frame **Type** and **Color**. You can set these individually for each element.

7. If needed, select an element from the list and select the text **Color**, **Font** and **Height**. You can set these individually for each element.

8. On the **Position** tab of the **Mark Contents** dialog box, set the text position, horizontal and vertical offset, and the text alignment. Text positioning depends on whether you use a symbol or not.

9. Click **Modify**.

10. Select the view label **Symbol** to be used in the label. You can also set the color, size, and the line length of the view label line and symbol.

11. Select the **Vertical (Above or Below)** and **Horizontal (Center by view frame or Center by view restriction box)** position of the view label.
12. Go to the Detail boundary tab and define the shape of the boundary and the color and type of the bounding line.

   Use the advanced option XS_DETAIL_BOUNDARY_RADIUS for setting a fixed size for the detail boundary.

13. On to the Detail mark tab, click the ... button next to A1 – A5 to open the Mark Contents dialog box and select the elements to be included in the detail mark.

14. Modify the element appearance and mark position as described above.

15. Click Modify.

16. Select the detail mark Symbol to be used in the mark. You can also change the color and size of the symbol.

17. Click modify in the Detail Symbol Properties dialog box.

See also

View, section view and detail view label mark elements on page 567
Section and detail mark elements on page 567

4.4 Dimensions

In addition to the automatically created dimensions defined in the drawing properties of the created drawings, Tekla Structures contains several tools for modifying the automatically created dimensions and for adding new dimensions in the final drawing.

See also

Example: Manual dimensions on page 143
Adding manual dimensions using User Coordinate System on page 148
Adding tags to dimensions on page 150
Example: Filtering out dimension tag content on page 151
Adding dual dimensions manually on page 153
Recreating dimensions for all parts on page 154
Adding manual dimensions on page 142
Adding manual dimensions to general arrangement drawings on page 148
Adding predefined reinforcement dimensions on page 155
Adding dimension (distribution) lines to reinforcing bars on page 156
Dimensioning reinforcing bar groups on page 158
Modifying dimension properties on page 166
Automatic dimension settings on page 381
Creating exaggerated dimensions on page 439
Dimensioning center of gravity on page 162
Adding manual dimensions

To add dimensions:

1. Hold down **Shift**, click **Dimensioning** and select one of the dimensioning commands depending on the type of dimension you want to create:

   - **Add Horizontal Dimension**: Create a dimension in the x direction by picking the points to be dimensioned. X depends on the current UCS.
   - **Add Vertical Dimension**: Create a dimension in the y direction by picking the points to be dimensioned. Y depends on the current UCS.
   - **Add Orthogonal Dimension**: Create a dimension in either the x or y direction by picking the points to be dimensioned. Tekla Structures uses the direction of the larger overall distance. X and y depend on the current UCS.
   - **Add Parallel Dimension**: Create a dimension parallel to a line you define. First pick two points to define the direction of the dimension line and then pick the points to be dimensioned.
   - **Add Perpendicular Dimension**: Create a dimension perpendicular to a line you define. First pick two points to set the direction of the dimension line, then pick the points to be dimensioned.
   - **Add Free Dimension**: Create a dimension parallel to a line between any two points you pick.
   - **Add Curved Dimension With Orthogonal Reference Lines**: Create curved dimension with orthogonal reference lines: Pick three points to define the arc and pick the points to be dimensioned. The dimension text on the line can be either a distance or an angle value.
   - **Add Curved Dimension With Radial Reference Lines**: Create curved dimension with radial reference lines. Pick three points to define the arc and pick the points to be dimensioned. The dimension text on the line can be either a distance or an angle value.
   - **Add Radial Dimension**: Create radial dimension. Pick three points to define the arc and pick a position for the dimension.
   - **Add Angular Dimension**: Create angular dimension. Pick the vertex point and two points to define the angle. Pick the side to place the dimension.

2. Modify the dimension properties in the properties dialog box.

3. Add the desired elements in dimension marks and modify their properties.

4. Add dimension tags with the desired elements as required and set the dimension tag rotation.
Here you can also select to include part count to dimension tags and select a filter that removes the desired default content from the tag.

The available dimension mark and dimension tag mark elements are the same as those for the part, bolt, reinforcement and surface treatment marks.

5. Click **OK** or **Apply**.
6. Add the dimensions by following the instructions on the status bar.
7. Drag the dimensions to the desired locations.

When you drag the dimensions, the **Placing** setting changes to fixed by default.

- It is very important to use correct snap switches to get the dimensions correct. You can change the switch temporarily by right-clicking and selecting the switch that suits the best for your purpose.
- In dimension types where you click the middle mouse button to place the dimension line, the placement setting affects the result. If you have set **Placing** to **fixed**, the position you click will be the location of the dimension line. If you have set **Placing** to **free**, the middle mouse button click defines which side of the object the dimension line is located on, and Tekla Structures places the dimension line.
- You can also pick outside the view when you place the dimensions. The view frame is resized automatically.

**See also**

- Object protection and placement settings in drawings on page 343
- XS_CHANGE_DRAGGED_DIMENSIONS_TO_FIXED
- Modifying dimension properties on page 166
- Dimension and dimensioning properties on page 533
- Changing the prefix in radial dimensions on page 441
- Adding tags to dimensions on page 150
- Mark elements on page 560
**Example: Manual dimensions**

Here are some examples of manual dimensions.

<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Parallel Dimension</strong></td>
<td><img src="image1.png" alt="Image" /></td>
</tr>
<tr>
<td>1 Shows the edge points picked for defining the direction for the parallel dimension line.</td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>2 Shows the dimension points picked.</td>
<td><img src="image3.png" alt="Image" /></td>
</tr>
</tbody>
</table>

Same part as before, now dimensioned with **Add Perpendicular Dimension**

<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="image5.png" alt="Image" /></td>
</tr>
<tr>
<td>1 Shows the edge points picked for defining the direction for the perpendicular dimension line.</td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
<tr>
<td>2 Shows the dimension points picked.</td>
<td><img src="image7.png" alt="Image" /></td>
</tr>
<tr>
<td>Command</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Add Curved Dimension --&gt; With Orthogonal Reference Lines</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>The dimension text on the line is a distance value.</td>
<td></td>
</tr>
</tbody>
</table>

If the ends of a curved beam or polybeam have been cut or fitted, the points at the ends of the beam do not necessarily lie on the true curve of the beam. This is because curved beams are created with straight segments. The points are indicated with 2.

To avoid creating incorrect curved dimensions, pick the three points defining the arc using three of the points indicated with 1.

Use end point snap.
<table>
<thead>
<tr>
<th>Command</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Add Curved Dimension --&gt; With Radial Reference Lines</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Curved</strong> set to <strong>Distance</strong>.</td>
<td></td>
</tr>
<tr>
<td>The dimension text on the line is a distance value.</td>
<td></td>
</tr>
<tr>
<td><strong>Add Curved Dimension --&gt; With Radial Reference Lines</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Curved</strong> set to <strong>Angle</strong>.</td>
<td></td>
</tr>
<tr>
<td>The dimension text on the line is an angle value.</td>
<td></td>
</tr>
<tr>
<td>Command</td>
<td>Example</td>
</tr>
<tr>
<td>----------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Add Angular Dimension</td>
<td><img src="image1" alt="Add Angular Dimension Example" /></td>
</tr>
<tr>
<td>Angle set to Degrees at angle vertex</td>
<td><img src="image2" alt="Add Angular Dimension Example" /></td>
</tr>
<tr>
<td></td>
<td><img src="image3" alt="Add Angular Dimension Example" /></td>
</tr>
<tr>
<td>Angle set to Degrees on side</td>
<td><img src="image4" alt="Add Angular Dimension Example" /></td>
</tr>
<tr>
<td></td>
<td><img src="image5" alt="Add Angular Dimension Example" /></td>
</tr>
<tr>
<td>Angle set to Triangle.</td>
<td><img src="image6" alt="Add Angular Dimension Example" /></td>
</tr>
<tr>
<td>Triangle base length set to 100</td>
<td><img src="image7" alt="Add Angular Dimension Example" /></td>
</tr>
<tr>
<td>Add Radial Dimension</td>
<td><img src="image8" alt="Add Radial Dimension Example" /></td>
</tr>
</tbody>
</table>

See also  
Dimensions on page 141  
Adding manual dimensions on page 142
Adding manual dimensions to general arrangement drawings

You can dimension parts to grids along their X, Y, or X and Y axis and along grid lines in general arrangement drawing plan views.

Limitations: Parts like beams that are not located along the grids are not dimensioned.

To add part dimensions in an open general arrangement drawing plan view:

1. Open the general arrangement drawing.
2. To check and change the dimension properties, click Dimensioning --> Dimension Properties, make the necessary changes and click Apply or OK.
3. To dimension, click Dimensioning --> Add GA Drawing Dimensions and do one of the following:
   • To dimension along grid lines, select Along Grid Lines and pick the view in the location where you want to create the dimensions.
   • To dimension along part X or Y axis or both, select the part, and select Along Part X Axis, Along Part Y Axis or Along Part X and Y Axis. The parts are dimensioned to the two nearest grids.

Tekla Structures creates the dimensions according to the dimension properties you defined in the Dimension Properties dialog box.

See also  Modifying dimension properties on page 166

Adding manual dimensions using User Coordinate System

You can pick UCS (user coordinate system) points to define the current coordinate system in the drawing view. If you do this, the dimensioning commands Add Horizontal Dimension, Add Vertical Dimension and Add Orthogonal Dimension follow the defined coordinate system.

To create dimensions in the horizontal direction using UCS:

1. Open a drawing.
2. Right-click the desired view, select Tools --> User Coordinate System (UCS) --> Set by Two Points.
3. Pick the UCS origin and the UCS X direction.
4. Click **Dimensioning --> Add Horizontal Dimension**.

5. Pick the start and end point for the dimension.

6. Point to the location where you want to add the dimension line and click the middle mouse button.

When you use the **Add Orthogonal Dimension** command, it automatically finds out whether the dimension line is in the X or Y direction depending on which one is the closest.

**See also**  
User coordinate system (UCS) on page 266  
Adding manual dimensions on page 142
Adding tags to dimensions

You can add dimension tags to dimensions in an open drawing. You can add dimension tags to single and combined dimensions.

Limitations:

- Rotation is not available for the middle dimension tags.
- The dimension tags are automatically updated according to model changes, when you update the drawing. If you want to disable the automatic update, you can freeze the drawing or set the advanced option `XS_INTELLIGENT_DRAWING_ALLOWED` to `FALSE`. This advanced option affects all drawings.

To add dimension tags to a dimension:

1. Double-click the dimension.
2. Go to the Tags tab and select the locations where you want to add dimension tags.
   
   You can add dimension tags above and below the dimension line to the left and right end of the line, to the dimension line ends, and in the middle of the dimension line below the line.

3. Click the ... buttons to go to the Tag Mark Properties dialog box.
   
   You can also enter text directly in the A - G boxes.

4. Select the tag rotation. Each tag has an independent rotation setting, so you can rotate some tags and leave others unrotated.

   - **Parallel to dimension line** does not rotate the tag. This is the default value.
   - **Perpendicular to dimension line** rotates the tag.

5. Include the elements that you want in the dimension tag.
   
   The available elements are the same as those of the part, bolt, reinforcement and surface treatment marks.

6. Select the element frame type and color and the text color, font, and height.
7. Click OK.
8. If you want to show the part count in the tag, set **Include part count in the tag** to Yes.
9. Use **Exclude parts according to filter** and select a predefined filter to remove some of the automatically created tag content.

In addition to the user-selectable elements, some of the dimension tag content is automatically created based on the dimension end point locations. If you want to exclude unnecessary tag content for parts that are located in the same location as the dimensioning point, create suitable drawing view filter.

10. Click **Modify**.

**Limitations**

Below is an example of dimension tags.

Below is an example of an unrotated and a rotated dimension tag.

**See also**

Part mark elements on page 561  
Bolt mark elements on page 562  
Reinforcement and neighbor reinforcement mark elements on page 564  
Surface treatment mark elements on page 566  
Using superscript in text on page 188  
Dimensions on page 141  
Modifying dimension properties on page 166  
Dimension and dimensioning properties on page 533  
Example: Filtering out dimension tag content on page 151
Example: Filtering out dimension tag content

In this example, you will remove from a dimension tag some content that is added in the tag automatically based on the dimension end point locations. First you will create a drawing view filter that you will use for removing the content.

The example below shows a tag that automatically contains the text "CORBEL". You will remove this text.

To create the filter and remove the desired content:

1. Open a drawing.
2. Double-click the view frame to open the View Properties dialog box.
3. Double-click Filter... to open the View Filter Properties dialog box.
4. Click Add row and create a filter according to the example below.
5. Enter concrete as the name of the filter in the box next to the Save as button and click the button to save the filter.

6. Click Cancel to close the dialog box.

7. In the drawing, double-click the dimension that contains the content that you want to remove.
   The Dimension Properties dialog box is displayed.

8. Go to the Tags page.

9. In Exclude parts according to filter, select the concrete filter.

10. Click Modify.

    Tekla Structures removes the text "CORBEL" from the dimension tag. The material type of corbel is concrete, and the concrete filter removes all concrete parts from the tag.

See also  Adding tags to dimensions on page 150

Adding dual dimensions manually

You can add dual dimensions manually in an existing drawing.

To add dual dimensions manually:

1. Go to Tools --> Options --> Options... --> Drawing dimensions --> Dimensions in tags, set the unit, formats and precision, and activate the dual dimensions for the drawing types you want.

2. Click OK.

3. Double-click a dimension in your drawing.

4. Go to the Tags tab, and enter the text DIMENSION in the middle dimension tag.
5. Click Modify.

6. If you do not want to show dual dimensions in all dimensions, you can manually delete the text DIMENSION from the tag.

**Example**  Below is an example of dual dimensions that use the unit mm and format ###.

```
\[ \begin{array}{ccc}
  \text{A:} & ... & \text{E:} \\
  \text{B:} & ... & \text{DIMENSION} \\
  \text{C:} & ... & \text{F:} \\
  \text{G:} & ... & \text{D:} \\
\end{array} \]
```

**See also**  Adding manual dimensions on page 142  
Modifying dimension properties on page 166  
Dimension and dimensioning properties on page 533

**Recreating dimensions for all parts**

You can recreate the same dimensions that were originally created for the parts in the drawing.

To recreate dimensions for all parts:

1. Open the drawing.

2. Check that you have set Dimension creation method in this view to Automatically in the view properties.  
   Tekla Structures dimensions parts only in views where this setting is set to Automatically.
3. Click **Dimensioning --> Recreate Dimensions for All Parts**.

Tekla Structures re-dimensions all views except linked, 3D and key plan views, and removes all manually created dimensions.

**See also**  
Adding manual dimensions on page 142  
View properties in drawings on page 529

---

**Adding predefined reinforcement dimensions**

You can add dimensions to reinforcing bar groups in an open cast unit drawing.

Each reinforcing bar group with identical spacing has a mark and dimension line. You can define the contents of the dimension marks and tagged dimension marks case by case or use predefined dimension property files.

To add reinforcement dimensions using predefined dimension property files:

1. Click **Dimensioning --> Dimension Properties**.

2. Modify the dimension properties:
   - For dimension marks, adjust the type, format, and appearance of the dimension and the contents of the dimension mark.
   - If you want to have dimension tags in your dimension, select where to add dimension tags and adjust the contents of the tags on the **Tags** tab.

3. Save the modified dimension properties by entering a name in the **Save as** box and clicking **Save as**.
   
   Save separate files for dimension marks and tagged dimension marks.

4. Click **Tools --> Options --> Options...** and go to the **Drawing dimensions** page.

5. Under **Add mark to reinforcement**, select the property files you just saved in the **Dimension Mark settings** and **Tagged Dimension Mark settings** lists.

6. Click **OK** in the **Options** dialog box.

7. Go back to the drawing, right-click the reinforcing bar group and select **Add Mark --> Dimension Mark** or **Tagged Dimension Mark** from the pop-up menu.

**Example**  
Below is an example of a reinforcement dimension with dimension marks.
Below is an example of a reinforcement dimension that contains dimension marks and a dimension tag.

Adding dimension lines, or distribution lines, to reinforcing bar groups. They show the distribution of the reinforcing bars in the group.

To create a dimension line:

1. Open a cast unit drawing.

See also

- Dimensions on page 141
- Adding manual dimensions on page 142
- Dimension and dimensioning properties on page 533
- Reinforcement and neighbor reinforcement mark elements on page 564

**Adding dimension (distribution) lines to reinforcing bars**

You can add dimension lines, or distribution lines, to reinforcing bar groups. They show the distribution of the reinforcing bars in the group.

To create a dimension line:

1. Open a cast unit drawing.
2. Right-click a reinforcing bar group and select **Create dimension line** from the pop-up menu. Tekla Structures creates the dimension line.

3. If needed, double-click the dimension line to display the **Dimension Properties** dialog box.

   Modify the properties as required. Click **Modify** to apply the changes.

4. If needed, you can drag a reinforcement dimension line out of the reinforcement bar group.

   When you do this, Tekla Structures draws a dashed line from the reinforcing bar to the dimension line. If the new location is in the reinforcement area, the reinforcing bar mark follows the intersection of the reinforcement bar and reinforcement dimension line.

   **Example**  Below is an example of the dimension line.

   ![Example of dimension line](example1.png)

   Below is an example of the dimension line when it has been dragged outside the reinforcing bar group.

   ![Example of dimension line when dragged outside](example2.png)
Dimensioning reinforcing bar groups

You can add dimensions to reinforcing bar groups using the `RebarGroupDimensionPlugin` application.

Before you start using this feature, add the `RebarGroupDimensionPlugin` command to a toolbar through Tools --> Customize. Always add commands to the User menu and to toolbars in the modeling mode, otherwise they are not saved.

To add dimensions to reinforcing bar groups:

1. Select the reinforcing bar groups.
2. Press down Shift and click the Create `RebarGroupDimensionPlugin` command that you added on a toolbar.
   
   If you do not want to adjust any properties, just click the command.
3. Select the Annotation type.
The first option is meant for cases where two or more groups are not overlapping. The second and third options are meant for cases where the groups are overlapping. The third option is otherwise similar to the second one, except that the dimension text is in 90 degrees angle in relation to the actual dimension line.

4. In **Prefix for spacing value**, enter the letters or text to be placed before the spacing value.

5. In **Settings for distribution line**, select the properties file that you want to use for the distribution line.

   You can control these properties by opening and modifying the properties file in the **Dimension Properties** dialog box.

6. In **Settings for note text**, select the properties file that you want to use for the annotation text part other than the position text.

   You can control these properties by opening and modifying the properties file in the **Text Properties** dialog box.

7. In **Show position in text**, select whether you want to show or hide the position text.
8. If you set Close dimension line to part ends to Default, the first annotation type is closed, and the other types are not. You can change this default behavior by selecting Yes or No.

9. In Settings for position text, select the properties file that you want to use for the position text in the annotation.

10. Go to the Advanced settings tab to control the relative locations and placing of various elements of the annotation.

11. In First line spacing, enter a millimeter value to indicate the space between the dimension line and the first line of dimension text.

12. In Next line spacing, enter a millimeter value to indicate the space between several lines of dimension text.

13. Select Free text below text and enter a millimeter value to indicate the space between the last line of dimension text and the next dimension line.
14. Select **Dimension line spacing** and enter a millimeter value to indicate the space between two or more dimension lines.

15. In **Tolerance for group width**, enter a decimal value to override the default tolerance value of 50 mm.

   The idea is to have a common dimension line and multiple texts whenever the reinforcing bar groups have equal widths, which means that the difference in width is smaller than the tolerance.

16. Click **OK**.

17. Click the location on the reinforcing bar group where you want to place the dimensions.
Dimensioning center of gravity

You can indicate the location of the center of gravity (COG) in single-part, assembly, and cast unit drawings by creating COG dimensions and a COG symbol at the center of gravity. You can also create COG dimensions in section views. COG dimensions will be automatically updated if the single part, assembly, or cast unit changes. The COG dimensions can also be cloned.

Limitations:

- If you copy or link a drawing containing COG dimensions to another drawing, such as a multidrawing, the COG dimensions will not be copied.
- You cannot create COG dimensions in general arrangement drawings or multidrawings.

To create COG dimensions:

1. Double-click the Create COG Dimension toolbar command.
2. Modify the options as required:
- In **Create**, select **Symbol** to see only the COG symbol, or **Dimensions** to see only COG dimensions. To see both, select **Both**.

- In **Dimensioning**, select to create **Horizontal** or **Vertical** dimensions, or **Both**.

- In **Dimension attributes**, you can load predefined dimension properties. The appearance settings (size, color, etc.) of the COG dimensions are read from the dimension property file you load in **Dimension attributes**. You can create and save dimension property files through **Dimensioning --> Dimension Properties**. For example, you may create a special COG dimension property file to change the color or arrow type, and load the saved properties in **Dimension attributes**.
• In Symbol Options, you can change the Symbol file in use and the symbol you want to use for COG, and load predefined symbol properties.

You can access the symbol options only if you have selected Both or Symbol for Create. The appearance settings (height, color, etc.) of the symbol are read from the symbol properties file you load in Symbol attributes.

You can create and save symbol property files through Annotating --> Properties --> Symbols... . For example, you may create a special COG symbol properties file to change the color and height of the symbol, and load the saved properties in Symbol attributes.

3. Click OK.

4. Pick the first point to specify the origin of the dimensions. The origin is the point from which you want to measure the location of the center of gravity. This point must be located within the view frame.

5. Pick the second point to place the dimensions. This point may fall outside the view frame.
The example below shows the created dimensions.

6. When the dimension is selected, handles are shown at the dimension origin and the dimension location. You can drag these handles to adjust the origin or the location, or move them using the standard editing commands.

See also

Editing drawings 165 Dimensions
Exaggerating selected dimensions (ExaggerateSelectedDimensions)

You can exaggerate narrow dimensions to make them easier to read. When exaggerated, a dimension that is narrower than the limit defined in the Options dialog box is enlarged using the defined scale. If there are many exaggerated dimensions, Tekla Structures arranges them automatically.

To exaggerate dimensions:
1. Go to Tools --> Options --> Options --> Drawing dimensions.
2. Set the Exaggeration limit and Exaggeration scale.
   Exaggeration scaling defines whether you are using Paper or Model as the exaggeration scaling method. If you select Paper, the exaggeration limit is multiplied by the view scale. If you select Model, and the scale is 1:10, all the dimensions smaller than 10 mm are exaggerated regardless of the drawing scale.
3. Click OK to save the settings and close the Options dialog box.
4. In an open drawing, click the dimension that you want to exaggerate.
5. Click Tools --> Macros, select ExaggerateSelectedDimensions from the list, and click Run.

Modifying dimension properties

You can modify the properties of the dimensions in an open drawing.

To modify dimensions:
1. Double-click a dimension.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
3. Select only the check boxes next to the properties that you want to modify.
4. On the **General** tab, modify the dimension type, format, and placing settings.
   For example, here you can set the dimension to be free or fixed. **Free** lets Tekla Structures
declare the location and direction of the dimension. **Fixed** allows you to place the
dimension at any point. For more information click the link in the **See also** section.

5. On the **Appearance** tab, modify the text, line and arrow settings.
   For more information, click the link in the **See also** section.

6. On the **Marks** tab, modify the dimension mark contents and exaggeration settings.
   Here you can also select whether you want to show plate side marks. For more
information, click the link in the **See also** section.

7. On the **Marks** tab, click the ... button next to **Prefix** or **Posfix** to add elements in the
dimension mark and modify element appearance.

8. On the **Tags** tab, add dimension tags as required, and set the dimension tag rotation.
   Here you can also select to include part count to dimension tags and select a filter that
removes the desired default content from the tag. For more information, click the link in
the **See also** section.

9. Click **Modify**.

**See also**  
General dimension properties on page 533  
Dimension appearance properties on page 537  
Dimension mark and dimension tag properties on page 538  
Adding tags to dimensions on page 150  
Dimension and dimensioning properties on page 533  
Adding manual dimensions on page 142

---

**Adding dimension points in anchor bolt plans**

You can add dimension points to dimensions inside the enlarged views in an open anchor
bolt plan.

**Limitations:** You cannot create new dimension lines that have dimension points inside both
the enlarged views and the plan view.

To add dimension points to the dimensions inside the enlarged views:

1. Select the enlarged view frame.
2. Select the dimension to modify.
3. Right-click and select **Add dimension point**.

**See also**  
Creating anchor bolt plans using saved settings on page 59  
Example: Dimensions in anchor bolt plans on page 458
Showing plate side marks

You can show plate side marks on dimension leader lines. The plate side marks indicate whether the dimension point is to the face or center of the part, for example, a plate, web, or flange.

To create plate side marks:

2. In the Dimension Properties dialog box, go to the Marks tab, set Type in Plate side marks to Specified to manually control the symbol and insert plate side mark symbols in the drawing.

   The option Automatic is available only in intelligent drawings, that is when the advanced option XS_INTELLIGENT_DRAWING_ALLOWED is set to TRUE.

3. Modify the other properties of the plate side marks as required:
   - You can select the left and right plate side mark.
   - You can set the mark size.
   - You can adjust the mark color.
   - You can set the offset of the mark from the dimension line.

4. Click Modify.

See also  
XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_LEFT
XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_CENTER
XS_DIMENSION_PLATE_SIDE_MARK_SYMBOL_RIGHT

Modifying dimension properties on page 166
Changing the location of short outside dimension texts

If you have selected to place texts of short dimensions outside the dimensions by setting Short dimensions to Outside on the General tab of the Dimension Properties, you can select on which side of the extension line the dimension text is placed.

Limitations: You can flip only start or end dimensions in a dimension set.

To change the location of the dimension text:
1. Click Dimensioning --> Edit Dimensions --> Flip Outside Dimension.
2. Click the dimension whose location you want to change.

You can place the dimension text outside the dimensions if there is enough space for the dimension text.

Setting new dimension start point

You can select a new start point for running dimensions (dimensions that start from a common start point).

To select a new start point:
1. Select an existing dimension in the drawing.
2. Click Dimensioning --> Edit Dimensions --> Set Dimension Start Point.
3. Select the new start point. Tekla Structures automatically updates the dimensions.

Example You can use this command to swap the running dimensions start point to the opposite end of the member. This is useful when running dimensions start from the opposite end of a member.
When you use the US absolute dimension type, Tekla Structures draws a new RD symbol (Running Dimension) at the new zero point and updates the dimensions according to the new start point.

Adding closing dimensions

In a drawing containing a reinforcing bar group, you can manually add closing dimensions to the edge of the part using the Add Dimension Point command.

To add closing dimensions:

1. Open a cast unit drawing.
2. Select the reinforcing bar group dimension line.
3. Click Dimensioning --> Add Dimension Point.
4. Select the points where you want to add the closing dimensions.

See also  Modifying dimension properties on page 166
 Tekla Structures creates the closing dimensions.

Adding dimension points

To add dimension points on a dimension line:

1. Select the dimension line.
   
   You can only add points to one dimension line at a time.

2. Click **Dimensioning** --> **Edit Dimensions** --> **Add Dimension Point**.

3. Click a position on the part where you want to add the dimension point.
   
   You can add several points.

4. If needed, you can remove a point by clicking **Dimensioning** --> **Edit Dimensions** --> **Remove Dimension Point** and clicking the point you want to remove.
   
   You can remove several points in a row.

See also  XS_REBAR_DIMENSION_MARK_MANUAL_CLOSE_TO_GEOMETRY

Adding dimension points on page 171
The **Add Dimension Point** and **Remove Dimension Point** commands are also available in the pop-up menu for dimensions.

See also  
Modifying dimension properties on page 166

Adding closing dimensions on page 170

---

### Linking perpendicular dimension lines

You can connect two perpendicular dimension lines. Connecting dimension lines makes your drawings clearer and easier to read. For example, you might want to link dimension lines of embedded objects in a cast unit, floor beams in a floor plan, or anchor bolts in an anchor bolt plan.

To connect two dimension lines:

1. Hold down Ctrl and select two perpendicular dimension lines to connect.
2. Click **Dimensioning** --> **Edit Dimensions** --> **Link Dimension Lines**.
3. If you want to unlink the dimension lines you linked, select the linked dimension line and click **Dimensioning** --> **Edit Dimensions** --> **Unlink Dimension Lines**.

**Example**  
Below is an example of linked dimension lines.

![Example of linked dimension lines](image)

The commands **Link Dimension Lines** and **Unlink Dimension Lines** are also available in the pop-up menu for dimensions.

See also  
Modifying dimension properties on page 166
Combining dimension lines

You can manually combine a group of two or more parallel dimension lines into one line.

To combine parallel dimension lines:
1. Hold down Ctrl and click the dimension lines you want to combine.
2. Click Dimensioning --> Edit Dimensions --> Combine Dimension Lines.

You can also select Combine Dimension Lines from the pop-up menu.

See also  Modifying dimension properties on page 166
Draggging dimension marks

Dimension marks can be freely dragged to avoid overlapping dimensions and marks. Ensure, that you have switched **Smart Select** on in **Tools --> Options**.

To drag dimension marks:
1. Select the dimension line.
   If you do not select the dimension line first, dragging will move the whole dimension, not just the dimension mark.
   When you select the line, the dimension mark handle becomes visible.

2. Point the handle, press down the left mouse button, and drag the dimension mark to the desired location.

**See also** *Modifying dimension properties on page 166*

Moving the end of the dimension line

You can move the end of the dimension line orthogonal to itself outside the part. The dimension tags are moved together with the end of the line. This is useful when the tags would otherwise cover part geometry or other objects, such as dimensions or marks.

**Limitations:** You can move the end of the dimension line in all straight dimensions, except elevation dimensions.

To move the end of the dimension line:
1. In an open drawing, click the dimension.
   The dimension line handle becomes visible.
2. Select the handle and drag the end of the line to the desired position.
   It is easier to select the handle when your hold down **Alt** and then click the handle.
   If the dimension contains dimension tags, the tags are visible while you drag.
4.5 Associative annotation objects

Marks, dimensions, and associative notes are all associative annotation objects. An associative annotation object updates according to the changes made in a model object in the model. All annotation objects that have associativity points can be considered associative. For example, in texts, the content does not change when the model changes but the associativity point can change.

In addition to the annotation objects Tekla Structures creates in a drawing based on the drawing properties when the drawing is created, you can also add new ones in the final drawing.

See also
- Drawing objects on page 17
- Dimensions on page 141
- Adding part marks on page 175
- Adding weld marks on page 215
- Adding level marks on page 176
- Adding associative notes on page 177
- Modifying associative annotation object properties on page 178
- Updating marks on page 179
- Change symbols on page 180
- Merging marks on page 183
- Dragging the mark and associative note leader line base point on page 184
- Using superscript in text on page 188

Adding part marks

In an open drawing, you can add part marks for all building objects, surface treatment and connections, or for the selected ones only. For each view, Tekla Structures creates the marks according to the mark properties in the view mark properties dialog box.

To add part marks, do one of the following:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Add part marks for all parts</td>
<td>Click <strong>Annotating --&gt; Add Part Marks --&gt; For All Parts</strong>. If you have deleted marks manually from the drawing, this command will not create the marks, and you will have to create them manually part by part.</td>
</tr>
</tbody>
</table>
| Add part marks for selected parts | 1. Select the parts.  
2. Click **Annotating --> Add Part Marks --> For Selected Parts**  
3. If the part mark does not contain any elements in the drawing view properties, the **Part Mark Properties** dialog box is displayed, and you can select the elements to be included in the part mark. Add elements and click **Modify**. |

Alternatively, you can right-click the parts and select the appropriate mark creation command from the pop-up menu.

Use orthogonal snapping in marks and associative notes with leader lines. For example, you can use it for placing your marks and notes in a more consistent way in exact locations. When you start dragging a mark or note from a leader line end handle and you have orthogonal snapping on (**O** or **Tools --> Ortho**), the leader line end handle locks to the closes orthogonal point in the drawing (0, 45, 90, 135, 180 degrees).

**See also**
- Associative annotation objects on page 175
- Modifying view-level drawing properties on page 314
- Modifying drawing properties of an existing drawing on page 313
- Modifying associative annotation object properties on page 178
- Mark elements on page 560
- Drawing settings on page 523

**Adding level marks**

A level mark is an associative annotation object that represents the elevation of a point. In addition to the automatic elevation dimensions that you can define in the drawing properties before creating the drawing, and the elevation information in the grid labels added in the
model, you can also add level marks in your drawing to ensure that the dimensions are correct.

To add level marks:
1. Open the drawing.
2. Hold down Shift and click Annotating --> Add Level Mark to open the Level Mark Properties dialog box.
3. Enter or modify the content and the appearance of the level mark.
4. Click Apply or OK to save the properties.
5. Pick a start point for the leader line and a position for the mark.

1. Elevation dimension in the grid label
2. Elevation dimension created with Add Level Mark in the drawing

Shortening value added in the user-defined properties of a part also affects level marks.

See also  Level mark properties on page 559
Mark appearance and merging properties on page 551

Adding associative notes

An associative note is an extra mark that contains additional information of the object it is attached to. Associative notes are updated according to the changes made in the object it is added to. You can add associative notes to building objects, such as parts and reinforcement, surface treatments, edge chamfers, pour breaks and pour objects. You can add multiple notes to one object.

To add an associative note:
1. Open the drawing.
2. Hold down Shift and click Annotating --> Add Associative Note and select one of the following commands:
   - With Leader Line: Add an associative note with a leader line at the position you specify.
• **Without Leader Line**: Create an associative note without a leader line at the position you specify.

• **Along Line**: Add an associative note along a line at the position you specify.

3. Select what kind of an object you want to attach the note to in the **Content** list.

4. Select the elements you want to show in the note, and modify the appearance of the note.

   Associative notes may contain the same elements as part marks.

   Associative note appearance properties are the same as the ones for part marks.

   Additionally, you can adjust the leader line arrow height and length.

   To place the note exactly in the position you pick and keep it there, click the **Place** button and select **fixed** in the **Placing** list.

5. Click **Apply** or **OK** to save the properties.

6. Select the object.

7. Follow the instructions on the status bar. Continue picking to add the same note in another location.

See below for some examples of leader lines. The one on the left is **With Leader Line**, the one in the middle **Without Leader Line** and the one on the right **Along Line**.

For edge chamfers and other hard-to-see items, it is easier to use the pop-up menu command **Add Associative Note**, as you do not have to select the object again after selecting the command from the pop-up.

---

**See also**

- Mark elements on page 560
- Mark appearance and merging properties on page 551
- Associative annotation objects on page 175

**Modifying associative annotation object properties**

You can modify the properties of the associative annotation objects in an open drawing. By associative annotation objects we mean associative notes and marks for parts, bolts, reinforcement, surface treatments, welds, levels, and connections.

To modify the properties of associative annotation objects:
1. Double-click a mark or a note.

2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.

3. Select only the check boxes next to the properties that you want to modify.

4. Add missing elements in the mark on the Content tab and change the element properties. For more information about the mark elements and mark properties, click the links in the See also section.

5. Adjust the mark frame and leader line settings.
   For more information about mark appearance properties, click the link in the See also section.

6. To exactly place the mark in the position you pick and keep it there, click the Place... button and select fixed in the Placing list.
   For more information about the placement settings, click the link in the See also section.

7. Leave the dialog box open, select all the marks that you want to change, and click Modify to apply the changes in all the selected marks.

   To modify the properties of the weld marks of welds that you added in the model, you need to modify the weld in the model. When you number the model, the weld marks are updated in the drawings.

See also
   Associative annotation objects on page 175
   Mark properties on page 550
   Mark elements on page 560
   Mark appearance and merging properties on page 551
   Defining placement settings for annotation objects on page 347

Updating marks

You can update part marks and weld marks in an open drawing. Normally part marks and weld marks are up to date when you open the drawing. Updating is needed in frozen drawings.

To update marks, do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Update all part marks</td>
<td>Click Annotating --&gt; Update Marks --&gt; All Part Marks.</td>
</tr>
<tr>
<td>Update selected part marks</td>
<td>1. Select the part marks you want to update.</td>
</tr>
</tbody>
</table>

Editing drawings 179 Associative annotation objects
To | Do this
---|---
2. | Click **Annotating** --**> Update Marks** --**> Selected Part Marks**.
Update all weld marks | Click **Annotating** --**> Update Marks** --**> All Weld Marks**.

Tekla Structures updates the marks according to your selection.

**See also**  
Associative annotation objects on page 175  
Freezing and unfreezing general arrangement drawings on page 274

**Change symbols**

Tekla Structures highlights the marks and dimension marks that have changed due to changes in the model, and dimension points that have been moved. Tekla Structures also highlights the changed angle dimensions, level marks, and associative notes.

Tekla Structures highlights the changes in the following way:

- A change symbol (by default, a cloud) is drawn around the old point, the new point and the dimension values, or around the changed mark or note.
- An arrow is drawn from the old dimension point to the new one.

**See also**  
Associative annotation objects on page 175

**Removing change symbols**

After you have checked all the change symbols that Tekla Structures has created, you can remove all of them or just the selected ones.

To remove change symbols, do one of the following:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Remove all dimension change symbols</td>
<td>Click Dimensioning --&gt; Review Dimensions --&gt; Remove Dimension Change Symbol --&gt; All.</td>
</tr>
</tbody>
</table>
| Remove the selected dimension change symbols | 1. Select the change symbols you want to remove.  
| Remove all mark change symbols          | Click Annotating --> Review Marks --> Remove Mark Change Symbol --> All. |
| Remove the selected mark change symbols | 1. Select the change symbols you want to remove.  
  2. Click Annotating --> Review Marks --> Remove Mark Change Symbol --> Single. |
| Remove all associative note change symbols | Click Annotating --> Review Marks --> Remove Associative Note Change Symbol --> All. |
| Remove the selected associative note change symbols | 1. Select the change symbols you want to remove.  
  2. Click Annotating --> Review Marks --> Remove Associative Note Change Symbol --> Single. |

**See also**  Change symbols on page 180

*Removing all change symbols (RemoveChangeClouds)*

You can remove dimension change symbols, mark change symbols and associative note change symbols in one go from an open drawing.

To remove all change symbols from a drawing that has a lot of different kinds of change symbols:

1. Open the drawing.
2. Click **Tools --> Macros**.
3. Select **RemoveChangeClouds** and click **Run**.

Tekla Structures removes all change symbols.

**Example**  The first image shows an example of a mark change symbol after a material change, and of a dimension change symbol after a change in the size of the part.
The second image shows the dimension text and the mark after running the macro.
Merging marks

You can merge marks to reduce the number of marks in the drawing and to make the drawing clearer. A merged mark has a single leader line. You can merge marks automatically and also manually in the final drawing.

In a final drawing, you can merge reinforcement marks and weld marks.

See also  Merging reinforcement marks manually on page 183
Merging weld marks on page 218
Merging marks automatically on page 471

Merging reinforcement marks manually

To manually merge reinforcement marks in a drawing:

1. Click Annotating --> Properties --> Merged Reinforcement Mark...
2. Modify mark properties as required.
3. Select the marks to merge in the drawing.
4. Right-click and select **Merge marks** from the pop-up menu.
5. If needed, you can split the merged marks by selecting the marks to split, right-clicking and selecting **Split marks**.

**See also** *Merging reinforcement marks automatically on page 474*

**Dragging the mark and associative note leader line base point**

You can change the place of the mark and associative note leader line base point. Ensure that you have switched **Smart Select** on in **Tools --> Options** to drag and drop by handles without selecting them first.

**Limitations:**
- If the base point is originally on a line, you can drag it along that line.
- If the base point is originally inside a part, you can drag the base point inside that part.

To drag the leader line base point:
1. Click the leader line.
2. Hold down the left mouse button and drag the base point to a new location.

**Limitations**

**See also** *Associative annotation objects on page 175*

*Leader line types on page 553*

**Creating and using customized leader line arrows**

If you do not find a suitable leader line arrow in the **Arrow** list in the **Mark Properties** dialog box, you can add an arrow of your own.

First you will create the arrow symbol in the Symbol Editor, and save the created symbol in the *arrow.sym* file. Then you need to add the position of the new symbol in the *arrow.sym* to the configuration file *arrow.txt* file, which tells which arrows are available for use in your environment.

To create a new arrow symbol and take it into use:

1. Click **Drawings & Reports --> Symbol Editor** to open the Symbol Editor. If you have a drawing open, click **Tools --> Symbol Editor** instead.
2. Open the *arrow.sym* file located in common environment or in your environment under symbols folder.
3. Click an empty symbol slot and sketch your symbol with drawing tools.
   You can also import AutoCAD or MicroStation files through **File --> Import**.
4. When the symbol is completed, point the symbol slot to check the number of the new symbol at the bottom of the window.

5. Save the arrow.sym file by clicking File --> Save.

6. Click File --> Exit to close the Symbol Editor.

7. Open the arrow.txt file located in the same symbols folder as the arrow.sym file. The file contains a list of symbol numbers.

8. Add the number of your symbol preceded by zero (0) in the correct position and separate it with a comma:
   016,017,018,019,020,021,022,023,024,032,048,049,101,102,110,200

9. Click File --> Save to save your change.

10. Add a bitmap of the created arrow in the ..\ProgramData\Tekla Structures \<version>\Bitmaps folder on your computer. Use the following format in the file name: dr_dialog_arrow_type_024.bmp.

11. Double-click a mark in a drawing to open the Mark Properties dialog box.

12. Open the Arrow list, and you should see that the new arrow symbol is now available for use.
We recommend you define a firm folder for symbols, because the default folders are overwritten when you upgrade to a newer version of Tekla Structures. Add the firm folder to the advanced option \texttt{DXK_SYMBOLPATH}.

See also Defining a firm folder for images and symbols on page 520

4.6 Independent annotation objects

Independent annotation objects are not linked or connected to the Tekla Structures model in any way. Texts, text files, DWG/DXF files, symbols, revision marks, links and hyperlinks are all independent annotation objects.

See also Drawing objects on page 17
Adding text on page 186
Adding links to text files on page 188
Adding links to other drawings on page 189
Adding hyperlinks on page 190
Adding links to DWG and DXF files on page 191
Adding revision marks on page 192
Adding symbols in drawings on page 238
Modifying the properties of independent annotation objects on page 193

Adding text

You can add text in the drawings.

To add text:
1. Hold down Shift and click Annotating --> Add Text and then select one of the following commands to create a single line or multiple lines of text:
   - **Text**: Add text without a leader line at the position you pick.
   - **Text with Leader Line**: Add text with a leader line at the position you pick.
   - **Text along Line**: Add text along a line at the position you pick.
   - **Along Line, Arrow at End Point**: Add text along a line at the position you pick. An arrow is inserted at the second position you pick.
   - **Along Line, Arrow at Start Point**: Add text along a line at the position you pick. An arrow is inserted at the first position you pick.
2. Enter the text in the **Text** box.
   Press **Enter** to make a line break.
3. Modify the text color, height, font, angle and alignment as required.
4. Select a frame type, leader line and color.
5. Select the leader line arrow type and size.
6. To exactly place the text in the position you pick, and keep it there, click the **Place**... button and select **fixed** in the **Placing** list.
7. Click **OK** or **Apply**.
8. Pick the point where you want to place the text. Depending on the command, you have to pick one to three times.
   - Text is aligned to left by default. Line spacing is automatically adjusted by the font size you select.
   - You can continue picking to add the same line of text in another location.

See below for examples of the different text options. From left: **Text; Text with Leader Line; Text along Line; Along Line, Arrow at End Point; and Along Line, Arrow at Start Point**.

---

You can drag the base point of the text leader line freely after adding the text.

---

**See also** Independent annotation objects on page 186
**Using superscript in text**

You can use superscript in texts in all your text objects, dimension marks, other marks and associative notes.

Before you can use superscript, set the advanced option `XS_SUPERSCRIPT_USED_IN_DRAWING_TEXTS` to `TRUE`.

To use superscript text:

1. Open the properties dialog box of the text object, mark or associative note.
2. Do one of the following:
   - For text objects, enter the desired text in the **Text** box.
   - For marks and associative notes, open the **Mark Content – text** dialog box by double-clicking **Text** in the **Available elements** list and enter the desired text in the **Text** box.
3. Enter circumflexes (^) around the characters that you want to have in superscript.
4. Click **Modify** or **OK** and **Modify** as required.

**Example**

This example shows how the superscript is entered in the **Text** box and what it looks like in the text.

![Example of superscript text](image)

**Adding links to text files**

You can insert a text file inside a frame in a drawing. Tekla Structures adds the text file using the properties in the **Text File Properties** dialog box. Tekla Structures creates a link to the text file. If you change the text in the file, it will change in all drawings containing a link to the text file.

To add a link to a text file:

1. Open the drawing where you want to add the text file.
2. Click **Annotating --&gt; Add Text --&gt; From Text File**.

**See also**

- Adding text on page 186
- Associative annotation objects on page 175
- Dimensions on page 141
- `XS_SUPERSCRIPT_USED_IN_DRAWING_TEXTS`
3. Set the text color, height, and font.
4. Set the frame line type and color.
5. Select if you want to scale the text.
   If you select **No scaling**, you only need to pick the upper left corner of the frame. Tekla Structures inserts the object in its original size. If you select **Scale to fit**, you need to pick two points to define the frame. Tekla Structures adjusts the object size to fit the frame.
7. Click **OK** or **Apply**.
8. Pick one or two points in the drawing to indicate the corners of the text file frame.

- To edit a text file, double-click the text inside the frame. Tekla Structures opens the original text file.
- To modify the text file properties, double-click the frame around the text.

**See also** Independent annotation objects on page 186

### Adding links to other drawings

You can insert a link to a drawing in a frame in a drawing. Tekla Structures adds the link to the drawing using the properties in the **Drawing Link Properties** dialog box.

To add a link to another drawing:
1. Open the drawing.
2. Click **Annotating** --> **Add Link** --> **To Other Drawing**... .
3. Modify the text color, height, font and effect.
4. Modify the frame line type and color.
5. Select if you want to scale the link. If you select **No scaling**, Tekla Structures inserts the link in its original size.
   If you select **Scale to fit**, Tekla Structures adjusts the object size to fit the frame.
6. In the **Drawing** list, select the drawing to link to.
   The drawings in the list are the drawings in the current model.
7. If you want to display text for the link instead of the drawing name, enter the text in the **Text** box.
8. Pick two points to define the frame and add the link.
9. Click **OK** or **Apply**.

---

**Editing drawings** 189  Independent annotation objects
You can open the linked drawing by double-clicking the link.

Example  In the example below, Scale to fit has been selected, and the link contains the name of the drawing.

![Diagram of linked drawing](image)

See also  Independent annotation objects on page 186

**Adding hyperlinks**

You can add links to Internet addresses (URLs) within a frame in a drawing.

To add a hyperlink:

1. Open a drawing where you want to add a hyperlink.
2. Click **Annotating --> Add Link --> Hyperlink...**
3. Modify the text color, height, font and effect.
4. Modify the frame line type and color.
5. Select if you want to scale the link.

   If you select **No scaling**, you only need pick the upper left corner of the frame when you insert the link. Tekla Structures inserts the link in its original size. If you select **Scale to fit**, you need to pick two points to define the frame. Tekla Structures adjusts the link size to fit the frame.

6. In the **File or URL** text box, enter an Internet address or filename and path.

   If you need to locate the file, click **Browse...**. Tekla Structures inserts an active hyperlink to the location you specify.
7. If you want to display text for the hyperlink instead of the hyperlink, enter the text in the **Text** box.

8. Click **OK** or **Apply**.

9. Pick one or two points in the drawing to indicate the corners of the hyperlink frame.

**Example**  In the example below, **Scale to fit** has been selected. The Internet address for the hyperlink is shown.

![Hyperlink Example](image)

Double-click the hyperlink text in the drawing to jump to the Internet address.

---

**See also**  *Independent annotation objects on page 186*

### Adding links to DWG and DXF files

You can insert a DWG or DXF file inside a frame in a drawing. Tekla Structures adds the DWG or DXF file using the properties in the **DWG/DXF Properties** dialog box. Tekla Structures creates a link to the selected DWG or DXF file. When you modify the file, Tekla Structures also modifies all the links in the drawing.

In DWG/DXF links, Tekla Structures supports Autocad version 2010 and earlier.

To add a link to a DWG or DXF file:

1. Open the drawing where you want to insert a link to a DWG/DXF file.
2. Click **View --> Add DWG / DXF File**.
3. Select the scaling options:
   - **Scaling type**:
     - **X**: Pick the left upper corner of the frame to insert the file. You can only set the drawing scale in the x direction.
     - **XY**: Pick the left upper corner of the frame to insert the file. You can set the drawing scale in both the x and y direction.
• **Scale to fit**: Pick the left upper and bottom right corners of the frame to size and create the frame. Tekla Structures scales the file to fit the frame.

• **Best fit**: Pick the left upper and bottom right corners of the frame to size and create the frame. Tekla Structures scales the file to fit, maintaining its original aspect ratio.

• **Scale in X**:
  - Scales the file in the x direction. Enter a coefficient to indicate the scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type must be set to X or XY.

• **Scale in Y**:
  - Scales the file in the y direction. Enter a coefficient to indicate the scale, for example, 1.0 for 100%, 1.5 for 150%, etc. The scaling type must be set to XY.

4. Select the link frame line type and color.

5. In Name, browse for the DWG or DXF file you want to use.

6. Pick one or two points in the drawing to place the frame.

7. Click OK or Apply.

   Tekla Structures adds the DWG or DXF drawing inside a frame in the drawing.

**See also**  Independent annotation objects on page 186

### Adding revision marks

Revision marks are symbols that you can add in the drawing when you want to indicate a change in the Tekla Structures model or drawing, containing information about the change. Tekla Structures creates the revision mark using the properties in the Revision Mark Properties dialog box. If you create revisions through the Drawing List, Tekla Structures will not create any marks inside the drawing. Using revision marks you can indicate the parts that have changed in your drawing.

To add revision marks:

1. Open the drawing.

2. Click Annotating --> Add Revision Mark and select Arrow on Left, Arrow on Right, Along Line, Arrow on Left... or Along Line, Arrow on Right.

3. Enter the mark, date, and information on the changes.

   Tekla Structures shows these in the revision table of the drawing.

4. To place the revision mark exactly in the position you pick and keep it there, click the Place... button and select fixed in the Placing list.

5. Go to the Appearance tab and set the text color, height, font and angle, the frame color, leader line and type, and the leader line arrow type and size.
Some revision mark types need to have a leader line, otherwise you cannot place them:

6. Click OK or Apply.

7. Pick a point or points to place the mark.

Tekla Structures creates the revisions and revision marks. You can also see the new revisions on the **Drawing List**.

See below for some examples of the revision marks.

---

**See also**
- Independent annotation objects on page 186
- Leader line types on page 553
- Revising drawings on page 276

---

**Modifying the properties of independent annotation objects**

You can modify the properties of texts, symbols, links, hyperlinks, links to DWG and DXF files, and revision marks in an open drawing.

To modify the properties of the independent annotation objects:

1. Double-click the object.

2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
3. Select only the check boxes next to the properties that you want to modify.
4. Modify the properties.
5. Click Modify.

See also  Independent annotation objects on page 186

4.7 Shapes

Shapes are objects that you add in a drawing mostly to highlight information existing in the Tekla Structures model.

In Tekla Structures drawings, the additional drawing objects can be clouds, lines, circles, rectangles, arcs, polylines, polygons and cover-up areas and cover-up lines.

See also  Drawing objects on page 17
Creating a shape in a drawing on page 194
Hiding building object outlines using cover-up tools on page 198
Drawing shape properties on page 587
Hiding building object outlines using cover-up tools on page 198

Creating a shape in a drawing

You can create lines, rectangles, circles, arcs, polygons, polylines, clouds and cover-up areas and lines in an open drawing.

To create a shape:
1. Hold down Shift, click Shapes and select one of the commands.
   - **Draw Line**: Draw a line between two points you pick.
   - **Draw Rectangle**: Draw a rectangle between points you pick. You can create rectangles with horizontal and vertical sides. To rotate the rectangle, use Edit > Move > Rotate.
   - **Draw Circle > By Center and Radius**: Draw a circle by picking the center point first and then a point on the circle that specifies the radius.
   - **Draw Circle > By Three Points**: Draw a circle that traverses the three points you pick, either clockwise or counter-clockwise.
   - **Draw Arc > By Endpoints and Center**: Draw an arc by specifying two end points first and then a center point. The center point specifies the center of the circle of which the arc is a part.
• **Draw Arc > By Three Points**: Draw an arc that traverses the three points you pick, either clockwise or counter-clockwise.

• **Draw Polyline**: Draw a line with straight or curved segments. **Bulge factor for all lines** is useful when you are creating curved polylines.

• **Draw Polygon**: Draw a polygon by picking the corner points. To close the polygon, pick the starting corner point again or click the middle mouse button. Use this command to create closed polylines, which you cannot with **Draw Polyline**.

• **Draw Cloud**: Create a cloud that traverses the points you pick. Close the cloud by clicking the middle mouse button. Set the **Bulge factor for all lines** for clouds in the properties dialog box.

• **Draw Cover-up Area**: Quickly hide model object outlines in drawings. To use, select the command and draw a non-transparent rectangular area over the model object outline that you want to hide.

• **Draw Cover-up Line**: Quickly hide model object outlines in drawings. To use, select the command and draw a non-transparent line over the model object outline that you want to hide.

2. Modify the properties as required.

3. Click **OK** or **Apply**.

4. Create the drawing shape by following the instructions on the status bar.

See also  
- Shapes on page 194
- Drawing shape properties on page 587
- Defining customized line types on page 521
- Hiding building object outlines using cover-up tools on page 198

### 4.8 Building objects in drawings

*Building objects* are 2D representations of the 3D parts that you have created in the model. After making the drawing, you can change the appearance and representation of the building objects in an open drawing.

If you want to change the model weld properties, go back to the model, and make the changes there. In the drawing, you can only change visibility settings and appearance of the model welds. For manually added drawing weld marks the properties can be changed in the drawings.

See also  
- Editing drawings on page 114
- Modifying building objects on page 196
- Shortening parts view by view on page 197

---

Editing drawings 195 Building objects in drawings
Modifying building objects

You can modify the drawing properties of the building objects (parts, bolts, reinforcement, surface treatment) in an open drawing.

**Limitations:** The color of the center lines can be changed only on the drawing and view level, not on the object level. For center lines, you can adjust only the color in the properties dialog box, not the type. You can adjust the line type of part center lines with the advanced option `XS_CENTER_LINE_TYPE`.

To modify the properties of a building object in a drawing:

1. Double-click a building object, for example a part, reinforcement, surface treatment, or bolt.
2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
3. Select the check boxes of only those properties that you want to modify.
4. On the **Contents** tab, select the part representation, whether to show hidden lines, center lines and reference lines, and which additional markings to show.
5. On the **Appearance** tab, select the color and type of the lines.
   It is easier to adjust the center line color, if you hide the hidden lines on the **Contents** tab first.
6. On the **Fill** tab, set the part and section fill options.
7. Click **Modify**.

**See also**  
- Part and neighbor part properties in drawings on page 568  
- Bolt content and appearance properties in drawings on page 571  
- Surface treatment visibility and content properties in drawings on page 572  
- Reinforcement/Neighbor reinforcement and mesh properties in drawings on page 577  
- `XS_DRAWING_PART_REFERENCE_LINE_TYPE`  
- `XS_CENTER_LINE_TYPE`  
- `XS_DRAWING_POINT_SCALE`
Shortening parts view by view

You can shorten parts in the selected view in an open drawing.

To shorten parts view by view:

1. Double-click the view frame.
2. In the View Properties dialog box, go to the Attributes2 tab.
3. In Cut parts, select Yes, Only in x direction or Only in y direction.
4. In Cut skew parts, select if you want to cut skewed parts.
5. In Minimum cut part length, set the minimum length of the shortened part.
   This option defines how long the part must at least be to get shortened. The length of the part must be at least twice the entered value.
6. In Space between cut parts, enter the distance between the cut parts on paper.
7. Click Modify.

To use a view shortening symbol instead of the empty area, set the advanced options XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS and XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS to TRUE. You can control the appearance of the view shortening symbol with the advanced options XS_SHORTENING_SYMBOL_COLOR, XS_SHORTENING_SYMBOL_LINE_TYPE, and XS_SHORTENING_SYMBOL_WITH_ZIGZAG.

Example Below is an example of how the view shortening symbol is displayed.
See also  
Shortening parts in drawing views on page 366  
Shortening and lengthening parts on page 365  
Building objects in drawings on page 195  
View properties in drawings on page 529  
XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS  
XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS  
XS_SHORTENING_SYMBOL_WITH_ZIGZAG  
XS_SHORTENING_SYMBOL_LINE_TYPE  
XS_SHORTENING_SYMBOL_COLOR  

Hiding building object outlines using cover-up tools
Use cover-up line and cover-up area tools for quickly hiding building object outlines in drawings:

1. Click Shapes --> Draw Cover-up Area or Draw Cover-up Line.
2. Draw a non-transparent rectangular area or line over the model object outline that you want to hide. You can drag the cover-up objects to another location, and resize the objects by dragging the handles.
Showing a single reinforcing bar in a group

To have Tekla Structures show only a single reinforcing bar from a group or mesh:

1. Select the reinforcing bar group or mesh.
2. Click Edit --> Adjust Reinforcing Bars.
3. Click the bar you want to remain visible.
4. If needed, change the number of visible bars again by double-clicking the bar and changing the Visibility of reinforcing bars setting.

When you use the Adjust Reinforcing Bars command to select the visible reinforcing bar, also the customized setting becomes available for the Visibility of reinforcing bars option in the Drawing Reinforcement Properties dialog box. You can use this setting only after you have used the Adjust Reinforcing Bars command and not, for example, when you create the drawing.

See also
Shapes on page 194

Reinforcement/Neighbor reinforcement and mesh properties in drawings on page 577
Building objects in drawings on page 195
Adjusting the location of a single reinforcing bar on page 199
**Adjusting the location of a single reinforcing bar**

To adjust a location of a single visible bar in a reinforcing bar group:
1. Right-click the reinforcing bar.
2. Select **Adjust location** from the pop-up menu.
3. Click the location where you want to place the bar.

If you have the whole reinforcing bar group visible, Tekla Structures deletes all bars except one from the group when you select the command.

---

**Showing layer information on reinforcing bars (RebarLayeringMarker)**

You can show reinforcing bar layer information in a drawing.

Before you can show layer information in a drawing, you must run the `RebarClassificator` macro in the model. The `RebarClassificator` classifies the meshes and reinforcing bars in the selected walls or slabs by their position. All reinforcing bars and meshes get an attribute indicating the layer where they are placed inside the concrete element.

To show reinforcing bar layer information:
1. Open the drawing.
2. Click **Tools** ---** Macros**.
3. Select **RebarLayeringMarker** from the list and click **Run**.
   - The **Rebar Layering marker** dialog box is displayed.
4. On the **Marking style** tab, select the marking style you want to use (symbol style or level prefix style).
5. On the **Marking settings** tab, select the marker line type.
6. On the **Marking settings** tab, do one of the following depending on the selected marking style:
   - For symbol style markers, select the symbol you want to use, and the symbol height.
   - For level prefix style markers, select the level prefix.
7. Click **All objects** to show layering markers on all reinforcing bars, or select the individual reinforcing bars and click **Selected objects** to show the markers on the selected bars only.
1. Symbol style layering marker. The number, for example number 1 in T1, indicates the layer number. The letter, for example T in T1, indicates whether the reinforcing bar is on the top, bottom, near side or far side layer.

2. Level prefix style layering marker. The number of triangles indicates the layer number from the face. Triangle orientation indicates whether the reinforcing bar is on the top, bottom, near side or far side layer. For example for top bars, the triangle head points downwards, and for bottom bars upwards.

See also Classifying reinforcement to layers (RebarClassificator)

Building objects in drawings on page 195

4.9 Custom presentations in drawings

You can modify the appearance of many of the objects in drawings using custom presentations. Custom presentations are delivered in Tekla Warehouse as extensions. The presentations can be controlled on the view level and object level.

When you have downloaded a custom presentation for an object type, the Custom presentation tab will become available in the drawing property dialog for that object. The list will only show custom presentations that are available for that specific object type – part, weld, mark, etc.

The following object types support custom presentations:

- welds and weld marks
• parts and part marks
• neighbor parts and part marks
• grid lines
• texts
• associative notes

Examples  In the example below, the Weld solid custom presentation is used for drawing the weld solids.

In the following example, Corners Only custom presentation is used for laser layout projection. Drawing all the lines of a part slows down the laser and makes it too dim to see on the layout table.

See also  Editing drawings on page 114

4.10 Exploding drawing plug-ins

You can explode drawing plug-ins into base objects, and then edit and use them as any other drawing objects. For example, if you want to modify COG dimension in a way that is not available for the plug-in, you can explode the COG dimension and then modify its properties in the Dimension Properties dialog box.

To explode a drawing plug-in:
1. Click a drawing object that is made using a plug-in.
2. Right-click and select **Explode**.

Tekla Structures explodes the plug-in into base objects that are added to the view. Now you can edit and use the exploded objects as any other drawing objects through the properties dialog box.

### 4.11 Welds in drawings

Tekla Structures shows the welds that you have added in a model as weld seams and weld marks in drawings. You can also add manual weld marks separately in an open drawing.

To change model welds in the drawing, you need to modify the weld in the model. When you update the model, the weld objects and weld marks are updated in the drawings. In drawings, you can modify the visibility and appearance of model weld objects and marks.

**See also**  
Weld concepts on page 203  
Examples: Model welds in drawings on page 205  
Adding weld marks on page 215  
Merging weld marks on page 218

#### Weld concepts

*Model welds* are displayed as *weld marks* and *welds* or weld seams in drawings. Welds and weld marks can be controlled separately. For example, you may want to show the welds in one drawing view and the weld marks in another.

You can also add weld marks in an open drawing using the **Add Weld Mark** command.

The *weld symbols* inside the weld marks indicate the weld properties defined for the model weld in the model or for the drawing weld mark in the drawing. Below is an example of a model weld seam (in red) and a model weld mark (in green) in a drawing.
In addition to the weld symbols, the weld mark contains a reference line and an arrow. The arrow connects the reference line to the arrow side of a connection. The welds on the arrow and other sides of a part can have different weld properties.

When parts are welded together, you can place welds on:

- The arrow sides only
- The other sides only
- Both the arrow and other sides

The following images describe the basic placement principles of welds.

1. Above line
2. Below line
3. Arrow side for weld
4. Other side for weld

By default Tekla Structures places the welds above line according to the ISO standard. You can change this to below line to comply with the AISC standard with the advanced option XS_AISC_WELD_MARK.

See also  Welds in drawings on page 203
Model weld mark visibility and appearance properties in drawings on page 557
Drawing weld mark properties on page 555
Examples: Model welds in drawings on page 205

Examples: Model welds in drawings

Example 1  In this example, the first image below shows an example of the Weld Properties dialog box in the model. You can add welds in the model by selecting one of the welding commands from Detailing --> Welds. Some of the weld properties are numbered in the dialog box, and the second image shows how these properties are shown in a weld mark in a drawing. The same numbers as in the dialog box are used in the weld mark to indicate the position and appearance of the property information in the weld.
1. Weld prefix
2. Weld size
3. Weld type
4. Weld angle
5. Weld contour symbol
6. Weld finishing symbol
7. Effective throat
8. Root opening
9. Edge/Around, weld around symbol is used
10. Workshop/Site, site weld symbol is used

**Example 2** The example below shows a staggered, intermittent weld. The length is set to 50 and the pitch to 100.
1. Staggered, intermittent weld
2. Length of weld segment
3. Pitch (center-to-center spacing) of weld segments

Example 3 The example below shows a non-staggered, intermittent weld. The length is set to 50 and the pitch to 100. The pitch is shown in the weld mark, if the pitch value is greater than 0.0.
Example 4  Below is an example of a continuous weld.

Example 5  In this example, the staggered, intermittent weld is selected, and the advanced option XS_AISC_WELD_MARK is set to FALSE to produce an ISO-compliant weld mark.
Example 6  In this example, the staggered, intermittent weld is selected like in the previous example, but the advanced option XS_AISC_WELD_MARK is set to TRUE to produce an AISC-compliant weld mark.

See also  Welds in drawings on page 203
Model weld mark visibility and appearance properties in drawings on page 557
Welding properties on page 586
Modifying model weld mark visibility and appearance in a drawing

You can select the welding properties that you want to show in model weld marks in drawings and adjust the appearance of model weld marks in the Welding Mark Properties dialog box.

To select which model weld properties to show and to modify the weld mark properties on drawing view level:

1. In an open drawing, double-click a view frame to open the View Properties dialog box.
2. Click Weld mark to open the View Welding Mark Properties dialog box.
3. Select whether to show the weld number.
4. Under Visibility:
   - Select the views where you want to show the weld marks.
   - Select what kind of welds to show, or whether to hide all welds.
   - Enter a weld size limit to filter welds of that size out of the drawing.
5. Under Above line, Below line and Other, delete the check mark from the Visibility check box next to a weld mark property that you want to hide.
   - Remember that if you hide Size, also Prefix is hidden, and when you hide Length, also Pitch is hidden.
6. To adjust the placing properties, click Place.
7. Click Modify.
8. Go to the Appearance tab and modify the weld mark text and line appearance.
9. Click Modify.

To open the Welding Mark Properties dialog box on the object level, double click the model weld mark in an open drawing.

Example  The first example shows the original weld mark where a lot of properties are visible.
In the second example, all other welding mark properties are hidden, except **Type** from **Above line** and **Below line**, and **Reference text** from **Other**.

See also  Model weld mark visibility and appearance properties in drawings on page 557
Modifying model weld appearance

You can modify the model weld object appearance on drawing level, drawing view level and drawing object level.

To modify the model weld object appearance on object level:
1. In an open drawing, double-click the model weld seam.
   It is easier to select the model weld, if you have only the Select drawing welds selection switch selected.
2. Modify the color of the weld.
3. Modify the weld line type.
4. Click Modify.

You can modify the properties of model weld objects on view level by double-clicking frame of the drawing view containing the weld objects and selecting Welds.

See also  Welding properties on page 586
Welds in drawings on page 203

Dragging weld marks

You can drag the model welds by the base point of the weld mark leader line along the weld seam. This way you can position the weld marks more optimally for increased clarity in the drawings.

Turn on Smart Select (Tools --> Options --> Smart Select), this makes selecting the leader line base point much easier.

To drag model weld marks:
1. Click the weld mark near the leader line base point.
2. Hold down the left mouse button and drag the base point to a new location by the leader line base point handle located in the tip of the arrow.
Limitations  You cannot drag the leader base point to the back-side of a double-sided weld.

Example  The first image below shows the welds in the model.

The second image shows the model weld marks in a drawing. The area within which the weld mark leader line base point can be dragged is indicated with dark green.
Adding weld marks

A weld mark is an associative annotation object that contains a set of weld properties. You can define automatic weld marks when you create the drawing, and also add additional weld marks in the drawing. Tekla Structures creates manual weld marks using the properties in the Weld Mark Properties dialog box.

To add weld marks:

1. Hold down Shift and click Annotating --> Add Weld Mark to open the Weld Mark Properties dialog box.

2. Enter or modify the content and the appearance of the weld mark.

   To exactly place the weld mark in the position you pick and keep it there, click the Place... button and select fixed in the Placing list.
3. Click **Apply** or **OK** to save the properties.

4. Pick a position for the weld mark.
   You can drag the drawing weld mark freely to a more suitable location by the leader base point handle.

**See also**
- Welds in drawings on page 203
- Drawing weld mark properties on page 555
- Defining placement settings for annotation objects on page 347

**Example: Weld marks added in drawings**

In this example, the first image below is the **Weld Mark Properties** dialog box in a drawing. The weld mark properties are numbered in the dialog box. The second image shows how the weld mark properties are displayed in a weld mark in a drawing. The same numbers are used
in the weld mark as in the dialog box to indicate the weld mark property in the weld. Under the images the meaning of different numbers is explained.
1. Weld prefix
2. Weld size
3. Weld type
4. Weld angle
5. Weld contour symbol
6. Weld finishing symbol
7. Effective throat
8. Root opening
9. Reference text. A weld mark added in a drawing does not have a weld number.
10. Edge/Around, here a weld around symbol
11. Workshop/Site, here a site weld symbol

See also Drawing weld mark properties on page 555
Adding weld marks on page 215

Merging weld marks

You can force Tekla Structures to use the same mark and symbol for identical welds in a drawing.

To merge weld marks:
1. Open a drawing.
2. Hold down Ctrl and select the weld marks to merge.
3. Right-click and select **Merge** from the pop-up menu.
   Tekla Structures combines the marks.

4. If needed, you can split merged weld marks by right-clicking the mark and selecting **Split**
   from the pop-up menu.

<table>
<thead>
<tr>
<th>Description</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Original drawing</td>
<td><img src="image1" alt="Original drawing" /></td>
</tr>
<tr>
<td>Merged weld marks.</td>
<td><img src="image2" alt="Merged weld marks" /></td>
</tr>
</tbody>
</table>

**See also**
- Merging marks automatically on page 471
- Associative annotation objects on page 175
4.12 Edge chamfers in drawings

You can show edge chamfers in drawings, and control the way they are shown by modifying the part properties and the edge chamfer properties. You can also add chamfer marks as associative notes.

See also

Building objects in drawings on page 195
Displaying edge chamfers in a drawing on page 220
Defining default line color and type for edge chamfers on page 221
Changing edge chamfer line color and type manually on page 222
Creating edge chamfer marks on page 222
Example: Edge chamfers on page 223

Displaying edge chamfers in a drawing

You can select whether you show edge chamfers in your drawing and the way they are shown.

To select whether the edge chamfers are shown and how:

1. Open a drawing containing edge chamfers.
2. Depending on the level where you want to make the changes, do one of the following:
   - Double-click the drawing and click Part...
   - Double-click a view frame and click Part...
   - Double-click the part containing edge chamfers
3. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.
4. Select the check boxes next to only the properties that you want to modify.
5. In the part properties dialog box, select Edge chamfers on in Additional marks.
6. Select Outline or Exact in Part representation list depending on the desired result.
7. Click Modify.

8. If needed, double-click an edge chamfer and modify the line color and type in the drawing.

If you know that you are going to use the same part representation settings for several drawings, save your settings in a properties file for later use.

See also
- Part and neighbor part properties in drawings on page 568
- Edge chamfers in drawings on page 220

**Defining default line color and type for edge chamfers**

You can define a default color and line type for edge chamfers.

1. Click **Tools --> Options --> Options...** and select **Drawing objects**.
2. Define the default line color.
3. Define the default line type.
4. Click **OK** to save and close the dialog box.

You can override the default settings manually in a drawing by changing the edge chamfer line color and type in the **Edge Chamfer Properties** dialog box.
Changing edge chamfer line color and type manually

You can manually modify the line type and color of the edge chamfers in drawings. This overrides the default color and type defined in the Options dialog box.

1. In the drawing, double-click an edge chamfer to display the Edge Chamfer Properties dialog box.
2. Select the desired color and line type.

Background color is often used for edge chamfer lines for the reason that you may not want to print edge chamfers, or see them in small scale drawings, but you want to be able select them, for example, to add chamfer marks.

Example

The following examples show how the edge chamfers are displayed with different part representation settings:

Part representation Exact.

Part representation Outline, edge chamfer not selected.

Part representation Outline, edge chamfer selected.

Creating edge chamfer marks

You can add associative notes to edge chamfers and use them as part marks.

To add a chamfer mark:

1. Modify the part properties and edge chamfer properties so that edge chamfers are visible and you can easily select them.
2. Hold down Shift and click Annotating --> Add Associative Note and select the type of note you want to create.
3. In the **Associative Note Properties** dialog box, modify the note properties as required.

4. Select **Edge chamfer** from the **Content** list.

5. Add the elements that you want to have in the edge chamfer mark.

6. Click the edge chamfer.

   If you use a leader line, you need to pick a position for the note.

   ![Example edge chamfer](image)

**See also**

- Edge chamfers in drawings on page 220
- Adding associative notes on page 177

**Example: Edge chamfers**

See below for typical examples of the ways showing edge chamfers.

In this example, **Part representation** is **Exact** and **Edge chamfers** are **on**. Background color is used in edge chamfer lines, because you usually do not want to show edge chamfers in printouts, but may want to see and select them in the drawing, for example, to add associative notes.
In this second example, **Part representation** is **Outline** and **Edge chamfers are on**. Background color is used in edge chamfer lines, because you may want to see and select chamfers in the drawing, for example, to add associative notes. This representation is often used when the scale is small and you do not need to see the small chamfers clearly. The edge chamfer presented in the bottom right corner of the image shows what the edge chamfer looks like when it is selected.
4.13 **Pours in drawings**

Tekla Structures shows cast-in-place structures as continuous in general arrangement drawings exactly like they have been modeled: overlappings and extra outlines vanish if the parts collide, have the same concrete material grade, have **Cast in place** as the **Cast unit type**, and have the same pour phase.

You can add associative notes to both pour breaks and pour objects.

Automatic dimensions cannot be created for the pours and pour breaks. You can add manual dimensions, but they are not associative. If the part geometry changes, the dimensions have to be updated manually.

Below are some examples of continuous cast-in-place structures.

---

**See also**
- Edge chamfers in drawings on page 220
- Displaying edge chamfers in a drawing on page 220
Below is an example where reinforcing bars have been added into a strip footing.
Pour breaks are shown in general arrangement drawings as they have been modeled. The pour breaks are represented by a symbol, see the image below. You can change the symbol using the advanced option. The symbol scale and the spacing between the symbols follows the drawing view scale automatically.

See also

Showing pours and pour breaks in drawings on page 228
Modifying pour breaks in drawings on page 229
Changing the pour break symbol on page 229
Adding associative notes on page 177
Showing pours and pour breaks in drawings

Pours and pour breaks are shown in the drawing if the pour management is enabled, and if the pour breaks are set visible.

To enable pour management and show pours correctly:
1. Go to Tools --> Options --> Advanced Options --> Concrete Detailing.
2. Check that the advanced option XS_ENABLE_POUR_MANAGEMENT is set to TRUE.
3. Click OK.
4. Open a general arrangement drawing containing pour breaks.
5. Double-click the drawing background to display the drawing properties dialog box.
6. Click Pour breaks and set the Visibility to Visible.
7. Click OK.
8. Click Neighbor reinforcement and set the Visibility of all reinforcing bars to Visible.
9. Click Modify.

The new settings are activated in the drawing, and the pours and pour breaks are shown accordingly.

See also  Pours in drawings on page 225

Modifying pour breaks in drawings

You can modify the appearance of pour breaks in drawings.

To modify pour breaks in an open drawing:
1. Double-click the pour break.
2. Go to the Appearance tab and adjust the color and type of the visible lines and hidden lines.
3. Click Modify.

See also  Pours in drawings on page 225

Changing the pour break symbol

To change the pour break symbol:
1. Go to Tools --> Options --> Advanced Options --> Drawing Properties.
2. Set a new value for the advanced option XS_POUR_BREAK_SYMBOL.
The default value is PourBreaks@0. The value refers to the PourBreaks.sym file where the symbol is defined. The symbol value starts with the symbol library file name and ends with the number of the symbol. The default symbol file is located in ..\ProgramData\Tekla Structures\<version>\environments\common\symbols.

You can also create a new symbol file containing a new symbol, and save it. Then define the new .sym file for XS_POUR_BREAK_SYMBOL. If you wish to use a symbol file that is not located under your environment folders, enter the complete path to the symbol file location, the symbol file name and symbol number for the advanced option.

3. Click Apply and OK.

Example

```
\[//\] \[//\] \[//\] \[//\]
```

See also  Pours in drawings on page 225

### 4.14 Reference models in drawings

Reference models can be shown in general arrangement, assembly and cast unit drawings. For example, you may want to use 3D plant models or architectural drawings as reference models.

See also  Reference models

Setting automatic reference model properties in drawings on page 230

Modifying properties of hidden lines in reference models using advanced options on page 231

**Setting automatic reference model properties in drawings**

To show or hide reference models in cast unit, assembly or general arrangement drawings, and change their visibility setting before creating a drawing:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Cast unit and assembly drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. Click **Reference objects**.

   The **Content** tab lists all the reference models included in the model.

5. In the **Visibility** column, select **Visible** from the list to show the selected reference models in the drawing.

6. Go to the **Appearance** tab and select the line color and type for all visible reference models.

7. Cast unit and assembly drawings: Click **Save** to save the view properties.

8. Click **OK**.

9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

   You can control the visibility and line type of hidden lines in reference models in drawings using advanced options **XS_SHOW_REFERENCE_MODEL_HIDDEN_LINES**, **XS_REFERENCE_MODEL_LINES_HIDDEN_BY_ITSELF**, **XS_REFERENCE_MODEL_LINES_HIDDEN_BY_OTHER_REFERENCE_MODELS**, **XS_REFERENCE_MODEL_LINES_HIDDEN_BY_PARTS**, **XS_REFERENCE_MODELS_HIDE_PART_LINES**, and **XS_REFERENCE_MODEL_HIDDEN_LINE_TYPE**.

---

**See also**

- Modifying properties of hidden lines in reference models using advanced options on page 231
- Reference models in drawings on page 230

---

**Modifying properties of hidden lines in reference models using advanced options**

You can control the visibility and line type of hidden lines of reference models in drawings using advanced options.

To set the visibility and line type of hidden lines:

1. Click **Tools --> Options --> Advanced Options**

2. Go to the **Drawing Properties** page.

Showing the hidden lines might slow down the system when you have large or several reference models in the drawing, especially if the advanced options `XS_REFERENCE_MODELS_HIDE_PART_LINES` or `XS_REFERENCE_MODEL_LINES_HIDDEN_BY_OTHER_REFERENCE_MODELS` have been set to `TRUE`.

If you set `XS_SHOW_REFERENCE_MODEL_HIDDEN_LINES` to `TRUE`, the other advanced options have no effect.

4. On the same page, set the line type used to display the hidden lines using the advanced option `XS_REFERENCE_MODEL_HIDDEN_LINE_TYPE`.

If you do not want to show hidden lines, set this advanced option to `0`.

**Example** In the example below, the lines are not hidden.

In the example below the following settings have been used:

- `XS_REFERENCE_MODEL_LINES_HIDDEN_BY_PARTS=TRUE`: Some of the foreground parts are hiding the reference model lines.
- `XS_REFERENCE_MODEL_LINES_HIDDEN_BY_ITSELF=TRUE`: The reference model is internally hiding its own lines.
- `XS_REFERENCE_MODELS_HIDE_PART_LINES=TRUE`: The reference model is hiding some of the part lines behind it.
- `XS_SHOW_REFERENCE_MODEL_HIDDEN_LINES=FALSE`: Allows the hidden lines to be hidden according to the above advanced options. If it is set to `TRUE`, the above advanced options have no effect.
• **XS_REFERENCE_MODEL_HIDDEN_LINE_TYPE** is set to 0: No hidden lines are shown.

See also  
XS_SHOW_REFERENCE_MODEL_HIDDEN_LINES  
XS_REFERENCE_MODEL_HIDDEN_LINE_TYPE  
XS_REFERENCE_MODEL_LINES_HIDDEN_BY_ITSELF  
XS_REFERENCE_MODEL_LINES_HIDDEN_BY_OTHER_REFERENCE_MODELS  
XS_REFERENCE_MODEL_LINES_HIDDEN_BY_PARTS  
XS_REFERENCE_MODELS_HIDE_PART_LINES  
Reference models in drawings on page 230

### 4.15 Grids in drawings

You can show grids and grid line labels in single-part, cast unit, assembly, and general arrangement drawings.

You can manually modify the grid properties in an open drawing.
Adding or removing grid lines in the model may cause unwanted changes in general arrangement drawings in some cases. You should avoid modifying grids after the general arrangement drawings are created.

See also  
- Modifying grid and grid line properties on page 234
- Hiding grids or grid lines on page 235
- Dragging grid labels on page 234
- Drawing grid properties on page 589

Modifying grid and grid line properties

You can modify grid properties on the drawing and view levels, and properties of individual grids or grid lines in an open drawing.

To modify grid properties in an open drawing:
1. Ensure that you have the correct selection switch selected.

   To modify grids, use the selection switch and to modify grid lines, use.

2. Double-click the grid or the grid line. Tekla Structures opens the Grid Properties or Grid Line Properties dialog box.

3. Visible shows the grid lines in the drawing. If you want to see the labels only, select Only grid labels visible.

4. Modify the label text placing, grid line and text settings as required.

5. Click Modify.

   To modify grid properties on drawing level, double-click the drawing background and select Grids.... To modify grid properties on view level, double-click the view frame and select Grids....

See also  
- Grids in drawings on page 233
- Drawing grid properties on page 589
Dragging grid labels

You can move single grid labels. This is useful, for example, if the label is covering an important area in a drawing.

Ensure, that you have switched **Smart Select** on in **Tools --> Options** to drag and drop by handles without selecting them first.

To move a grid label:

1. Ensure that you have the grid line selection switch selected.
2. Click a grid.
3. Hold down the left mouse button and drag the label by the handle to a new location.

**See also** Grids in drawings on page 233

Hiding grids or grid lines

You can hide grids and grid lines.

To hide a grid or a grid line:

1. Ensure that you have the correct selection switch selected.

   To hide grids, use the selection switch and to hide grid lines, use .
2. Click a grid or a grid line.
3. Right-click the grid or the grid line and select **Hide/Show --> Hide from drawing view** from the pop-up menu.

If you want to show the grids or grid lines, press B until the color mode is **Color**, right-click the grid or the grid line, and select **Hide/Show --> Show in drawing view**. You can see and select the hidden grids and grid lines only in **Color** mode.

**See also** Grids in drawings on page 233

4.16 Symbols in drawings

You can use symbols in drawings in various places, for example, as separate objects, in marks, object representation, arrows etc. We recommended you get familiar with the Symbol Editor, so that you can create new symbols and modify the existing ones.

With the **Symbol Files** browser you can easily change the symbol file in use and access Symbol Editor.
Tekla Structures searches the symbol files from folders listed in DXK_SYMBOLPATH (defined in the environment initialization file <your_environment>.ini and in the Tekla Structures initialization file teklastructures.ini). Alternatively, you can add your own DXK_SYMBOLPATH in options.ini under the model folder and define your own symbol folder paths there. Note, that also the path settings in the <your_environment>.ini file need to be added there. The last read .ini file settings are used. At startup of Tekla Structures, the reading order of the .ini files containing DXK_SYMBOLPATH is:

- teklastructures.ini
- <your_environment>.ini
- options.ini

All symbol files that are found are available to be used in Tekla Structures. If there are symbol files with the same name, the one that is read last is used.

In addition to the symbols mentioned above, there are moment connection symbols that you can manage with drawing tools.

**See also**
- Creating and modifying symbol files on page 236
- Adding symbols in drawings on page 238
- Modifying symbol properties on page 238
- Managing moment connection symbols on page 239
- Adding surface treatment symbols in drawings (AddSurfaceSymbols) on page 241
- Adding symbols in marks on page 486
- DXK_SYMBOLPATH
- Defining a firm folder for images and symbols on page 520
- Creating and using customized leader line arrows on page 184

**Creating and modifying symbol files**

The Symbol Files browser allows you to change the symbol file in use. It also provides access to Symbol Editor, where you can create new symbol files, and create and modify symbols.

We strongly recommend that you do not modify the original symbol files delivered with your Tekla Structures application. If you need to modify any symbols, copy the original symbol file and work on the copy, keeping the original symbol file intact.

**See also**
- Viewing and modifying symbol file contents on page 237
- Creating a new symbol file on page 237
Changing the symbol file in use on page 238

Adding symbols in marks on page 486

**Viewing and modifying symbol file contents**

You can view and modify the contents of a symbol file.

To view or modify the contents of a symbol file:

1. Open the Mark content – symbol dialog box by selecting Symbol from the available mark elements list in the mark properties dialog box, or open the Symbol properties dialog box by selecting Annotating --> Properties --> Symbol .
2. Click Select... next to the File box.
3. Select a file from the Symbol Files list and click Edit.
   This opens the selected symbol file in Symbol Editor.
4. If you modify the file in the Symbol Editor, save the file: Click File --> Save or File --> Save As and give a new name.
5. Click OK.

---

In Symbol Editor, you can copy symbols between symbol files (*.sym). Press Ctrl + C and select the symbol you would like to copy, then open the symbol file you want to copy to (or a new symbol file), select the location for the symbol and press Ctrl + V.

---

See also Creating and modifying symbol files on page 236

---

**Creating a new symbol file**

You can create new symbol files to be used in drawings.

To create a new symbol file:

1. Open the Mark content – symbol dialog box by selecting Symbol from the available mark elements list in the mark properties dialog box or the Symbol properties dialog box by selecting Annotating --> Properties --> Symbol .
2. Click Select... next to the File box.
3. In the Symbol Files dialog box, click Create new....
4. Create the symbol in the Symbol Editor.
5. Click File --> Save and save the symbol file in the folder that you use for keeping the symbols.
6. Click Refresh in the Symbol Files browser.

See also Creating and modifying symbol files on page 236
Changing the symbol file in use

You can change the currently used symbol file.

To change the symbol file in use:

1. Open the Mark content – symbol dialog box by selecting Symbol from the available mark elements list in the mark properties dialog box, or the Symbol properties dialog box by selecting Annotating --> Properties --> Symbol.
2. Click Select... next to the File box.
3. Select a new file from the Symbol Files list and click OK or double-click the file.

See also  Symbols in drawings on page 235
Creating and modifying symbol files on page 236

Adding symbols in drawings

Symbols added as separate objects are independent annotation objects. They can be represented in three different ways: without leader lines, with leader lines and along lines. Tekla Structures adds symbols using the properties defined in the Symbol Properties dialog box.

To add a symbol in a drawing:

1. In the drawing, hold down Shift and select Annotating --> Add Symbol and one of the three symbol commands:
   - Symbol: Add a symbol in the current drawing without a leader line.
   - Symbol along Line: Create a symbol along the line you define by picking two points. Then pick an insertion point for the symbol.
   - Symbol with Leader Line: Add a symbol with a leader line pointing to the point you pick first.
2. Modify other symbol properties.
3. Click OK.
4. Pick one to three points in the drawing to place the symbol. The symbol command you selected affects the number of points to pick.

See also  Symbols in drawings on page 235
Modifying symbol properties

You can modify the properties of symbols in an open drawing.

To modify the symbol properties:

1. Double-click a symbol.

2. Switch all the check boxes off in the dialog box by clicking the on/off switch at the bottom of the dialog box.

3. Select only the check boxes next to the properties that you want to modify.

4. If necessary, change the symbol file in use and select the symbol to use.

5. To modify symbol placement settings, click Place.
   Here you can set the placing to free or fixed, specify the search margin, minimal distance and select the desired quarter to place the symbol.

6. Go to the Appearance tab and set the symbol color, height and angle, and the frame type, leader line and color.

7. Click Modify.

See also  
Symbols in drawings on page 235
Placement properties for annotation objects on page 586
Leader line types on page 553

Managing moment connection symbols

Moment connections show the beams that are connected to columns with rigid connections. With drawing tools you can manage moment connection symbols: create, update and delete them.

See also  
Creating moment connection symbols (Drawing tools) on page 239
Updating moment connection symbols (Drawing tools) on page 241
Deleting moment connection symbols (Drawing tools) on page 241
User-defined attributes

Creating moment connection symbols (Drawing tools)

In general arrangement drawings, you can create moment connection symbols to show the beams that are connected to columns with rigid connections. The symbols are created according to part end releases. You can create moment connection symbols automatically for all parts in a drawing view, or for selected parts.

To create moment connection symbols in a general arrangement drawing:

1. Open the drawing.
2. Click **Tools --> Macros**...

3. In the **Macros** dialog box, select **Drawing tools** and click **Run**.

4. Click **Create moment connection symbols** in the **Drawing tools** toolbar.

5. In the **Create moment connection symbols** dialog box, select the color for the symbols from the color list.

6. In the **Create moment connection symbols** dialog box, enter a scale for the symbols in the box next to the color list.

7. Do one of the following:
   a. To create moment connection symbols for all parts in a drawing view, select the view.
   b. To create moment connection symbols for selected parts, select the parts.

8. Click **Create**.

The moment connection symbols are created according to analysis part and connection release properties:

- If a connection exists, start and end release information is read from the **Start releases** and **End releases** tabs in the analysis part properties dialog box.

- If a connection does not exist, release information is read from the **End conditions** tab in the user-defined attributes dialog box of the part.

**Limitations**

- Moment connection symbols are created to reference lines. This means that offsets are not taken into use.

**Example**

![Moment connection symbols example](image)
Updating moment connection symbols (Drawing tools)

To update moment connection symbols:
1. Click Tools --> Macros...
2. In the Macros dialog box, select Drawing tools and click Run.
3. Click Create moment connection symbols in the Drawing tools toolbar.
4. Do one of the following:
   a. To update the moment connection symbols of all parts in the view, select the view.
   b. To update the moment connection symbols of selected parts, select the parts.
5. Click Create.

When you do this, Tekla Structures removes all previously created symbols, and creates new ones that are up-to-date.

Deleting moment connection symbols (Drawing tools)

To delete moment connection symbols:
1. Click Tools --> Macros...
2. In the Macros dialog box, select Drawing tools and click Run.
3. Click Create moment connection symbols in the Drawing tools toolbar.
4. Do one of the following:
   a. To delete the moment connection symbols of all parts in the view, select the view.
   b. To delete the moment connection symbols of selected parts, select the parts.
5. Click Delete.

See also Managing moment connection symbols on page 239
Adding surface treatment symbols in drawings (AddSurfaceSymbols)

You can add surface treatment symbols in drawings using the AddSurfaceSymbols macro.

Before you start, ensure that you have an object that has surface treatment in the model, and that you have created a drawing of that object.

To add surface treatment symbols in a part in a drawing:

1. Open a drawing that has a part containing surface treatment.
2. Click **Tools** → **Macros** to open the **Macros** dialog box.
3. Select **AddSurfaceSymbols** and click **Run**.
   
The **Create surface symbols** dialog box is displayed.
4. Select the texts that you want to include in the surface treatment symbol from the **Available Elements** list and add the texts to the **Elements in mark** by clicking **Add**.
5. Select **All views** to include the symbols in all drawing views, or **Selected views** to include the symbols only in the views you select.
6. Change the font settings, if necessary.
7. If you selected **Selected views**, select the views where you wish to have surface treatment symbols.
8. Click **Create**.

Tekla Structures creates the surface treatment symbols according to the defined settings. You can change the symbol properties and the text afterwards in the **Text properties** dialog box, which is opened when you double-click the symbol.
4.17 Changing drawing objects

You can move, copy, reshape, resize, trim, split and divide drawing objects added in the drawing. For objects that have leader lines, you can modify the shape of the leader line. You can also use drawing tools and align objects, create chamfers, and create fillets. What you can do to an object depends on the object type.

See also  Editing drawings on page 114
Dragging, reshaping and resizing drawing objects on page 243
Copying with offsets on page 245
Arranging drawing objects on page 246
Hiding and showing objects in drawings and drawing views on page 247
Trimming on page 251
Splitting on page 253
Dividing on page 253
Modifying the shape of leader lines on page 254
Aligning drawing objects on page 255
Creating fillets (Drawing tools) on page 255
Creating chamfers (Drawing tools) on page 256
Managing cut lines (Drawing tools) on page 259
Copying and moving objects

Draggin, reshaping and resizing drawing objects

Many drawing objects, dimension lines and leader lines of many drawing objects have handles. You use these handles to reshape, and resize objects. You can also drag the objects.

Before you start, click a drawing object or and object frame to activate it and show the handles. Switch Smart Select on in Tools --> Options to drag by the object handles without selecting the handle first.

Do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Drag the object | • Point the handle, object or object frame, hold down the left mouse button and drag the object to a new location.  
  The object follows the cursor while you drag the object, and you can all the time see what the end result will be.  
  With circles, you can also use the middle handle for dragging. |
<p>| Resize the object | 1. Click one of the objects or object frame handles.                  |</p>
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reshape the object</td>
<td>1. Click the middle handle of a line or a handle on the cloud, polyline or polygon.</td>
</tr>
<tr>
<td></td>
<td>2. Drag the handle to resize the object or object frame.</td>
</tr>
<tr>
<td></td>
<td>To enlarge the rectangle in all directions, drag from a corner handle.</td>
</tr>
</tbody>
</table>

[Diagram of reshape object]
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>2. Drag the handle to reshape the object.</td>
<td></td>
</tr>
</tbody>
</table>

If you drag an annotation object, its placing setting may be set to **fixed** depending on what it's set for the advanced options:

- `XS_CHANGE_DRAGGED_DIMENSIONS_TO_FIXED`
- `XS_CHANGE_DRAGGED_MARKS_TO_FIXED`
- `XS_CHANGE_DRAGGED_NOTES_TO_FIXED`
- `XS_CHANGE_DRAGGED_TEXTS_TO_FIXED`

This means that the annotation object stays where it is even though you update the drawing.

---

**See also**

- Changing drawing objects on page 242
- Object protection and placement settings in drawings on page 343
- `XS_CHANGE_DRAGGED_DIMENSIONS_TO_FIXED`
- `XS_CHANGE_DRAGGED_MARKS_TO_FIXED`
- `XS_CHANGE_DRAGGED_NOTES_TO_FIXED`
- `XS_CHANGE_DRAGGED_TEXTS_TO_FIXED`

**Copying with offsets**

You can copy lines and circles with offsets. You can copy lines to a new location in the direction you point using the offset that you specify. You can also create new circles.
centered in the same location as the original circle and adjust the radius by the offset that you specify.

To copy with offset:
1. Click **Tools --> Macros**...
2. In the **Macros** dialog box, select **Drawing tools** and click **Run**.
3. Select the object that you want to copy.
4. Click **Copy with Offset** in the **Drawing tools** toolbar.
5. Enter the offset in the dialog box that is displayed.
6. Click the view in the direction where you want to copy the object. If you are copying a line, Tekla Structures makes a new copy of the line in the specified location. If you are copying a circle, Tekla Structures creates a new circle that is centered in the same location as the original circle, and adjusts the radius by the offset that you specified.

**Example**  
Example of a copied line:

![Example of a copied line](image1)

Example of a copied circle:

![Example of a copied circle](image2)
Arranging drawing objects

You can use the Arrange Drawing Objects (Freeplace) command to position drawing objects. Tekla Structures positions the objects using the protection properties set for the drawing and the placing properties of each object type.

To arrange drawing objects:
1. Double-click the open drawing, click Protection..., check the drawing protection properties and modify them as required.
2. Click Modify.
3. Double-click drawing objects, and then click Place... to check and modify the placing settings.
   If the object is set to Fixed, the Arrange Drawing Objects command has no effect.
4. Click Modify.
5. In the drawing, select the drawing objects you want to arrange.
6. Do one of the following:
   - Click View --> Arrange Drawing Objects (Freeplace) --> Near Current Locations.
     Tekla Structures positions the selected drawing objects so that they do not overlap other objects. Objects located in a free location are not moved, and overlapping objects are moved as close to the current location as possible.
   - Click View --> Arrange Drawing Objects (Freeplace) --> Ignore Current Locations.
     Tekla Structures positions the selected drawing objects so that they do not overlap with other objects without checking the current location of the objects.

Hiding and showing objects in drawings and drawing views

You can hide selected drawing objects in drawings and drawing views. When you hide a part, Tekla Structures will hide all its related objects. Note that if an object is hidden in drawing views it will not be printed.

To hide drawing objects:
1. Check that the ghost outline selection is the one that you need in Tools --> Options --> Ghost Outline. In colored drawings, hidden objects are shown as ghost outlines, if this setting is selected. In grayscale and black and white drawings, hidden objects are not shown even if Ghost Outline is selected.
2. Select the desired color mode by pressing B.
3. Select the objects you want to hide.

See also Changing drawing objects on page 242
Object protection and placement settings in drawings on page 343
4. Click View --> Hide/Show Object and one of the following options:
   - **Hide from Drawing View.** Tekla Structures hides the selected object in the view you select it.
   - **Hide from Drawing.** Tekla Structures hides the selected object in all views.

**Example** Below are some examples of the results with different combinations of selections.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color mode is set to <strong>Color.</strong> No objects are hidden. Part marks are shown.</td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Setting</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------------------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Color mode is set to <strong>Color. Ghost Outline</strong> is not selected. Parts</td>
<td><img src="image1" alt="Example" /> are hidden and related part marks</td>
</tr>
<tr>
<td>are not shown.</td>
<td></td>
</tr>
<tr>
<td></td>
<td><img src="image2" alt="Example" /></td>
</tr>
</tbody>
</table>

Color mode is set to **Color. Ghost Outline** is selected. Hidden parts are shown as ghost outlines and related part marks are not shown.

![Example](image3)
<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color mode is set to <strong>Black and White. Ghost Outline</strong> is selected, but it has no effect on black and white drawings. Parts are hidden and related part marks are not shown.</td>
<td>![Example Image]</td>
</tr>
</tbody>
</table>

See also [Changing drawing objects on page 242](#)

**Listing hidden parts in drawings**

You can select whether to list the hidden parts in drawings, for example, in the material list.

1. Open a drawing containing hidden parts.
2. Double-click the drawing to open the drawing properties dialog box.
3. Click **Layout**....
4. On the **Drawing size** tab, select whether you want to list the hidden parts in **List hidden objects in templates**. **No** removes all information about the hidden parts, also from the total weight.
5. Click **Modify**.
In the example below, the hidden reinforcing bars are listed.

<table>
<thead>
<tr>
<th>CAST UNIT BILL OF MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Unit</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>CF/3</td>
</tr>
</tbody>
</table>

FOOTING

<table>
<thead>
<tr>
<th>Reinforcement Type</th>
<th>Grade</th>
<th>Diameter (mm)</th>
<th>Length (m)</th>
<th>Volume (m³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>12</td>
<td>3100</td>
<td>600</td>
<td>2500</td>
</tr>
</tbody>
</table>

Reinforcement total weight (kg): 34.0

CAST UNIT TOTAL WEIGHT (kg): 6033.4

In the example below, the hidden reinforcing bars are not listed.

<table>
<thead>
<tr>
<th>CAST UNIT BILL OF MATERIAL</th>
</tr>
</thead>
<tbody>
<tr>
<td>Cost Unit</td>
</tr>
<tr>
<td>------------</td>
</tr>
<tr>
<td>CF/3</td>
</tr>
</tbody>
</table>

FOOTING

<table>
<thead>
<tr>
<th>Reinforcement Type</th>
<th>Grade</th>
<th>Diameter (mm)</th>
<th>Length (m)</th>
<th>Volume (m³)</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>12</td>
<td>3100</td>
<td>600</td>
<td>2500</td>
</tr>
</tbody>
</table>

Reinforcement total weight (kg): 34.0

CAST UNIT TOTAL WEIGHT (kg): 6033.4

Limitations
Listing hidden objects does not work in all templates. It works in templates containing PART rows, but not in hierarchical templates. For example, if the template is of type ASSEMBLY - PART, and the Assembly is included in the drawing, all of its parts will also be included.

See also Hiding and showing objects in drawings and drawing views on page 247

Trimming

You can shorten or extend a line relative to the boundary you select in an open drawing. The boundary can be a line, part, arc, or rectangle, for example.

To trim a line:
1. Click **Edit --> Trim**.
2. Select the object to be used as a boundary.
3. Click the middle mouse button.
4. Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Extend the line</td>
<td>Click the end of the line to extend it to the boundary line.</td>
</tr>
</tbody>
</table>

Original lines:
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Shorten the line from the left or right end</strong></td>
<td>Click the line at the end from which you want to shorten it.</td>
</tr>
<tr>
<td>Original line:</td>
<td>Line clicked at the left end:</td>
</tr>
<tr>
<td></td>
<td>Line clicked at the right end:</td>
</tr>
</tbody>
</table>
### Splitting

You can cut an object into two pieces at a point you select in an open drawing. You can split lines, polylines, circles, and arcs.

To split a line:

1. Select the line.

2. Click **Edit --> Split**.

3. Pick a point on the line to indicate the location for splitting.

4. Tekla Structures splits the line into two.

---

**See also** [Shapes on page 194](#)

[Changing drawing objects on page 242](#)
Dividing

You can divide an object into a number of segments that you specify in an open drawing. You can divide lines and arcs.

To divide a single line into four lines of equal length:
1. Select the line.

2. Click Edit --> Divide.
3. In the displayed Segments dialog box, enter the number of segments, for example 4, and click OK.

Tekla Structures divides the line into four lines.

See also  Shapes on page 194
Changing drawing objects on page 242

Modifying the shape of leader lines

You can modify the shape of the leader line for any independent and associative annotation objects that have leader lines.

To modify the leader line shape:
1. Select the leader line you want to modify
2. Drag from the middle point of the line.
3. Drag further from the created handle points and new middle points.

See also  Additional ways for modifying part mark leader lines on page 466
Dragging the mark and associative note leader line base point on page 184
Aligning drawing objects
You can align objects to the bottom, to the vertical center, to the left, to the horizontal center, to the right, and to the top. You can also position objects horizontally or vertically at equal distances from each other.

1. Open the Alignment toolbar from Tools --> Toolbars
2. Select the objects that you want to align.
3. Select the aligning command from the toolbar.
4. If you selected one of the two commands that position objects at equal distance, type the distance in the displayed dialog box.

To create a row of objects, align them first to the top and then position them horizontally at equal distances from each other. You do not need to reselect the objects between the two commands.

Example  Below is an example where marks have been aligned to left.

Edited drawings 255  Changing drawing objects
Creating fillets (Drawing tools)

With the Create Fillet command you can connect two intersecting lines by extending the two selected lines to their intersection point. If no intersection point is found or if it is outside the drawing, nothing will be done.

To create a fillet:
1. Click Tools --> Macros...
2. In the Macros dialog box, select Drawing tools and click Run.
3. Select two intersecting lines.
4. Click the Create Fillet in the Drawing tools toolbar.
Creating chamfers (Drawing tools)

You can create chamfers between two lines using the distance that you specify. You can create both straight and round chamfers.

To create a chamfer:

1. Click **Tools** --> **Macros**...
2. In the Macros dialog box, select **Drawing tools** and click **Run**.
3. Select two intersecting lines.
4. Do one of the following:

   a. To create a straight chamfer, click **Create Straight Chamfer** in the **Drawing tools** toolbar.
      Enter the distance that you want to have between the two lines (the length of the chamfer line) in the displayed dialog box.

   b. To create a round chamfer, click **Create Round Chamfer** in the **Drawing tools** toolbar.
      Enter the desired radius in the displayed dialog box.

**Example**  
Example of a straight chamfer:
Example of a round chamfer:
Managing cut lines (Drawing tools)
Cut lines are lines that are displayed using a zigzag or a dash-and-dot to show that the line is partially outside the view border. With drawing tools you can manage cut lines: create, update and delete them.

See also
- Creating cut lines on page 259
- Updating cut lines on page 260
- Deleting cut lines on page 261
**Creating cut lines**
You can create cut lines to show the lines that are partially outside the view border. You can create cut lines automatically for all parts in the view, or for selected parts.

To create cut lines:
1. Click **Tools** --&gt; **Macros**...
2. In the **Macros** dialog box, select **Drawing tools** and click **Run**.
3. Click **Create cut lines** in the **Drawing tools** toolbar.
4. In the **Create cut lines** dialog box, select the type (zigzag or dash-and-dot) for the line from the list of types.
5. In the **Create cut lines** dialog box, select the color for the line from the color list.
6. In the **Create cut lines** dialog box, enter a scale for the line in the box next to the list of types.
7. Do one of the following:
   a. To create cut lines for all parts in the view, select the view.
   b. To create cut lines for selected parts, select the parts.
8. Click **Create**.

**Limitations**
- Cut lines cannot be created for polybeams.
- **View extension for neighbor parts** setting is not taken into account.

**Example**

![Example Image]

**Updating cut lines**
To update cut lines:
1. Click **Tools** --&gt; **Macros**...
2. In the **Macros** dialog box, select **Drawing tools** and click **Run**.
3. Click **Create cut lines** in the **Drawing tools** toolbar.
4. Do one of the following:
   a. To update the cut lines of all parts in the view, select the view.
b. To update the cut lines of selected parts, select the parts.

5. Click **Create**.

When you do this, Tekla Structures removes all previously created cut lines, and creates new ones that are up-to-date.

**Deleting cut lines**

To delete cut lines:

1. Click **Tools --> Macros...**

2. In the Macros dialog box, select **Drawing tools** and click **Run**.

3. Click **Create cut lines** in the Drawing tools toolbar.

4. Do one of the following:
   a. To delete the cut lines of all parts in the view, select the view.
   b. To delete the cut lines of selected parts, select the parts.

5. Click **Delete**.

### 4.18 Colors in drawings

You have three basic color modes for line colors in drawings. The color modes are **Black and White**, **Gray Scale**, and **Color**. By default, drawings are black and white.

In addition to the three basic color modes, you can have a black background and colored lines in drawings (advanced option `XS_BLACK_DRAWING_BACKGROUND`).

**Colors and gray shades**

The table below shows the colors available in Tekla Structures, and how the different colors are shown in black and white drawings and in grayscale drawings. The corresponding pen numbers referring to the line weights used in the printed drawings are also listed.

<table>
<thead>
<tr>
<th>Name</th>
<th>Pen</th>
<th>Tekla Structures color</th>
<th>Black and white</th>
<th>Gray scale</th>
<th>Lightness</th>
</tr>
</thead>
<tbody>
<tr>
<td>Invisible</td>
<td>9</td>
<td></td>
<td></td>
<td></td>
<td>Invisible</td>
</tr>
<tr>
<td>Black</td>
<td>7</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Red</td>
<td>1</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Green</td>
<td>3</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Blue</td>
<td>5</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Cyan</td>
<td>4</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Yellow</td>
<td>2</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
<tr>
<td>Magenta</td>
<td>6</td>
<td></td>
<td></td>
<td></td>
<td>0%</td>
</tr>
</tbody>
</table>
## Changing drawing color

You can change the color of the drawings.

To change the drawing color:

1. Open a drawing.
2. Click **Tools** --> **Options** --> **Drawing Color Mode**, and select **Black and White**, **Gray Scale** or **Color**.

   You can toggle between the color modes by pressing B on the keyboard.

   ![Tip](image)
   You can change the background color to black using the advanced option `XS_BLACK_DRAWING_BACKGROUND`. If the background is black, use **Color** as color mode.

### Example

Below is an example of a color drawing.
In grayscale mode, the colors from 1 to 7 (black, red, green, blue, cyan, yellow, magenta) are shown in black, and the colors from 8 to 14 (brown, dark green, dark blue, blue-green, orange, gray) are shown in different shades of gray. Below is an example of a gray scale drawing.

Below is an example of a black-and-white drawing.
Specifying and using special color

You can define a special color that is not converted to black when printed. This color will be printed as color or grayscale, depending on the selected printer settings. The special color is defined using RGB (Red Green Blue) values in a scale of 0 to 255. The special color is applied on parts as a hatch.

You can specify a special color for a building object before creating a drawing, and use it in the final drawing for shape or a building object.

To define and use a special color in a final drawing:
1. Click Tools -> Options -> Advanced Options... -> Hatching.
2. Define the color using the following advanced options:
   - XS_HATCH_SPECIAL_COLOR_R
   - XS_HATCH_SPECIAL_COLOR_G
   - XS_HATCH_SPECIAL_COLOR_B
   The default value for all of the above advanced options is 230.
   The smaller the values are, the darker the shade.
3. Click OK or Apply.
4. Open a drawing.

See also  XS_BLACK_DRAWING_BACKGROUND
Colors in drawings on page 261
5. Double-click a drawing object to open the properties dialog box. For example, click a building object or a rectangle.

6. Select a fill type.

7. Select the Special fill color.

8. Click Modify.

See also

Colors in drawings on page 261
Colors and line weights in printing on page 303

Pen numbers in Color Table

*Pen numbers* in the Color Table dialog box refer to the line weights used in the printed drawing. By default, pen number 0 corresponds to a line weight of 0.1 mm. The final line weight in a printed drawing is the default pen thickness multiplied by the pen number. For example, pen number 25 will give a line weight of 2.5 mm.

- The line thicknesses displayed on the screen are taken from the first printer instance on the Printer instances list in the Printer Catalog. When you print a drawing, the line thickness is taken from the printer instance you use for printing.
- In color drawings, the lines are shown with different thicknesses if the setting Tools --> Options --> Use Printer Linewidths is selected.
- In black and white drawings, Tekla Structures shows the black lines on the screen using pen number thickness defined for the color in the Color Table.
- You can change the default pen thickness using the advanced option XS_BASE_LINE_WIDTH.

See also XS_BASE_LINE_WIDTH

Changing the pen numbers for colors (line weight) on page 265
Colors in drawings on page 261

*Changing the pen numbers for colors (line weight)*

You can change the pen numbers for the colors to show and print lines with different thicknesses.

To change the pen numbers:

1. Open a drawing.

2. Click Drawing File --> Print Drawings and go to the Line thickness tab.
3. Enter or change a pen number.
   For example, to get line weight of 2.5 mm, enter 25. The preview shows the changed line thickness.

4. Click Close.

5. In a color drawing, click Tools --> Options and select Use Printer Linewidths, otherwise you cannot see the changes on the screen.

See also
- Changing drawing color on page 262
- Colors in drawings on page 261
- Pen numbers in Color Table on page 265
- XS_BASE_LINE_WIDTH

### 4.19 User coordinate system (UCS)

The **UCS** is a local user coordinate system you can use in a drawing view. It is easier to position drawing objects in view, when you place objects relative to a user-defined point of origin, or base point in the drawing view.

Tekla Structures shows the UCS symbol in the current drawing view, when you create, copy, move, or modify graphical objects.

You can define a different point of origin for the UCS for each drawing view, and change the UCS point of origin as often as you like.

The following example shows several views, each with their own UCS.
To position an object using the global coordinate system, you need to calculate the coordinates of the object from the point of origin of the drawing.

See also

- Adding manual dimensions using User Coordinate System on page 148
- Setting a new UCS on page 267
- Toggling between two user coordinate systems on page 268
- Resetting UCS on page 268
- Keyboard shortcuts for UCS on page 268

### Setting a new UCS

You can set a new UCS using one point or two points.

To set a new UCS:

1. Open a drawing.
2. Click **Tools --> User Coordinate System (UCS)** and select one of the following commands:
   - Select **Set Origin** to set the new UCS using one point.
   - Select **Set by Two Points** to set the new UCS using two points.

   Tekla Structures displays the UCS symbol with a crosshair marking the center point.
3. Click the view where you want to place the origin.

4. If you are using two points, pick a point to define the direction of the x axis.

See also User coordinate system (UCS) on page 266
Adding manual dimensions using User Coordinate System on page 148

Toggling between two user coordinate systems

You can toggle between two user coordinate systems that have the same point of origin: the UCS following the axes of the drawing view and the oriented UCS you have created.

- To toggle between the coordinate systems, select Tools --> User Coordinate System (UCS) --> Toggle Orientation (Ctrl + T).

See also User coordinate system (UCS) on page 266

Resetting UCS

You can reset the UCS to its original position in the current view or in all views.

Do one of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Reset the UCS in the current view</td>
<td>Click Tools --&gt; User Coordinate System (UCS) --&gt; Reset Current (Ctrl + 1).</td>
</tr>
<tr>
<td>Reset the UCS in all drawing views</td>
<td>Click Tools --&gt; User Coordinate System (UCS) --&gt; Reset All (Ctrl + 0).</td>
</tr>
</tbody>
</table>

See also User coordinate system (UCS) on page 266

Keyboard shortcuts for UCS

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Set UCS origin</td>
<td>U</td>
</tr>
<tr>
<td>Set UCS by two points</td>
<td>Shift+U</td>
</tr>
<tr>
<td>Toggle orientation</td>
<td>Ctrl+T</td>
</tr>
<tr>
<td>Reset current</td>
<td>Ctrl+1</td>
</tr>
<tr>
<td>Reset all</td>
<td>Ctrl+0</td>
</tr>
</tbody>
</table>

See also User coordinate system (UCS) on page 266
4.20 Saving drawings

Tekla Structures automatically saves drawings at set intervals. You can also save your drawing whenever you want to.

To save a drawing:
- In the open drawing, click Drawing File --> Save.

Both the drawing *.dg and the model *.db1 and *.db2 are saved. The drawings are saved in the \drawings folder under the model folder.

See also Finding and opening drawings on page 103
Closing drawings on page 270

4.21 Deleting unnecessary drawing files in single-user mode

You can remove all your unnecessary drawing files in the single user mode without waiting for Tekla Structures to automatically remove them. By default, all unnecessary drawing files are deleted automatically after seven days. To remove the files, you need to have full privileges. By default, the privileges are full. If you want to restrict the command usage, you need to modify the privileges.inp file. Add the command Remove unnecessary drawing files to a toolbar or User menu through the Customize dialog box.

Always create and modify the User menu or toolbars in the modeling mode. If you create or modify the User menu or toolbars in the drawing mode, the new User menu, a new toolbar, or User menu or toolbar changes are not saved.

To add the command in the User menu and to remove the unnecessary drawing files:
1. Select Tools --> Customize...
2. Search for the command Remove unnecessary drawing files in the list of commands on the left.
3. Select the Menu tab on the right.
4. Select the command and add it in the User menu by clicking the right arrow.
5. Click Close.
6. Restart Tekla Structures to activate the new command.
7. Click the command Remove unnecessary drawing files on the menu when you want to remove the unnecessary drawing files from the \drawings folder under the model folder.
If you want to restrict the command usage, add the following line in the privileges.inp file:

```
action:RemoveUnnecessaryDrawingFiles [who] [access]
[who] is everyone or <Windows_logon_name>, or <domain_name> [access] can be none/view/full.
```

In the following example, only the administrator can use the Remove unnecessary drawing files command:

```
action:RemoveUnnecessaryDrawingFiles everyone none
action:RemoveUnnecessaryDrawingFiles ORGANIZATION\admin full
```

See also

### 4.22 Closing drawings

You can only have one drawing open at a time. Tekla Structures always has to close an open drawing before you can open another one.

To close a drawing:

1. Click the **Close** button in the upper-right corner of the drawing window.
2. If you have made changes in the drawing, Tekla Structures asks you to confirm if you want to save your changes.

You can also select to freeze the drawing, and create a snapshot.

See also

- Finding and opening drawings on page 103
- Freezing drawings on page 274
- Creating and viewing drawing snapshots on page 111

### 4.23 Keyboard shortcuts for drawings

<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open <strong>Drawing list</strong> when a drawing is open</td>
<td>Ctrl+O</td>
</tr>
<tr>
<td>Open <strong>Drawing list</strong> in model mode</td>
<td>Ctrl+L</td>
</tr>
<tr>
<td>Open previous drawing</td>
<td>Ctrl+Page Up</td>
</tr>
<tr>
<td>Open next drawing</td>
<td>Ctrl+Page Down</td>
</tr>
</tbody>
</table>

See also

- Editing drawings
<table>
<thead>
<tr>
<th>Command</th>
<th>Keyboard shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Open any drawing after creating the drawing</td>
<td>Ctrl+Shift</td>
</tr>
<tr>
<td>Associativity symbol</td>
<td>Shift+A</td>
</tr>
<tr>
<td>Set next drawing color mode</td>
<td>B</td>
</tr>
<tr>
<td>Ghost outline</td>
<td>Shift+G</td>
</tr>
<tr>
<td>Add an orthogonal dimension</td>
<td>G</td>
</tr>
<tr>
<td>Add free dimension</td>
<td>F</td>
</tr>
<tr>
<td>In <strong>Drawing list</strong>: Open user-defined attributes</td>
<td>Alt+U</td>
</tr>
<tr>
<td>In <strong>Drawing list</strong>: Add to Master Drawing Catalog</td>
<td>Ctrl+M</td>
</tr>
<tr>
<td>In <strong>Drawing list</strong>: Revision</td>
<td>Ctrl+R</td>
</tr>
<tr>
<td>In <strong>Master Drawing Catalog</strong>: Select all</td>
<td>Ctrl+A</td>
</tr>
<tr>
<td>In <strong>Master Drawing Catalog</strong>: Create drawings for all parts</td>
<td>Alt+A</td>
</tr>
<tr>
<td>In <strong>Master Drawing Catalog</strong>: Create drawings</td>
<td>Alt+C</td>
</tr>
</tbody>
</table>

**See also**  
*Editing drawings on page 114*  
Assigning a keyboard shortcut for a command
There are many ways you can control and manage the drawings you have created.

Click the links below to find out more:

- Updating drawings when the model changes on page 272
- Locking and unlocking drawings on page 273
- Freezing and unfreezing general arrangement drawings on page 274
- Issuing drawings on page 275
- Deleting drawings on page 276
- Revising drawings on page 276

5.1 Updating drawings when the model changes

Saved drawings need updating because of model changes. Cast-unit, assembly, single part and multidrawings use position numbers as identifiers. Many changes affect numbering, so many times the parts need to be renumbered. When such changes have been made, the drawings cannot be updated before the parts are renumbered. The drawings needing updates are indicated by flags in the Drawing List. Renumbering model objects after creating drawings may also generate flags.

- General arrangement drawings do not need model numbering to be updated. If you use part position numbers in part marks, you must number the model to get updated marks, because old and not updated marks have question marks in them. If you do not use numbering, you can modify general arrangement drawings without numbering. Then, for example, profile changes are highlighted with revision clouds.
- When you update multidrawings, also the linked drawings are updated.

Do the following after changing the model:
1. Check the numbering settings by clicking **Drawings & Reports → Numbering → Numbering Settings**.

2. Select **Compare to old** for both the new and modified parts.

3. Number all model objects that have same numbering series settings by clicking **Drawings & Reports → Numbering → Number Series of Selected Objects**, or number only new or modified model objects by clicking **Drawings & Reports → Numbering → Number Modified Objects**.

4. Check the drawing list for status flags.

5. To find the parts that have been affected, select each drawing marked with the ! flag in the **Drawing List** and click the **Select objects** button. Tekla Structures highlights the affected parts in the model. Do the following:
   a. Check the numbering history log for renumbered parts by clicking **Tools → Display Log File → Numbering History**.

<table>
<thead>
<tr>
<th>Part id: 31227</th>
<th>series: PB/1</th>
<th>PB/0 - PB/14</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part id: 31233</td>
<td>series: PB/1</td>
<td>PB/0 - PB/14</td>
</tr>
<tr>
<td>Part id: 31239</td>
<td>series: PB/1</td>
<td>PB/0 - PB/14</td>
</tr>
<tr>
<td>Assembly id: 5580</td>
<td>series: AB/1</td>
<td>AB/0 - AB/1</td>
</tr>
<tr>
<td>Assembly id: 5699</td>
<td>series: AB/1</td>
<td>AB/0 - AB/2</td>
</tr>
<tr>
<td>Assembly id: 5614</td>
<td>series: AB/1</td>
<td>AB/0 - AB/3</td>
</tr>
<tr>
<td>Assembly id: 5597</td>
<td>series: AB/1</td>
<td>AB/0 - AB/4</td>
</tr>
<tr>
<td>Assembly id: 6631</td>
<td>series: AB/1</td>
<td>AB/0 - AB/5</td>
</tr>
<tr>
<td>Assembly id: 6662</td>
<td>series: AB/1</td>
<td>AB/0 - AB/6</td>
</tr>
<tr>
<td>Assembly id: 6692</td>
<td>series: AB/1</td>
<td>AB/0 - AB/7</td>
</tr>
</tbody>
</table>

   b. To find the renumbered parts in the model, select the relevant entries from the numbering history log. Tekla Structures highlights the corresponding parts in the model.

6. Select the affected drawings from the **Drawing List** and click **Update**.

7. If you have new parts in the model, create drawings for them.

---

**5.2 Locking and unlocking drawings**

You can indicate that a drawing is not available for editing by locking it. When a drawing is locked, it cannot be accidentally modified. Locking prevents the drawings from being opened, updated, cloned, deleted, or modified, even if the model changes. The geometry of the locked
drawing still changes when the model changes. Tekla Structures flags locked drawings for update if the model changes.

To lock and unlock drawings:

1. In the **Drawing List**, select the drawing(s) you want to lock.
2. Click **Lock --> On**.

   The Locked by column in the **Drawing List** shows who has locked the drawing. If you have logged in to your Tekla account, the account name is shown. Otherwise the user name is shown.

3. To unlock the drawings, select the drawings and click **Lock --> Off**.

See also  Working with drawings on page 272

Selecting drawings in the Drawing List on page 108

---

**5.3 Freezing drawings**

You can select whether to allow Tekla Structures to update all associative objects on top of the drawing views. The geometry of the model is always updated, but freezing is used to stop the drawing intelligence (associativity) of drawing objects on top of the model views, and prevents them from being updated. For example, parts are updated, but dimensions, marks, views, and shapes are not.

See also  Freezing and unfreezing general arrangement drawings on page 274

Freezing and unfreezing single part, cast unit and assembly drawings on page 275

How freezing affects drawings on page 275

Working with drawings on page 272

Selecting drawings in the Drawing List on page 108

Updating marks on page 179

---

**Freezing and unfreezing general arrangement drawings**

To freeze a general arrangement drawing:

1. If you have the drawing open, close it without saving it.
2. In the **Drawing List**, select the drawing you want to freeze.
3. Click **Freeze --> On**.
4. When freezing is no longer necessary, select the frozen drawings and click **Freeze --> Off**.

See also  Freezing drawings on page 274
Freezing and unfreezing single part, cast unit and assembly drawings

To freeze and unfreeze single part, cast unit and assembly drawings:

1. Save the model.
2. Open a drawing.
3. If the drawing does not look the way you want, close it without saving it.
4. Reopen the model. Do not save it.
5. In the **Drawing List**, select the drawing you want to freeze.
6. Click **Freeze --> On**.
7. Open the drawing.
8. When freezing is no longer necessary, select the frozen drawings and click **Freeze --> Off**.

**See also**  
Freezing drawings on page 274

How freezing affects drawings on page 275

How freezing affects drawings

Freezing affects drawings in the following way:

- The associativity does not disappear from a frozen drawing. When you unfreeze the drawing, the associativity works again.
- Freezing does not have any effect on the cloning result. If you edit the drawing, it does not matter whether you freeze the drawing before or after editing it.
- If a drawing is frozen, the associative drawing objects are not updated when the drawing is updated. This means that the dimensions and views are not updated, and the marks do not follow the parts if the parts have been moved.
- If a drawing is frozen, and the part changes in the model, the geometry of the part is updated in the frozen drawing when the drawing is updated.
- Unfreezing the drawing before cloning does not have any effect on the cloning result. This means, for example, that it does not matter whether you keep the drawing frozen all the time or temporarily unfreeze it before cloning.
- If you unfreeze a drawing before update, the drawing is updated normally.

**See also**  
Freezing drawings on page 274
5.4 Issuing drawings

When a drawing is released for fabrication, it should be marked as issued in the Drawing List. The geometry of the issued drawings is updated when the model changes. Issuing only prevents the recreation of the drawing during update. The issuing information can be used to filter the Drawing List and in templates.

To issue drawings:
1. In the Drawing List, select the drawings to be issued.
2. Select Issue --> On.

Tekla Structures marks the issued drawings with a flag 💌

When an issued drawing has been edited or otherwise changed, the color of the flag changes 💌 and the text Issued drawing changed is displayed.

To show the issue date in a report, add the template field DATE_ISSUE in the appropriate report template.

See also Working with drawings on page 272

5.5 Deleting drawings

You can delete drawings in the Drawing List.
1. In the Drawing List, select the drawings you want to delete.
2. Click Delete.
3. When Tekla Structures asks you to confirm the deletion, select Yes.

If you press down Shift, Tekla Structures will not ask you to confirm the deletion.

See also Working with drawings on page 272
Selecting drawings in the Drawing List on page 108
5.6 Revising drawings

When you revise drawings, you can attach information to them about the changes you have made. Tekla Structures displays this information alongside the revision number or mark. The revision date also appears in the revision table within drawings. The revision number or mark is also shown in the Drawing List by default. Revision information can also be used in reports.

You can revise drawings through the Drawing List or when the drawing is open. When you revise the drawings using Add Revision Mark in an open drawing, Tekla Structures creates marks in the drawing indicating the places where the changes have been made.

The report drawing_issue_rev.xr shows the most recent revision dates of drawings.

To show the revision mark instead of the revision number in the Drawing List, set the advanced option XS_SHOW_REVISION_MARK_ON_DRAWING_LIST to TRUE.

See also
- XS_SHOW_REVISION_MARK_ON_DRAWING_LIST
- Adding revision marks on page 192
- Creating revisions on page 277
- Changing revisions on page 278
- Deleting revisions on page 278

Creating revisions

You can create revisions to follow the changes in the drawing.

To create a revision:

1. In the Drawing List, select the drawings to revise.
2. Click Revision....
   The Revision Handling dialog box is displayed.
3. Enter a mark in the Mark box.
   Marks can be numerical or alphabetical such as 1, 2, 3... or A, B, C...
4. Fill in the Created by information and select the creation date from the calendar that is displayed when you click the down-arrow next to the Date option.
5. If you need to give information about who checked and approved the drawing, enter the information in the corresponding boxes and select the appropriate dates.
6. Enter a revision description in the Description box.
7. Enter delivery information in the Delivery box.
8. Enter any additional information in the Info 1 and Info 2 boxes.
9. Click **Create**.

The revision number or mark is now displayed in the **Drawing List**. When you open the drawing, you can see the revision information in the revision table if there is one in the drawing.

---

Each drawing has its own unique revision number, but several drawings can share the same revision mark, date, and other information. To attach the same revision information to several drawings simultaneously, select multiple drawings from the drawing list.

---

**See also**  
Revising drawings on page 276  
Revision handling attributes on page 279

---

**Changing revisions**

You can change revision information afterwards.

To change a revision:

1. Select a revised drawing from the **Drawing List**.
2. Click **Revision...**
3. In the **Revision Handling** dialog box, select the number of the revision that you want to change from the **Rev. No.** list.
4. Change the revision information.
5. Click **Modify**.
6. Close the **Revision Handling** dialog box.

**See also**  
Working with drawings on page 272  
Revision handling attributes on page 279

---

**Deleting revisions**

You can delete unnecessary revisions.

To delete a revision:

1. Select a revised drawing from the **Drawing List**.
2. Click **Revision...**
3. In the **Revision Handling** dialog box, select the revision number from the list next to the **Mark** box.
4. Click **Delete**.

When you delete a revision, Tekla Structures automatically adjusts the remaining revision numbers for that drawing. The revision marks do not change.

**See also**  Working with drawings on page 272

### Revision handling attributes

The revision handling attributes can be included in drawing templates and report templates. All revision handling attributes and the corresponding options in the Revision Handling dialog box are listed below.

<table>
<thead>
<tr>
<th>Revision handling attribute</th>
<th>Option in the Revision Handling dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>MARK</td>
<td>The revision mark in the <strong>Mark</strong> box.</td>
</tr>
<tr>
<td>NUMBER</td>
<td>The revision number in <strong>Rev. No.</strong>.</td>
</tr>
<tr>
<td>CREATED_BY</td>
<td>The <strong>Created by</strong> information of the revision.</td>
</tr>
<tr>
<td>DATE_CREATE</td>
<td><strong>Date</strong> next to <strong>Created by</strong>.</td>
</tr>
<tr>
<td>CHECKED_BY</td>
<td>The <strong>Checked by</strong> information of the revision.</td>
</tr>
<tr>
<td>DATE_CHECKED</td>
<td><strong>Date</strong> next to <strong>Checked by</strong>.</td>
</tr>
<tr>
<td>APPROVED_BY</td>
<td>The <strong>Approved by</strong> information of the revision.</td>
</tr>
<tr>
<td>DELIVERY</td>
<td>The <strong>Delivery</strong> information of the revision.</td>
</tr>
<tr>
<td>DESCRIPTION</td>
<td>The revision <strong>Description</strong>.</td>
</tr>
<tr>
<td>DATE_APPROVED</td>
<td><strong>Date</strong> next to <strong>Approved by</strong>.</td>
</tr>
<tr>
<td>INFO1</td>
<td>The <strong>Info 1</strong> text of the revision.</td>
</tr>
<tr>
<td>INFO2</td>
<td>The <strong>Info 2</strong> text of the revision.</td>
</tr>
<tr>
<td>LAST</td>
<td>The revision number of the latest revision in <strong>Rev. No.</strong>.</td>
</tr>
<tr>
<td>LAST_CREATED_BY</td>
<td>The <strong>Created by</strong> information of the latest revision.</td>
</tr>
<tr>
<td>LAST_CHECKED_BY</td>
<td>The <strong>Checked by</strong> information of the latest revision.</td>
</tr>
<tr>
<td>LAST_DATE_CHECKED</td>
<td>The <strong>Checked by Date</strong> of the latest revision.</td>
</tr>
<tr>
<td>LAST_DATE_APPROVED</td>
<td>The approval <strong>Date</strong> of the latest revision.</td>
</tr>
<tr>
<td>LAST_DELIVERY</td>
<td>The <strong>Delivery</strong> information of the latest revision.</td>
</tr>
<tr>
<td>LAST_MARK</td>
<td>The revision mark of the latest revision in the <strong>Mark</strong> box.</td>
</tr>
<tr>
<td>LAST_DESCRIPTION</td>
<td>The <strong>Description</strong> of the latest revision.</td>
</tr>
<tr>
<td>LAST_DATE_CREATE</td>
<td>The <strong>Created by</strong> date of the latest revision.</td>
</tr>
<tr>
<td>LAST_APPROVED_BY</td>
<td>The <strong>Approved by</strong> information of the latest delivery.</td>
</tr>
<tr>
<td>LAST_INFO1</td>
<td>The <strong>Info 1</strong> text of the latest revision.</td>
</tr>
<tr>
<td>LAST_INFO2</td>
<td>The <strong>Info 2</strong> text of the latest revision.</td>
</tr>
</tbody>
</table>

**See also**  Creating revisions on page 277
Tekla Structures provides a real-time preview of drawings. You can print the previewed drawings as PDF files, save them as plot files and print them on a selected printer. You can also map drawing colors to line thicknesses.

**Limitations in printing**

- There is only one set of color line thickness settings, which means that you cannot save different settings for each printer.
- You cannot print to several paper sizes at the same time.
- You can only save one set of dialog settings.
- The `hardware_BRICKS`, `hardware_CHESS` and `hardware_LINES` hatches are not supported.
- Images in drawings are previewed in color even if you select Grayscale or Black and white.
- The advanced option `XS_PLOT_VIEW_FRAMES` is not supported.
- When you have open a drawing in Tekla Structures, you can only preview and print that drawing. Also, when you open another drawing (for example, by double-clicking on another drawing in the Drawing List), the preview may not update. Select the drawing again (single-click) in the Drawing List and the preview is then updated to match the selection.
6.1 Printing to a .pdf file, plot file or printer

To print to a .pdf file, plot file or printer:

1. Open the Drawing List and select the drawings that you want to print.
2. Click File --> Print --> Print Drawings.
3. Select the desired drawing from the list of Drawings on the top.

The drawings are shown one by one in a preview. The preview shows the drawings always up to date.

4. Use Next and Previous to scroll through the set of selected drawings.
5. Select the printing option:
   - PDF file: Converts drawings to PDF format.
   - Printer: Sends the drawings to the selected printer.
   - Plot file: Converts drawings to print files in a format suitable for the selected printer and saves them in a specified location.
6. If you need to change Windows printing settings for a printer or for a plot file, click the Properties button.
7. Define the printing settings. The available settings depend on which printing option you have selected:

- **File location**: Enter the location for the .pdf or plot file, or use Browse to browse for the folder.
  
  The \Plotfiles folder under the model folder is the default value.

- **Open folder when finished**: Opens the .pdf or plot file folder in Windows Explorer after the printouts have been created.

- **Open file when finished**: Opens the .pdf file after it has been created.

- **Output to single file**: Prints the selected drawings to a single .pdf file.
  
  If you do not select this option, each drawing will be printed in a .pdf file of its own.

- **File extension**: Allows you to specify a file name extension for the plot file. The default is plt.

- **File prefix**: Allows you to enter a specific prefix in the file name.

- **File suffix**: Allows you to enter a specific suffix in the file name.
  
  When you enter a prefix or suffix, the file name preview displayed under the File prefix and File suffix boxes will reflect the change immediately.

  The file name can be controlled by a couple of advanced option switches for customizing print file names, except when you generate a single combined multiple drawings .pdf file.

- **Fit to paper**: Fits the drawing to a specific paper size.

- **Scale**: Defines the scale to force the printout to a specific scale.
  
  The Scale value will turn red if the drawing cannot fit on the specified sheet.

- **Center drawing on paper**: Centers the drawing on the sheet (or sheets).

- **Print on multiple sheets**: Allows you to print on multiple sheets and specifies the direction of printing the sheets. Select either **Left to right, top to bottom** or **Bottom to top, right to left**.
  
  When you use Print on multiple sheets, select a particular paper size.

- **Paper size**: Defines the paper size or use automatic size.
  
  With the Auto setting Tekla Structures selects the paper size that has the least wasted area when the scaled print is fitted to the printable area on the sheet.

  Printers are often unable to print on the full area of a sheet, and leave borders. The **printable area** is determined for the selected printer when the option Printer or Plot file is selected. In the case of creating a .pdf file, the printer is not known so the output is sized to the full sheet. However, when printing a .pdf, the same problem exists and the drawing content is fitted to the printable area of whatever printer is being used. The printable area is show with white background and the non-printable border is shaded gray in the preview image below.
• **Orientation**: Defines the orientation or use automatic orientation.

  The *Auto* setting means that the orientation that wastes least space is selected automatically.

• **Color**: Select if the output is to be **Color**, **Black and white** or **Grayscale**.

• **Number of copies**: Defines the number of plot file or printout copies to be printed.

• **Embed fonts**: If selected, the fonts will be embedded in the .pdf file.

  This ensures that fonts may be reproduced on a system that does not have them installed, but increases the file size. In certain cases fonts may automatically be embedded. When using non-Latin fonts it is recommended that embedding is selected, otherwise the .pdf may not be displayed correctly. When fonts are embedded, in order to keep the file as small as possible, embed only the subset used in the document, not the full range.

8. Go to the **Line thickness** tab and map drawing colors to line thicknesses.

  Line thicknesses are expressed as a multiple of the advanced option XS_BASE_LINE_WIDTH value. The default value is typically 0.1 mm. This means that the line thickness value 5 would result in a line width of 0.5 mm.

9. Click **Print** to print the drawings in .pdf format or as plot files, or send them to a printer according to the settings you defined in the dialog box.

**Example**  
Below is an example of printing to multiple sheets. The option **Bottom to top, right to left** is selected. The numbers indicate the printing order of sheets.
In the next example, the option Left to right, top to bottom is selected.

See also  Printing drawings on page 280
6.2 Printing configuration files

In printing, two configuration files are used related to paper sizes and drawing sizes: PaperSizesForDrawings.dat and DrawingSizes.dat.

- PaperSizesForDrawings.dat defines a list of paper size names allowed to be used, and their dimensions.
- DrawingSizes.dat provides a list of properties that should be set up to match the drawing sizes configured in the Tekla Structures drawing layout definitions. It is used to link those drawings to the paper size name that each drawing was set up for, and provides information about the drawing sizes and the margins around them.

The PaperSizesForDrawings.dat file is by default located in the ..\ProgramData\Tekla Structures\<version>\environments\common\system folder. The DrawingSizes.dat file is located in the \system folder in the common, UK, Germany, US imperial and US metric environments. Default values are provided in the files installed with the printing functionality and should be appropriate in most cases. However, the optimum values are dependent on the details of the existing drawing layout definitions. If the printed area of the drawing needs to be moved, or if inappropriate paper sizes are being selected, full instructions about how to make adjustments are detailed in these two files.

Make copies of the original configuration files if you want to modify the settings, and place the copies in appropriate folders. This means that you may have several copies of the configuration files on your computer. When needed, these files are searched for and the first one found is used in the following search order:

- model folder
- project folder as defined by the XS_PROJECT advanced option
- firm folder as defined by the XS_FIRM advanced option
- folders as defined by the XS_SYSTEM advanced option

If no files are found default values will be used.

When making copies of the files, keep them first in a test model folder. Validate the results before using them through the project, firm or environment folders. Also, keep backup copies of the configuration files in a safe location as reinstalling later versions of Tekla Structures may overwrite your own settings.

See also
- Printing drawings on page 280
- Printing to a .pdf file, plot file or printer on page 281
6.3 Customizing print output file names

You can affect the way Tekla Structures automatically names the .pdf files and plot files by using certain drawing-type-specific advanced options.

To customize the print output file names:

1. In Tekla Structures, go to Tools --> Options --> Advanced Options --> Printing.

2. Enter values for any or all of the advanced options
   
   XS_DRAWING_PLOT_FILE_NAME_A, XS_DRAWING_PLOT_FILE_NAME_W, XS_DRAWING_PLOT_FILE_NAME_G, XS_DRAWING_PLOT_FILE_NAME_M, or XS_DRAWING_PLOT_FILE_NAME_C.

   The letter at the end indicates the drawing type. You can also combine several values. The values are not case sensitive.

3. Click OK.

Example  Use single % around the values. The example below results in the following assembly drawing .pdf name: E_P1_PLATE_Revision=2.pdf:

\[
\text{XS\_DRAWING\_PLOT\_FILE\_NAME\_A}=\text{E\_}\%\text{NAME}\_\%\text{TITLE}\_\text{Revision=}%\%\text{REV}\_\text{pdf}
\]

<table>
<thead>
<tr>
<th>Possible values</th>
<th>Value</th>
<th>Example of the result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>%NAME%</td>
<td>P_1</td>
<td>Part, assembly, or cast unit position, using the file name format prefix_number.</td>
</tr>
<tr>
<td></td>
<td>%DRAWING_NAME%</td>
<td>P-1</td>
<td>Part, assembly, or cast unit position, using the file name format prefix-number.</td>
</tr>
<tr>
<td></td>
<td>%NAME_-%</td>
<td>P1</td>
<td>Part, assembly, or cast unit position, using the file name format prefixnumber.</td>
</tr>
<tr>
<td></td>
<td>%DRAWING_NAME_-%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>%REV%</td>
<td>2</td>
<td>Drawing revision number.</td>
</tr>
<tr>
<td></td>
<td>%REVISION%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>%DRAWING_REVISION%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>%REV_MARK%</td>
<td>B</td>
<td>Drawing revision mark.</td>
</tr>
<tr>
<td></td>
<td>%REVISION_MARK%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>%DRAWING_REVISION_MARK%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>%TITLE%</td>
<td>PLATE</td>
<td>Drawing name from the drawing properties dialog box.</td>
</tr>
<tr>
<td></td>
<td>%DRAWING_TITLE%</td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td>%UDA:\text{&lt;drawing user-defined attribute&gt;}%</td>
<td>Painted</td>
<td>Value of a user-defined drawing attribute. The user-defined drawing attributes are</td>
</tr>
</tbody>
</table>

1. Click OK.
<table>
<thead>
<tr>
<th>Value</th>
<th>Example of the result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>defined in objects.inp. The actual values for the user-defined attributes are entered in the drawing-specific user-defined attributes dialog box.</td>
<td></td>
</tr>
<tr>
<td>%REV? - &lt;text&gt;%</td>
<td>2 - Rev</td>
<td>Adds conditional prefixes. In this example, if REV exists, Tekla Structures adds the text between ? and % to the filename.</td>
</tr>
</tbody>
</table>
| %TPL:<template attribute>% | Base plate | You can use template attributes that can be found in Template Editor. The actual values for these attributes are entered in the drawing properties dialog box. Examples:  
  • %TPL:TITLE1%  
  • %TPL:TITLE2%  
  • %TPL:TITLE3%  
  • %TPL:DR_DEFAULT_HOLE_SIZE %  
  • %TPL:DATE%  
  • %TPL:TIME%  
  • %TPL:DR_DEFAULT_WELD_SIZE % |

See also  Printing to a .pdf file, plot file or printer on page 281

### 6.4 Printing drawings using Tekla Structures printer instances

You can also use Tekla Structures own printer instances for printing drawings. To do this, you need to set XS_USE_OLD_PLOT_DIALOG to TRUE. Using this advanced option takes the Printer Catalog dialog box in use, and requires printer instances to be set in Tekla Structures.

Setting up printers in the Microsoft Windows environment is not covered in this documentation. It is assumed that printers are set up and tested in your environment. For further information about on setting up printers, contact your system administrator.

Click the links below to find out more:
- Printing single drawings on page 288
- Printing multiple drawings with different sizes in one go on page 291
- Creating PDF files on page 291
Printing single drawings

There are many ways you can start printing single drawings: you can use menu commands, icons, and pop-up menu commands.

Before you print the drawing, check that the printer instance settings are correct and the layout contains the correct drawing size settings.

To print single drawings using menu commands in an open drawing:

1. In the drawing, click Drawing File --> Print Drawings...
2. In the Print Drawings dialog box, select the printer instance you want to use.
3. If needed, modify the printing settings and add frames and foldmarks in the printout.
4. Click Print.

Shortcut for opening the Print Drawings dialog box: Shift+P.

See also
- Adding frames and foldmarks in drawings on page 296
- Printing drawings using Tekla Structures printer instances on page 287
- Printing settings in Print Drawings dialog box on page 303
- Setting up printer instances in Printer Catalog on page 299
- Example: Printing on A4 in landscape on page 288
- Example: Printing on A3 in portrait on page 289
Example: Printing on A4 in landscape

This example describes how you can print on A4 paper in landscape style in black and white.

In this example, it is assumed that the print area h*b is defined h being along the longer side of the paper and b being along the shorter side of the paper. When using some other printer driver you might have to change h*b values if you find out that the printer driver uses h along the short side of the paper.

To print on A4 in landscape in black and white when a drawing is open:

1. In drawing properties dialog box, click **Layout**.
2. Set **Size definition mode** to **Specified size** and set **Drawing size** to 287 * 200.
   
   You can also use **Autosize**. Then you need to make sure that you have defined appropriate **Fixed sizes** or **Calculated sizes**.
3. Click **Modify** and **OK**.
4. Select **Drawing File --> Print Drawings...**.
5. In the **Print Drawings** dialog box, click the printer instance you want to use.
6. Click **Add/Edit** and check that the printer settings are correct:
   
   • **Paper size**: A4 210 x 297 mm
   • **Print area h*b**: 287 x 200
   • **Color**: Black/white
7. Click **Update**.
8. Click **OK**.
9. Set **Scaling** to **Scale** and enter 1.
   
   In this case also **Scaling** setting **Auto** would produce a similar printout because drawing size and h*b are the same.
10. Set **Orientation** to **Landscape** (or **Auto**).
11. Set **Print area** to **Entire Drawing**.
12. Click **Print**.

See also  **Printing drawings using Tekla Structures printer instances on page 287**

Example: Printing on A3 in portrait

This example describes how you can print on A3 paper in portrait style in black and white.

You can print from the **Drawing List** or when a drawing is open.

To print on A3 in portrait in black and white when a drawing is open:

---

Printing drawings using Tekla Structures printer instances on page 287
1. In drawing properties dialog box, click **Layout**.

2. Set **Size definition mode** to **Specified size** and set **Drawing size** to 287 * 410.
   
   You can also use **Autosize**. Then you need to make sure that you have defined appropriate **Fixed sizes** or **Calculated sizes**.

3. Click **Modify** and **OK**.

4. Select **Drawing File --> Print Drawings**.

5. In the **Print Drawings** dialog box, click the printer instance you want to use.

6. Click **Add/Edit** and check that the printer settings are correct:
   - **Paper size**: A3 297 x 420 mm.
   - **Print area h*b**: 410 x 287
   - **Color**: Black/white

7. Click **Update**.

8. Click **OK**.

9. Set **Scaling** to **Scale** and enter 1.

10. Set **Orientation** to **Portrait** (or **Auto**).

11. Set **Print area** to **Entire Drawing**.

12. Click **Print**.

**See also**: Printing drawings using Tekla Structures printer instances on page 287

**Example: Printing A3 drawing on A4 paper**

This example describes how you can print an A3 drawing on A4 paper. This is useful, for example, when you need draft drawings that do not have to show the correct scale.

To print an A3 drawing on A4:

1. Open the A3 drawing.

2. Select **Drawing File --> Print Drawings**.

3. In the **Print Drawings** dialog box, click the printer instance that you want to use.

4. Click **Add/Edit**, click the printer instance that you are going to use and ensure that it prints to A4 paper.

   Also ensure that the **Print area h*b** value takes into account the printer hard margins. In this case, the **Print area h*b** could be 287 * 200.

5. If you changed any settings, click **Update** and **OK**.

   If you did not change any settings in the **Printer Catalog**, click **OK** to return to the **Print Drawings** dialog box.
6. Set Scaling to Auto. When you use Auto, and the drawing is bigger than the paper, the drawing is scaled down to fit the paper.

7. Click Print.

See also Printing single drawings on page 288

Printing multiple drawings with different sizes in one go

You can print multiple drawings from the Drawing List. You can print drawings of different sizes at the same time.

To print multiple drawings even of different sizes:

1. In the Drawing List, select the drawings you want to print.

2. Click the Print drawings button on the toolbar.

3. In the Print Drawings dialog box, indicate the printers you want to use.
   
   To select several printers, hold down Ctrl and select the printers.

   When you select drawings of several sizes and several printers, Tekla Structures sends each drawing to the printer that is using the smallest paper size on which the drawing will fit. For example, if you have two printers selected, one A4 and one A3, Tekla Structures will send A4 drawings to the A4 printer and A3 to the A3 printer.

4. Set Scale to 1.

   This makes it possible for Tekla Structures to select and use the printer instance that is using the correct paper size.

5. If necessary, modify other printing settings and add frames and foldmarks in the printout.

6. Click Print.

See also Adding frames and foldmarks in drawings on page 296

Printing drawings using Tekla Structures printer instances on page 287

Printing single drawings on page 288

Creating PDF files

You can use any standard PDF printer to create PDF files in Tekla Structures, such as pdfFactory, Win2PDF or Adobe Acrobat.

Before you start creating PDF files using Adobe Acrobat, ensure that you have Adobe Acrobat and Adobe Distiller installed and configured with the Adobe Postscript Printer Driver set up to print to file. Consult your Adobe documentation for more information.
Also ensure that you have an Adobe postscript printer instance in the Tekla Structures printer catalog.

To create PDF files:

1. In the Drawing List, select the drawings of which you want to make PDF files.

2. Click the Print drawings button.

3. In the Print Drawings dialog box, select the PDF printer instances you want to use.

   If you select several printer instances, Tekla Structures sends each drawing to the printer instance that is using the smallest paper size on which the drawing will fit. For example, if you have two printer instances selected, one A4 and one A3, Tekla Structures will send A4 drawings to the A4 printer and A3 to the A3 printer.

4. If needed, modify the printing settings and add frames and foldmarks in the PDF.

5. Click Print.

   Tekla Structures creates the PDF files and saves them in the folder that you specified when you defined the printer instance. The file will have the name shown in the Drawing List with the extension .ps.

Limitations

Do not use the Print to file option when you create PDF files.

See also

Printing settings in Print Drawings dialog box on page 303
Adding an Adobe postscript printer instance on page 301
Adding frames and foldmarks in drawings on page 296
Printing drawings using Tekla Structures printer instances on page 287

Printing to file

Before you start, make sure you have a printer instance set up to print to file.

To print to a file:

1. In the Drawing List, select all the drawings that you want to print.

2. Click the Print drawings button on the toolbar.

3. Click a printer instance that is set up to print to file.

4. Select the Print to file check box.

   Specify the folder. You can use the folder specified during printer instance setup or click Browse... to locate the destination folder in the Browse For Folder dialog box.

   If you do not enter a folder, Tekla Structures creates the files in the current model folder or in the folder defined by the advanced option XS_DRAWING_PLOT_FILE_DIRECTORY.
5. If needed, modify other printing settings and add frames and foldmarks in the printout.
6. Click **Print**.

Tekla Structures prints the selected drawings to files in the specified folder using the drawing names.

**See also**  
- Printing settings in Print Drawings dialog box on page 303
- Printing drawings using Tekla Structures printer instances on page 287
- Adding a print-to-file instance on page 300

**Customizing print file names**

By default, Tekla Structures uses the drawing names as print file names. You can customize these file names using an advanced option indicating the drawing type, and entering switches defining the format of the print file name as a value.

To customize the filenames:

1. Go to **Tools --> Options --> Advanced Options... --> Printing**.
2. Enter switches for the advanced options **XS_DRAWING_PLOT_FILE_NAME_A**, **XS_DRAWING_PLOT_FILE_NAME_W**, **XS_DRAWING_PLOT_FILE_NAME_G**, **XS_DRAWING_PLOT_FILE_NAME_M**, and **XS_DRAWING_PLOT_FILE_NAME_C**
   
   You can also combine several switches. The switches are not case sensitive.
3. Click **OK**.

**Example**  
The example below results in the filename **E_P1_PLATE_Revision=2.dxf**:

- **XS_DRAWING_PLOT_FILE_NAME_A**=
  
  E_%NAME.%_TITLE%REV%.%REV%.dxf

**See also**  
- Switches for customizing print file names on page 293
- Printing to file on page 292
### Switches for customizing print file names

Use the following switches when you want to customize the print file name format. If you are defining these in an `.ini` file, use double `%%`. Use single `%` in the **Advanced Options** dialog box.

<table>
<thead>
<tr>
<th>Switch</th>
<th>Example of the result</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><code>%%NAME%%</code></td>
<td><code>P_1</code></td>
<td>Part, assembly, or cast unit position, using the filename format prefix_number.</td>
</tr>
<tr>
<td><code>%%DRAWING_NAME%%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%%NAME.-%</code></td>
<td><code>P-1</code></td>
<td>Part, assembly, or cast unit position, using the filename format prefix-number.</td>
</tr>
<tr>
<td><code>%%DRAWING_NAME.-%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%%NAME.%</code></td>
<td><code>P1</code></td>
<td>Part, assembly, or cast unit position, using the filename format prefixnumber.</td>
</tr>
<tr>
<td><code>%%DRAWING_NAME.%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%%REV%</code></td>
<td>2</td>
<td>Drawing revision number, if <strong>Include revision mark to filename</strong> is checked in the <strong>Print Drawings</strong> dialog box.</td>
</tr>
<tr>
<td><code>%%REVISION%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%%DRAWING_REVISION%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%%REV_MARK%</code></td>
<td><code>B</code></td>
<td>Drawing revision mark, if <strong>Include revision mark to filename</strong> is checked in the <strong>Print Drawings</strong> dialog box.</td>
</tr>
<tr>
<td><code>%%REVISION_MARK%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%%DRAWING_REVISION_MARK%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%%TITLE%</code></td>
<td><code>PLATE</code></td>
<td>Drawing name from the drawing properties dialog box.</td>
</tr>
<tr>
<td><code>%%DRAWING_TITLE%</code></td>
<td></td>
<td></td>
</tr>
<tr>
<td><code>%UDA:&lt;drawing user-defined attribute&gt;%</code></td>
<td>Painted</td>
<td>Value of a drawing user-defined attribute. The drawing user-defined attributes are defined in <code>objects.inp</code>. The actual values for the user-defined attributes are entered in the drawing-specific user-defined attributes dialog box.</td>
</tr>
<tr>
<td>%REV? - &lt;text&gt;%</td>
<td><code>2 - Rev</code></td>
<td>Adds conditional prefixes. In this example, if <code>REV</code> exists, Tekla Structures adds the text between ? and % to the filename.</td>
</tr>
<tr>
<td><code>%TPL:&lt;template attribute&gt;%</code></td>
<td><code>Base plate</code></td>
<td>You can use here template attributes that can be found in Template Editor. The actual values for these attributes are entered in the drawing properties dialog box. Examples:</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>%TPL:TITLE1%</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>%TPL:TITLE2%</code></td>
</tr>
<tr>
<td></td>
<td></td>
<td>• <code>%TPL:TITLE3%</code></td>
</tr>
</tbody>
</table>
### Switches, Example of the result, Description

<table>
<thead>
<tr>
<th>Switch</th>
<th>Description</th>
</tr>
</thead>
</table>
|        | • %TPL:DR_DEFAULT_HOLE_SIZE%  
|        | • %TPL:DATE%  
|        | • %TPL:TIME%  
|        | • %TPL:DR_DEFAULT_WELD_SIZE% |

See also Customizing print file names on page 293

Objects.inp properties

Template Attributes Reference Guide

**XS_DRAWING_PLOT_FILE_NAME_A**

**XS_DRAWING_PLOT_FILE_NAME_C**

**XS_DRAWING_PLOT_FILE_NAME_W**

**XS_DRAWING_PLOT_FILE_NAME_M**

**XS_DRAWING_PLOT_FILE_NAME_G**

### Printing to multiple sheets

Before printing to multiple sheets, make sure that the layout of the drawing supports printing on several smaller sheets. Remember that Tekla Structures automatically adds a 5 mm margin to the printouts.

Also ensure that you have set up the printer instance correctly for printing to multiple sheets.

To print on several smaller sheets:

1. In the drawing, click **Drawing File --> Print Drawings...**.
2. In the **Print Drawings** dialog box, select the printer instance you want to use.
3. Select the **Print on multiple sheets** option.
4. In **Scaling**, set **Scale** = 1. This preserves the scale. The number of sheets is rounded up.
   
   Do not use **Auto** when you print to multiple sheets.

   Tekla Structures calculates the required amount of sheets needed to print the drawing.
5. If needed, modify other printing settings and add frames and foldmarks in the printout.

   If you set **Orientation** to **Auto**, Tekla Structures selects an orientation that results in the smallest number of printed sheets.
Tekla Structures prints the drawing to multiple sheets so that it prints the lower right corner the first, and the upper left corner the last (see the numbered sheets in the example below). If you want to have drawing frames and/or the title blocks for each smaller size sheet, you need to use proper table layout as shown in the example below.

Use the advanced option `XS_PRINT_MULTISHEET_BORDER` to set borders that are left out from the smaller sheets.

**Adding frames and foldmarks in drawings**

You can have a frame around drawing contents, or two drawing frames inside each other. You can add default Tekla Structures frames around the drawing contents, or use DWG/DXF files in the table layouts as drawing frames.

You can create foldmarks as guides for folding printed drawings. They are small lines between and perpendicular to the drawing frames.
Adding frames and foldmarks in printouts

Drawing frames to be printed are controlled in the `standard.fms` file under the system folder. There is no saving option in the **Drawing Frame Properties** dialog box, which is why the default values are located in a standard file.

To add frames and foldmarks:

1. In the **Print Drawings** dialog box, click **Frames**.
2. In the **Drawing Frame Properties** dialog box, select the check boxes of the frames you want to print.
3. In **Margins**, enter in millimeters the distance between each frame and the left, right, bottom, and top edge of the paper.
4. Select a color for each frame.
5. To print the foldmarks, select the **Foldmarks** check box.
6. Enter in millimeters the horizontal and vertical distances of the first foldmarks from the lower right corner of the outer frame, and between the other foldmark.
7. Select a color for the foldmarks.
8. Click **OK**.

See also

- Printing drawings using Tekla Structures printer instances on page 287
- Adding frames and foldmarks in printouts on page 297
- Adding a DWG/DXF file frame on page 298
- XS_PLOT_VIEW_FRAMES
Below is an example of the properties dialog box contents and the standard file.

![Drawing Frame Properties dialog box](image)

```plaintext
cia_drframe.drframe1_en 1
cia_drframe.drframe2_en 0
cia_drframe.fold_en 0
cia_drframe.x1 5.000000
ncia_drframe.y1 5.000000
ncia_drframe.x2 5.000000
ncia_drframe.y2 5.000000
ncia_drframe.pen 4
cia_drframe.x1_2 0.000000
ncia_drframe.y1_2 0.000000
ncia_drframe.x2_2 0.000000
ncia_drframe.y2_2 0.000000
ncia_drframe.pen_2 4
ncia_drframe.fold_width 0.000000
ncia_drframe.fold_height 0.000000
ncia_drframe.fold_pen 0
```

There is a fixed distance value of 5 mm in drawing frame margins. Thus, if you want to use a drawing frame margin with a drawing title that sticks to the frame corner, you need to change not only the drawing frame margin in the **Drawing Frame properties** dialog box in **Print Drawings**, but also the **Vector between corners** in the **Tables** dialog box (Drawing Layout -- Table layouts -- Tables).

**See also**
- Adding frames and foldmarks in drawings on page 296
- Table layouts on page 327
**Adding a DWG/DXF file frame**

DWG/DXF files can be used as drawing frames. You can do this by adding the DWG/DXF file in the table layout of the drawing.

1. Click **Drawings & Reports --> Drawing Settings --> Drawing Layout...**.
2. Select a layout and click **Table layout...**.
3. Select a table layout and click **Tables...**.
4. Double-click **DWG/DXF** in the **Available tables** list.
5. Select the file and click **OK**.
6. Click **Update**.
7. Set the **Scale**.
8. Select **Transparent**.
9. Click **OK**.

**See also**  
Adding frames and foldmarks in drawings on page 296  
Table layouts on page 327

**Setting up printer instances in Printer Catalog**

Tekla Structures uses Microsoft Windows printer drivers to write the printed data directly to a printer, print file or PDF file.

There are two stages in setting up printer instances in Tekla Structures:

- First, you need to add a printer instance in the **Printer Catalog**. By default, several printer instances are already defined.
- Next, you need connect the printer instances to printer drivers and adjust the printer instance settings. You can also connect one printer driver to several printer instances, for example, to print in different sizes on the same printer.

**See also**  
Adding a printer instance on page 299  
Adding a print-to-file instance on page 300  
Adding an Adobe postscript printer instance on page 301  
Defining paper size on page 302  
Defining print area h*b on page 303  
Colors and line weights in printing on page 303
**Adding a printer instance**

To add a printer instance in Tekla Structures **Printer Catalog**:

1. In the model, click **File** --> **Print** --> **Printer Catalog**....

2. In the **Printer Catalog** dialog box, click an existing printer instance that has similar settings to the one you want to add.

3. Enter a name for the new printer instance in the box under the **Printer instances** list.

4. Click **Add**.

5. Click **Browse**... to access the **Select Printer** dialog box, which shows a list of Microsoft Windows printer drivers currently configured in your system.

6. Click a printer driver and then **OK**.

7. Select the paper size.

8. Enter the print area in **Print area h*b** (height and width).

9. If necessary, use **Offset for print origin** to move the drawing print origin.

10. Select **Black/white**, **Gray Scale** or **Color**.

    If you select **Color**, Tekla Structures prints lines with the colors defined in the drawing properties.

11. Click **Color table** to map pen size to the on-screen line color. The background color is not printed.

12. Click **Update**.

13. Click **OK**.

14. Confirm that you want to save changes to the model folder.

**See also**  
Printing drawings using Tekla Structures printer instances on page 287  
Defining paper size on page 302  
Defining print area h*b on page 303  
Colors and line weights in printing on page 303

---

**Adding a print-to-file instance**

To add a print-to-file instance in the **Printer Catalog**:

1. In **Printer Catalog**, click **Add**.

2. Enter a printer instance name for the printer driver, followed immediately (no spaces) by **@path\folder\**. The folder must already exist. For example, 11X17@d:\small\
You can also leave the folder out. If you do this, Tekla Structures prints the file in the current model folder or in the folder specified for the advanced option `XS_DRAWING_PLOT_FILE_DIRECTORY`.

`XS_DRAWING_PLOT_FILE_DIRECTORY` overrides the folder defined in the Printer Catalog.

3. Click **Add**.
4. Click **Browse...** to access the Select Printer dialog box and click a printer driver that is configured to print to file and then click **OK**.
5. In **Paper size**, select **By print area**.
6. Enter the print area in **Print area h*b**.
7. Enter a file name extension, for example, **plt** for a print file.
8. Select **Color**, **Gray Scale** or **Black/white** as the color.
9. Click **Color table...** to map pen size to the on-screen line color.
10. Click **Update**.
11. Click **OK**.
12. Confirm that you want to save changes to the model folder.

One way to send different drawing sizes to different folders is to set up a Microsoft Windows printer to print to file for each paper size you will use. Enter a different destination folder for each paper size in the Printer instances in Tekla Structures.

See also Setting up printer instances in Printer Catalog on page 299
Adding a printer instance on page 299
Printing to file on page 292
Printing drawings using Tekla Structures printer instances on page 287

Adding an Adobe postscript printer instance

To add a Adobe postscript printer instance to the Printer Catalog:
1. In **Printer Catalog**, click **Add**.
2. Enter a new printer instance name followed immediately (no spaces) by @ and the folder where Adobe Distiller should look for files. For example, `A4_PDF@c:\plots\pdf\in\`. 
3. Click **Add**.
4. Click **Browse...** to access the **Select Printer** dialog box. Click the Adobe postscript printer driver and then **OK**.

5. Set **Paper size** to **By print area**.

6. Enter the print area in **Print area h*b**.

7. Enter the file name extension **ps**.

8. Select **Black/white**, **Gray Scale** or **Color** as the color.

9. Click **Color table** to map pen size to the on-screen line color.

10. Click **Update**.

11. Click **OK**.

12. Confirm that you want to save the changes to the model folder.

**See also**  
- Defining print area h*b on page 303  
- Adding a printer instance on page 299  
- Printing drawings using Tekla Structures printer instances on page 287

**Defining paper size**

Use the **Paper size** setting in **Printer Catalog** to select the paper size used in printing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Named paper size</td>
<td>Tekla Structures lists a named paper sizes for most sizes A3 and smaller. Selecting one of the listed sizes is recommended for A3 printers and smaller.</td>
</tr>
<tr>
<td>By print area</td>
<td>The printer selects the paper size based on the print area. This option is recommended for A2 printers and larger. If you use a named paper size with a larger printer than A3, drawings larger than the print area are cropped to the size of the print area.</td>
</tr>
<tr>
<td>None</td>
<td>Sends no size information to the printer. This option provides legacy support for Xsteel 5.0 and is not recommended for use in other circumstances.</td>
</tr>
</tbody>
</table>

To print to different paper sizes, you can define several printer instances, each using a different paper size, but all connected to the same physical printer. For more information about setting up print devices in Microsoft Windows, see your operating system documentation.

**See also**  
- Adding a printer instance on page 299  
- Printing tips on page 305
Defining print area \( h \times b \)

When defining the print area, keep in mind the following facts:

- Tekla Structures uses the print area values to position the printout on the paper. Ensure that the values for \( h \) and \( b \) relate to the paper size required.

  Usually the value is the paper size less the hard clip margins of the printer. For example, if the paper size is 297*420, the print area could be 407 * 284. See your printer documentation for the hard clip margins of your printer.

- Usually for roll feed printers, \( h \) defines the roll width direction and \( b \) defines the roll feed direction. Usually for tray feed printers, \( h \) defines the tray feed direction, and \( b \) defines the tray width direction. Enter the values, and test how the printing works. If you can see, that the direction is wrong, switch the \( h \) and \( b \) values.

- When you are printing from Tekla Structures, it uses the values set for the printer in the Tekla Structures printer instance settings in the Printer Catalog, and overrides for these settings the Windows printer settings.

See also Setting up printer instances in Printer Catalog on page 299
Adding a printer instance on page 299

Colors and line weights in printing

Different screen colors can be mapped to different line weights in the Color Table dialog box that can be opened from the Printer Catalog. The pen numbers in Color Table correspond to the line weights used in the printed drawing. Pen number settings are printer instance specific.

The line weight displayed on the screen in drawings is taken from the first printer on the printer list.

See also XS_BASE_LINE_WIDTH

Setting up printer instances in Printer Catalog on page 299
Colors in drawings on page 261
Pen numbers in Color Table on page 265
Changing the pen numbers for colors (line weight) on page 265
**Printing settings in Print Drawings dialog box**

When you have activated the **Print drawings** command, for example, from the toolbar, the **Print Drawings** dialog box is displayed. It contains options for setting up printing.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Print to file</strong></td>
<td>Prints the drawing to a file.</td>
</tr>
</tbody>
</table>
| **Include revision mark to file name** | Adds the latest revision of the printed drawing to the filename.  
Revision number is used by default. However, if you set the advanced option `XS_SHOW_REVISION_MARK_ON_DRAWING_LIST` to `TRUE`, the revision mark is used. |
| **Scaling**                  | **Auto** fits the drawing to the **Print area h*b** size, i.e. fits it to the paper. This is useful, for example, when you are printing draft drawings on A4. With this option you can include everything in the printout, but the scale of the drawing may be affected as drawing size is fitted to the **Print area h*b**.  
With **Auto**, if the drawing size is smaller than the paper, the drawing is scaled up to fill the defined **Print area h*b**, keeping the aspect ratio.  
Entering an exact scale in the **Scale** box scales the drawing manually to the defined scale.  
Examples on **Scale**: 1.0 = 100%, 0.9 = 90% |
| **Print on multiple sheets** | Prints the drawing on multiple small sheets.                                  |
| **Number of copies**         | Defines the number of copies.                                                |
| **Orientation**              | **Auto** orientates the drawing to suit the paper.  
**Landscape** prints the drawing horizontally - as it is displayed on the screen.  
**Portrait** prints the drawing vertically. |
| **Print area**               | **Entire drawing** prints the entire drawing.  
**Visible area** prints the area visible in the current drawing window. |
| **Add/Edit**                 | Add or delete printer instances, or modify their settings.                  |
| **Frames**                   | Opens a dialog box where you can select to print frames and foldmarks.      |
| **Printer setup**           | Opens the Windows print setup dialog box where you can change the printing settings for the current Tekla Structures session only. The changes that you make are not saved for the printer permanently. |
Printing tips

Here are some tips that help you print drawings the way you want.

• If you are printing a drawing to a smaller paper, the line weights are scaled accordingly. This means that no lines are drawn too thickly and the drawings are more readable.

• You can force a drawing to use a different size paper: Open the drawing and go to Drawing Properties --&gt; Layout. In Size definition mode, select Specified size. Insert the required sheet size into Drawing size.

• If a drawing does not fit to the paper or is printed to a wrong location, use the Offset for print origin option in the Printer Catalog to move the drawing print origin for the selected printer instance.

  The advanced options XS_PLOT_ORIGIN_MOVE_X and XS_PLOT_ORIGIN_MOVE_Y move the print origin in the x or y direction for all printer instances. If you set values for the advanced options, they are used instead of the Offset for print origin value.

• You can disable the print date information to prevent the loss of information when working with multi-user models. This is useful in cases where a user modifies drawings while another user prints the same drawings. Use the XS_DISABLE_DRAWING_PLOT_DATE to disable the print date.

• You can add several Windows printer drivers for the same physical printer, and define an exact paper size for each printer driver in Windows printer driver printing preferences or printing defaults. Then in Tekla Structures, you can set printer instances so that you select the printer driver that matches the desired paper size. See the table at the end.

• If you only have one Windows printer driver for one physical printer, define the largest paper size you are going to use for that printer driver in Windows printer driver printing preferences or printing defaults, for example, A0. Then in Tekla Structures, you can use that one printer driver, and set several printer instances for it, each using the necessary paper size. See the table below.
<table>
<thead>
<tr>
<th>Physical printer</th>
<th>Windows printer drivers</th>
<th>Tekla Structures printer instances</th>
</tr>
</thead>
<tbody>
<tr>
<td>One printer.</td>
<td>Separate Windows printer drivers for each needed size.</td>
<td>Separate Tekla Structures printer instances are defined for each needed size, each printer instance is using the printer driver with a matching paper size.</td>
</tr>
</tbody>
</table>

- A0
- A1
- A2
- A3
- A4

| One printer.     | One Windows printer driver. The printer driver is set to the biggest needed paper size. | Separate Tekla Structures printer instances are defined for each needed size, the same printer driver is used for each printer instance. |

- A0
- A1
- A2
- A3
- A4

See also  Printing drawings using Tekla Structures printer instances on page 287
Setting up printer instances in Printer Catalog on page 299
Modifying drawing settings

Drawing settings tell Tekla Structures what the drawing should look like and what it should include.

**Automatic drawing settings** are settings that are defined through:

- Drawing, view and object properties in various drawing types. The properties are stored in properties files. Properties can be defined separately for each drawing that you create, but it is advisable to save the most commonly used settings in properties files for future use, for example, in **Master Drawing Catalog**. When creating a new drawing, always start by loading automatic drawing properties that you think contain the best settings for the drawing you are creating, and then adjust them as required before creating the drawing. Properties can be adjusted also after you have created the drawing.

You can open the drawing properties dialog boxes for setting the automatic drawing properties by selecting **Drawings & Reports** --> **Drawing Settings** and then selecting the drawing type.

- Drawing settings that are defined through various options and advanced options in **Options** and **Advanced Options**.

- Additional settings files, such as **rebar_config.inp** for setting reinforcement, and **hatch_types1.pat** for setting hatch patterns.

**Single-part, assembly and cast unit drawing properties**

These drawings contain two types of automatic properties: drawing-specific and view-specific. Drawing-specific properties apply to the whole drawing: drawing titles, drawing layout, user-defined properties, protection settings, and some detail and section view properties.
View-specific properties are defined separately for each view that you select to create. For example, you might want to show marks in one view, dimensions in another, and surface treatment in the third one. You can create as many views as you need.

To specify the drawing views to create and the properties to use, follow the path shown in the image below. First select the views to create and select view properties to be used for the views. If you need to adjust view properties or create new ones, click View properties and adjust the view properties, including the properties for dimensions, filters, marks and objects. Always use Save to save the view properties, otherwise your changes are not saved.
Drawing-specific and view-specific properties in single-part, assembly and cast unit drawings can be modified in an open drawing by double-clicking the drawing background or the view frame, respectively. The available properties are the same as in the dialog boxes shown above.

**General arrangement drawing properties**

Automatic drawing properties for general arrangement drawings can be defined on drawing level before creating the drawing. You can modify the drawing level properties in an open drawing by double-clicking the drawing background.
You select the views that you want to create after activating the creation of a general arrangement drawing. You can adjust the view-level properties in an open drawing by double-clicking a view frame.
You can modify the dimension, mark and object properties manually in an open drawing and save the changed properties in properties files to be use later on for different purposes.
7.1 Modifying and saving automatic drawing properties before creating drawings

Tekla Structures creates drawings using the automatic drawing properties defined separately for each type of drawing.

Ensure that the drawing properties are set and the necessary drawing properties files or master drawings are available before creating drawings.

To modify and save automatic drawing properties:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.

2. If possible, load drawing properties closest to the ones you need by selecting a properties file from the list at the top.
   
   In general arrangement drawing properties, you need to click Load.

3. Do one the following, depending on the type of the drawing:
Single-part, assembly and cast unit drawings:

a. Go through the various properties in the options tree and adjust the values as requires.
   The check boxes next to the options are automatically selected when you change something for that particular option.

b. To adjust view-level settings (views, dimensions, marks and objects), click View creation, select the desired view and view properties file and click View properties.

c. Adjust the settings as required.

d. Click Save in View Properties to save the properties in the view properties file, when you are done.

e. Click OK in View Properties to return to the drawing properties.

General arrangement drawings:

a. Switch off the all the check boxes by clicking the on/off switch at the bottom.

b. Select the check boxes for only the options that you wish to change.

c. Go through the various properties in the drawing properties dialog box, and make the necessary changes.

d. Click OK in each subdialog box where you changed the properties to save the changes and to return to drawing properties.

4. Click Save to save the properties.
   If you want to save the changes in another drawing properties file, enter the new name.
   In general arrangement drawing properties, click Save as.

Now you can create a drawing using the modified drawing properties file.

7.2 Modifying drawing properties of an existing drawing

If you are not satisfied with the drawing settings after creating the drawing and checking it, you can modify the automatic drawing properties in the created drawing.

To modify the drawing properties of an existing drawing:

1. Open the drawing
2. Double-click the drawing background.
3. Do one the following, depending on the type of the drawing:
Single-part, assembly and cast unit drawings:

a. Go through the various options in the options tree and adjust the values as required.
   The check boxes next to the options are automatically selected when you change something for that particular option.

b. To adjust view-level settings (views, dimensions, marks and objects), click **View creation**, select the desired view and view properties file and click **View properties**.

c. Adjust the view properties as required.

d. Click **Save** in **View Properties** to save the properties in the view properties file, when you are done.

e. Click **OK** in **View Properties** to return to the drawing properties.

General arrangement drawings:

a. Switch all the check boxes off by clicking the on/off switch at the bottom of the dialog box.

b. Select the check boxes for only the options that you wish to change.

c. Go through the various options in the drawing properties dialog box, and make the necessary changes.

d. Click **OK** in each subdialog box where you changed the properties to save the changes and to return to drawing properties.

4. Click **Modify**.
   The drawing is changed according to the changes that you made in the drawing properties.

---

Some of the changes in you make require a drawing recreation. For more information, see **Settings affecting the recreation of drawings on page 315**.

---

You can also modify the properties of several drawings by selecting them from the **Drawing List**, right-clicking and selecting **Properties**.

---

**See also**  
Modifying view-level drawing properties on page 314
7.3 Modifying view-level drawing properties

Most of the properties that a single-part, assembly and cast unit drawing has are specified for each of the drawing views separately in the automatic drawing properties.

You can modify the view-level drawing properties after you have created the drawing. The changes you make apply only to the view that you have selected to modify.

To modify drawing properties on the view level after you have created a drawing:
1. Open the drawing.
2. Double-click a drawing view frame to open the drawing view properties dialog box.
3. The check boxes are off by default. When you touch a property, for example, select an option, Tekla Structures adds a check mark to the check box next to the option in the option tree.
4. Make the necessary changes.
5. Click Modify when you are ready with the changes.

The view changes according to the changes that you made in the drawing view properties.

Some of the changes in you make require a drawing recreation. For more information, see Settings affecting the recreation of drawings on page 315.

See also Modifying drawing properties of an existing drawing on page 313

7.4 Settings affecting the recreation of drawings

Changing the following settings requires the drawing to be recreated. The changes will be applied, and the drawing will be recreated only if and when you click Modify.

In the View creation panel:
- Coordinate system
- Around X
- Around Y
- Around Z
- Undeformed
- Unfolded
- New views added into the Views list.

If at least one of the above mentioned settings is changed, the Recreate the drawing option is automatically set to Yes and the drawing will be recreated when you click Modify. If you
manually set **Recreate the drawing** to **Yes**, the drawing will also be recreated. When **View creation** settings have changed and drawings will be recreated, you will get a warning message.

In the **Section view** panel:

- **Section depth**
- **Distance for combining cuts**
- **Left section**
- **Middle section**
- **Right section**

If at least one of the above mentioned settings is changed, Tekla Structures automatically recreates the drawing without giving a warning message when you click **Modify**.

If you only want to modify the view properties for one of the created views:

- If the changed properties are saved in the same file for all created views, the only way to modify the properties for one view is to set **Recreate the drawing** to **Yes**.

- If the changed properties are saved in a separate file not used for other created views, and that file is selected for the changed view in the **Views** list, then drawing will only be updated on **Modify**, not recreated.

See also  Preventing automatic drawing updates and recreation on page 316

Updating drawings when the model changes on page 272

7.5 **Preventing automatic drawing updates and recreation**

Below there are some tips that help you to prevent automatic drawing updates and recreation:

- Freeze the drawings where you do not want to update all associative objects on top of the drawing views. The building objects (parts, bolts, welds, etc.) are always updated in frozen drawings.

- Lock the drawings that you do not want to update.

- If you update a drawing that **has not been modified**, the drawing is recreated. Drawings are automatically recreated unless the drawing has been edited and then saved, or the drawing has been issued using the **Issue** functionality in the **Drawing List**. Use the advanced **XS_RECREATE_UNMODIFIED_DRAWINGS** to control the recreation of unmodified drawings.

- To prevent Tekla Structures from automatically updating drawings if the model changes, clear the value field of the advanced option **XS_INTELLIGENT_DRAWING_ALLOWED**.

See also  Settings affecting the recreation of drawings on page 315
7.6 Modifying and saving drawing object properties

You can change the properties of the objects in the drawings such as parts, marks, bolts, and welds, and save the object properties files for later use.

To modify and save object properties in an open drawing:

1. Open a drawing.
2. Double-click the object that you want to modify.
   For example, double-click a part.
3. Change the desired settings in the property dialog box.
   For example, go to the Appearance tab and change the part color.
4. In the box next to the Save as button, enter the name for the properties file and click Save as.
5. Click Cancel to close the object properties dialog box.

Now you have a new object properties file. You can load the properties in this file in other drawing objects, in this case, parts. You can also use the object properties files with filters to apply detailed object level settings.

See also Loading saved drawing object properties in an existing drawing on page 317

Loading saved drawing object properties in an existing drawing

You can change the object properties in an existing drawing by loading saved object properties.

To load saved object properties:

1. Open the drawing.
2. Double-click the drawing object you want to change to open the object properties dialog box. For example, double-click a part.
3. Select the desired object properties file from the list next to the Load button and click Load.

![Image of Save and Load buttons with red_part selected]
4. Click **Modify**.

Tekla Structures changes the drawing object according to the settings in the loaded object properties file.

**See also** Modifying and saving drawing object properties on page 317

### 7.7 Detailed object level settings

In addition to defining automatic drawing mark and object properties, you can also set up a special representation for marks and building objects in drawings and use these detailed object level settings for specific purposes. For example, you may want to define that all columns in a specific general arrangement drawing are shown in a specific color, and in all other general arrangement drawings in the default part color.

In general arrangement drawings, you can use detailed object level settings on both drawing and view level. In other drawing types, this setting is view specific.

In order to create detailed objects settings, you need to have:

- A filter that selects the objects that you want to be affected
- Object properties that you want to apply on the objects

**See also** Creating detailed object level settings in a general arrangement drawing on page 318

#### Creating detailed object level settings in a general arrangement drawing

Before creating the detailed object level settings, create the object properties that you want to use, and save the properties in a properties file. For example, in part properties, set the part color to blue and save the properties.

To create detailed object level settings on drawing level in general arrangement drawings:

1. Select **Drawings & Reports --> Drawing Settings --> General Arrangement Drawing**
2. Click **Filter** and create a drawing filter that selects the objects that you want to have special representation.
For example, create a filter that selects columns.

3. Save the filter by entering a name for it and click **Save as**.
4. Click **Cancel** to close the dialog box.
5. In the drawing properties dialog box, click **Edit settings**.
6. In the **Object level settings for drawing/for view** dialog box, click **Add row** and select the filters to be used, the drawing object types and the drawing object properties to be used.

By doing this, you are combining the filter, object type, and object property settings into detailed object level settings.

You can add several rows in detailed object level settings.

7. Give the object level settings a name and save using **Save as**.

Now you have new detailed object level settings to be applied on a drawing.

**See also**  
Modifying and saving drawing object properties on page 317  
Example: Applying detailed object level settings on drawing level on page 319

**Example: Applying detailed object level settings on drawing level**

In this example, different detailed object level settings will be set up for various types of building objects, such as beams, columns and braces. Before doing this, drawing object properties for beams, columns and braces have been created so that they have different colors. The drawing in question is a general arrangement drawing.

First you will make a general arrangement drawing filter, save detailed object level settings in a settings file and apply the new detailed object level settings on drawing level.

In this example, the filter uses part names defined in the model, similarly as in modeling filters.
1. Click **Drawings & Reports --> Drawing Settings --> General Arrangement Drawing**.
2. Click **Filter** in the drawing properties dialog box.
3. Create filters by **Part - Name** for column, beam, and brace and save the settings using **Save as** with different names, such as `ts_column`, `ts_beam` and `ts_brace`.

![General - Filter Properties dialog box](image)

4. Click **Cancel** to close the dialog box.
Now you have created the required filters needed for selecting the desired parts.
5. In the **General Arrangement Drawing Properties** dialog box, click **Edit settings**.

6. In the **Object level settings for drawing** dialog box, select the filters to be used, the drawing object types and the drawing object properties to be used:
   a. Click **Add row** and select `ts_column` as **Model object (Drawing filter)**, **Part** as **Drawing object type** and **column** as **Settings used**.
   b. Click **Add row** and select `ts_beam` as **Model object (Drawing filter)**, **Part** as **Drawing object type** and **beam** as **Settings used**.
   c. Click **Add row** and select `ts_brace` as **Model object (Drawing filter)**, **Part** as **Drawing object type** and **brace** as **Settings used**.
7. Save the detailed object level settings as `gatype1` using **Save as**.

---

Modifying drawing settings 320 Detailed object level settings
The same detailed object level settings can be used in other general arrangement properties, you do not need to create new ones.

8. Click **Cancel** to exit the dialog box.

9. Create a general arrangement drawing.

10. Open the created general arrangement drawing and double-click the drawing background to open the drawing properties.

11. Click **Edit settings**.

12. Load object level settings you created, in this example *gatype1*, and click **Load**.

13. Click **OK**.

14. Click **Modify** to apply the changes in the drawing.

15. Confirm the detailed object level changes by clicking **Yes** in the on **Object level settings changed!** confirmation message box.
Creating detailed object level settings in cast unit drawings

Before creating the detailed object level settings, create the object properties that you want to use, and save the properties in a properties file. For example, in reinforcement properties, set color to red and save the properties. You create detailed object level settings in the same way in single-part drawings and assembly drawings.

To create detailed object level settings on view level:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
   
   For example, select **Cast Unit Drawing**.

2. Click **View creation**, and click **View properties**.

3. Click **Filter** and create a view filter that selects the objects that you want to have special representation.
For example, create a filter that selects reinforcing bars in class 100 and 101.

4. Save the filter by entering a name for in the box at the top and clicking **Save**.
5. Click **View properties** in the options tree and click **Edit settings**.
6. In the **Object level settings for view** dialog box, click **Add row** and select the filters to be used, the drawing object types and the drawing object properties to be used.

By doing this, you are combining the filter, object type, and object property settings into detailed object level settings.

You can add several rows.
7. Give the detailed object level settings a name (here **class_100**) and save using **Save as**.

Now you have new detailed object level settings to be applied on a drawing.
Example: Applying detailed object level settings on view level

In this example, detailed object level settings will be set up for lifting anchors. Before doing this, drawing object properties for lifting anchors have been created so that they use different color. The drawing in question is a cast unit drawing.

First you will make a cast unit drawing view filter, save detailed object level settings in a settings file and apply the new detailed object level settings in a view.

1. Click Drawings & Reports --> Drawing Settings --> Cast Unit Drawing.
2. Click View creation --> View properties.
3. Click Filter in the drawing properties dialog box.

4. Create a filter by Reinforcing bar - Class and enter value 100 101.

5. Save the filter as class100filter and click Save.

Now you have the filter needed for selecting the reinforcing bar.

6. Click View properties in the options tree and click Edit settings.

7. In the Object level settings for view dialog box, select the filter to be used, the drawing object type and the drawing object properties to be used:
   a. Click Add row and select class100filter as Model object (Drawing filter), Reinforcing bar as Drawing object type and class100 as Settings used.

8. Save the detailed object level settings as class_100 using Save as.
The same detailed object level settings can be used in other cast unit drawing properties, you do not need to create new ones.

9. Click Cancel to exit the dialog box.

10. Create a cast unit drawing containing lifting anchors and open the drawing.

11. Double-click the view frame to open the View properties dialog box.

12. Click Edit settings.

13. Load object level settings you created, in this example class_100, and click Load.

14. Click OK.

15. Ensure that Use detailed object level settings is set to Yes.

16. Click Modify to apply the changes in the view.

17. Confirm the detailed object level changes by clicking Yes in the on Object level settings changed! confirmation message box.

The lifting anchors now have a different color, they are red.
7.8 How Tekla Structures applies drawing properties

Tekla Structures generates drawings according to the properties defined for each drawing type. You define the desired properties before you create the drawings. The way Tekla Structures connects the properties to the drawing you create depends on the method you select for creating the drawing:

- If you create the drawings in the **Master Drawing Catalog** using saved settings, Tekla Structures uses the properties defined in the saved settings file you select. Saved settings file in the **Master Drawing Catalog** is the same thing as the drawing properties file you save in various drawing properties dialog boxes.

- If you create the drawings in the **Master Drawing Catalog** using a rule set, Tekla Structures creates the drawing according to the properties defined in the saved settings file or cloning template file used in the rule set.

- If you create the drawings in the **Master Drawing Catalog** using cloning templates, Tekla Structures creates the drawing using the properties that you have defined for the drawing used as a cloning template together with the manual modifications that you have made in the drawing.

- If you create drawings through **Drawings & Reports** menu commands, pop-up menu commands or toolbar commands Tekla Structures uses the current drawing properties.

See also  
Modifying drawing settings on page 307  
Master Drawing Catalog on page 51  
Creating drawings on page 25  
Creating general arrangement drawings on page 47  
Creating single-part, assembly, or cast unit drawings on page 48

7.9 Drawing layout

A **drawing layout** defines which **drawing tables** to include in the drawing and the set of rules for increasing the drawing size when necessary. The layout connects a set of **drawing table layouts** and drawing sizes. Tekla Structures selects the smallest defined drawing size that will fit the drawing views and the connected table layout. This tells Tekla Structures which elements to include in the drawing automatically. Each drawing layout has its own:

- Table layouts
- Fixed drawing sizes
- Calculated drawing sizes

Tekla Structures has several predefined drawing layouts. Each drawing type; assembly, single-part, cast unit, general arrangement, and multidrawing, has its own layouts. You can also create customized layouts.
Using different layouts you can, for example, set assembly drawings to use A1 and A2 size
drawing sheets, and single-part drawings to use A3 and A4 sheets. Another example is that
you may want to include a material list in assembly drawings, but not in general
arrangement drawings.

Tekla Structures saves the new layouts you create in separate files with the file name
extension .lay. The layout files are located in the \attributes folder in the model folder. You
can copy them to project or firm folders defined by advanced options XS_FIRM and
XS_PROJECT.

See also Table layouts on page 327
Tables on page 329
Creating a new layout on page 330
Setting margins and spaces for drawing views on page 332
Creating and adding a new table layout on page 332
Adding tables in a table layout on page 333
Replacing a table with another one on page 333
Setting the properties of tables in a table layout on page 334
Key plans on page 335
Adding a DXG/DXF file in a table layout on page 337
Modifying tables in Template Editor on page 339
Selecting a new layout on page 338

Table layouts

A table layout is a group of tables or templates included in a drawing of a certain type and
size. The layout defines:

- Which tables are included in the drawing
- Where the tables are located in the drawing
- How much space Tekla Structures leaves between the drawing frame and views and
  between the drawing views

Table layouts define the background of the drawing, not the number or location of the
drawing views to include. You can use the same table layout with different drawing sizes, or
give each drawing size its own table layout. For example, if the number of views changes in a
drawing and Tekla Structures chooses a new drawing size, Tekla Structures may also choose
another table layout.

The examples below illustrate the relationship between the table layout and drawing views.
The drawing views are blue, and the elements of the table layout are red.

Below is an example of a GA drawing layout.
1. General arrangement drawing view
2. Part list on assembly or cast unit level
3. Revision table and title block

Below is an example of an assembly drawing.

1. Margins between the drawing frame and the outermost views
2. Spaces between the views
3. Top view
4. Front view
5. Section views A-A and B-B
6. Drawing frame
7. Key plan
8. Revision table
9. Material list
10. Drawing title block
11. Table layout consists of several elements
12. Fold marks

See also  Adding frames and foldmarks in drawings on page 296
Creating and adding a new table layout on page 332
Adding tables in a table layout on page 333
Replacing a table with another one on page 333
Setting the properties of tables in a table layout on page 334
Drawing layout on page 326

Tables

The term table refers to various elements of the drawing layout, such as:

- Tables (such as revision tables)
- Title blocks
- Lists (such as part and bolt lists)
- General notes
- Key plans
- DWG/DXF files

Tables contain information on model objects. If you change the model, Tekla Structures updates the contents of the affected drawings and tables. The contents of the tables are filled in by Tekla Structures at run time. You can create tables in Template Editor. In Template Editor, the tables are referred to as templates.

The available graphical templates are read from the following folders in the following order, and shown in the Available tables list in the Tables dialog box:

- Template directory (XS_TEMPLATEDIRECTORY)
- Current model folder
- Project folder (XS_PROJECT)
- Firm folder (XS_FIRM)
- Environment-specific system templates folder (XS TEMPLATEDIRECTORY_SYSTEM)
- System folder (XS_SYSTEM)
Creating a new layout

If none of the layouts meet your needs, you can create a new one from scratch or on the basis of an existing layout.

To create a layout:

1. Click **Drawings & Reports --> Drawing Settings --> Drawing Layout**.
2. Do one of the following:
   - To create a new layout from scratch, enter the name of the new layout in the box under the list of layouts and click **Add**.
     The new layout is empty.
   - To create a new layout on the basis of an existing layout, select a layout from the list and enter a new name for the new layout in the box under the list of layouts and click **Add**.
     The contents of the new layout are the same as those of the layout you selected from the list.
3. Define and add table layouts and fixed and calculated sizes in the empty layout or modify the table layouts and fixed and calculated sizes in the layout you created on the basis of an existing layout.
4. Close the dialog box.

Now you can use the new layout in your drawings.

See also  Defining fixed sizes on page 330
Defining calculated sizes on page 331
Drawing layout on page 326

**Defining fixed sizes**

Fixed drawing sizes have a specific size (width and height), and table layout. You can use fixed sizes in autosizing.

To define the fixed drawing sizes in a layout:

1. Click **Drawings & Reports --> Drawing Settings --> Drawing Layout**.
2. Select the layout and click **Fixed sizes**.
3. Select a fixed size from the list.
   To create a new size, enter its name and click Add.
4. Enter the width and height.
5. Select the table layout.
6. Click Update.
7. Repeat steps 3–6 for each fixed size.
8. Click Apply or OK.

---

Use fixed sizes when you print drawings to small (A4 and A3) printing devices.
Single-part and assembly drawings also typically use fixed drawing sizes.

See also
Creating a new layout on page 330
Drawing size and drawing view scale on page 339

**Defining calculated sizes**

You can use calculated drawing sizes to define the rules Tekla Structures follows when it automatically adjusts drawing size. You can also connect layouts to drawing sizes that meet certain criteria.

To set the rules and connect layouts:
1. Click Drawings & Reports --> Drawing Settings --> Drawing Layout.
2. Select the layout and click Calculated sizes.
3. Use Increasing step to define the interval by which Tekla Structures increases the drawing size when it needs to.
   This can be set individually for drawing width and height. You can also define the maximum size of the drawing. If the drawing exceeds the width or height limit you set here, Tekla Structures uses an oversize sheet with no table layout.
4. You can connect a layout to drawings that meet one of the following size criteria:
   - **Size A4** for drawings exactly this size
   - **Size A3** for drawings exactly this size
   - **Height = A3** for drawings having the same height as an A3 sheet (=297 mm)
   - **Height > A3** for drawings with a larger height than A3.
     For each size, Tekla Structures makes the table layouts available depending on the layout you select.
5. Click OK or Apply.
Creating and adding a new table layout

To create a new table layout and add in a layout:
1. Click Drawings & Reports --> Drawing Settings --> Drawing Layout.
2. Select a layout from the list of layouts.
3. Click Table layouts to display the Table Layouts dialog box.
4. Enter the name of the new table layout in the box under the list of table layouts and click Add.
5. Enter the margins between the drawing views and frame, and the spaces between two drawing views in Margins and Spaces.
6. Click Tables to display the Tables dialog box.
7. Add tables in your table layout, define the location, scale and transparency settings for each table.
8. After each table you add, click Update.
9. Click OK or Apply to save the table layout.

See also Table layouts on page 327
Setting margins and spaces for drawing views on page 332
Setting the properties of tables in a table layout on page 334

Setting margins and spaces for drawing views

Table layouts define the margins between the drawing views and the frame, and the space between two drawing views.

A margin is the width or height from the outermost drawing views to the drawing frame. A space is the horizontal or vertical distance between two drawing views.

To set the margins and spaces:
1. Click Drawings & Reports --> Drawing Settings --> Drawing Layout.
2. Select a layout and click Table layout.
3. Select the table layout on the list.
4. Enter margins and spaces.
5. Click Update.
6. Repeat step 3–5 for each table layout.
7. Click OK or Apply.

See also  Table layouts on page 327
Creating and adding a new table layout on page 332

Adding tables in a table layout
To add tables (Template Editor templates, key plans, DWG/DXF files) in a table layout:
1. Open the Tables dialog box by clicking Drawings & Reports -- Drawing Settings --> Drawing Layout.
2. Select a drawing layout and click Table Layout.
3. Select a table layout and click Tables.
4. On the Available tables list, double-click each table you want to include in the table layout.
   You can also use the arrow buttons to add and remove tables.
5. Set the table properties as required for each table you add.
6. Click Update.
7. Click OK or Apply.

See also Setting the properties of tables in a table layout on page 334
Table layouts on page 327
Modifying tables in Template Editor on page 339

Replacing a table with another one
Be careful when you delete tables from table layouts. Other tables may use the table as a reference object. Also, when you replace tables with new ones, the new ones do not inherit the location of the deleted tables.
To delete a table from a table layout and replace it with a new one:
1. Select Drawings & Reports --> Drawing Settings --> Drawing Layout to display the Layout dialog box.
2. Select a drawing layout and click Table Layouts.
3. Select a table layout and click Tables.
4. Check if the table you are going to delete is used as a reference the table for another table. If it does, and you delete the table, you cannot see any tables at all in the layout.
5. Delete the table that you wish to replace by selecting the table from the Chosen tables list and clicking the left arrow.

6. Select a new table from the Available tables list and add it to the Chosen tables list by clicking the right arrow.

7. Define the binding point of the new table and its location relative to the reference object.

8. Set the transparency, scale and the distance from the reference object, if necessary.

9. Click Update and OK.

10. Click Update and OK in the Table Layouts dialog box.

11. Click OK in the Layout dialog box.

See also  Table layouts on page 327  
Adding tables in a table layout on page 333

Setting the properties of tables in a table layout

You can define the location of each individual table in a table layout by binding it to the drawing frame or to another table.

In the illustration below, the lower right corner of the drawing title (table) is bound to the lower right corner of the drawing frame (reference).

To set the properties of a table in a table layout:

1. Open the Tables dialog box by clicking Drawings & Reports --> Drawing Settings --> Drawing Layout .

2. Select a layout and click Table Layout .

3. Select a table layout and click Tables.

4. Select a table from the Chosen tables list.

5. Choose one of the table corners as its reference point, and select the check box in that corner.
6. In the **Reference** box, select the reference object, which can be another table included in the table layout, or the drawing frame.

7. Choose the reference point of the reference object, and select the check box in the appropriate corner.

8. In the **Vector between corners** boxes, define the horizontal and vertical distance of the table from the reference object.
   
   By default, Tekla Structures places tables side by side.

9. In **Scale**, set the size of the table relative to its original size.
   
   Each table can have its own scale.

10. If you want the table to be transparent, select the **Transparent** check box.
    
    A transparent table can overlap with another table, view or drawing object.

11. Click **Update**.

12. Repeat steps 2–11 for all the tables on the **Chosen tables** list.

13. Click **OK** or **Apply** to save the table layout.

---

You can also position a table in the midpoint of a frame or table boundary by selecting two reference points, for example, the lower left and right corners.

If you do not use the right combinations of reference points for tables and binding objects, Tekla Structures may position drawing tables outside the drawing.

---

**See also**

- Table layouts on page 327
- Tables on page 329
- Adding tables in a table layout on page 333
**Key plans**

A key plan or a key plan view is a small map in a drawing that indicates the location of an assembly, a cast unit, or a part in the model. The key plan contains the model grid and the assembly, cast unit, or part shown in the included drawing view.

---

**Adding a key plan in a table layout**

Before you start, create a drawing that you want to use as a key plan.

To add a key plan in a layout:

1. Click **Drawings & Reports --> Drawing Settings --> Drawing Layout**.
2. Select the layout you want to modify and click **Table layout**.
3. Select the table layout you want to modify and click **Tables**.
4. From the Available tables list, double-click **Key plan**. The Drawing List is displayed.
5. Select the drawing that you want to use as a key plan drawing and click **OK**.

---

See also

Adding a key plan in a table layout on page 336

Setting up a drawing view to be used as a key plan on page 337

Table layouts on page 327
6. From the Chosen tables list, select Key plan and set the key plan properties.
7. Click Update.
8. Click OK.

Now you can create a drawing using the layout containing the key plan. Check the drawing properties before creating a drawing to ensure that you are using the correct layout.

**See also**  Setting the properties of tables in a table layout on page 334

---

**Setting up a drawing view to be used as a key plan**

Tekla Structures automatically includes the correct part in the key plan. Drawings that contain only one view of the correct scale can be used as a key plan. Tekla Structures only uses the view from the drawing, and the view position, drawing size, and templates are not relevant to a key plan drawing.

Set the view properties for the key plan as follows:

1. Open the drawing and double-click the view boundary to open the View Properties dialog box.
2. Set the desired drawing scale.
   Tekla Structures uses the scale of the key plan view in every drawing using it. You cannot change the scale in the layout properties.
3. Set the drawing view boundaries so that all parts are visible. To do this, change the $x_{\text{min}}$, $x_{\text{max}}$, $y_{\text{min}}$, and $y_{\text{max}}$, or select the view and drag the boundary using the handles on the x and y axes of the view.
4. Set other view properties.
   All the changes you make in the properties affect the key plan. For example, if you set part and bolt marks to be visible, they will also be visible in the key plan.
5. Click Modify.

---

Do not filter out anything indicated with not in drawings that will be used as key plans. Tekla Structures clears the not check boxes in the filter automatically when the key plan is inserted in another drawing.

**See also**  Key plans on page 335
Adding a DXG/DXF file in a table layout

You can add DWG and DXF files in table layouts. For example, you might have some details in a DWG or DXF file that you want to show in certain types of drawings and therefore add the file in the layout.

To add a DWG or a DXF file in a table layout:

1. Click **Drawings & Reports --> Drawing Settings --> Drawing Layout**.
2. Select the layout you want to modify and click **Table layout**.
3. Select the table layout you want to modify and click **Tables**.
4. From the **Available tables** list, double-click **DWG/DXF**.
5. Select the DWG/DXF file that you want to add.
6. Click **OK**.
7. From the **Chosen tables** list, click the selected DWG/DXF file and set the properties as required.
   
   For example, set the required scale and define the location for the DWG/DXF file in the drawing. Test the layout before using it to ensure, that the settings are as you wish.
8. Click **Update**.
9. Click **OK**.

Now you can create a drawing using the layout containing the DWG/DXF file. Check the drawing properties before creating a drawing to ensure that you are using the correct layout.

See also  
Setting the properties of tables in a table layout on page 334
Adding links to DWG and DXF files on page 191

Selecting a new layout

You can define which layout to use in a drawing in drawing properties. The layout information is stored in the drawing property files. We recommend that you create as many property files as you need different layouts for the different drawing types.

To select a new layout and save the layout information in a drawing property file:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Click **Layout**.
4. Select a new layout from the **Layout** list.
5. General arrangement drawings: Click **OK**.
6. Click **Save** to save the changed properties and **OK** to close the drawing properties dialog box.

Now you can create a drawing using the drawing property file that contains the changed layout information.

**See also**  [Drawing layout on page 326](#)

### Modifying tables in Template Editor

If you need to modify the tables in the drawing, open them in Template Editor (TplEd). In the Template Editor, tables are called templates. You can only open tables with templates created or saved in Template Editor version 3.2. or later.

If your templates are located in a protected folder, the templates are read-only. You cannot save a modified template in a protected folder if you are not an administrator. You may save the modified in the model folder, firm folder or project folder, for example.

To modify a table:

1. In a drawing, double-click the table you want to modify.

2. Tekla Structures shows the following message:

   ![Tekla Structures dialog](image)

   **Tekla Structures**
   
   You are about to edit this template.
   
   To apply the changes in this drawing, save the template after editing and reopen the drawing.
   
   Please note that this change will be applied in all drawings that have this template in the drawing layout definition.
   
   Do you want to edit this template in Template editor?
   
   ![Yes] ![No]

3. Click **OK**. Tekla Structures starts the Template Editor, and the selected table is displayed.

4. Modify the template an save the changes by selecting **File** --> **Save**.

For more information about the Template Editor, see the TplEd help, which is also available in PDF format on the Tekla Structures installation DVD.

**See also**  [Tables on page 329](#)
7.10 Drawing size and drawing view scale

Tekla Structures offers you several combinations of settings that you can use for defining the drawing size and the drawing view scale. Which one you use, depends on your needs:

- If you always want to use a certain scale, then you would set the exact scale to be used and let Tekla Structures automatically select the drawing size that suits the selected scale. This is called autosizing. You can define different scales for main views and section views. All main views in a drawing automatically use the same scale unless you fine-tune individual views manually.

- If you always need to use a certain drawing size, for example, A3, A4 or A1, then you would set the size and let Tekla Structures automatically select the drawing view scale that suits the selected size. This is called autoscaling.

- If you are not bound to any specific drawing sizes or drawing view scales, you might want to let Tekla Structures take care of both.

See also
- Modifying and saving automatic drawing properties before creating drawings on page 312
- Using exact drawing size and automatic drawing view scale on page 341
- Using exact drawing view scale and automatic drawing size on page 340
- Autoscaling and autosizing drawings on page 342

Using exact drawing view scale and automatic drawing size

You can let Tekla Structures find appropriate sizes and table layouts for drawings. This is very useful if, for example, the number, size, or location of drawing views might change. Tekla Structures automatically updates drawings to adapt to these changes by using different drawing sizes and table layouts.

To define exact drawing view scale and let Tekla Structures automatically select the suitable drawing size:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click Layout.
4. Set Size definition mode to Autosize.
5. Select the set of drawing sizes for Tekla Structures to use. You have the options:
   - **Calculated sizes**: Use this when you want to define the rules that Tekla Structures follows when it tries to adjust the drawing size.
   - **Fixed sizes**: Use this when you want Tekla Structures to use fixed drawing sizes A2, A3, A4, etc.
   - **Calculated/fixed sizes**: Use this when you want Tekla Structures to select the smallest of the suitable sizes.
6. Go to the Scale tab and set Autoscale to No.
   This way Tekla Structures uses the exact scale that you have set for the main views and section views.

7. Click View creation, select the view and the properties that you want to change, and click View properties.

8. On the Attributes 1 tab, set the desired Scale.

9. Click Save to save the drawing properties, then click OK and create the drawing.
   When you create the drawing, Tekla Structures creates the views using the selected scale and selects the smallest drawing size where the views fit in the drawing. Tekla Structures may also need to change the table layout to adapt to the new drawing size. It will then use another appropriate table layout within the same layout specified in drawing properties.

See also
- Drawing size and drawing view scale on page 339
- Drawing layout on page 326
- View properties in drawings on page 529
- Section view properties on page 532

Using exact drawing size and automatic drawing view scale

If you need to use a specific size in your drawings, for example, A3, A2, or A1, you can specify the exact size, and let Tekla Structures automatically select the suitable drawing view scale. The drawing size should always be smaller than the actual paper size to accommodate printer margins.

To use exact size and automatically scale the view:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click Layout.
4. On the Drawing size tab, set Size definition mode to Specified size and enter the drawing size.
5. Select the table layout from the Table layout list.
6. On the Scale tab, set Autoscale to Yes.
7. Set the main view and section view scales.
   Enter the denominators of scales and separate them with spaces. For example, enter "5 10 15 20" for the scales 1/5, 1/10, 1/15, and 1/20.
8. Select the Scale change mode, which defines the relationship between the scales of main and section views within a drawing.
   The options are:
   - main = section: The scales of the main and section view are equal.
• **main < section**: Main view scales are smaller than section view scales.
• **main <= section**: Main view scales are smaller than or equal to section view scales.

9. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

10. Enter the preferred scale.
   
   Do the same for each view that you create.

11. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

Tekla Structures creates the drawing using the specified size. Tekla Structures first tries to use the preferred scale for the drawing views, then the alternative scales, and selects the largest possible scale.

See also  
- Drawing size and drawing view scale on page 339
- Drawing layout on page 326
- View properties in drawings on page 529
- Section view properties on page 532

### Autoscaling and autosizing drawings

If you are not bound to any specific drawing sizes or drawing view scales, you can let Tekla Structures take care of both.

To use both autoscaling and autosizing:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.

2. Load the properties that you want to change.

3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. On the **Attributes 1** tab, set the preferred drawing view scale.
   
   Do the same for all of the views you plan to create.

5. Click **Save** to save the view properties.

6. Click **OK** to return to drawing properties.

7. Click **Layout**, go to the **Scale** tab and set **Autoscale** to **Yes**.

8. Set the alternative main view and section view scales.

9. Select the **Scale change mode**.

10. Enter the **Preferred size**.

11. On the **Drawing size** tab, set **Size definition mode** to **Autosize**.

12. Select the set of drawing sizes (**Calculated sizes**, **Fixed sizes** or **Calculated/Fixed sizes**).
13. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

When you use both autoscaling and autosizing at the same time, Tekla Structures follows the steps below:

- First Tekla Structures tries to find a drawing size where the drawing contents fit by first trying to use the exact scale defined in **View properties** ***Attributes 1*** and the smallest drawing size defined in the current layout (**Drawings & Reports** ***Drawing Settings*** ***Layout*** ***Calculated/Fixed sizes***).
- Then Tekla Structures increases the drawing size until it reaches the **Preferred size** defined in **Layout** ***Scale***.
- If the drawing fits with the original scale, Tekla Structures tries to increase the scale using the alternative main and section view scales you defined in **Layout** ***Scale***.
- If the drawing does not fit to any of the defined scales, Tekla Structures starts to increase the drawing size until the contents fit, using the fixed or calculated sizes or both. When necessary, Tekla Structures changes to another appropriate table layout within the current layout.
- When the views fit, Tekla Structures begin to increase the scale again so that the final drawing uses the largest possible scale.

See also **Drawing size and drawing view scale on page 339**
**Drawing layout on page 326**
**View properties in drawings on page 529**
**Section view properties on page 532**

### 7.11 Object protection and placement settings in drawings

When you create a drawing, Tekla Structures uses predefined rules for positioning annotation objects such as marks and dimensions. The annotation objects are automatically placed in the first suitable position considering the following settings:

- The protected areas defined in drawing properties. How the protection settings are applied depends on the drawing order of the objects in the drawing: the parts are drawn first, then the marks and then the dimensions.
- The placing and leader line type settings of the annotation objects defined in the annotation object properties. Marks are usually drawn before dimensions, but if the marks have leader lines, they are drawn after the dimensions.
- The predefined mark location and part orientation settings for some marks.
- The modeling direction of parts.

You can modify the placement settings and select the leader line type in the object level dialog boxes of texts, notes, marks and dimensions. On the object level, you can select if you want to use fixed or free placement. The protection settings for the whole drawing are also considered when you add annotation objects manually.
You can access the **Protection Properties** through the drawing properties dialog box:

When you create a drawing, Tekla Structures places the views in the drawing according the settings in the drawing layout and view properties. In final drawings, you can select whether to use fixed or free view placement of views.

See also:
- Protected areas on page 344
- Protecting areas in drawings on page 346
- Defining placement settings for annotation objects on page 347
- Defining automatic free or fixed placement of drawing views on page 349
- Defining placement settings for dimensions on page 348
- Placement properties for annotation objects on page 586

**Protected areas**

You can define protected areas in drawings to prevent text, marks or dimensions from being placed in the area. When Tekla Structures places text, marks, dimensions or other annotation objects in a drawing, it first checks the protection settings.

The drawing properties files contain predefined protection properties, which you may change. When you load the drawing properties, the protection settings in the loaded file are applied in your drawing.

Below is an example of the protection properties dialog with explanations of the selections.

1. With a selection like this, text and marks may overlap with part corners and edges, but not with part content.
2. With a selection like this, dimension values may not overlap with other dimension arrowheads, lines or values.

The objects on the top define the areas to be protected, see descriptions below:

<table>
<thead>
<tr>
<th>Column</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Part corners" /></td>
<td>Part corners</td>
</tr>
<tr>
<td><img src="image" alt="Part edges" /></td>
<td>Part edges</td>
</tr>
<tr>
<td><img src="image" alt="Part content" /></td>
<td>Part content</td>
</tr>
<tr>
<td><img src="image" alt="Text, mark or weld mark" /></td>
<td>Text, mark or weld mark</td>
</tr>
<tr>
<td><img src="image" alt="Dimension arrowhead" /></td>
<td>Dimension arrowhead</td>
</tr>
<tr>
<td><img src="image" alt="Dimension line" /></td>
<td>Dimension line</td>
</tr>
<tr>
<td><img src="image" alt="Dimension value" /></td>
<td>Dimension value</td>
</tr>
<tr>
<td><img src="image" alt="Cutting line" /></td>
<td>Cutting line</td>
</tr>
<tr>
<td><img src="image" alt="Section mark" /></td>
<td>Section mark</td>
</tr>
<tr>
<td><img src="image" alt="Weld arrow" /></td>
<td>Weld arrow</td>
</tr>
<tr>
<td><img src="image" alt="Weld mark content" /></td>
<td>Weld mark content</td>
</tr>
</tbody>
</table>

The objects on the left define which objects, or object elements, Tekla Structures cannot place in the protected areas. See the descriptions below:

<table>
<thead>
<tr>
<th>Row</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Text, mark or weld mark" /></td>
<td>Text, mark or weld mark</td>
</tr>
<tr>
<td><img src="image" alt="Dimension arrowhead" /></td>
<td>Dimension arrowhead</td>
</tr>
<tr>
<td><img src="image" alt="Dimension line" /></td>
<td>Dimension line</td>
</tr>
</tbody>
</table>
You can check which areas are protected by using the **Draw Protect** command. This command is available in the **Customize** dialog box, and you can add it on a toolbar.

When you click the **Draw Protect** button, the protected areas are shown with colors.

<table>
<thead>
<tr>
<th>Row</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Icon" /></td>
<td>Dimension value</td>
</tr>
</tbody>
</table>

See also

- Protecting areas in drawings on page 346
- Object protection and placement settings in drawings on page 343

### Protecting areas in drawings

To protect areas in the drawings:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Click **Protection**.
4. Select check boxes to indicate the areas that you want to protect from text, marks, weld marks, associative notes, dimension arrowheads, dimension lines or dimension values.

   - For example, to prevent text, marks, dimensions or other annotation objects from being placed over the inside area of parts, select the third check box on the first row. The first row defines the placement of annotation objects, and the icon above the third check box indicates the inside area of parts. With this setting, Tekla Structures may place annotation objects on the corners and edges of parts.

   - If you clear the first two columns of check boxes, Tekla Structures does not protect part corners and edges. This increases drawing speed and decreases the memory...
requirements. You can still protect these areas by using the third column of check boxes for part protection.

5. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

See also  
- Object protection and placement settings in drawings on page 343
- Protected areas on page 344
- XS_USE_CONVEX_PROTECT_AREA

**Defining placement settings for annotation objects**

You can define automatic placement settings for the annotation objects before creating a drawing. You can modify the settings in an open drawing.

To define placement settings for annotation objects before you create a drawing:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click an object that you want to adjust, for example **Part Mark**.
5. On the appropriate tab, click the **Place** button to open the **Placing** dialog box.
6. Adjust the placement settings. The options available in the dialog box vary depending on the annotation object type.
   - In **Minimum distance**, enter the closest distance Tekla Structures should use to place the drawing object.
   - In **Maximum distance**, enter the farthest distance Tekla Structures should use to place the drawing object, for example, a mark. If no place for mark is found within the specified distance, Tekla Structures will force the mark to that distance.
   - In **Search margin**, enter the minimum distance within which Tekla Structures searches for a space to place the object.
To move marks away from each other, use **Search margin**, not **Minimum distance**. Keep the minimum distance setting as small as possible to reduce the possibility of marks overlapping.

Select the **Quarter** to define the areas Tekla Structures searches for a space to place the object.

7. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties.

8. Click **OK**.

9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**  
Object protection and placement settings in drawings on page 343  
Placement properties for annotation objects on page 586

**Defining placement settings for dimensions**

You can control the space between parallel dimension lines and the location of the dimension in relation to the object it is dimensioning. You can also select whether to place short dimension text inside or outside the dimension.

In single-part, assembly and cast unit drawings, these settings can be defined only on object level in an open drawing, saved into a dimension properties file and taken into use in **Dimensioning Rule Properties** dialog box. In general arrangement drawings the settings can be defined on drawing, view and object level.

To adjust dimension placement:

1. Go to the **General** tab of the **Dimensions** dialog box.

2. In **Dimension lines spacing**, enter the desired space between two parallel dimension lines.

3. Select whether to place short dimension text inside or outside of the dimensions from the **Short dimension** list.

4. Click **Place**.

5. In **Minimum distance**, enter the closest distance Tekla Structures should use to place the dimension.

6. If Tekla Structures cannot place the dimension at the minimum distance, it moves the dimension by the value you enter in the **Search margin** box. Tekla Structures tries to place the dimension using the **Search margin** value until it finds a place for the dimension.

7. Click **OK** to close the dimension placing dialog box.

8. Click **OK**.
Remember that in addition to dimension placement settings, the placement is also affected by Protection properties. Tekla Structures uses the protection properties to prevent marks and dimensions from being placed in protected areas.

See also
- Object protection and placement settings in drawings on page 343
- Protecting areas in drawings on page 346
- General dimension properties on page 533
- Dimension appearance properties on page 537

Defining automatic free or fixed placement of drawing views

You can always maintain the views in the same location or let Tekla Structures find a suitable place for the view during drawing updates using the Fixed or Free placement setting.

In general arrangement drawings, this setting can only be defined on view level in an open drawing.

To define automatic free or fixed placement of in single-part, assembly and cast unit drawings:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click View creation, select the view and the properties that you want to change, and click View properties.
4. On the Attributes 1 tab, select one of the following options:
   - Set Place to Fixed to always keep the view in the same location when you update the drawing.
   - Set Place to Free to let Tekla Structures find a suitable place for the view when you update the drawing.
5. Click Save to save the view properties.
6. Click OK to return to drawing properties.
7. Click Save to save the drawing properties, then click OK and create the drawing.

Arrange Drawing Views only affects views where the Place is set to Free. Fixed views are not moved.

See also
- Object protection and placement settings in drawings on page 343

Modifying drawing settings 349 Object protection and placement settings in drawings
7.12 Automatic drawing views

*Automatic drawing views* are views that you select to create in *View creation* before creating a single-part, assembly or cast unit drawing. You can define the desired drawing view properties before you create the drawings separately for each view.

When you create general arrangement drawings, you cannot select the views to be created in the general arrangement properties dialog box, but you select them when you activate the drawing creation. However, you can define automatic settings that apply to all the views you create in a general arrangement drawing.

**See also**
- Defining the views to create in single-part, assembly and cast unit drawings on page 350
- Defining automatic view settings for general arrangement drawings on page 351
- Defining view labels and view label marks on page 352
- Setting the view projection type on page 354
- Including single-part drawings in assembly drawings on page 355
- Part orientation in drawing views on page 356
- Showing neighbor parts in views on page 364
- Shortening and lengthening parts on page 365
- Unfolding polybeams in drawings on page 369
- Undeforming deformed parts in drawings on page 370
- Showing part openings and recesses in drawings on page 372
- Setting automatic section view properties on page 374

**Defining the views to create in single-part, assembly and cast unit drawings**

Before you create single-part, assembly or cast unit drawings, select the views that you want to include automatically in *View creation*. At the same time, set the view properties.

To select the drawing views to be created and set the view properties:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the drawing properties file that you want to modify from the list at the top.
3. Click **View creation**.
4. Click the **Attributes** tab and change the settings as required.
5. Select the views you want to create. You can create as many views as you like.
   - If you select off, Tekla Structures does not create the view, but dimensions the parts in the available views. If you set all four main views off, Tekla Structures will still create one front view.
• If you select on, Tekla Structures always creates the view, even if it was not necessary in order to show the dimensions. For section views, Tekla Structures creates one additional section view showing the middle of the main part. For end views, Tekla Structures creates an end view from one end of the main part.

• If you select auto, Tekla Structures creates the view if it is necessary in order to show the dimensions. For section views, Tekla Structures creates the necessary number of views to show all the dimensions. For end views, Tekla Structures also creates another end view from the other end of the main part, if there are dimensions at that end.

6. For each of the views that you create, select the view properties that you want to use in the View properties column.

The lists contain predefined properties for different types of drawings, and also the view properties that you save on the View Properties panel.

7. Check the view properties for each view by selecting the view from the list and clicking View properties.

8. Check the settings on the Attributes 1, Attributes 2, and Label tabs and change them as required.

9. Modify dimensioning, mark and object settings as required.

10. Save the view properties by clicking Save.

11. Click OK.

12. Click Save to save the drawing properties, then click OK and create the drawing.

See also View properties in drawings on page 529
Section view properties on page 532
Automatic drawing views on page 350
Modifying and saving automatic drawing properties before creating drawings on page 312

Defining automatic view settings for general arrangement drawings

Before you create general arrangement drawings, define the automatic view properties that you want to use.

To define the automatic view settings for general arrangement drawings:
1. Click Drawings & Reports --> Drawing Settings --> General Arrangement Drawing.
2. Load the drawing properties file that you want to modify from the list at the top.
3. On the Attributes tab, change the settings as required.
4. Go to the Shortening tab and define the part shortening settings.
5. Go to the Label tab and define the view label text, symbol and position.
6. If you want to create an anchor bolt plan drawing, go to the Anchor bolt plan tab and set Show as anchor bolt plan to Yes.

Change the other related settings as required.

7. Click OK to return to drawing properties.

8. Click Save to save the drawing properties, then click OK and create the drawing.

See also
- View properties in drawings on page 529
- Automatic drawing views on page 350
- Creating anchor bolt plans using saved settings on page 59
- Modifying and saving automatic drawing properties before creating drawings on page 312

Defining view labels and view label marks

All drawing views can have view labels, which may contain text and symbols. You can set the contents of the main view labels and section view labels before you create the drawing, and adjust them after you have created the drawing.

To define the view label mark contents and position:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.

2. Load the properties that you want to change.

3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.

   General arrangement drawings: Click View.

4. Click Attributes and go to the Label tab.

5. Click the ... button next to A1 - A5 to open the Mark Contents dialog box

   The illustration in the view properties dialog box is only one way to position the label text. When you modify the positioning, the illustration in the dialog box does not change.

   ![Illustration of view labels](image)

6. On the Content tab, select the elements that you want to include in the view label mark.

7. If needed, select an element from the list and click Add frame and select the frame Type and Color.

8. If needed, select an element from the list and select the text Color, Font and Height.

9. Go to the Position tab and set the text position, horizontal and vertical offset, and the text alignment.

   Text positioning depends on whether you use a symbol or not.
10. Click OK.

11. Select the view label Symbol you want to use in the label.

You can simply use only a label or add a symbol in it. You can also set the color, size, line length and the position of the view label.

12. Select the position for the view label: Vertical (Above or Below) and Horizontal (Center by view frame or Center by view restriction box).

13. To save the changes, click Save.

14. Click OK.

15. Click Save to save the drawing properties, then click OK and create the drawing.

See below for examples of view labels:

Drag the view label to the desired page in an open drawing.
The view frame is resized automatically, if necessary.

See also View, section view and detail view label mark elements on page 567
Mark appearance and merging properties on page 551
Positioning properties of view label, section and detail marks on page 554
View properties in drawings on page 529
Section view properties on page 532
Setting the view projection type

Projection type defines how Tekla Structures places the projections of a part in cast unit, single-part, and assembly drawings. Projection type affects the order of the views in the drawing.

To set the projection type:
1. Click **Drawings & Reports** --> **Drawing Settings** and select the drawing type.
2. Load the properties you want to change.
3. Click **Layout** and go to the **Other** tab.
4. Select one of the following:
   - **First angle** (also referred to as European projection).
   - **Third angle** (also referred to as American projection).
5. To save the properties in the properties file, click **Save**.
6. Click **OK** and create the drawing.

First-angle projection:
Including single-part drawings in assembly drawings

You can include single-part drawings of the individual parts that make the assembly in assembly drawings. You can use existing single-part drawings on the Drawing List or create new drawing views.

To include single-part drawings:

1. Click Drawings & Reports --> Drawing Settings --> Assembly Drawing.
2. Click Layout and go to the Other tab.
3. Set Include single-parts to Yes.
   This activates the Single-part attributes list.
4. In the Single-part attributes list, select the desired drawing properties to be used in the single-part view. The properties file standard is the default.
5. Click Save to save the drawing properties in the desired properties file.
6. Click **OK** and create the drawing.

The value of the advanced option

```
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_IN_ASSEMBLY_DRAWINGS
```

affects how Tekla Structures creates the single-part views. If the option is set to **TRUE**, Tekla Structures will use single-part drawings in the **Drawing List**. If it is set to **FALSE**, or if there is no existing single-part drawing for a given part, a new view will be created according to the **Include single parts** setting. The default value is **FALSE**.

**See also**  
XS_USE_EXISTING_SINGLE_PART_DRAWINGS_IN_ASSEMBLY_DRAWINGS  
XS_SINGLE_CENTERED_SCREW  
XS_SINGLE_CLOSE_DIMENSIONS  
XS_SINGLE_CLOSE_SHORT_DIMENSIONS  
XS_SINGLE_COMBINE_DISTANCE  
XS_SINGLE_COMBINE_MIN_DISTANCE  
XS_SINGLE_COMBINE_WAY  
XS_SINGLE_DIMENSION_TYPE  
XS_SINGLE_DRAW_PART_AS  
XS_SINGLE_EXCLUDE  
XS_SINGLE_FORWARD_OFFSET  
XS_SINGLE_NO_SHORTEN  
XS_SINGLE_ORIENTATION_MARK  
XS_SINGLE_PART_EXTrema  
XS_SINGLE_PART_SHAPE  
XS_SINGLE_SCALE  
XS_SINGLE_SCREW_INTERNAL  
XS_SINGLE_SCREW_POSITIONS  
XS_SINGLE_USE_WORKING_POINTS  
XS_SINGLE_XDIMENSION_TYPE  
XS_NO_END_VIEWS_TO_INCLUDED_SINGLE_DRAWINGS

Adding single-part views in assembly drawings on page 129  
Automatic drawing views on page 350

**Part orientation in drawing views**

In single-part, assembly, and cast unit drawings, you can adjust the orientation of the parts in the drawing views by selecting an appropriate coordinate system and by rotating the parts.
You can also separately set the viewing direction of columns, beams and bracings in assembly drawings. The project north setting also affects part orientation.

See also
- Changing the coordinate system on page 357
- Rotating parts in drawing views on page 359
- Defining plate orientation in drawings on page 361
- Setting viewing direction for columns in assembly drawings on page 363
- Setting viewing direction for beams and bracings in assembly drawings on page 363
- Orientation settings on page 590

**Changing the coordinate system**

The coordinate system defines:

- The angle from which the part, assembly, or cast unit is viewed.
- How the part, assembly, or cast unit is rotated.
- The orientation of the dimensions in the drawing view.

To change the coordinate system:

1. Click **Drawings & Reports** ---**>** **Drawing Settings** and select the drawing type.
2. Load the drawing properties that you want to change.
3. Click **View creation** and go to the **Attributes** tab.
4. In **Coordinate system**, select one of the available coordinate systems. The options are **local**, **model**, **oriented**, **horizontal brace**, **vertical brace**, **Fixed**.
5. To save the changes, click **Save**.
6. Click **OK** and create the drawing.

**Options**

- **local**

   Tekla Structures uses the local coordinate system of the main part. The x axis of the part is parallel to the x axis of the drawing, and the start point (the end point created first) of the part is on the left. The start point is marked with yellow, and the end point created second is marked with pink.
• **model**

Tekla Structures uses the global coordinate system. The part has the same position in the drawing as it has in the model. This is one option when you want to show columns vertically. You can also use this option to display sloping parts in position. Tekla Structures cannot display horizontally skewed parts.

• **oriented**

Tekla Structures uses the local coordinate system of the main part, but the coordinate system is oriented so that the x axis of the part points to the right even if the part was created from right to left.

• **horizontal brace**

Tekla Structures automatically rotates the drawing views so that the front view is from the top of the model. This is used for skewed braces. It automatically rotates the front view around the x axis.

• **vertical brace**

Tekla Structures automatically rotates the drawing views so that the front view is in the same plane as the brace in the model. This is used for skewed braces. It automatically rotates the front view around the x axis.
• For concrete parts, the option Fixed rotates the front view so that it shows the casting direction (the face that is top in form) of the concrete part, if it is defined in the model.

**See also**  Casting direction  
*Part orientation in drawing views on page 356*

### Rotating parts in drawing views

In addition to setting the coordinate system, you can also rotate a part, assembly, or cast unit in a drawing view around its local axes.

To rotate a part in a drawing view:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the drawing properties that you want to change.
3. Click **View creation** and go to the **Attributes** tab.
4. In **Rotate coordinate system**, specify the angle:
   - With the **X axis**, you can rotate in steps of 90 degrees (0, 90, 180, 270).
   - With the **Y axis**, you can rotate in steps of 180 degrees (0, 180).
   - With the **Z axis**, you can specify any angle.
5. To save the properties, click **Save**.
6. Click **OK** and create the drawing.

See examples of rotating around the *x* axis below:
1. 0 degrees
2. 90 degrees
3. 180 degrees
4. 270 degrees

See an example of rotating the same part 180 degrees around the y axis below.

See an example of rotating the same part 30 degrees around the z axis below.
Defining plate orientation in drawings

Plates created with the Contour plate command are automatically oriented in drawings. The longest side of the plate always faces downwards in the drawing. You can affect this orientation by using the advanced options XS_POLYGON_SQUARE_CORNER_PREFERENCE_FACTOR and XS_POLYGON_PERPENDICULAR_EDGE_PREFERENCE_FACTOR.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Contour plate in the model view.](example1.png) | 1. Contour plate in the model view.  
2. First creation point  
3. Second creation point |
| ![Single-part drawing of the contour plate.](example2.png) | Single-part drawing of the contour plate. |
Instead of using automatic plate orientation, you can set the plate main axis to follow the line created by the first and second points you pick, regardless of the plate dimensions. This enables you to define the plate orientation in drawings or reports.

To define the contour plate orientation with first and second picked points:

1. Create the contour plate.
   
   The first and second points you pick also define the plate's main axis.

2. Double-click the plate to open the Contour plate properties dialog box.

3. Click User-defined attributes, and click the Orientation tab.

4. Select From 1st to 2nd creation point in the Main axis direction list.

5. Click Modify, and close the dialog box.

6. Click Drawings & Reports --> Numbering --> Number Modified Objects to update numbering.

7. To view the orientation of the plate, create a single-part drawing of the plate.

<table>
<thead>
<tr>
<th>Example</th>
<th>Description</th>
</tr>
</thead>
</table>
| ![Contour plate in the model view.](chart1.png) | Contour plate in the model view.  
1. First creation point  
2. Second creation point |
| ![Single-part drawing of the plate. The user-defined attribute Main axis direction is set to From 1st to 2nd creation point.](chart2.png) | Single-part drawing of the plate. The user-defined attribute Main axis direction is set to From 1st to 2nd creation point. |
Setting viewing direction for columns in assembly drawings

In assembly drawings, you can define the front view direction separately for columns. The default value for the front view direction for columns is **As beam and bracing**.

To define the direction of the front view for columns in assembly drawings:

1. Click **Tools --> Options --> Options** and go to the **Orientation marks** tab.
2. Use the **Columns in assembly drawing** options to set the front view direction of columns:
   
   - If you have set the coordinate system to **local** in **View creation** properties, Tekla Structures uses the coordinate system of the column when setting the direction of the front view.
   
   - If you have set the coordinate system to **oriented**, the column is in a horizontal position, and the direction of the front view is the option you select (**North**, **East**, **South** or **West**).
   
   - If you have set the coordinate system to **model**, the column is in a vertical position, and the direction of the front view is the option you select (**North**, **East**, **South** or **West**).
3. Click **OK**.

See also  
**Orientation settings on page 590**  
**Part orientation in drawing views on page 356**

Setting viewing direction for beams and bracings in assembly drawings

In assembly drawings, you can define the front view direction separately for beams and bracings.

To define the viewing direction for beams and bracings:

1. Click **Tools --> Options --> Options** and go to the **Orientation marks** tab.
2. Use the **Beams and bracings in assembly drawing** options to set the front view direction. The default value is **North or east**.
   
   - If the beam or bracing is parallel to the X axis of the model, it is also parallel to the X axis in the drawing.
   
   - If you have set the coordinate system to **model**, and the beam or bracing is sloped, it is also sloped in the drawing.
3. Click **OK**.

See also  
**Orientation settings on page 590**  
**Part orientation in drawing views on page 356**
Showing neighbor parts in views

Neighbor parts refer to (optionally shown) parts that are close to the part that is depicted in a drawing. Depending on settings, the neighbor parts may be parts somehow connected to the part in question, or just parts that happen to be close by. You can select which neighbor parts to show in views and also automatically extend the view boundary if necessary.

To control which neighbor parts to show and extend the view boundary automatically:
1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Neighbor part.
5. On the Visibility tab, select the parts and that you want to show using the following options:
   • None does not show neighbor parts.
   • Connected parts shows all parts connected to the model object.
   • Connecting parts shows only the parts the model object is connected to.
   • All components combines the Connected parts and the Connecting parts options.
   • By extreme show all parts within the boundaries of the main and secondary part. This setting is affected by the value entered for View extension for neighbor parts on the Attributes (1) tab.
   • Main/Secondary parts: Main parts shows only neighbor parts that make the main part of an assembly or a cast unit.
   • Main/Secondary parts: Secondary parts shows only neighbor parts that are secondary parts of an assembly or a cast unit.
   • Main/Secondary parts: Both shows both main and secondary parts.
   • Skew parts: Yes shows skew parts as neighbor parts in the drawing, No does not show skew parts as neighbor parts.
   • Bolts: Yes shows the bolts in the neighbor parts, whereas No does not show the neighbor part bolts.
6. Click Attributes.
7. Enter a value by which to extend the view in the View extension for neighbor parts box.
   Try different values and check which one suits your needs. Often too big values do not work very well. If you set the value to 0, neighbor part extension is not shown.
8. To save the changes, click Save.
9. Click OK to return to the drawing properties.
10. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

If you do not want to see neighbor part extensions in drawing views, set the advanced option `XS_VISUALIZE_VIEW_NEIGHBOR_PART_EXTENSION` to **FALSE**.

**Example**  
In the following example, **View extension for neighbor parts** is set to **100**. No neighbor parts are located in this area.

![Diagram showing view extension for neighbor parts](image)

**See also**  
- Part and neighbor part properties in drawings on page 568  
- View properties in drawings on page 529  
- Section view properties on page 532  
- Automatic drawing views on page 350

**Shortening and lengthening parts**

Use the shortening functionality in the model to make the part longer or shorter in the drawing than in the model. This can be useful for adding length to concrete precast parts in the cast condition while the model stays in the erected state. The most common use for this is to account for prestressing elastic shortening, where the part actually shrinks a fraction of an inch after casting and after the strands are cut.

You can shorten and lengthen parts also in drawing views.

**See also**  
- Shortening a part in the model on page 366  
- Lengthening a part in the model on page 366  
- Shortening parts in drawing views on page 366  
- Lengthening shortened parts in drawing views on page 369  
- Shortening parts view by view on page 197
Shortening a part in the model

To shorten a part in the model:
1. Double-click a part to open the part properties dialog box.
2. Go to the Deforming tab.
3. In the Shortening box, define the degree of shortening.
4. Click Modify.

When drawings are created, Tekla Structures decreases the true length of the part by the value defined in the Shortening box. Shortening is applied linearly along the length in drawings.

To show the dimensions of the shortened part correctly in the drawings, set the setting Undeformed to Yes in drawing properties on the Attributes tab of the View creation properties.

See also  Shortening and lengthening parts on page 365
Undeforming deformed parts in drawings on page 370

Lengthening a part in the model

To have a concrete part lengthened in cast unit drawings, you must enter a negative value for shortening in the part properties dialog box.

To lengthen a part in drawings:
1. Double-click a part to open the part properties dialog box.
2. Go to the Deforming tab.
3. In the Shortening box, enter a negative value.
   For example, −20 would result in a part that is cast 20 units longer than the part in the model.
4. Click Modify.

See also  Shortening and lengthening parts on page 365

Shortening parts in drawing views

If parts are quite large and do not include any important details, you can shorten them in drawing views. Parts are only cut in empty areas. If there is something important, for
example, a stiffener in the part, the part is not cut in that area, because that area is not considered empty.

To shorten parts:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.

2. Load the properties that you want to change.

3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. Go to the **Attributes 2** tab.

5. In **Cut parts**, select one of the following:
   - **Yes** to cut in both X and Y direction.
   - **Only in X direction**
   - **Only in Y direction**

6. In **Minimum cut part length** and **Space between cut parts**, select how to cut the middle regions of the parts in drawing views.

   The **Minimum cut part length** defines how long the part must at least be to get shortened. The length of the part must be at least twice the entered value.

   The **Space between cut parts** defines the distance between cut parts on paper. For example, try 3.0 mm.

7. Set **Cut skew parts** to **Yes** to also cut skew parts in views.

8. To save the changes, click **Save**.

9. Click **OK**.

10. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Related advanced options**

- You can show view shortening symbols in drawings by setting the advanced options `XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS` and `XS_DRAW_HORIZONTAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS` to TRUE through **Tools --> Options --> Advanced Options --> Drawing Properties**.

- You can also control the appearance of the view shortening symbol with the advanced options `XS_SHORTENING_SYMBOL_COLOR`, `XS_SHORTENING_SYMBOL_LINE_TYPE`, and `XS_SHORTENING_SYMBOL_WITH_ZIGZAG`.

**Examples**

Below is an example of a part before and after cutting. Note that the width is the same in the non-cut and cut part. **Minimum cut part length** is 1’ 4” and cut length is 3/8”.

![Part Before and After Cutting](image)
The following example describes the meaning of **Minimum cut part length**, **Space between cut parts**, and an area that is not considered to be empty in the part, and therefore the part is not cut. **Minimum cut part length** is set to 650, which means that the part is shortened in the view at 650.

1. **Space between cut parts** is set to 1. This means the distance between cut parts on paper (not in model).
2. There is not enough empty area between the stiffeners, and that is why the part is not shortened at **Minimum cut part length**.

Below is an example of using the advanced options **XS_DRAW_VERTICAL_VIEW_SHORTENING_SYMBOLS_TO_PARTS** and **XS_SHORTENING_SYMBOL_WITH_ZIGZAG**.
After Tekla Structures has scaled drawing views and selected the drawing size, it may stretch shortened views to fill up empty areas of the drawing.

To lengthen shortened parts:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click Layout and go to the Other tab.
4. Set Expand shortened parts to fit to Yes.
5. To save the changes, click Save.
6. Click OK and create the drawing.

See also  
Shortening and lengthening parts on page 365
Shortening parts view by view on page 197
Automatic drawing views on page 350
View properties in drawings on page 529

**Lengthening shortened parts in drawing views**

After Tekla Structures has scaled drawing views and selected the drawing size, it may stretch shortened views to fill up empty areas of the drawing.

To lengthen shortened parts:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click Layout and go to the Other tab.
4. Set Expand shortened parts to fit to Yes.
5. To save the changes, click Save.
6. Click OK and create the drawing.

See also  
Shortening and lengthening parts on page 365
Shortening parts in drawing views on page 366
Unfolding polybeams in drawings

When you create a drawing, you can automatically unfold polybeams. You can unfold polybeams and bent plates in single-part drawings. Tekla Structures unfolds the polybeams according to unfolding parameters, which define the location of the neutral axis when a profile is unfolded.

Limitations:

- You can unfold only beams that have been created with the Polybeam command. You cannot unfold beams created with the Curved beam command, for example.
- You can unfold a polybeam only on one plane.

To unfold a polybeam in a single-part drawing:

2. Load the properties that you want to change.
3. Click View creation in the options tree and go to the Attributes tab.
4. Set Unfolded to Yes.
5. To save the changes, click Save.
6. Click OK and create the drawing.

Tekla Structures unfolds the polybeam in the single-part drawing.

The Unfolded setting in the View Properties properties dialog box on the Attributes 2 tab is ignored in drawing creation.

See also View properties in drawings on page 529
Undeforming deformed parts in drawings

Deformed parts are parts that have been warped or cambered in the model. You can undeform these parts and show the developed (undeformed) shape of deformed parts in drawings. You may want to do this, for example, if you want a concrete part to have two states: as erected (in the model view) and as cast (in the drawing view).

You can automatically undeform parts when you create a drawing.

Shortenings are hidden if you set Undeformed to No.

To create drawings that show the developed shape of parts and hide the part deformations:
1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click View creation and go to the Attributes tab.
4. To hide deforming angles and cambering, set Undeformed to Yes.
5. To save the changes, click Save.
6. Click OK and create the drawing.

The created drawing shows the developed shape and dimensions of the part.
See below for an example of a undeformed part in a drawing.

See below for an example of a warped part in a drawing.
The Undeformed setting in the View Properties properties dialog box on the Attributes 2 tab is ignored in drawing creation.

See also View properties in drawings on page 529

Showing part openings and recesses in drawings

You can select if you want to show symbols for part openings and recesses (blind holes) in drawing views.

To show openings and recesses in parts in a drawing views:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click View creation, select the view and the properties that you want to change, and click View properties.
4. Go to the Attributes 2 tab.
5. Set Show openings/recess symbol to Yes.
6. To save your changes, click Save.
7. Click OK to return to the drawing properties.
8. Click Save to save the drawing properties, then click OK and create the drawing.

By default, Tekla Structures displays openings and recesses in the following way:

<table>
<thead>
<tr>
<th>Type of opening</th>
<th>Shown as</th>
<th>Examples</th>
</tr>
</thead>
</table>
| Hole through a part                 | Hole symbol                                   | ![Hole symbol](image)
| Recess in the front face of a part  | Recess symbol and bounding lines shown as unbroken lines | ![Recess symbol and lines](image) |
| Recess in the back face of a part   | Recess symbol and bounding lines shown as dashed lines<br>Remember to switch hidden lines on for parts. | ![Recess symbol and dashed lines](image) |

See also View properties in drawings on page 529

Automatic drawing views on page 350
Additional ways for showing symbols in openings and recesses on page 373

Additional ways for showing symbols in openings and recesses

Tekla Structures contains some advanced options that give you more variety for showing the openings and recesses in your drawings.

To use other types of symbols in openings and recesses, and to show symbols in openings located at part borders and in part corners:

1. Click Tools --> Options --> Advanced Options and go to Drawing Properties.

2. Set the advanced option XS_USE_CROSS_FOR_OPENING_SYMBOL to FALSE to show the openings and recesses as follows:

   - ![Symbol 1](image1)
   - ![Symbol 2](image2)
   - ![Symbol 3](image3)

3. Set XS_USE_OPENING_SYMBOL_IN_BORDER HOLES to TRUE to show opening/recess symbols in openings located at part borders. This advanced option is by default set to FALSE. The symbol used depends on the setting of the advanced option XS_USE_CROSS_FOR_OPENING_SYMBOL.

   - ![Symbol 4](image4)
4. Set XS_USE_OPENING_SYMBOL_IN_CORNER_HOLES to TRUE to show opening/recess symbols in openings located in part corners. This advanced option is by default set to FALSE. The symbol used depends on the setting of the advanced option XS_USE_CROSS_FOR_OPENING_SYMBOL.

See also Showing part openings and recesses in drawings on page 372

**Setting automatic section view properties**

Properties for automatic section views need to be set in two places in drawing properties: in Section view, and in View creation --> View properties.

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click Section view.
4. On the Attributes tab, set values for options **Section depth** and **Distance for combining cuts**.
• **Section depth** defines the positive and negative depth of the section view when sections are not combined. In an open drawing, you can adjust the section view depth also by dragging the view boundary.

• **Distance for combining cuts** defines the distance range for combining cut views.

• You can additionally control which section views get combined using the advanced option **XS_DRAWING_CUT_VIEW_COMPARISON_CRITERIA**.

5. Still on the Attributes tab, set the direction of the **Left section**, **Middle section** and **Right section** to left or right.

6. Go to the **Cutting line** tab and set the section mark line length and offset (distance between the section mark and the section).

7. Go to the **Section mark** tab and modify the section mark settings:
   a. Click the ... button next to **A1 – A5** to open the **Mark Contents** dialog box.
   b. Select the elements that you want to include in the mark.
   c. If needed, select an element from the list and click **Add frame** and select the frame **Type** and **Color**.
   d. If needed, select an element from the list and select the text **Color**, **Font** and **Height**.
   e. Go to the **Position** tab and select the side to show the text, the text position, the horizontal and vertical offset, and the text rotation options.
   f. Click **OK** to return to drawing properties.

8. Click **View creation** and add the section and end views you want to create.

9. In the **View creation** panel, select the view and the properties that you want to change and click **View Properties**.

10. Adjust the scale, view label and view direction marks as required.

11. Click **Save** to save the view properties.

12. Click **OK**.

13. Repeat steps 9 - 12 for all the section and end views you create.

14. To save the changes, click **Save**.

Now you can create drawings with automatic section and end view properties that you just modified and saved.

**See also**
- View properties in drawings on page 529
- Section view properties on page 532
- Examples of section view and mark settings on page 375
Examples of section view and mark settings

Combining section views

1. Distance for combining cuts = 1'- 4"
2. Section depth = 4"
3. Combined sections

Section view direction
The arrow in the section view symbol indicates the direction of the section view, as shown below:

1. Left section, right direction
2. Middle section, right direction
3. Right section, left direction

Section marks
See below for examples of section marks:
Showing section and end view direction marks

You can display view direction marks in section views and end views.

To show view direction marks:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click View creation, select the view and the properties that you want to change, and click View properties.
   - In this case, select a section view or an end view.
4. Go to the Label tab in View Properties.
5. Select one of the options in View direction marks: Show marks:
   - Symbol only
   - Label only
   - Symbol and label
   - None does not show any marks.
6. Define the height of the symbol and text label in Height.
7. To save the changes, click Save.
8. Click OK.
9. Click Save to save the drawing properties, then click OK and create the drawing.
The view direction mark is shown with a small symbol (optionally with a text label) around the end or section view.

![Diagram of view direction mark]

The view orientation mark position follows the label position setting. In the image below, **Center by view restriction box** has been selected for the label.

![Diagram of view orientation mark]

---

**Modifying drawing settings**

378

**Automatic drawing views**
**Tips**

- You can drag view direction marks to a better place in a drawing view: click the view frame to activate the handles, point the handle, press and hold down the left mouse button and drag. The view frame is resized automatically, if necessary.

- You can define the view direction mark symbol in **Tools --> Options --> Advanced Options --> Drawing Properties** by using the following advanced options:
  
  - `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK`
  - `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM`
  - `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT`
  - `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP`

  The default symbol is `xsteel@66`.

**See also**

- `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BACK`
- `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_BOTTOM`
- `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_FRONT`
- `XS_DRAWING_VIEW_DIRECTION_MARK_SYMBOL_TOP`

**Section view properties on page 532**

**Setting the location of end views and section views**

You can select to always place section views and end views next to the main view or in any empty location in a single-part, assembly, and cast unit drawing.

To set the location of section views and end views:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Click **Layout** and go to the **Other** tab.
4. Set **Align end views with main view** to **Yes** to place the views next to the main view.
5. Set **Align section views with main view** to **Yes** to place the views next to the main view.

6. To save the changes in a drawing properties file, click **Save** at the top.

7. Click **OK** and create the drawing.

   If you select **No**, Tekla Structures places the section and end views in any available location.

**Example**  
End and section views in any location (**No** selected).

End and section views beside the main view (**Yes** selected).
Dimensions are associative annotation objects that represent building object measurements. Dimensions are more than lines or vectors; they are interactive callouts of geometry. In automatic dimensioning Tekla Structures creates dimensions in the whole drawing or in the created drawing views based on dimensioning settings you define before creating the drawing.

In single-part, assembly and cast unit drawings automatic dimensions are set view by view.

In general arrangement drawings, automatic dimensions are set for the whole drawing.

You can define automatic dimensions settings before you create a drawing and you can also modify the settings after you have created the drawing.
Automatic view–specific dimensions

Automatic view-specific dimensioning gives you full control on the dimensions in each drawing view you create, with a lot of dimensioning options. Automatic view-specific dimensioning can be used in single-part, assembly and cast unit drawings.

In view-specific dimensioning, the dimensions are created based on the rules you define. You can define what you want to dimension, where the dimensions are placed, in which order they are created, and which settings you want to use for each dimension. You can dimension shapes and holes, for example.

Below you can find short description on how to proceed in dimensioning.

1. When you click the View creation option in the options tree in drawing properties, you are able to select the views to be created and the view properties to be used.

2. Click View properties.

3. Click Dimensioning in the options tree.

   In the Dimensioning panel, you can add rules by clicking Add rule. Then select which dimensioning rules you want to use in the Dimensioning type column and the desired dimensioning rule properties file.
4. You can modify the selected rule by clicking **Edit Rule**.

In the **Dimensioning Rule Properties** dialog box, you can select what to dimension, how to dimension, which objects to measure from, where to place the dimensions, and select the dimension properties. The **Dimension properties** list contains properties files that you have saved in the object level **Dimension Properties** dialog box in an open drawing. For example, you may want to use some special font or color in the dimensions. To do this, double-click a dimension in a drawing, make the necessary changes and save the properties file. Then you can load the properties here.
If you select *Integrated dimensions*, the *Dimensioning Properties* dialog box is displayed. Make your changes to the settings on the tabs and save the properties file with a unique name using *Save as*. You can also load dimension properties here as well.
5. When you have set the rule properties, give a name to the rules file and click **Save as**.

6. Click **Close** to return to the **Dimensioning** panel.

7. Ensure that you have selected correct dimensioning properties files for the dimensioning rules.
8. Enter a unique name for the view properties in the box at the top of the View Properties dialog box and click Save.

Now you can select the saved view properties for a view in the View creation panel. These view properties contain the saved dimensioning properties.

See also Dimensioning rule properties on page 394
Dimensioning using dimensioning type Integrated on page 411

Example: Creating automatic overall and hole dimensions on view level

In this example, you will create a cast unit wall panel drawing that contains
- one front view with automatic overall and hole dimensions
- one section view with overall dimensions

In overall and hole dimension rules you will apply the dimension properties that you have earlier created and saved manually in a cast unit drawing. You will save the created dimensioning rule properties in view properties. Finally, you will save the created view properties in drawing properties and create a cast unit drawing.

Before starting, create manually in the object-level Dimension Properties dialog box in an open cast unit drawing a dimension properties file dim_font_5, where the dimension text font size is 5.00, and a dimension properties file dim_red, where the dimension color is red.

In this example, we are going to dimension the following cast unit wall panel in the model:

Defining views to be created

To create the desired drawing views:
1. Click Drawings & Reports --> Drawing Settings --> Cast Unit Drawing.
2. Load the properties that you want to change.
3. Click View Creation.
4. In the View Creation panel, click Add row to add new views in your drawing.
   
   In this example, you want to add two views, one front view and one section view.

<table>
<thead>
<tr>
<th>Views</th>
<th>Attributes</th>
</tr>
</thead>
<tbody>
<tr>
<td>View type</td>
<td>on/off</td>
</tr>
<tr>
<td>Front view</td>
<td>On</td>
</tr>
<tr>
<td>Section views</td>
<td>On</td>
</tr>
</tbody>
</table>

5. Set the on/off setting to On for the views that you want to create.
   
   If the list contains extra views, set them to Off or use the Delete row button to delete them.

   Now you have defined the views that you want to create. Next, you need to define the dimensions that you want to have in the front view and section view.

   **Defining front view dimensions**
   
   To define the dimensions for the front view:

   1. Select a view in the View Creation panel.
      
      In this example, select one Front view.

   2. Click View properties and then click Dimensioning in the option tree to define the dimensions to be created in the front view.

   3. In the Dimensioning panel, use Add row to add two new dimension rules in the dimensioning rules list.

   4. Select Overall dimensions for the first rule and Hole dimensions for the second.

      The order of the rules in the list defines the order of the dimension lines in the drawing: the dimension created by the first rule is placed closest to the dimensioned part.

      Leave Current assembly in the Filter column for both rules.
5. To define what kind of overall dimensions to create, click the *Overall dimensions* row, and click *Edit Rule*.

6. In the **Dimensioning Rule Properties** dialog box, define what to dimension, where and how to place the dimensions, and which dimension properties to use.

   - Select the check boxes above and on left side of the object, and also the check box in the upper-left corner to link the dimensions together.

   - Use default values in the **Start point** lists. The default values are left for the **Horizontal** and bottom for the **Vertical** dimension.

   - From the **Dimension properties** list, select a suitable set of saved dimension properties. In this example, select the dimension properties file `dim_font_5`, which contains a definition for a larger font.

   - Give the dimensioning rule a unique name and click **Save as**.

   In this example, the name **overall** is used.
7. Click Close.

8. Next, define the hole dimensions. In the Dimensioning panel, select Hole dimensions from the dimensioning rules list and click Edit Rule.

9. Create dimensioning rules for hole dimensions:
   - Select the check boxes above and on left side of the object, and also the check box in the upper-left corner to link the dimensions together.
   - Use the default values in the Start point lists.
   - In Close lines, select the setting that extends the dimension lines to the other end of the cast unit.
   - In Dimension to, select the setting that dimensions to both ends.
   - From the Dimension properties list, select a suitable set of saved dimension properties. In this example, select the dimension properties file dim_red containing a definition for red dimensions.
   - Give the hole dimensioning rule a unique name and click Save as. In this example, the name hole is used.
10. Click Close.

11. For the Overall dimensions rule, select overall properties, and for the Hole dimensions rule, select hole properties from the Properties column.

12. In the View Properties dialog box, give the front view properties a unique name and click Save as.

In this example, the front view properties are saved with the name CU_Front.

Now you have saved the view properties for the front view containing overall and hole dimensions. Leave the View Properties dialog box open for further modifications.
Defining section view dimensions

Also a section view is needed in the cast unit drawing, because you want to show the wall thickness. Next, you will create overall dimensions for the section view.

1. In the View Creation panel, select the Section views row and click View properties.

2. Load the view properties file CU_Front.
   
   You can start creating new view properties on the basis of already existing view properties.

3. Click Dimensioning in the options tree.

4. In the Dimensioning panel, delete the unnecessary hole dimension rule by clicking the Hole dimensions row and Delete row.
   
   You will only need the overall dimensions in the section view.

5. Click the Overall dimensions row and click Edit Rule.

6. Create a dimensioning rule for the overall dimensions in the section view:
   
   • Select the check box below the object only, because you only want to show the thickness.

   • Select the same dimension properties as for the overall dimensions in the front view, because you want to show the dimension text with a little bit larger font: dim_font_5.

   • Give the rule a unique name and click Save as.

   In this example, the name thickness is used.
7. Click Close.

8. In the Dimensioning panel, select thickness in the Properties column as the property file for the overall dimensioning rule.

9. Give a unique name for the section view properties and click Save as.
   In this example, the name CU_Section is used.

10. Click OK.
    Now you have saved the view properties for the section view containing overall dimensions.

<table>
<thead>
<tr>
<th>View type</th>
<th>on/off</th>
<th>View label</th>
<th>View properties</th>
</tr>
</thead>
<tbody>
<tr>
<td>Front view</td>
<td>On</td>
<td>CU_Front</td>
<td></td>
</tr>
<tr>
<td>Section views</td>
<td>On</td>
<td>CU_Section</td>
<td></td>
</tr>
</tbody>
</table>

1. In the View Creation panel, select CU_Front for the front view and CU_Section for the section view.

2. In the Drawing Properties dialog box, give the drawing properties a unique name and click Save as.
   In this example, the name CU_Wall_panel is used.
3. Click **OK** and create the cast unit drawing.

Tekla Structures creates the cast unit drawing according your definitions in different properties files. The cast unit drawing contains a front view and a section view. The overall dimensions in both views have a little bit larger font, and the front view has red hole dimensions. Only the wall thickness is dimensioned in the section view.

You can use the drawing properties file `CU_Wall_panel` later on when you need drawings with similar settings.
You can still change the dimensioning settings in the views after creating the cast unit drawing:

1. Double click the drawing view frame to open the view properties dialog box.

2. Click **Dimensioning** in the options tree to open the **Dimensioning** panel where you can select and then edit the dimensioning rules.
### Dimensioning rule properties

The following table describes the options and their settings in the Dimensioning Rule Properties dialog box. This dialog box can be opened by selecting View creation in a Drawing Properties dialog box and then clicking View Properties --> Dimensioning --> Edit Rule.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is dimensioned</td>
<td>Sets the dimensioning type:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Overall dimensions</strong> creates dimensions for the bounding box of the objects you select in the Measure from list.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Edge shape</strong> creates dimensions for the edge of the object selected in the Measure from list.</td>
</tr>
<tr>
<td></td>
<td>For sandwich walls, the default setting Cast unit / Assembly may not give the desired result with Edge shape. Then you can dimension the internal and external layers separately according to the part name.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Secondary parts</strong> creates dimensions for the secondary parts of a cast unit or an assembly.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Holes</strong> creates dimensions for the holes of the objects selected in the Measure from list. The hole dimensions are combined according to the Combine on one line setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Recesses</strong> creates dimensions for the recesses of the objects selected in the Measure from list. The hole dimensions are combined according to the Combine on one line setting.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Distance to grid</strong> creates dimensions from the grid line to the bounding box of the object selected in the Measure from list. This setting works only when the grid lines are visible.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Filter</strong> can be used to dimension anything that can be filtered. It is often used when dimensioning embeds. For example, you can dimension bolt locations after you have created a filter for bolts.</td>
</tr>
<tr>
<td></td>
<td>When you select Filter from the What is dimensioned list, a list is displayed where you can select the filter. The filter is a drawing view filter and you need to create it beforehand to be able to use it here.</td>
</tr>
<tr>
<td>Dimension line location</td>
<td>Controls on which sides of the cast unit the dimensions will be created.</td>
</tr>
<tr>
<td>and linking</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>• Dimension line locations are rotated together with the drawing view if the view is manually rotated.</td>
<td></td>
</tr>
<tr>
<td>• When selecting both sides, top and bottom or left and right, the objects will be dimensioned on the side that is closest to the object.</td>
<td></td>
</tr>
<tr>
<td>• When only a part of the cast unit is selected for the rule, one of the check boxes will be dimmed and you cannot select it.</td>
<td></td>
</tr>
<tr>
<td>• When you have selected one vertical and one horizontal dimension line, the linking check boxes in the corners are activated, and you can link the perpendicular dimension lines. The check boxes are dimmed by default.</td>
<td></td>
</tr>
<tr>
<td>• You can select objects for dimensioning from the whole cast unit or only from one half of the cast unit. If you do this, objects in the other half will be ignored in dimension creation. The default value is the whole cast unit.</td>
<td></td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Orientation</td>
<td>Orients the dimensions along the sloped edge of a part. Another possibility is to create horizontal or vertical dimensions.</td>
</tr>
<tr>
<td></td>
<td>• This option is visible only when the dimensioning type <strong>Filter</strong> or <strong>Edge shape</strong> is selected.</td>
</tr>
<tr>
<td></td>
<td>• When <strong>Filter</strong> is selected, there are two settings available for orientation.</td>
</tr>
<tr>
<td></td>
<td>The first setting places the dimensions along the sloped edge:</td>
</tr>
<tr>
<td></td>
<td><img src="image1.png" alt="Diagram of sloped edge dimensions" /></td>
</tr>
<tr>
<td></td>
<td>The second setting places the dimensions horizontally and vertically:</td>
</tr>
<tr>
<td></td>
<td><img src="image2.png" alt="Diagram of horizontal and vertical dimensions" /></td>
</tr>
<tr>
<td></td>
<td>• When <strong>Edge shape</strong> is selected, there are three settings available for orientation. First two settings work in the same way as the first</td>
</tr>
</tbody>
</table>

---

Modifying drawing settings 397 Automatic dimension settings
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>two <strong>Filter</strong> settings. The first setting is the default value. The third one creates both dimensions:</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td>Minimum length for skew section</td>
<td>Defines the minimum length of skewed sections when dimensions are still created for skew sections. The default value is 300 mm. For example, when you use the value 500 mm and the skew section is shorter than 500 mm, the dimensions are not created along the skew section, but horizontally and vertically instead.</td>
</tr>
<tr>
<td>Start point</td>
<td>Defines where the origin points for the dimensions are:</td>
</tr>
<tr>
<td></td>
<td>- The default values are left for the <strong>Horizontal</strong> and bottom for the <strong>Vertical</strong> dimension.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>- The setting marked with symbol � وعنITE chooses the nearest edge as the dimension origin, for every dimension separately. In the example below, the object is closer to the right edge, and so the horizontal dimension starts from there.</td>
</tr>
<tr>
<td>Vertical = Horizontal</td>
<td>Often the settings are similar for both directions, and when this option is used, only vertical settings need to be set.</td>
</tr>
<tr>
<td>Close lines</td>
<td>Defines whether the dimension lines extend to the other end of the cast unit or assembly or not. The dimension lines extend to the other end by default.</td>
</tr>
<tr>
<td>Dimension to</td>
<td>Defines which points of the selected objects are dimensioned:</td>
</tr>
<tr>
<td></td>
<td>- Both ends is the default.</td>
</tr>
<tr>
<td></td>
<td>- If you select the center point setting and the object is a custom part (=embed), the Tekla Structures will use the component insertion point, which is not always in the center. For other objects, the actual center point will be used.</td>
</tr>
<tr>
<td>Round holes</td>
<td>Defines whether the round holes will be dimensioned by center point or diameter:</td>
</tr>
<tr>
<td></td>
<td>- This option is visible only when Holes or Recesses is selected.</td>
</tr>
<tr>
<td></td>
<td>- The diameter is the default value.</td>
</tr>
<tr>
<td></td>
<td>- Currently, round holes are identified only by cut part profile (prefix D). If you create the round hole using round chamfers, for example, the hole will not be dimensioned.</td>
</tr>
<tr>
<td>Dimension properties</td>
<td>Attribute file takes into use the dimensions properties defined in the dimension properties file that has been saved earlier on the object level Dimension Properties dialog box in a drawing. The default value is standard.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Measure from</td>
<td>Defines the objects that will be used as the origin point for the dimensions. The available settings are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cast unit/Assembly</strong>: This is the default value. If you select this setting, you have three more settings available:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Only concrete/steel parts</strong>: For a cast unit, only concrete parts are used, and for steel only steel parts.</td>
</tr>
<tr>
<td></td>
<td>• <strong>All parts</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>All parts and rebars</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>Main part</strong>: This setting uses cast unit or assembly main part.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Part name</strong>: If you select <strong>Part name</strong>, you can define the part name.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Filter</strong>: If you select <strong>Filter</strong>, you can use a predefined filter for selecting the objects that you want to use as dimension origin points.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Current part</strong>: Select <strong>Current part</strong> when you are dimensioning a single part.</td>
</tr>
<tr>
<td>Combine on one line</td>
<td>Creates a rule based on a filter, for example, for embeds (EB_*), and then groups the embeds according to the main part name, so that embeds with different names will get their own dimension lines. The filtered object can be a part, a reinforcing bar or an assembly. The available settings are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All objects</strong> (default)</td>
</tr>
<tr>
<td></td>
<td>• <strong>By name</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>By position number</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong></td>
</tr>
<tr>
<td></td>
<td>When <strong>Holes</strong> or <strong>Recesses</strong> is selected, the <strong>Combine on one line</strong> option changes to display suitable settings for holes or recesses. The available settings are:</td>
</tr>
<tr>
<td></td>
<td>• <strong>All holes</strong> (default)</td>
</tr>
<tr>
<td></td>
<td>• <strong>Any holes of the same size</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>By cut part name</strong></td>
</tr>
<tr>
<td></td>
<td>• <strong>No</strong></td>
</tr>
<tr>
<td>Combine only objects that have the same X or Y coordinate</td>
<td>Combines only the dimensions of objects that are on the same horizontal or vertical line. By default, this option is not selected.</td>
</tr>
<tr>
<td>Tolerance</td>
<td>The tolerance is the maximum distance between objects when Tekla Structures still considers the objects to be on the same line. 50 mm is the default value.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Preferred combining direction</td>
<td>Sets the preferred direction for combining dimensions if an object can be combined both in horizontal and in vertical direction. X is the default value.</td>
</tr>
<tr>
<td>Do not create dimensions shorter than</td>
<td>Defines the minimum length of the dimensions for Tekla Structures to create them. 0 is the default value, which means that all dimensions are created.</td>
</tr>
</tbody>
</table>
| Do not dimension holes smaller than | Defines the minimum diameter for the holes for Tekla Structures to create the dimensions.  
  With this option you can prevent the creation of dimensions for small holes. The distance is the shortest dimension of a hole. If any dimension of the hole is larger than the given value, the hole will be dimensioned in all directions. For example, with value 40, a rectangular hole of 80*30 will get both dimensions 80 and 30. Default value is 0, which means that all dimensions are created. |
| Component objects | Defines how component objects are dimensioned:  
  • **By reference points** (default) places the dimensioning point to the first insertion point of the component. Only one dimension will be created for each component regardless of the number of parts inside the components.  
  • **As secondary objects** creates separate dimensions for each part inside the component. |

**See also** on page 0  
Creating a drawing view filter for view-level dimensioning on page 407  
Dimension and dimensioning properties on page 533

**Examples: Dimensions created with view-level dimensioning**

See below for examples of dimensions created with different settings in the Dimensioning Rule Properties dialog box.

**Overall dimensions**
Edge shape

Secondary parts

Holes
Recesses

Distance to grid
Filter: Embeds

Filter: Bolts

To get the location of every bolt in the bolt group dimensioned, set **Dimension** to **midpoint**.
Filter: Reinforcing bars and strands

Use the midpoint option to dimension each bar in a group:

Start point and end point option will dimension the first and the last reinforcing bar in a group:
If you want to have separate dimension lines for reinforcing bars that are not of the same size, set the **Combine on one line** to **By position number**:

To make the rule creation easier, the midpoint setting of the **Dimension to** option works so that it will create dimensions to start point and end point of the reinforcing bars that are parallel to the view plane:

If you want to get different size of reinforcing bars on separate dimension lines, set **Combine on one line** to **By position number**:
Creating a drawing view filter for view-level dimensioning

You need to create a drawing view filter to use the Filter option in dimension creation. It is important that you create the filter on the drawing view level, not on the drawing level.

To create a drawing view filter:

1. In an open drawing, double-click the drawing view frame to open the View Properties dialog box.
2. Click Filter.
3. Click Add row and define the filter properties.

See also  Dimensioning rule properties on page 394
• Add a row first to define the **Object type** object category. This needs to be defined for all drawing view filters that are going to be used in dimensioning definitions. Set the **Value** to **Part** or **Reinforcing bar**

![Image of filter dialog box](image)

4. Use **Save as** to save the filter with a unique name.

5. Click **Cancel** to close the dialog box.

Now you can select the drawing view filter from the filter list in the **Dimensioning Rule Properties** dialog box and use it for dimensioning. If the filter is not displayed immediately after creation, refresh the list by closing and opening the dialog box.

![Image of Dimensioning Rule Properties dialog box](image)

**See also**

- Dimensioning rule properties on page 394
- Examples: Dimensions created with view-level dimensioning on page 401
- Creating a filter for holes or recesses on page 409
- Creating a filter for the main part of an assembly on page 409
- Creating an exclude filter for dimension tag on page 410
- Creating an exclude filter for stirrups in section views on page 411
Creating a filter for holes or recesses

You can create a filter for cut parts. The filter must be created in the modeling mode (not in drawing mode).

1. Click Edit --> Selection Filter.
2. Add the first row:
   • Select Object as category, Object type as property and Equals as condition.
   • To fill 11 in the value, use Select from model, and select a cut part.
3. Add the second row:
   • Select Template as category, enter NAME in uppercase as property and select Equals as condition.
   • Enter the name of the template as the value.
4. Select check boxes Selection filter and All drawing types.
5. Save the filter with a unique name using Save as.

See also Creating a drawing view filter for view-level dimensioning on page 407
Creating a filter for the main part of an assembly

When your subassembly consists of many objects, but you only want to select the main part for dimensioning, you can create a filter like below:

See also Creating a drawing view filter for view-level dimensioning on page 407

Creating an exclude filter for dimension tag

Often several objects need to be excluded from dimension tag content. With the example filter shown below it is possible to exclude everything else from the tag content, except cut parts that have the name ‘HVAC’.
Creating an exclude filter for stirrups in section views

The view-based dimensioning currently dimensions reinforcing bar polygon points along the center line of the reinforcing bar. Below is an example of a stirrup in section view. In some cases, the resulting dimensions are created similarly regardless of the hook type.

To avoid this kind of results, you can use suitable filtering criteria. See below for an example of a filter, where stirrups (shape 14) are excluded but all other reinforcing bars are dimensioned.

See also Creating a drawing view filter for view-level dimensioning on page 407
Dimensioning using dimensioning type Integrated

In the Dimensioning dialog box, you can control what gets dimensioned and how in a drawing. You can experiment with different combinations of options to achieve different kinds of dimensioning effects.

To select the dimensions to create and modify the dimensioning settings:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Dimensioning.
5. Select Integrated as the dimensioning type, select dimensioning rule properties and click Edit Rule.
6. Select the dimensions to create and adjust the related settings.

The available tabs and settings depend on the drawing type:

- On the Part dimensions tab, select the part dimensions to create and adjust the related settings.
- On the General tab, adjust settings related to minimizing the number of views, dimension type, combining dimensions, closing dimensions, limit for dimensioning asymmetry in secondary parts, forward offset, grid dimensions, dimension position, and part marks on dimension line.
- On the Position dimensions tab select the position dimensions to create. They indicate the position of parts in relation to the main part or to work points.
- On the Bolt dimensions tab, select the bolt dimensions to create, combine bolt dimensions and select the side for the dimension.
- On the Dimension grouping tab, group dimensions and adjust the related settings.
- On the Sub-assembly tab, create dimensions for parts in sub-assemblies and adjust the related settings.
- On the Reinforcement dimensions tab, create dimensions for reinforcing bar groups in cast unit drawings, add dimension marks and adjust the related settings.

7. Save the dimensioning settings by clicking Save and close the dialog box by clicking Close.
8. Save the view properties by clicking Save and return to the drawing properties dialog box by clicking OK.
9. Click Save to save the drawing properties, then click OK and create the drawing.

See also

- Creating minimum and maximum position dimensions for bolts on page 436
- Grouping identical objects to the same dimension line on page 413
- Modifying dimensions for unfolded parts on page 434
Grouping identical objects to the same dimension line

You can group identical parts, bolts, components and cuts or shapes to the same dimension line. You also have the option to include automatic dimension tags to grouped dimensions.

To group identical objects to the same dimension line:

1. In the Dimensioning Properties dialog box, go to the Dimension Grouping tab.
2. In Activate dimension grouping, select the objects that you want to group.
3. Highlight a row (Parts, Bolts, Components or Cuts/Shapes in the Activate dimension grouping list and select the elements by which you define the identical conditions in grouping properties.
4. In Automatic tagging, select the appropriate options to include automatic dimension tags.
5. If you want Tekla Structures to update dimension grouping automatically, set the option Update grouping when model changes to Yes.
6. Click OK.

![Diagram showing dimensioning](image)

You can change the dimension tag contents in the final drawing and include some other elements in the tag.

See also
- Dimension grouping properties on page 546
- Dimensioning using dimensioning type Integrated on page 411

### Adding elevation dimensions

You can add elevation dimensions (level marks) in your drawings for the start and end points of parts. Tekla Structures dimensions elevations relative to a reference point, which you can change. For example, if the elevation is 5000 mm, and you set the reference point to 200, the elevation changes to 4800 mm. You can also change the elevation dimension prefix, which in the English version is EL by default.

To change the reference point and create elevation dimensions using another prefix:

1. Go to the **Position dimensions** tab, and set **Elevation dimensions** to **On**.
2. Click OK.
3. In the drawing properties dialog box, click **View -- Attributes**.
4. Do one of the following:
   - To use a specific value, select **Specified** from the **Datum point for elevations** list and enter a value in the **Datum level** box.
   - To measure reference points relative to the view plane, select **View plane** from the **Datum point for elevations** list.
5. Click OK.
6. To change the prefix, open the `dim_operation.ail` file in a text editor that supports UTF-8 coding. Recommended editors are Visual Studio and Notepad++. 

This file is located in the `Tekla Structures/<version>/messages/` folder. Replace `EL` with a new prefix on the following line in the file:

```csharp
string dim_operation_dim_elevation_prefix{entry = ("enu", "EL");};
```

Shortening value added in the user-defined properties of a part affects also elevation dimensions.

**Example**

*Diagram showing an elevation dimension for a skew part with EL as the prefix.*

**Limitations**

Tekla Structures creates elevation dimensions for skew parts only if the parts are in the same position in the drawing as they are in the model. This means that the coordinate system must be set to `model`.

If you are using `local`, `oriented`, or `brace` coordinate systems, Tekla Structures does not draw the elevation dimensions for skewed parts by default. If you want to create elevation dimensions, set the advanced option `XS_DRAW_SKEWED_ELEVATIONS` to `TRUE` in `Tools --> Options --> Advanced Options --> Dimensioning: Parts`. See below for an example of an elevation dimension for a skew part.

*Diagram showing an elevation dimension for a skew part with EL as the prefix.*

**See also**

- Part orientation in drawing views on page 356
- Position dimensioning properties on page 542
- Dimensioning using dimensioning type Integrated on page 411
- Adding level marks on page 176
**Check dimensions**

*Check dimensions* are additional dimensions you can use for checking, usually in thinner text than other dimensions. They are not required for fabrication or erection, and they are mainly used for checking detailing, not for assembling parts.

Tekla Structures uses *work points* to create check dimensions. Work points can be either the points between which the part was originally created, or the intersection point of the reference lines of the parts. The reference line location depends on the part position **depth** set in the part properties dialog box. If it is **middle**, the reference line is the center line, if it is **front**, the line is located in the part front edge, etc.

**Knock-off dimension** is a special type of check dimension that dimensions the distance from work points to the end of the part.

**See also**  Creating check dimensions on page 416

### Creating check dimensions

You can create additional dimensions to check the accuracy of dimensions.

To create check dimensions, do any of the following:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
<th>Number in the image</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create check dimensions between outermost work points.</td>
<td>Click Dimensioning --&gt; Part dimensions and set Main part work points to Yes.</td>
<td>1</td>
</tr>
<tr>
<td>Create check dimensions between outermost bolts.</td>
<td>Click Dimensioning --&gt; Bolt dimensions and set Extreme bolts to Assembly or Main part.</td>
<td>2</td>
</tr>
<tr>
<td>Create check dimensions from outermost work point to first bolt.</td>
<td>Click Dimensioning --&gt; Bolt dimensions and set Extreme bolts to Assembly or Main part and Extreme bolts to work points to Yes.</td>
<td>3</td>
</tr>
<tr>
<td>Create horizontal and vertical check dimensions between the work points in a skewed brace.</td>
<td>Click Dimensioning Position dimensions and set Main part skew position to Yes.</td>
<td>4</td>
</tr>
<tr>
<td>Create check dimensions between the work points, such as the intersections of main and neighbor part reference lines.</td>
<td>Click Dimensioning --&gt; Position dimensions and set Position bolts to or Position parts to Working points or Both.</td>
<td></td>
</tr>
<tr>
<td>Create check dimensions to the bolt hole locations in the main part.</td>
<td>Click Dimensioning --&gt; Position dimensions and set Main part bolt position to On.</td>
<td></td>
</tr>
</tbody>
</table>
To Do this

Create knock-off dimensions.

Click **Dimensioning --&gt; Part dimensions** and set **Knock-off dimensions** to **On**.

---

See also

- Check dimensions on page 416
- Part dimensioning properties on page 544
**Example: Part dimensioning**

Here are some examples of what the part dimensions look like with different settings selected on the Part dimensions tab.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Internal</strong> dimensions set to <strong>None</strong></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Internal</strong> dimensions set to <strong>All</strong></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Overall dimensions</strong></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
<tr>
<td>Dimensioning setting</td>
<td>Example</td>
</tr>
<tr>
<td>------------------------------------------</td>
<td>---------</td>
</tr>
<tr>
<td>Main part shape (Shape dimensions) set to On.</td>
<td><img src="image1" alt="Diagram" /></td>
</tr>
<tr>
<td>Bevel dimensions set to On.</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
<tr>
<td>Bevel angle set to Angle of cut.</td>
<td><img src="image3" alt="Diagram" /></td>
</tr>
</tbody>
</table>
### Dimensioning setting

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bevel angle set to Angle of beam.</td>
<td><img src="image" alt="Bevel angle example" /></td>
</tr>
</tbody>
</table>

#### See also
- Part dimensioning properties on page 544
- Dimensioning using dimensioning type Integrated on page 411

### Example: Bolt dimensioning

Here are a couple of examples of what the bolt dimensions look like with different settings.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part bolt internal dimensions is set to All on the Bolt dimensions tab of the Dimensioning Properties dialog box.</td>
<td><img src="image" alt="Bolt dimensions example" /></td>
</tr>
</tbody>
</table>
All bolt and hole dimensions are shown in the front view of the main assembly. The elements **Gage of outstanding leg** (GOL) and **Center-to-center distance** (C/C or Gage) have been added in a bolt and hole mark in **Bolt mark... > Content**.

**Example: Position dimensioning**

Here are some examples of what the position dimensions look like with different settings selected on the **Position dimensions** tab.

### Dimensioning setting

<table>
<thead>
<tr>
<th>Position parts to is set to None.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Example</td>
</tr>
</tbody>
</table>

See also:

- **Bolt dimensioning properties on page 545**
- **Bolt mark elements on page 562**
- **Dimensioning using dimensioning type Integrated on page 411**
<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Position parts to</strong> is set to <strong>Main part.</strong></td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Position bolts to</strong> is set to <strong>Working points.</strong></td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
<tr>
<td>Dimensioning setting</td>
<td>Example</td>
</tr>
<tr>
<td>-----------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Secondary part</strong> is dimensioned <strong>By bolts.</strong></td>
<td><img src="image1.png" alt="Diagram 1" /></td>
</tr>
<tr>
<td><strong>Secondary part</strong> is dimensioned <strong>By parts.</strong></td>
<td><img src="image2.png" alt="Diagram 2" /></td>
</tr>
<tr>
<td><strong>Secondary part</strong> is dimensioned <strong>By both.</strong></td>
<td><img src="image3.png" alt="Diagram 3" /></td>
</tr>
<tr>
<td><strong>Secondary part</strong> is dimensioned <strong>By bolts.</strong> <strong>Secondary part dimension direction is Neighbor part.</strong> <strong>Position from is set to Work points.</strong></td>
<td><img src="image4.png" alt="Diagram 4" /></td>
</tr>
</tbody>
</table>

1. **Running dimensions start from the intersection of the main and secondary part (=work point)**
2. **Dimensions are aligned with the neighboring part**
<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Main part bolt position</strong> is set to <strong>Off</strong>.</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td><em>(Main part bolt internal dimensions is set to Internal on the Bolt dimensions tab.)</em></td>
<td></td>
</tr>
<tr>
<td><strong>Main part bolt position</strong> is set to <strong>On</strong>.</td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
<tr>
<td><em>(Main part bolt internal dimensions is set to Internal on the Bolt dimensions tab.)</em></td>
<td></td>
</tr>
<tr>
<td>By default, create minimum and maximum position dimensions are not created for bolts. For information on how to create these dimensions, see <a href="#">Creating minimum and maximum position dimensions for bolts on page 436</a>.</td>
<td></td>
</tr>
<tr>
<td><strong>Main part skew position</strong> is set to <strong>Yes</strong>.</td>
<td><img src="image3.png" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Skew position</strong> is set to <strong>Angle</strong>.</td>
<td><img src="image4.png" alt="Diagram" /></td>
</tr>
<tr>
<td>Dimensioning setting</td>
<td>Example</td>
</tr>
<tr>
<td>----------------------</td>
<td>---------</td>
</tr>
<tr>
<td><strong>Centered part</strong> is set to <strong>Internal</strong>.</td>
<td>![Example Image]</td>
</tr>
<tr>
<td><strong>Centered part</strong> is set to <strong>Position</strong>.</td>
<td>![Example Image]</td>
</tr>
<tr>
<td><strong>Center bolt</strong> is set to <strong>Internal</strong>.</td>
<td>![Example Image]</td>
</tr>
<tr>
<td><strong>Center bolt</strong> is set to <strong>Position</strong>.</td>
<td>![Example Image]</td>
</tr>
</tbody>
</table>

See also  
Position dimensioning properties on page 542  
Dimensioning using dimensioning type Integrated on page 411
Example: Closing dimension

Here are some examples of how Tekla Structures creates dimensions with different options selected in the **Close dimensions** area on the **General** tab.

<table>
<thead>
<tr>
<th>Closing option</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Close dimensions</strong> is set to No.</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td><strong>Close dimensions</strong> is set to All.</td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>
Closing option | Example
--- | ---
Short dimensions is set to No. | ![Diagram](image1)

See also  
[General dimensioning properties on page 539](#)  
[Dimensioning using dimensioning type Integrated on page 411](#)

**Example: Combining dimensions**

Here are some examples of how Tekla Structures combines dimensions with different options selected on the General tab.

<table>
<thead>
<tr>
<th>Combining option</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option No prevents dimensions from being combined.</td>
<td><img src="image2" alt="Diagram" /></td>
</tr>
</tbody>
</table>

Option 1 combines part position dimensions with part internal dimensions, and bolt group internal dimensions with bolt edge distances. Bolt position dimensions are not combined with bolt internal dimensions.
<table>
<thead>
<tr>
<th>Combining option</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Option 2 combines the part position dimension with part internal dimensions and bolt group internal dimensions. Bolt internal dimensions are combined with bolt position dimensions. Edge distances are shown separately.</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td>Option 3 combines bolt internal dimensions and position dimensions in the same dimension line.</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td>Option 4 combines bolt group position dimensions with part position dimensions. Part and bolt internal dimensions are not combined with this option, but bolt internal dimensions are combined with bolt edge distances.</td>
<td><img src="image" alt="Example" /></td>
</tr>
<tr>
<td>Option 5 combines internal dimensions and the position dimension of bolt groups where there are several bolt groups.</td>
<td><img src="image" alt="Example" /></td>
</tr>
</tbody>
</table>
Combining option | Example
--- | ---
Option 4.5 uses a combination of option 5 for the main part and a combination of option 4 for the secondary parts.

**Distance 5'-0**

**Distance 1'-0**

**Min distance 5'-0**

**Min distance 5"**

See also  
- General dimensioning properties on page 539  
- Dimensioning using dimensioning type Integrated on page 411
Example: Combining bolt group dimensions

For dimensioning and marking purposes, Tekla Structures treats bolt groups located close together as one group on the basis of the minimum number of dimensions to combine and format selected on the **Bolt dimensions** tab. See an example below:

![Diagram showing combination of bolt groups]

1. Bolt group 1
2. Bolt group 2

See also  
- **Bolt dimensioning properties on page 545**
- **Dimensioning using dimensioning type Integrated on page 411**

Example: Forward offset

Here are some examples of how Tekla Structures locates dimensions with different forward offset values set on the **General** tab.

<table>
<thead>
<tr>
<th>Forward offset setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Forward offset</strong> greater than the 1'-8 dimension to the hole group.</td>
<td>![Diagram showing forward offset example]</td>
</tr>
</tbody>
</table>

Modifying drawing settings 430  Automatic dimension settings
Forward offset setting

**Example**

**Forward offset** set to a smaller value.

<table>
<thead>
<tr>
<th>RD</th>
<th>1'8</th>
<th>6</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>3</td>
<td>3</td>
<td></td>
</tr>
</tbody>
</table>

See also  
- General dimensioning properties on page 539
- Dimensioning using dimensioning type Integrated on page 411

**Example: Recognizable distance**

Here is an example of how Tekla Structures uses the **Recognizable distance** setting. If you set value for **Recognizable distance** on the **General** tab, and the asymmetry of the parts is smaller than the distance you entered, Tekla Structures represents it using a dimension.

This setting is used, when the **Internal** dimension is set to **Necessary**. Recognizable distance dimension is not necessarily needed, if the part can be assembled correctly without it.

A typical example is a rectangle that is almost as long as it is wide.

<table>
<thead>
<tr>
<th>1/4</th>
<th>1'1</th>
</tr>
</thead>
<tbody>
<tr>
<td>12'6</td>
<td></td>
</tr>
</tbody>
</table>

See also  
- General dimensioning properties on page 539
- Dimensioning using dimensioning type Integrated on page 411
Example: Preferred dimension side

You can set the preferred dimension side for parts and bolts on the Part dimensions tab and Bolt dimensions tab. The examples below show how the different settings for Preferred dim side look like for part dimensions.

See also
- Part dimensioning properties on page 544
- Bolt dimensioning properties on page 545
- Dimensioning using dimensioning type Integrated on page 411
**Example: Reinforcement dimension**

Here are some examples of how Tekla Structures creates dimensions for reinforcing bar groups with different options selected on the **Reinforcement dimensions** tab.

<table>
<thead>
<tr>
<th>Settings</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions for reinforcing bar groups is set to On, no dimension tags selected in Mark location.</td>
<td><img src="image1.png" alt="Example 1" /></td>
</tr>
<tr>
<td>Dimensions for reinforcing bar groups is set to On, dimension tags selected in Mark location.</td>
<td><img src="image2.png" alt="Example 2" /></td>
</tr>
<tr>
<td>Dimensions for reinforcing bar groups is set to On, dimension tags selected in Mark location, Close dimensions to binding geometry is set to Yes.</td>
<td><img src="image3.png" alt="Example 3" /></td>
</tr>
</tbody>
</table>

See also [Reinforcement dimensioning properties on page 548](#)
[Dimensioning using dimensioning type Integrated on page 411](#)

**Adding automatic dual dimensions**

You can create dual dimension tags automatically in all types of drawings.

**Limitations:**

Dual dimensions can only be shown in relative and US absolute dimensions, but not in absolute dimensions.

To create dual dimensions:

1. Click Click **Tools --> Options --> Options** and select **Drawing dimensions**.
2. Set the units, format and precision.
3. Select the drawing types where you want to have the dual dimensions.
4. Click **OK**.
When Tekla Structures creates the drawing, it adds in the lower dimension tag in the selected unit and format, and adds the text DIMENSION in the middle dimension tag in the **Dimension Properties** dialog box.

<table>
<thead>
<tr>
<th>Show dimension in middle tag of automatic dimensions:</th>
</tr>
</thead>
<tbody>
<tr>
<td>• In assembly drawings</td>
</tr>
<tr>
<td>• In single-part drawings</td>
</tr>
<tr>
<td>• In cast unit drawings</td>
</tr>
<tr>
<td>• In general arrangement drawings</td>
</tr>
</tbody>
</table>

**Example**  Below is an example of dual dimensions using the units mm and format ###.

![Dual Dimensions Example](image)

**See also**  [Automatic dimension settings on page 381](#)

### Modifying dimensions for unfolded parts

In single-part drawings, you can control the dimensions Tekla Structures adds for unfolded parts that have been created using **View --> Attributes --> Unfolded =Yes**. Use the advanced options in **Tools --> Options --> Advanced Options --> Dimensioning: Unfolding**.

To control the dimensions:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create bending line dimensions for unfolded parts.</td>
<td>Set the advanced option XS_DRAW_BENDING_LINE_DIMENSIONS_IN_UNFOLDING=TRUE.</td>
</tr>
<tr>
<td>To</td>
<td>Do this</td>
</tr>
<tr>
<td>-------------------------------------------------------------------</td>
<td>----------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Create angle and radius dimensions for unfolded parts.            | Set the advanced option
|                                                                   | XS_DRAW_ANGLE_AND_RADIUS_INFO_IN_UNFOLDING=TRUE.                                                                                      |
| Set a prefix text for an angle dimension.                         | Set the advanced option
|                                                                   | XS_ANGLE_TEXT_IN_UNFOLDING_BENDING_LINE_DIMENSIONING=A=.                                                                           |
| Set a prefix text for a radius dimension.                         | Set the advanced option                                                                                                               |
|                                                                   | XS_RADIUS_TEXT_IN_UNFOLDING_BENDING_LINE_DIMENSIONING=R=.                                                                          |
| For angle text dimensions, show the interior angle instead of the exterior angle. | Set the advanced option                                                                                                               |
|                                                                   | XS_DRAW_INSIDE_ANGLE_IN_UNFOLDING=TRUE.                                                                                               |
| Set the format for angle text.                                    | Set the advanced option
|                                                                   | XS_UNFOLDING_ANGLE_DIM_FORMAT=1.                                                                                                     |
|                                                                   | 
|                                                                   | ###= 0                                                                                                                                |
|                                                                   | ###[.#]= 1                                                                                                                             |
|                                                                   | ###.#=2                                                                                                                               |
|                                                                   | ###[#]= 3                                                                                                                              |
|                                                                   | ###.##= 4                                                                                                                              |
|                                                                   | ###[#]=5                                                                                                                                |
|                                                                   | ###.###= 6                                                                                                                              |
|                                                                   | ### *#*= 7                                                                                                                              |
|                                                                   | ###*##*= 8                                                                                                                              |
| Set the accuracy of the angle text.                               | Set the advanced option                                                                                                               |
|                                                                   | XS_UNFOLDING_ANGLE_DIM_PRECISION=1                                                                                                    |
|                                                                   | 0.00= 1                                                                                                                                |
|                                                                   | 0.50= 2                                                                                                                                |
|                                                                   | 0.33= 3                                                                                                                                |
|                                                                   | 0.25= 4                                                                                                                                |
|                                                                   | 1/8= 5                                                                                                                                |
|                                                                   | 1/16= 6                                                                                                                                |
|                                                                   | 1/32= 7                                                                                                                                |
|                                                                   | 1/10= 8                                                                                                                                |
|                                                                   | 1/100= 9                                                                                                                                |
|                                                                   | 1/1000= 10                                                                                                                             |
Creating minimum and maximum position dimensions for bolts

By default, Tekla Structures does not create minimum and maximum position dimensions for bolts.

To create minimum and maximum position dimensions for bolts:

1. Go to Tools --> Options --> Advanced Options --> Dimensioning: Bolts
2. Set XS_BOLT_POSITION_TO_MIN_AND_MAX_POINT to TRUE.

The examples below show a maximum bolt dimension of 40:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Before setting the advanced option.</td>
<td><img src="image1.png" alt="Diagram" /></td>
</tr>
<tr>
<td>After setting the advanced option to TRUE.</td>
<td><img src="image2.png" alt="Diagram" /></td>
</tr>
</tbody>
</table>

Dimensioning using dimensioning type Integrated on page 411

Creating dimension line extensions

You can create line extensions for dimensions that have line arrows.

To create dimension line extensions:

1. Click Tools --> Options --> Options.
2. Go to the Drawing dimensions page.
3. Enter the length of the dimension line extension in the Dimension line extension length for line arrow box.
**Limitations**  Line extensions cannot be applied to dimensions that have different arrows from line arrows, or to knock-off dimensions of the following type:

![Knock off dimension type](image)

**Example**

<table>
<thead>
<tr>
<th>Line extensions on</th>
<th>No line extensions</th>
</tr>
</thead>
</table>

**See also**  [Dimension appearance properties on page 537](#)

---

**Setting the dimension extension line length**

You can adjust the length of the dimension extension lines. To adjust the extension line settings:

1. Go to the **General** tab of the **Dimensions** dialog box.
2. Select an option from the **Short extension line** list:

<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No</td>
<td><img src="image" alt="Extension line" /></td>
</tr>
<tr>
<td>Yes</td>
<td><img src="image" alt="Extension line" /> Use this option to create extension lines all of the same length: <img src="image" alt="Extension line" /></td>
</tr>
</tbody>
</table>

---

Modifying drawing settings  437  Automatic dimension settings
<table>
<thead>
<tr>
<th>Options</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>On grid lines only</td>
<td>Use this option to use the short extension line automatically if a dimension line falls on a grid line. Elsewhere the extension line will be as usual.</td>
</tr>
</tbody>
</table>

3. Click OK.

4. If you need to adjust the extension line lengths, go to Tools --> Options --> Advanced Options --> Dimensioning: General and use the following advanced options:

- Use `XS_DIMENSION_EXTENSION_LINE_TOWARD_FACTOR` to adjust the length of the dimension extension lines that are facing towards the dimension points.
- Use `XS_DIMENSION_EXTENSION_LINE_AWAY_FACTOR` to adjust the length of the dimension extension lines that are facing away from the dimension points.

1. Text height * 1.0 (default)
Changing the appearance of absolute dimensions

You can select whether to show zero at the zero point of the absolute dimensions, and also change the orientation of the absolute dimensions.

To change the appearance of absolute dimensions:

1. Click **Tools** > **Options** > **Options**, and go to the **Drawing dimensions** page.
2. Set **Show zero in absolute dimensions** to **No** if you do not want to show zero at the zero points in absolute dimensions. **Yes** is the default value.
3. Set **Draw absolute dimension values parallel to dimension line** to **Yes** to show dimensions parallel to dimension lines in absolute dimensions. **No** is the default value.
4. Click **OK**.

**Example**  
In the following example, dimensions are parallel to the dimension line and zero is shown at the zero point.

```
1672  681  0
```

**See also**  
*Dimension appearance properties on page 537*  
*Automatic view-specific dimensions on page 382*  
*Settings in the Options dialog box*
Creating exaggerated dimensions
You can exaggerate narrow dimensions to make them easier to read.

When you enable the exaggeration of the dimensions, a dimension that is narrower than the defined limit is enlarged. If there are many exaggerated dimensions, Tekla Structures arranges them automatically. Setting exaggeration consists of selecting the exaggeration limit and the exaggeration scale, enabling the exaggeration and setting the direction, origin, width, position and height for the exaggerated dimensions.

For single-part, assembly and cast unit drawings, save the dimension exaggeration properties on object level in an open drawing into a dimension properties file, which you can take into use when you modify dimensioning rules.

Limitation: Exaggeration works only if the dimension extension lines are long. Set Short extension line to No on the General tab of the Dimension Properties dialog box.

To set the exaggeration:
1. Go to Tools -- Options -- Options -- Drawing dimensions.
2. Enter the exaggeration limit in the Exaggeration limit box.
3. Select Paper or Model as the exaggeration scaling method.
   If you select Paper, the exaggeration limit is multiplied by the view scale. For example, if the scale is 1:10 and the limit is 10 mm, then all the dimensions smaller than 100 mm are exaggerated.
   If you select Model, and the scale is 1:10, all the dimensions smaller than 10 mm are exaggerated regardless of the drawing scale.
4. Click OK.
5. Open a drawing and double-click a dimension.
6. Go to the Marks tab of the Dimensions dialog box.
7. Enable the exaggeration by setting Exaggeration to Specified.
8. Set the values for Direction, Origin, Width, Position and Height.
9. Enter a name for the dimension properties file at the top and click Save.
10. If you want to modify the current dimension, click Modify. Otherwise, close the dialog box.
    Now you have a dimension properties file that contains the exaggeration settings, which you can load later on or use in dimensioning rules.

Example  See below for an example of exaggerated dimensions:
Changing the prefix in radial dimensions

By default, the prefix of radial dimensions is R, for example, R 200.

To change the dimension prefix to Radius 200, for example:

1. Open the file `dim_operation.ail` located in `..\Tekla Structures \<version>\messages\`.
2. Change the prefix R to Radius:
### Dimensioning plates

You can dimension plates using the advanced options in **Tools --> Options --> Advanced Options... --> Dimensioning: Parts**.

To dimension plates:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Dimension the plates to the edge that is nearest to the neighbor part | **Set the advanced option**  
  
  `XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR` to **TRUE**. |
| Dimension the plates to the leading edge of the beams | **1.** Disable the advanced option  
  
  `XS_USE_PLATE_SIDE_POSITIONING` by deleting the value from the box.  
  
  **2.** Set the advanced option  
  
  `XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR` to **FALSE**.  
  
  **3.** Set the advanced option  
  
  `XS_PART_POSITION_TO_LEADING_EDGE` to **TRUE**. |
| Dimension the plates to the leading edge of the columns | **1.** Disable the advanced option  
  
  `XS_USE_PLATE_SIDE_POSITIONING` by deleting the value from the box.  
  
  **2.** Set the advanced option  
  
  `XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR` to **FALSE**.  
  
  **3.** Set the advanced option  
  
  `XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO` to **TRUE**. |
| Dimension the plates to the trailing edge          | **1.** Disable the advanced option  
  
  `XS_USE_PLATE_SIDE_POSITIONING` by deleting the value from the box.  
  
  **2.** Set the advanced option  
  
  `XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR` to **FALSE**. |

See also Adding manual dimensions on page 142

```csharp
string dim_operation_dim_radius_prefix( ... entry = ("enu", "R "););
string dim_operation_dim_radius_prefix( ... entry = ("enu", "Radius "););
```
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>3. Disable the advanced option</td>
<td><code>XS_PART_POSITION_TO_LEADING_EDGE</code> by deleting the value from the box.</td>
</tr>
<tr>
<td>4. Disable the advanced option</td>
<td><code>XS_PART_POSITION_TO_LEADING_EDGE_IN_COLUMNS_ALSO</code> in the same way.</td>
</tr>
<tr>
<td>Dimension the plates using their original reference points in the</td>
<td>1. Set the advanced option</td>
</tr>
<tr>
<td>model</td>
<td><code>XS_PART_POSITION_TO_EDGE_NEAREST_TO_NEIGHBOUR</code> to <code>FALSE</code>.</td>
</tr>
<tr>
<td></td>
<td>2. Set the advanced option</td>
</tr>
<tr>
<td></td>
<td><code>XS_USE_PLATE_SIDE_POSITIONING</code> to <code>TRUE</code>.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> If you have created one plate from left to right and another</td>
</tr>
</tbody>
</table>
Dimensioning profiles

You can affect the way Tekla Structures dimensions different profiles in drawings. For example, you can have Tekla Structures always dimension round bars to the middle of the profile and large I profiles to the top.

To define dimension settings for profiles, you need to edit the dimension planes table `dim_planes_table.txt`.

To define dimensioning settings for profiles:

1. Go to **Tools -- Options -- Advanced Options... -- Dimensioning: Parts**.
2. Set the advanced option `XS_PART_DIMENSION_PLANES_TABLE` as follows:
   ```
   XS_PART_DIMENSION_PLANES_TABLE=%XS_PROFDB%\dim_planes_table.txt
   ```
   This variable defines the path to the part dimension planes table.
3. Open the `dim_planes_table.txt` file in any text editor, for example, Microsoft Notepad. The file is located in `..\Tekla Structures\<version>\environments\<environment>\profile`.
4. Edit the file contents.
5. To use the new settings in drawings, restart Tekla Structures and recreate the drawings. Changing the file does not automatically update existing drawings.

**Example** Here is an example of a dimension planes table:

```
dim_planes_table.txt
FLANGE WEB
ProfType,MaxSize, middle, right, left, middle, right, left
========================================================================
1, 300.0, TRUE*, FALSE, FALSE, FALSE, TRUE*, TRUE
7, -1.0, TRUE*, FALSE, FALSE, TRUE*, FALSE, FALSE
```

The line beginning with 1 means that Tekla Structures always dimensions I profiles (ProfType = 1) smaller than 300 mm (MaxSize = 300) to the middle of the flange and to the right edge of the web, no matter how the part was created.

The line beginning with 7 means that Tekla Structures always dimensions round tubes (ProfType = 7) to the middle of the profile.

The ProfType numbers run in the same order as the profiles in the Profile catalog:
- 1 = I profile
- 2 = L profile
- 3 = Z profile
- 4 = U profile
• 5 = plate
• 6 = round bar
• 7 = round tube
• 8 = square pipe
• 9 = C profile
• 10 = T profile
• 15 = ZZ profile
• 16 = CC profile
• 17 = CW profile
• 51 = polygon_plate etc.

The value \(-1.0\) in the MaxSize indicates that there is no size limit for the profile.
The asterisk after TRUE indicates that it is the default value.

See also
XS_I_PROFILE_CENTER
XS_DO_NOT_CREATE_PROFILE_DIMENSIONS_FOR_CONCRETE
XS_PART_DIMENSION_PLANES_TABLE
Dimensioning using dimensioning type Integrated on page 411

Sloped dimension texts
Tekla Structures aligns slightly sloped dimension text. If the dimension text is sloped more than a certain degree, Tekla Structures flips the text.

Below is an example of a dimension text that is slightly sloped.

Below is an example of a flipped dimension text.
The default limit for aligning dimension text is 0.1 (5.74 degrees). When this limit is exceeded, the dimension text gets flipped. To adjust this limit, use the advanced option XS_TEXT_ORIENTATION_EPSILON.

See also XS_TEXT_ORIENTATION_EPSILON

Automatic dimensioning of general arrangement drawings

In the general arrangement drawing General - Dimensioning Properties dialog box, you can create part, grid and overall dimensions, and control the way they are created. You can experiment with different combinations of options to achieve different kinds of dimensioning effects.

To select the dimensions to create and modify the dimensioning settings:

1. Click Drawings & Reports --> Drawing Settings --> General Arrangement Drawings.
2. Click Dimensioning.
3. Select the dimensions to create and modify the related settings.
4. On the Grids tab, adjust the grid dimension and overall dimension creation settings and the positioning of the dimensions.
5. On the Parts tab, adjust part dimension creation settings and the positioning of the dimensions.
6. Click OK.

See also Object groups in dimensioning on page 447
Dimensioning object groups on different dimension lines on page 447
Example: Grid and overall dimensions on page 448
Example: Using maximum leader line length options on page 450
Example: Dimensioning parts partly outside the view on page 451
Example: Limiting the number of outside dimensions on page 451
Example: Part dimension positioning on page 452
Object groups in dimensioning

In dimensioning of general arrangement drawings, the term object group refers to objects that have been grouped together for the purpose of dimensioning object groups on different dimension lines.

You can use the object groups (selection filters) that you have created when modeling, or create the necessary groups through the Parts tab in the General – Dimensioning Properties dialog box. For example, you might want to create an object group for beams of a certain size.

See also Filtering objects
Dimensioning object groups on different dimension lines on page 447

Dimensioning object groups on different dimension lines

You can use object groups to specify different objects to be dimensioned on different dimension lines.

To do this:

2. Add the desired object groups to dimensioning rules by clicking Add rule and selecting the rule from the list in the Object group column.
3. If needed, you can create object groups of your own by clicking Object group. For example, add object group rules for beams of different size.
4. For each object group, select the Positioning option, the Horizontal position option, and the Vertical position option, depending on the type of the objects in the group. For example, for beam groups, set Horizontal position to Left side to position the beam dimensions to the left side of the grid.
5. If needed, in the Tag column, enter the text tags that you want to display for the different object groups in the drawing. For example, enter the size of the beam.

Example In this example, we created several beam groups, one for each beam size to be dimensioned, then selected the position for the dimensions in different groups, and added tags to be displayed for each group:
See also
- Object groups in dimensioning on page 447
- Example: Part dimension positioning on page 452
- Part dimensioning properties (GA drawings) on page 549
- Automatic dimensioning of general arrangement drawings on page 446
**Example: Grid and overall dimensions**

Here are some examples of what the grid and overall dimensions look like with different settings selected on the Grid tab.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Grid line dimensions</strong> is set to <strong>On</strong>, <strong>Overall dimension</strong> to <strong>On</strong>, <strong>Horizontal</strong> to <strong>Left</strong>, and <strong>Vertical</strong> to <strong>above</strong>.</td>
<td><img src="image1" alt="Example 1" /></td>
</tr>
<tr>
<td><strong>Grid line dimensions</strong> is set to <strong>On</strong>, <strong>Overall dimension</strong> to <strong>Off</strong>, <strong>Horizontal</strong> to <strong>Left</strong>, and <strong>Vertical</strong> to <strong>above</strong>.</td>
<td><img src="image2" alt="Example 2" /></td>
</tr>
</tbody>
</table>

*See also*  
Grid and overall dimensioning properties (GA drawings) on page 548  
Automatic dimensioning of general arrangement drawings on page 446
**Example: Using maximum leader line length options**

Here are some examples of how the dimensions are positioned when you have set values for the *Maximum leader line length* options on the *Parts* tab.

<table>
<thead>
<tr>
<th>Dimensioning setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>A value has been set for <strong>Outside dimensions</strong>.</td>
<td><img src="image" alt="Example of outside dimensions" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Dimension example" /></td>
</tr>
<tr>
<td>A value has been set for <strong>Inside dimensions</strong>.</td>
<td><img src="image" alt="Example of inside dimensions" /></td>
</tr>
<tr>
<td></td>
<td><img src="image" alt="Dimension example" /></td>
</tr>
</tbody>
</table>
Example: Dimensioning parts partly outside the view

Here is an example of how the parts are dimensioned if you set the option Include parts not entirely in the view to On on the Parts tab.
**Example: Limiting the number of outside dimensions**

Here is an example of what the part dimensions look like when you have set 3 as the value for the option **Maximum number of outside dimensions** on the Parts tab. Tekla Structures has created three dimensions outside the grid and the fourth inside the grid.

![Diagram showing part dimensions]

**See also**  
Part dimensioning properties (GA drawings) on page 549  
Automatic dimensioning of general arrangement drawings on page 446

**Example: Part dimension positioning**

Here are some examples of how the part dimensions are positioned in general arrangement drawings with different positioning settings selected on the Parts tab.

In the example below, Positioning is set to **Inside grid**, which places all dimensions next to or near the grid.
In the example below, **Positioning** is set to **Outside grid**, which places all dimensions outside the grid.
In the example below, **Horizontal position** is set to **Left side**, which places all dimensions to horizontal parts to the left of the grid.

In the example below, **Horizontal position** is set to **Right side**, which places all dimensions to horizontal parts to the right of the grid.
In the example below, **Horizontal position** is set to **Distributed to both sides**, which places all dimensions to horizontal parts to the side of the grid nearest the part they are dimensioning.
In the example below, **Vertical position** is set to **Above**, which places all dimensions to vertical parts above the grid.

In the example below, **Vertical position** is set to **Below**, which places all dimensions to vertical parts under the grid.
In the example below, **Vertical position** is set to **Distributed to both sides**, which places all dimensions to vertical parts to the side of the grid nearest the part they are dimensioning.
Example: Dimensions in anchor bolt plans

Below are examples of what the dimensions in anchor bolt plans look like in different situations.

First an example of a typical situation, where all columns are located in grid line intersections:

If the column reference point is not located on the grid line, Tekla Structures dimensions the reference point automatically relative to the grid lines. See the example below.
If the column is rotated relative to the drawing, the rotation is also automatically dimensioned. See the example below.
If you set the advanced option `XS_ANCHOR_BOLT_PLAN_USE_VIEW_COORDSYS_FOR_BOLT_DIMENSIONS` to `FALSE` and create the drawing, all dimensions are in the drawing coordinate system.
7.14 Automatic mark settings

Marks are associative annotation objects that are used for identifying individual building objects in a drawing. A mark displays a set of user-selectable properties. Automatic marks are marks that Tekla Structures creates in a drawing based on the mark properties defined separately for each view before creating a drawing. You can modify the mark properties after creating the drawing, and add marks manually in an open drawing.

The mark properties define what Tekla Structures shows marks and how the marks are shown. In addition, Tekla Structures uses the `contentattributes_global.lst` attributes file for setting the default unit settings for some mark elements. You can use `contentattributes_userdefined.lst` when you want to configure settings of your own.

Tekla Structures is able to create the following automatic marks:

- Part marks
- Bolt marks

See also [XS_ANCHOR_BOLT_PLAN_USE_VIEW_COORDSYS_FOR_BOLT_DIMENSIONS](#)  
Creating anchor bolt plans using saved settings on page 59
• Neighbor part marks
• Connection marks
• Weld marks
• Reinforcement marks
• Surface treatment marks
• Dimension marks
• View and section view label marks, and section marks

See also
Adding automatic marks on page 462
Setting the visibility of marks on page 464
Merging marks automatically on page 471
Defining contents of bolt mark Size element using advanced options on page 487
Adding level attributes in part marks on page 478
Adding user-defined attributes and template attributes in marks on page 480
Adding templates in marks on page 484
Adding symbols in marks on page 486
Adding pull-out pictures in reinforcement marks on page 489
Unit settings for marks on page 476
Mark location on page 468
Setting the appearance of mark text, frames and leader line on page 465
Mark properties on page 550
Mark elements on page 560
Object protection and placement settings in drawings on page 343
Associative annotation objects on page 175

Adding automatic marks

You can set up marks for building objects (parts, neighbor parts, bolts, surface treatment, connections, reinforcement, and neighbor reinforcement) in the view properties dialog box.

You can save mark settings in a view property file for later use. For general arrangement drawings, automatic marks are defined on drawing level.

To add automatic marks:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the drawing properties that you want to change by selecting the drawing property file from the list at the top.
   General arrangement drawings: You need to click **Load**.

3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. Click the mark type you want to modify, for example, **Part mark**.

5. For some marks, you need to select from a list the object that you are defining the marks for.
   For example, for part marks, you can define part mark settings independently for main and secondary parts, and for sub-assembly main and secondary parts.

6. Add elements in the mark by double-clicking the elements in the **Available elements** list.

7. Modify the element appearance (frame and font).
   For length, height, spacing and diameter elements, you can adjust also the unit and format.

8. Use the **Move up** and **Move down** buttons to place the elements in the order you want.

9. Modify the appearance, placement and visibility settings on the **Content** and **General** tabs.

10. Single-part, assembly and cast unit drawings: Save the view properties by entering a properties file name in the box at the top and click **Save**.
    General arrangement drawings: When you are ready, click **OK** in the subdialog to save the changes and close the subdialog.

11. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**  This is an example of a part mark.
1. Assembly position
2. Size
3. Mark frame
4. Profile
5. Mark element frame
6. Length

See also  
Automatic mark settings on page 461  
Merging marks automatically on page 471  
Mark location on page 468  
Dimension appearance properties on page 537  
Defining placement settings for annotation objects on page 347  
Mark properties on page 550  
Mark elements on page 560  
Adding symbols in marks on page 486  
Adding templates in marks on page 484  
Adding user-defined attributes and template attributes in marks on page 480  
Defining contents of bolt mark Size element using advanced options on page 487  
Adding pull-out pictures in reinforcement marks on page 489

Setting the visibility of marks

Using the visibility options in the mark properties you can indicate the views where the marks are displayed.

To set the visibility of marks:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
3. Click a mark type. For example, click Part mark.

4. Go to the General (or Appearance) tab page in mark properties.

5. Select where you want to display the marks using the Visibility of marks or Visibility in view options. The available options depend on the mark type.

6. Single-part, assembly and cast unit drawings: Click Save to save the change in view properties.

7. Click OK.

8. Click Save to save the drawing properties, then click OK and create the drawing.

See also  Mark appearance and merging properties on page 551
Mark properties on page 550

Setting the appearance of mark text, frames and leader line

You can add frames around single mark elements and around the mark itself. You can also adjust the appearance of the mark text and leader line. For some elements, you can change the unit and format.

To adjust the appearance of mark text, leader line and frames, and the unit and format for length, height, spacing and diameter elements:

1. On the Content tab of the in mark properties, select one or several elements from the Elements in mark list.
   
   To select all elements to apply your changes in all of them, hold down Shift and click the last element in the list.

2. Click Add frame.

3. Select a Type and Color for the frame.
   
   You can select a different frame type and color for each element you add.

4. Select the element text Color, Font and Height.
   
   You can select a different color, font and font height for each element you add.

5. If necessary, change the unit and the format of a length, height, spacing or diameter element.
   
   Before you can do this, you must first select the element from the Elements in mark list.

6. Go to the General (or the Appearance) tab and select the mark frame Type and Color.

7. Select the Type for the leader line and the Arrow to use.
   
   All marks do not have leader lines, in which case the leader line type selection is not available.
8. If you want to hide leader lines of hidden parts, set **Use hidden lines for hidden parts** to **Yes**.
   This option is not available for all marks.

9. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties.

10. Click **OK**.

11. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also** Additional ways for modifying part mark leader lines on page 466
Placing the base point of the reinforcement mark leader line automatically on page 467
Mark appearance and merging properties on page 551
Mark properties on page 550

### Additional ways for modifying part mark leader lines

You can modify part mark leader line settings using a couple of advanced options. Click **Tools**
---> **Options** --&gt; **Advanced Options** and go to **Marking: Parts**.

To modify part mark leader line settings using advanced options:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define whether a leader line is drawn when the leader line is shorter than defined with the advanced option</td>
<td>Set <strong>XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS</strong> to <strong>TRUE</strong> (default) to always draw leader lines in part marks. When you set this option to <strong>FALSE</strong>, the leader line is not drawn if it would be shorter than the minimum you set for the advanced option <strong>XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH</strong>.</td>
</tr>
<tr>
<td>Give a minimum length for the leader line. If the length is less than this value, the leader line is not drawn.</td>
<td>Set a value in millimeters for the advanced option <strong>XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH</strong>.</td>
</tr>
<tr>
<td>Define the leader line start position for a leader line with a rectangular frame.</td>
<td>Set a value for the advanced option <strong>XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_RECTANGULAR_FRAME</strong>.</td>
</tr>
<tr>
<td>Define the leader line start position for a leader line of a mark without a frame and for a leader line of a mark with a mark element frame.</td>
<td>Set a value for the advanced option <strong>XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME</strong>.</td>
</tr>
<tr>
<td>Define the length of the leader line extension.</td>
<td>Set a value for the advanced option <strong>XS_MARK_LEADER_LINE_EXTENSION_LENGTH</strong>.</td>
</tr>
</tbody>
</table>

**See also** **XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS**
**XS_DRAW_SHORT_LEADER_LINES_OF_PART_MARKS_MINIMUM_LENGTH**
**XS_MARK_LEADER_LINE_EXTENSION_LENGTH**
**XS_MARK_LEADER_LINE_POSITION_TYPE_FOR_NO_FRAME**
Placing the base point of the reinforcement mark leader line automatically

Tekla Structures places the base point of reinforcement mark leader lines so that it points to only one reinforcing bar. You can adjust how Tekla Structures searches for the place for the base point. Click Tools --> Options --> Advanced Options and go to Concrete Detailing.

To place the reinforcement mark leader line base point automatically:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Select an optimal place for the base point.</td>
<td>Set $\text{XS_ENABLE_REBAR_MARK_LEADER_LINE_BASE_POINT_OPTIMIZATION}$ to $\text{TRUE}$.</td>
</tr>
<tr>
<td>Define how far the other reinforcing bars must be from the base point in order for Tekla Structures to place the base point.</td>
<td>Set a millimeter value for $\text{XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_TOLERANCE}$.</td>
</tr>
<tr>
<td>Define the search step length while searching for an optimal place for the base point along the reinforcing bar.</td>
<td>Set a millimeter value for $\text{XS_REBAR_MARK_LEADER_LINE_BASE_POINT_SEARCH_STEP_LENGTH}$.</td>
</tr>
</tbody>
</table>

Example  An example showing optimized base points.

See also  Setting the appearance of mark text, frames and leader line on page 465

$\text{XS\_REBAR\_MARK\_LEADER\_LINE\_BASE\_POINT\_SEARCH\_STEP\_LENGTH}$
Mark location

The location of the mark is affected by:

- The placement settings in the mark properties
- The type of the selected leader line
- The predefined mark location and part orientation settings
- The modeling direction of parts
- Protection settings

See also
- Setting a predefined location for beam, bracing and column marks on page 468
- Protected areas on page 344
- Defining placement settings for annotation objects on page 347
- Using part mark as an orientation mark in general arrangement drawings on page 497
- Orientation settings on page 590
- Part mark and surface treatment mark leader line types and mark location on page 469
- Reinforcement leader line types and mark location on page 470
- Leader line types and mark location for reinforcing bar group marks on page 469
- Mark properties on page 550
- Mark appearance and merging properties on page 551

Setting a predefined location for beam, bracing and column marks

By default, part marks are placed at the end point of the part. You can change this by adjusting the predefined location settings for beam, bracing and column marks.

1. Click **Tools** --> **Options** --> **Options** --> **Orientation marks**.
2. In **Mark location: Preferred location for beams and bracings**, select **Left** or **Right** to place the mark to the left or right end of the part.
3. In **Mark location: Mark always to center of column in GA drawings**, select **Yes** to place part marks in the center of columns in plan views, or **No** to place part marks on the same flange in GA drawings and assembly drawings.
4. Click **OK**.

See also
- Mark location on page 468
Part mark and surface treatment mark leader line types and mark location

Part marks and surface treatment marks have several types of leader lines you can select. The type of the leader line affects the location of the mark.

<table>
<thead>
<tr>
<th>Leader line type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>⫫</td>
<td>Always uses a leader line.</td>
</tr>
<tr>
<td>⫫(⫫)</td>
<td>Tries to find a space along the part for the mark. If impossible, Tekla Structures uses a leader line.</td>
</tr>
<tr>
<td>⫫</td>
<td>The mark is always along the part. Lack of space might cause the mark to overlap other elements.</td>
</tr>
<tr>
<td>⫫</td>
<td>The mark is always inside the part.</td>
</tr>
<tr>
<td>⫫</td>
<td>The mark is always inside the part and parallel to the part axis.</td>
</tr>
<tr>
<td>⫫(⫫)</td>
<td>Tries to find a space for the mark inside the part. If impossible, Tekla Structures places the mark along the part with a leader line.</td>
</tr>
<tr>
<td>⫫(⫫)</td>
<td>Tries to find a space inside the part for the mark and align it parallel to the part axis. If impossible, Tekla Structures places the mark along the part with a leader line.</td>
</tr>
<tr>
<td>⫫</td>
<td>Places the part mark along and in the middle of a part face.</td>
</tr>
</tbody>
</table>

See also Mark location on page 468
Mark appearance and merging properties on page 551
Mark properties on page 550

Leader line types and mark location for reinforcing bar group marks

In reinforcing bar groups Tekla Structures first tries to place the mark on the middle bar if it is visible. If that is not possible, Tekla Structures tries the next visible bar.

Here is a list of leader line options available for identical reinforcement marks and reinforcing bar group marks:
<table>
<thead>
<tr>
<th>Option</th>
<th>Image</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>One leader line to group</td>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="example1.png" alt="Example" /></td>
</tr>
<tr>
<td>One leader line per row</td>
<td><img src="image2.png" alt="Image" /></td>
<td><img src="example2.png" alt="Example" /></td>
</tr>
<tr>
<td>Parallel leader lines</td>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="example3.png" alt="Example" /></td>
</tr>
<tr>
<td>Leader lines to one point</td>
<td><img src="image4.png" alt="Image" /></td>
<td><img src="example4.png" alt="Example" /></td>
</tr>
</tbody>
</table>

See also
- Mark appearance and merging properties on page 551
- Mark location on page 468
- Mark properties on page 550
Reinforcement leader line types and mark location

Reinforcement marks have several types of leader lines you can select. The type of the leader line affects the location of the mark.

Tekla Structures tries to place the mark close to the midpoint on straight bars, or to the midpoint of the longest bar segment.

<table>
<thead>
<tr>
<th>Reinforcement leader line type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>![Leader Line Icon]</td>
<td>Always creates a leader line.</td>
</tr>
<tr>
<td>![Leader Line Icon with Bar]</td>
<td>Tries to find a space along the reinforcing bar for the mark. If impossible, creates a leader line.</td>
</tr>
<tr>
<td>![Leader Line Icon Parallel]</td>
<td>The mark is always along the reinforcing bar. The mark may overlap other elements if there is not enough space.</td>
</tr>
<tr>
<td>![Leader Line Icon with Bar Parallel]</td>
<td>The mark is parallel to the reinforcing bar.</td>
</tr>
<tr>
<td>![Leader Line Icon Parallel with Bar]</td>
<td>The mark is parallel to the reinforcing bar on line. If there is not enough space for the mark, a leader line is created.</td>
</tr>
</tbody>
</table>

See also  
Mark location on page 468  
Setting the appearance of mark text, frames and leader line on page 465  
Mark appearance and merging properties on page 551  
Mark properties on page 550

Merging marks automatically

You can let Tekla Structures automatically merge marks.

You can automatically merge part marks, surface treatment marks and reinforcement marks.

See also  
Merging part marks on page 473  
Merged reinforcement marks on page 474  
Merging reinforcement marks automatically on page 474  
Merging marks on page 183

Merged part marks

A merged part mark means that only one part mark is used for similar parts in a drawing. Merged part marks indicate the number of included parts, and contain the specified part mark contents, and the near side and far side information. The marks are merged only in x direction of the main part.

Tekla Structures merges marks for visible parts in drawings if:
• The secondary parts are welded or bolted to the same main part.
• The parts are on the same line.
• Distances between the parts are equal.
• The parts have the same part position.
• Distance between parts is not more than what is set for the advanced option XS_PART_MERGE_MAX_DISTANCE.
• There are at least as many parts in the array as it has been set for the advanced option XS_MIN_MERGE_PART_COUNT.

Limitations
• Part marks can be merged only on view and drawing level. It is not possible to merge or split part marks manually.
• Tekla Structures does not merge neighbor part marks.

Example
In the example below, the part marks are merged.

In the example below, the leftmost part marks are not merged, because they are too far from each other.

In the example below, the marks in the y direction are not merged.
You can merge part marks automatically to reduce the number of marks in the drawing.

To merge part marks automatically:
1. On the General tab in the part mark properties, set **Merge marks** to **On**.
2. Single-part, assembly and cast unit drawings: Click **Save** to save the changes in view properties and **OK** to return to drawing properties.
   General arrangement drawings: Click **OK**.
3. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

This setting merges marks for identical secondary parts on both faces of main parts.

See also
- **Merging part marks on page 473**
- **Mark appearance and merging properties on page 551**
- **XS_MULTIPLIER_SEPARATOR_FOR_MERGED_PART_MARK**
- **XS_NSFS_POSTFIX_FOR_MERGED_PART_MARK**
- **XS_NS_POSTFIX_FOR_MERGED_PART_MARK**
**Merged reinforcement marks**

Tekla Structures can automatically merge similar reinforcement marks of bars. Merged marks may include several blocks, and additional information. Blocks combine similar single marks.

To have Tekla Structures automatically merge reinforcement marks in drawings, the reinforcement must be attached to a concrete part or cast unit in the model.

Tekla Structures automatically merges marks for visible reinforcing bars in drawings if:

- The bars belong to the same concrete part or cast unit.
- The direction of the bars is the same.
- The bar marks are identical.
- The bars are close to each other.
- A straight line can be drawn through all the bars.

You can also define the distance within which to automatically merge marks for visible reinforcing bars using advanced options.

**See also**  
Merging reinforcement marks manually on page 183  
Merging reinforcement marks automatically on page 474

**Merging reinforcement marks automatically**

1. Go to the **Merging** tab of the **Cast Unit - Reinforcement Marks** dialog box.
2. Select an option from the **Identical marks in same cast unit** list to merge marks and create leader lines.
3. If there are several possible merge directions, select the direction from **Preferred direction of merge**.
4. Select the contents to be included in the merged reinforcement marks from the **Available elements** list.

To ensure that merged reinforcement marks appear in the drawing, always include **Symbol separating blocks in mark** as the last element in the reinforcement mark. To omit the separating symbol, leave this box blank, but still include the element in the mark.
5. If needed, add a frame around the single elements in the mark. You can define the frame individually for each element.

6. Adjust the font, font height and the color of the mark text. You can adjust these settings individually for each element.

7. Click OK.

**Example** In this example, we merge three A φ12 L2000 marks to a block, and six V φ8 L650 marks to another block, and then merge them in the following way:

3 A φ12 L2000 c/c150 & 6 V φ8 L650 c/c50

1. Single mark content
2. Symbol separating the blocks
3. Block prefix
4. Distance between groups
5. Block 1
6. Block 2

**See also** Mark appearance and merging properties on page 551

**Showing mark frames and leader lines for hidden parts**

If a part is behind another part in the drawing so that it is hidden, you can select to show the mark frame and leader line of the hidden part with a dashed or a solid line.

To set the mark frame and leader line appearance for the part marks of hidden parts:

1. In part mark properties, go to the **General** tab.
2. Use one of the following options:
<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Use hidden lines for hidden parts: Yes</strong></td>
<td>Part mark frame and leader line are shown with a dashed line.</td>
</tr>
<tr>
<td><strong>Use hidden lines for hidden parts: No</strong></td>
<td>Part mark frame and leader line are shown with a solid line.</td>
</tr>
</tbody>
</table>

3. Single-part, assembly and cast unit drawings: Click **Save** the save the view properties.

4. Click **OK**.

---

The advanced option `XS_OMIT_MARKS_OF_HIDDEN_PARTS_IN_GA_DRAWINGS` affects the displaying of marks of hidden objects in general arrangement drawings.

---

See also
- Mark appearance and merging properties on page 551
- `XS_OMIT_MARKS_OF_HIDDEN_PARTS_IN_GA_DRAWINGS`
- Mark properties on page 550

---

**Unit settings for marks**

**Tekla Structures** uses the `contentattributes_global.lst` attributes file for setting the default unit settings for various mark elements. This file defines, for example, the unit used, and the number of decimals. You can change the unit and format for the length, height, diameter, and spacing elements in the mark, associative note and dimension mark properties dialog box. If you change the unit and format, save the changes for future usage in a property file if necessary. One additional way to change the unit is to add individual settings at the end of the `contentattributes.lst` file.

The `contentattributes_global.lst` file also defines default values for attributes in templates created in Template Editor.
Do not edit contentattributes_global.lst.

For user-defined attributes in mark elements, the default unit settings are taken from the contentattributes_userdefined.lst file. You can use contentattributes_userdefined.lst also when you want to configure settings of your own. By default, this file is located in ..\Program Files\Tekla Structures\<version>\nt\TplEd\settings, but often the location depends on your environment.

The container file contentattributes.lst lists all the files that contain the actual attribute definitions. The order of the files included in contentattributes.lst defines the reading order of the files.

You can add in the mark a template that changes the unit and number of decimals. This affects all drawings that have marks containing the changed template.

Example

This first example shows how you can change the unit and format of a length element in the part mark, save your changes in a property file and apply the changes in a part mark.

1. Double-click the background of an open drawing to open the Drawing Properties dialog box.
2. Click Part mark.
3. And a Length element in the part mark.
4. Adjust the unit and format as required. For example, select mm and ###.##.
   The unit and format settings become available when you select a length element in the Elements in mark list.

<table>
<thead>
<tr>
<th>Automatic</th>
<th>mm</th>
<th>cm</th>
<th>m</th>
<th>foot - inch</th>
<th>cm / m</th>
<th>inch</th>
</tr>
</thead>
<tbody>
<tr>
<td>Automatic</td>
<td>###</td>
<td>##</td>
<td>###</td>
<td>###</td>
<td>###</td>
<td>#/e</td>
</tr>
</tbody>
</table>

5. Give a name to the property file next to the Save as button and click Save as.
   Now you load this file later on when you need to use the same unit and format again.
6. Click Modify.
   All the part marks in your drawing now have the new unit and format setting for the length element.
Example

This second example shows a situation when you want a certain project to have certain individual settings. In this case, you can add `contentattributes.lst` under the model folder, and add this individual setting at the end of the `contentattributes.lst`. See the example below showing the included global attributes and user attributes files, and the added DIAMETER setting.

```plaintext
// Template Editor 3.20 - Attributes

// This is a container file where all needed attribute files are included.

// Global attributes defined in source code
[INCLUDE :settings\contentattributes_global.lst]

// User attributes defined in 'objects.ini'
[INCLUDE contentattributes_userdefined.lst]

DIAMETER FLOAT RIGHT TRUE 5 2 Length mm

[ENDINGS] // Do NOT remove this line
```

See also

Mark elements on page 560

Template attribute files

Adding templates in marks on page 484

Location of certain files in hidden folders

Adding level attributes in part marks

You can add level attributes (TOP_LEVEL, BOTTOM_LEVEL, ASSEMBLY_TOP_LEVEL, ASSEMBLY_BOTTOM_LEVEL, and ASSEMBLY.MAIN_PART.TOP_LEVEL) in part marks and associative notes as user-defined attributes. The level attributes take the dimension format from the `MarkDimensionFormat.dim` file. You can change the dimension format in the level attributes in an open drawing.

You can add level attributes in automatic and manual marks, and modify the settings later on.

To add level attributes and change their dimension format in an open drawing:

1. In the open drawing, double-click the part mark where you want to add level attributes.
2. In part mark properties, double-click the User-defined attribute element to add it to the mark.
3. Enter a user-defined attribute name in the Mark content - user defined attribute dialog box.
   
   You can enter TOP_LEVEL, BOTTOM_LEVEL, ASSEMBLY_TOP_LEVEL, ASSEMBLY_BOTTOM_LEVEL, CAST_UNIT_TOP_LEVEL, CAST_UNIT_BOTTOM_LEVEL, and/or ASSEMBLY.MAIN_PART.TOP_LEVEL.
4. Click Modify.
5. Repeat steps 1 - 4 to all marks where you want to add level attributes.
6. Click Dimensioning --> Dimension Properties.
7. Select MarkDimensionFormat from the Load list and click Load.
8. Change the unit, precision and format.

| automatic | 0.00 | ### |
| mm | 0.50 | ###[,] |
| cm | 0.33 | ###, |
| m | 0.25 | ###[,] |
| foot - inch | 1/8 | ###,## |
| cm / m | 1/16 | ###,### |
| inch | 1/32 | ###,## |
| | 1/10 | ##/## |
| | 1/100 | #/##/# |
| | 1/1000 | #/#/#/## |

9. Click Save to save the changes in the MarkDimensionFormat file.
10. Right-click the drawing and select Update all marks.

Example

In the following example, TOP_LEVEL and ASSEMBLY_TOP_LEVEL have been added in the mark.

In the following example, the top level of the part itself (TOP_LEVEL), the top level of the assembly (ASSEMBLY_TOP_LEVEL), and the top level of the assembly main part (ASSEMBLY_MAIN_PART.TOP_LEVEL) have been added in the mark.
**Adding user-defined attributes and template attributes in marks**

All types of building object marks allow you to add user-defined attributes and template attributes. For example, you might want to add control numbers or specify the number of characters in part numbers in assembly or part marks.

You can add user-defined attributes in automatic and manual marks.

To add a user-defined attribute in a building object mark:

1. In the mark properties dialog box, double-click the **User-defined attribute** element to add it to the mark.

2. Enter the user-defined attribute name in the **Mark content - user defined attribute** dialog box exactly as it appears in the **objects.inp** file.

   You can also enter a template attribute.

3. Click **OK**.
4. Save the properties and create the drawing.

**Example** In the following example, the user-defined attribute `OBJECT_LOCKED` has been added in the part mark after a text element `Locked`.

![Locked: Yes](image)

**See also**
- Adding level attributes in part marks on page 478
- Customizing user-defined attributes
- Template Attributes Reference Guide
- ASSEMBLY_BOTTOM_LEVEL
- ASSEMBLY_TOP_LEVEL
- TOP_LEVEL
- BOTTOM_LEVEL
- Mark elements on page 560
- Common elements in marks on page 560
- Automatic mark settings on page 461

**Example 1: Creating a mark template containing separate value fields and text elements**

You may want to use decimals instead of fractions in your part marks in the US Imperial environment. In this example, you will create a part mark template and use separate value fields and text elements in the template to change from fractions to decimals. You will also set the desired number of decimals.

You can do this in automatic and manual marks.

To create a part mark template containing separate value fields and text elements in an automatic part mark:

1. Click **Drawings & Reports** --> **Drawing Settings** and select the drawing type. Load the desired drawing properties.
2. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
3. Click **Part mark**.
4. Double-click **Template** in the **Available elements** list.
5. In the **Mark content – template** dialog box, click **Create new...**. This starts the Template Editor.

6. Click **File --> New** and create a new graphical template.

7. Click **Insert -->> Component -->> Row**.

8. Select **PART** as the content type.

9. Click **Insert -->> Text**, enter **L** and place it inside the row you just added.

10. Click **Insert -->> Value field** and place the value field on the right side of the **L** text.

11. In the displayed **Select Attribute [Part]** dialog box, scroll down to **PROFILE – Profile**, open the profile tree, select the **HEIGHT – height** property and click **OK**.

12. Double-click the value field. In the **Value Field Properties** dialog box, change the settings as follows:
   - **Unit**: inch
   - **Decimals**: 1
   - **Length**: 8

13. Click **OK**.

14. Click **Insert -->> Text**, enter **X** as text and place it on the right side of the value field.

15. Repeat steps 8–11 to add another value field for the width information (**WIDTH – Width** profile property).

16. Click **Insert -->> Text** and add the second **X** between the value fields.

17. Add the third value field for the profile flange thickness by selecting **FLANGE_THICKNESS_1 – Flange thickness 1** profile property and modify the settings as follows:
   - **Unit**: inch
   - **Decimals**: 2
   - **Length**: 4

18. Click **Edit -->> Properties...** and minimize the height and the width of the row.

19. Click **File --> Save** to save the template.

   The template is by default saved as a **.tpl** file in the **\mark** folder under the model folder. You can copy this template to other models as required.

20. In Tekla Structures, click **Refresh list** in the **Mark content – template** dialog box to see the template you created.

21. Select the template and click **OK**.

22. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties and click **OK** to return to drawing properties.

   General arrangement drawings: Click **OK** to save the mark properties and return to drawing properties.
23. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**  
The first example below uses fractions and the second one decimals.

![Fraction example](image1)

![Decimal example](image2)

**Example 2: Creating a mark template containing a formula in the value field**

In the second example, you want to use decimals instead of fractions in US Imperial environment and make the change by using a formula in the value field.

You can do this in automatic and manual marks.

To create a part mark template and define the content by using a formula in the value field in an automatic part mark:

1. Click **Drawings & Reports** --> **Drawing Settings** and select the drawing type.
   
   Load the desired drawing properties.

2. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

3. Click **Part mark**.

4. Double-click **Template** in the **Available elements** list.

5. In the **Mark content – template** dialog box, click **Create new**....

   This starts the Template Editor.

6. Click **File** --> **New** and create a new graphical template.

7. Click **Insert** --> **Component** --> **Row**.

8. Select **PART** as the content type.

9. Click **Insert** --> **Value field**, and place the field.

10. In the displayed **Select Attribute [Part]** dialog box, click the **Formula...** button.
11. Add the following formula in the **Formula** box and click **OK**:

```
"L " + format(GetValue("HEIGHT"),"Length","inch",1) + " x 
"+ format(GetValue("WIDTH"),"Length","inch",1) + " x " + 
format(GetValue("PROFILE.FLANGE_THICKNESS_1"),"Length","inch",2)
```

12. Double-click the value field to open the **Value Field Properties** dialog box.

13. Set the **Data type** to text, enter a name for the field, for example, **PART_MARK**, and ensure that the length value you give in the **Length** field is high enough to fit all the characters and numbers included, for example, 20.

14. Click **OK**.

15. Click **Edit --> Properties** and minimize the height and the width of the row.

16. Click **File --> Save** to save the template.

   The template is by default saved as a **.tpl** file in the **\mark** folder under the model folder. You can copy this template to other models as required.

17. In Tekla Structures, click **Refresh list** in the **Mark content - template** dialog box to see the template you created.

18. Select the template and click **OK**.

19. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties and click **OK** to return to drawing properties.

   General arrangement drawings: Click **OK** to save the mark properties and return to drawing properties.

20. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**  
[Example 1: Creating a mark template containing separate value fields and text elements on page 481](#)

[Adding templates in marks on page 484](#)

---

**Adding templates in marks**

You can create custom graphical templates (**.tpl**) with Template Editor and add them as elements in all types of marks and associative notes. In the mark templates, you can include detailed information of an embed or assembly, such as the submaterial used. Or you can use a template that changes the unit and the number of decimals in measurement values in a mark. You can also add graphical objects using the Template Editor tools in your mark templates. You can use templates in marks and associative notes in all drawing types.
Before you add a template in a mark, ensure that the template you use does not contain any margins.

The size of the templates in part marks is calculated according to the actual size of template contents. Only lines and texts in the template are considered when calculating the exact size. This means, for example, that circles or bitmaps in the template do not have any effect.

To add a template in a mark:

1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the drawing properties that you want to change.
   - General arrangement drawings: You need to click **Load**.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click the mark type that you want to change.
   - For example, click **Part mark**.
5. In the mark properties dialog box, double-click the **Template** element in the available elements list to add it in the mark.
   - This will remove all other elements from the mark.
6. Select a template from the list in the **Mark content – template** dialog box. If you have not created a template yet, or want to edit the template, you can do it from here.
   - Remember that if you edit the template here, the change affects all drawings that have marks containing the changed template.
7. Click **OK**.
8. Single-part, assembly and cast unit drawings: Save the view properties by clicking **Save** and click **OK** to return to drawing properties.
   - General arrangement drawings: Click **OK** to save the mark properties and return to drawing properties.
9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.
10. When necessary, place the saved mark attribute files from the \attribute folder into your firm folder.

The mark templates are by default searched from the following folders in the following order:

- [%XS_TEMPLATE_DIRECTORY%\mark
- ModelDir\mark
- %XS_PROJECT%\mark
- %XS_FIRM%\mark
- %XS_TEMPLATE_DIRECTORY_SYSTEM%\mark

Modifying drawing settings 485 Automatic mark settings
The mark folder name can be changed using the advanced option XS_TEMPLATE_MARK_SUB_DIRECTORY.

**Example**

![Example mark](image)

**Limitations**
Mark templates do not support image files like the other graphical drawing templates.

**See also**
- XS_TEMPLATE_MARK_SUB_DIRECTORY
- Adding automatic marks on page 462
- Example 1: Creating a mark template containing separate value fields and text elements on page 481
- Example 2: Creating a mark template containing a formula in the value field on page 483
- Unit settings for marks on page 476

**Adding symbols in marks**

All types of marks allow you to add symbols in them. You can select the symbol file to be used and the symbol to be added in the mark.

To add a symbol in a mark in a cast unit or single-part drawing, for example:

1. Click **Drawings & Reports** --> **Drawing Settings** and select the drawing type.
2. Load the drawing properties that you want to change.
3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. In the options tree, click the mark type that you want to change.
   For example, click **Part mark**.
5. In mark properties, double-click **Symbol** in the **Available elements** list.

6. In the **Mark content – Symbol** dialog box, click **Select** next to the **File** box to select the symbol file you want to use.

7. When you have selected the file, click **Select** next to the **Number** box to select the number of the symbol you want to use.

8. Click **OK**.

   Tekla Structures adds the name of the symbol file and the number of the symbol in the elements list.

9. Save the view properties by clicking **Save** and click **OK** to return to the drawing properties panel.

10. Save the drawing properties by clicking **Save**, click **OK** and create the drawing.

See also  
- Symbols in drawings on page 235
- Automatic mark settings on page 461

### Defining contents of bolt mark Size element using advanced options

You can use a couple of advanced options to define the contents of the bolt mark **Size** element in different types of drawings in **Tools --> Options --> Advanced Options --> Marking: Bolts**.

- Note that general arrangement drawings have separate advanced options.
- Any changes made to the advanced options listed in the table below will take place only in the new drawings you create and if you modify the affected bolt marks.

To define the contents for a bolt mark size element:

<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
</table>
| Define the contents of the size element in slotted hole marks or longhole marks (general arrangement drawings). | Set a value for the advanced option **XS_LONGHOLE_MARK_STRING_FOR_SIZE**.  
Set a value for the advanced option **XS_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA**. |
| Define the contents of the size element in slotted hole marks or longhole marks (general arrangement drawings) for site bolts. | Set a value for the advanced option **XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE**.  
Set a value for the advanced option **XS_SITE_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA**. |
<table>
<thead>
<tr>
<th>To</th>
<th>Do this</th>
</tr>
</thead>
<tbody>
<tr>
<td>Define the contents of the size element in slotted hole marks or longhole marks (general arrangement drawings) for workshop bolts.</td>
<td>Set a value for the advanced option <code>XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE</code>. Set a value for the advanced option <code>XS_SHOP_LONGHOLE_MARK_STRING_FOR_SIZE_IN_GA</code>.</td>
</tr>
<tr>
<td>Define the contents of the size element in hole marks.</td>
<td>Set a value for the advanced option <code>XS_HOLE_MARK_STRING_FOR_SIZE</code>. Set a value for the advanced option <code>XS_HOLE_MARK_STRING_FOR_SIZE_IN_GA</code>.</td>
</tr>
<tr>
<td>Define the contents of the size element in hole marks for site bolts.</td>
<td>Set a value for the advanced option <code>XS_SITE_HOLE_MARK_STRING_FOR_SIZE</code>. Set a value for the advanced option <code>XS_SITE_HOLE_MARK_STRING_FOR_SIZE_IN_GA</code>.</td>
</tr>
<tr>
<td>Define the contents of the size element in hole marks for workshop bolts.</td>
<td>Set a value for the advanced option <code>XS_SHOP_HOLE_MARK_STRING_FOR_SIZE</code>. Set a value for the advanced option <code>XS_SHOP_HOLE_MARK_STRING_FOR_SIZE_IN_GA</code>.</td>
</tr>
<tr>
<td>Define the contents of the size element in bolt marks.</td>
<td>Set a value for the advanced option <code>XS_BOLT_MARK_STRING_FOR_SIZE</code>. Set a value for the advanced option <code>XS_BOLT_MARK_STRING_FOR_SIZE_IN_GA</code>.</td>
</tr>
<tr>
<td>Define the contents of the size element in bolt marks for site bolts.</td>
<td>Set a value for the advanced option <code>XS_SITE_BOLT_MARK_STRING_FOR_SIZE</code>. Set a value for the advanced option <code>XS_SITE_BOLT_MARK_STRING_FOR_SIZE_IN_GA</code>.</td>
</tr>
<tr>
<td>Define the contents of the size element in bolt marks for workshop bolts.</td>
<td>Set a value for the advanced option <code>XS_SHOP_BOLT_MARK_STRING_FOR_SIZE</code>. Set a value for the advanced option <code>XS_SHOP_BOLT_MARK_STRING_FOR_SIZE_IN_GA</code>.</td>
</tr>
</tbody>
</table>

You can use any combination of text and the following options as the value for the above advanced options. Enclose each option in `%` characters. To use special characters enter a backslash (`\`) followed by an ASCII number. You can use the options in any order, and make calculations.

- `BOLT_NUMBER`
- `DIAMETER`
- `LENGTH`
- `HOLE.DIAMETER`
- `LONG_HOLE_X`
• LONG_HOLE_Y
• LONGHOLE_MIN (the shorter of the slotted hole dimensions)
• LONGHOLE_MAX (the longer of the slotted hole dimensions)
• BOLT_STANDARD
• BOLT_MATERIAL
• BOLT_ASSEMBLY_TYPE
• BOLT_COUNTERSUNK
• BOLT_SHORT_NAME
• BOLT_FULL_NAME

Example  Example of using the advanced options:
XS_LONGHOLE_MARK_STRING_FOR_SIZE=D%HOLE.DIAMETER% (%HOLE.DIAMETER+LONG_HOLE_X%x%HOLE.DIAMETER+LONG_HOLE_Y%)
XS_SITE_HOLE_MARK_STRING_FOR_SIZE=D%HOLE.DIAMETER%

Please note that for calculations the operator (+, -, *, /) must not be outside the "%" marks:
Correct: %OPTION1*OPTION2%
Incorrect: %OPTION1%*%OPTION2%

For example, if OPTION1 = 5.0 and OPTION2 = 3.0, the results would be "15" and "5*3"

See also  Bolt mark elements on page 562

Adding pull-out pictures in reinforcement marks

To illustrate the shape and dimensions of a reinforcing bar in a drawing, you can add a pull-out picture of the bar in the reinforcement mark.

Pull-out pictures can be added in automatic and manually created marks.

To add pull-out picture in an automatic mark in a cast unit drawing:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the drawing properties that you want to change.
3. Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. Click **Reinforcement mark**.

5. In the **Cast Unit - Reinforcement Mark Properties** dialog box, double-click the **Pullout picture** element in the **Available elements** list to add it to the reinforcement mark.

6. In the **Pullout picture** dialog box, select the scaling option in **Scale by**:
   - **Auto** autoscales the pull-out.
   - **One factor** and **Two factors** scale the pull-out according to the values that you enter.
     - The scale of the pull-out is relative to the scale of the drawing view. For example, if the drawing view scale is 1/10 and the pull-out scaling is 2, the actual scale of the pull-out in the drawing view is 1/5.

7. In **Rotation**, select the rotation of the pull-out: **Automatic**, **Plane** or **3D**. If the pull-out is 3D, and you select **Automatic**, Tekla Structures automatically shows the pull-out in 3D.

8. In **End marks**, define the shape of bar ends in the pull-out.

9. Select **Dimensions** to show bar dimensions in the pull-out.

10. Select **Exaggeration** to show reinforcing bar hooks more clearly in the pull-out.

11. Select **Bending radius** to show the bending radius of the reinforcing bar.

12. Select **Bending angle** to show bar bending angles in the pull-out.

13. Click **OK**.

14. Click **Save** to save the view properties and **OK** to return to drawing properties.

15. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Example**

A 3D pull-out showing the bending radius:
To change the leader line length, color, line type, or representation of a pull-out, open the `rebar_config.inp` file in `..\Tekla Structures\<version>\environments\<environment>\system` and edit the following lines:

- `PullOutLeaderLineMinLength`,
- `PulloutColor`,
- `PulloutVisibleLinetype` and `PulloutRepresentation`.

See also
- Reinforcement and neighbor reinforcement mark elements on page 564
- Adding automatic marks on page 462
- Reinforcement settings for drawings (rebar_config.inp) on page 579
7.15 Automatic grid settings in drawings

You can show grids in all types of drawings. You change the appearance and visibility of the labels, label frames, and grid lines.

See also
- Grids in drawings on page 233
- Setting automatic grid properties on page 493
- Drawing grid properties on page 589
Setting automatic grid properties

You can modify drawing grid properties of single-part, assembly and cast unit drawings individually for each view. In general arrangement drawings, you can modify the grid properties on both view and drawing level. You can also modify individual grid properties of in an open drawing.

Adding or removing grid lines in the model may cause unwanted changes in general arrangement drawings in some cases. You should avoid modifying grids after the general arrangement drawings are created.

To set automatic grid properties:
1. Click **Drawings & Reports --> Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Single-part, assembly and cast unit drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.
4. Click **Grid**.
5. Modify the grid properties as required.
6. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties.
7. Click **OK**.
8. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

The advanced options **XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH** and **XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR** allow you to adjust the grid labels further.

See also
- Automatic grid settings in drawings on page 491
- Drawing grid properties on page 589
- XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH
- XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR

7.16 Automatic part and neighbor part settings in drawings

Parts and neighbor parts in drawings are building objects that will exist in the real structure or which will be closely related to the structure.

Parts and neighbor parts have drawing properties that affect the way that the part is shown in the drawing.
Setting automatic drawing part properties

You can define what is shown in a part and how the part is shown.

To set the part contents and appearance before creating a drawing:

1. Click **Drawings & Reports** --- > **Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Click **Part**.
4. On the **Contents** tab, select the part representation, whether to show hidden lines, center lines and reference lines, and which additional markings to show.
   
   A *reference line* is a line between the points from which a part is created.
5. On the **Appearance** tab, select the color and type of the lines.
   
   The color of the center lines can be changed only on the drawing and view level, not on the object level. For center lines, you can only adjust the color in the properties dialog box, not the type. You can adjust the line type of part center lines with the advanced option **XS_CENTER_LINE_TYPE**.
6. On the **Fill** tab, set the part and section fill options.
7. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties.
8. Click **OK** to return to drawing properties.
9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

See also

- Setting automatic drawing part properties on page 494
- Setting automatic neighbor part properties on page 496
- Example: Part representations on page 494
- Indicating part orientation on page 497
- Part and neighbor part properties in drawings on page 568

Automatic part and neighbor part settings in drawings on page 493

Part and neighbor part properties in drawings on page 568

Example: Part representations on page 494

**XS_CENTER_LINE_TYPE**

**XS_DRAWING_PART_REFERENCE_LINE_TYPE**

**XS_DRAWING_POINT_SCALE**
Example: Part representations

Here are some examples of what parts look like with different settings defined in the Part Properties dialog box.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part representation is set to <strong>Outline</strong>.</td>
<td><img src="image" alt="Outline" /></td>
</tr>
</tbody>
</table>
| Part representation is set to **Exact**.     | ![Exact](image)  
The **Edge chamfers** check box is selected in **Additional marks**. |
| Part representation is set to **Symbol**.    | ![Symbol](image) |
| Part representation is set to **Symbol with partial profile**. | ![Symbol with partial profile](image) |
| Part representation is set to **Bounding box**. | ![Bounding box](image) |
| Part representation is set to **Base box**.   | ![Base box](image) |
The Hidden lines check box is not selected.

The Hidden lines check box is selected.
The Own hidden lines check box is selected.

1. Hidden lines for other parts are shown
2. Hidden lines for the main part are shown.

See also Setting automatic drawing part properties on page 494
Part and neighbor part properties in drawings on page 568
Automatic part and neighbor part settings in drawings on page 493

Setting automatic neighbor part properties

You can define what is shown of neighbor parts and how the neighbor parts are shown. You can also control the visibility of the neighbor part bolts.

To set the neighbor part visibility, contents and appearance before creating a drawing:

1. Click Drawings & Reports → Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Click Neighbor part.
4. Select the desired visibility options on the Visibility tab.
   • For more information, see Showing neighbor parts in views on page 364
5. On the Contents tab, select the neighbor bolt representation, whether to show hidden lines, center lines and reference lines, and which additional markings to show.
   
   A reference line is a line between the points from which a part is created.
6. On the Appearance tab, select the color and type of the lines.
   
   The color of the center lines can be changed only on the drawing and view level, not on the object level. For center lines, you can only adjust the color in the properties dialog box, not the type. You can adjust the line type of part center lines with the advanced option XS_CENTER_LINE_TYPE.
7. Single-part, assembly and cast unit drawings: Click Save to save the view properties.
8. Click OK.
9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**
- Automatic part and neighbor part settings in drawings on page 493
- Part and neighbor part properties in drawings on page 568
- Example: Part representations on page 494
- XS_CENTER_LINE_TYPE
- XS_DRAWING_PART_REFERENCE_LINE_TYPE
- XS_DRAWING_POINT_SCALE

**Indicating part orientation**

Part orientation marks indicate the erection direction of assemblies and cast units. You can indicate the part orientation by using part marks, by including compass direction in marks, and showing orientation marks and connecting side marks.

**See also**
- Mark location on page 468
- Using part mark as an orientation mark in general arrangement drawings on page 497
- Displaying compass direction in part marks on page 499
- Displaying connecting side marks on page 502
- Part and neighbor part properties in drawings on page 568
- Automatic part and neighbor part settings in drawings on page 493

**Using part mark as an orientation mark in general arrangement drawings**

In general arrangement drawings, part marks appear at the same end as in assembly drawings. Parts with the same assembly position are always marked at the same end.

To use the part marks as orientation marks in general arrangement drawings:

1. Select **Drawings & Reports** --> **Drawings Settings** --> **Assembly Drawing**.
2. Load the properties that you want to change.
3. In assembly drawing properties, click **View creation** --> **Attributes** and set the **Coordinate system** to **oriented** or **model**.
   
   You must use **oriented** or **model** if you want the **Viewing direction** settings in **Tools** --> **Options** --> **Options** --> **Orientation marks** to have effect.
4. Click **Save** to save the properties and **OK** to close the dialog box.
5. In the model, click **Drawings & Reports** --> **Numbering** --> **Numbering Settings** and clear the **Beam orientation** and **Column orientation** check boxes.
   
   When you do this, similar assemblies get the same number regardless of the part orientation.
6. Go to **Tools --> Options --> Options --> Orientation marks** and set the following options:
   - Set the desired **Viewing direction** for beams, bracings and columns.
   - Set **Mark always to center of column in GA drawings** to **No**.
   - Set **Preferred location for beams and bracings** to **Left or Right**.
     The preferred location determines the end where the mark is placed.

7. Click **OK**.

8. Check the leader line type through **Drawings & Reports --> Drawings Settings --> General Arrangement Drawing --> Part marks --> General**.

   Place the mark near the part end, not in the middle of the part using one of the following settings:
   
   ![Leader line type](image)

9. Click **Save** to save the drawing properties and **OK** to close the dialog box.

10. Create assembly (and single-part) drawings using the settings you modified.

11. Create general arrangement drawings using the settings you modified.

---

In general arrangement drawings, the cast unit part marks behave in the same way as the assembly part marks, except when **Top in form face** is set to **Front** or **Back** on the **Parameters** tab of the part’s **User-defined attributes** dialog box. These settings tell the end where the part mark is placed.

When you update an assembly drawing so that the mark is placed at the other end of the part, remember to update the marks in the corresponding general arrangement drawing. Tekla Structures does not do this automatically.

**Example**  
The part mark is positioned at the stiffener side:

![Part mark at stiffener side](image)

The marks are positioned at the same side irrespective of the orientation of the beams:
Displaying compass direction in part marks

You can include face direction information in part marks. No matter where you add or move the mark, the face direction stays the same. The face direction indicates the compass direction (North, East, South, West) of the face where the mark appears.

Limitation: Tekla Structures indicates the face direction only if it is the same for all assemblies or cast units with the same assembly or cast unit position number.

To add face direction information for parts:

1. Check in which direction north is in the model by clicking Tools --> Options --> Options --> Orientation marks and checking Project north.

2. In the model, click Drawings & Reports --> Numbering --> Numbering Settings and select the Column orientation check box.
   
   This forces Tekla Structures to show the face direction in the part mark for two similar columns with different orientation.

3. In the desired assembly or cast unit drawing view properties, click Part mark and insert the Face direction element in the part mark.
Now the assembly or cast unit drawings show the face direction in the part marks.

Displaying orientation marks (north marks)

You can use orientation marks or north marks to indicate the erection direction of assemblies. The default orientation mark is a triangle inside a circle.

To display orientation marks for main parts:
1. In the assembly drawing properties, go to the desired view properties, click Part --> Content and select the Orientation marks check box.
2. Save the view properties.
3. Click OK.
4. Save the assembly drawing properties and click OK.
5. If needed, define which parts Tekla Structures considers to be columns, braces or beams by setting the skew limits through Tools --> Options --> Options --> Orientation marks --> Skew limit.
6. Use the following advanced options to adjust orientation marks:
   - XS_ORIENTATION_MARK_DIRECTION
   - XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS
   - XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS
   - XS_NORTH_MARK_SYMBOL
   - XS_HIDDEN_NORTH_MARK_SYMBOL
   - XS_NORTH_MARK_SCALE
   - XS_GA_NORTH_MARK_SYMBOL (general arrangement drawings)

See also Indicating part orientation on page 497
Orientation settings on page 590
7. Create the assembly drawing.

For different parts, Tekla Structures draws orientation marks in the following way:

- To the top flange of beams, at the end which points closest to the north or to another designated point of the compass (see part 1 and 2 in the illustration below)
- To the lower end of columns, on the flange which points closest to the north or to another designated point of the compass (see part 4 in the illustration below)
- To the flange of bracing, at the end which points closest to the north or to another designated point of the compass (see 3 A and B in the illustration below)

You can display orientation marks for single-part views included in assembly drawings with the advanced option `XS_SINGLE_ORIENTATION_MARK`.

See also

- `XS_ORIENTATION_MARK_DIRECTION`
- `XS_ORIENTATION_MARK_MOVE_DIST_FOR_BEAMS`
- `XS_ORIENTATION_MARK_MOVE_DIST_FOR_COLUMNS`
- `XS_NORTH_MARK_SYMBOL`
- `XS_HIDDEN_NORTH_MARK_SYMBOL`
- `XS_NORTH_MARK_SCALE`
- `XS_GA_NORTH_MARK_SYMBOL`
- `XS_GA_HIDDEN_NORTH_MARK_SYMBOL`
- `XS_GA_NORTH_MARK_SCALE`
- `XS_SINGLE_ORIENTATION_MARK`

Indicating part orientation on page 497
Part and neighbor part properties in drawings on page 568
Displaying connecting side marks

You can use a symbol in assembly drawings to indicate the side of a part to which a connecting part is attached.

To display connecting side marks:
1. Select Drawings & Reports --> Drawings Settings --> Assembly Drawing.
2. Load the properties that you want to change.
3. Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Part.
5. On the Content tab, select the Connecting side marks check box.
6. Click Save to save the view properties.
7. Click OK.
8. Click Save to save the drawing properties, then click OK and create the drawing.

If needed, you can change the connecting side mark symbol with the advanced option XS_CONNECTING_SIDE_MARK_SYMBOL, and use XS_MIN_DISTANCE_FOR_CONNECTING_SIDE_MARK to control whether the connecting side mark is drawn or not.

See also  XS_CONNECTING_SIDE_MARK_SYMBOL
7.17 Automatic bolt settings in drawings

Bolts are connecting objects that fasten parts or assemblies or attach to them. There are several ways to display bolts in drawings.

See also  Setting automatic bolt properties in drawings on page 503  
Creating user-defined bolt symbols on page 504  
Example: Bolt representations on page 504  
Bolt content and appearance properties in drawings on page 571  
Part and neighbor part properties in drawings on page 568

Setting automatic bolt properties in drawings

You can define what is shown in bolts and how the bolts are shown.

To define the automatic bolt content and appearance settings before creating the drawing:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Bolts.
5. On the Content tab, select the bolt representation, bolt symbol content, and the visibility of bolts in main parts.
   For assembly and cast unit drawings, you can also set the visibility of bolts in secondary parts and sub-assemblies.
6. On the Appearance tab, select the color of the bolts.
7. Single-part, assembly and cast unit drawings: Click Save to save the view properties.
8. Click OK.
9. Click Save to save the drawing properties, then click OK and create the drawing.

See also  Automatic bolt settings in drawings on page 503  
Bolt content and appearance properties in drawings on page 571  
Example: Bolt representations on page 504
Creating user-defined bolt symbols

You can create your own bolt symbols and use them in drawings. You only need to create bolt symbols if you need different bolt symbols than the ones that you can find in Tekla Structures.

To create bolt symbols in the Symbol Editor and take them into use in your drawing:

1. Save the symbol file `ud_bolts.sym` in the symbol folder (usually the folder `..\Tekla Structures\<version>\environments\common\symbols\`).
2. Open Microsoft Notepad, or any text editor.
3. Create a text file consisting of lines in three columns:
   - The first column contains the bolt assembly standard.
   - The second contains the bolt diameter.
   - The third column contains the name of the symbol file and the symbol number, separated with the `@` character.
   
   Example of file contents:
   
   ```
   7990 24 ud_bolts@1
   7990 25 ud_bolts@2
   ```

   Tekla Structures uses the user-defined symbol for bolts in drawings that have the standard and diameter you define in this text file.

4. Save the file with the name `bolt_symbol_table.txt`.

5. Set the name of the file as a value for the advanced option `XS_USER_DEFINED_BOLT_SYMBOL_TABLE` in Tools --> Options --> Advanced Options --> Marking: Bolts as follows:

   ```
   set XS_USER_DEFINED_BOLT_SYMBOL_TABLE=bolt_symbol_table.txt
   ```

   You can also enter a full path to the bolt definition file. Without the path Tekla Structures searches for the file in the model, firm, project, and system directories.

6. To use your own bolt symbol, select Bolt --> Content --> Solid/Symbol --> User-defined symbol in the drawing view properties dialog box.

See also Automatic bolt settings in drawings on page 503
Example: Bolt representations

There are several representation options available for displaying bolts in drawings. You can select the options from the **Solid/symbol** list. Here are some examples of different selections.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Solid</strong></td>
<td><img src="image1.png" alt="Solid Example" /></td>
</tr>
<tr>
<td><strong>Exact Solid</strong></td>
<td><img src="image2.png" alt="Exact Solid Example" /></td>
</tr>
<tr>
<td><strong>Symbol</strong></td>
<td><img src="image3.png" alt="Symbol Example" /></td>
</tr>
<tr>
<td><strong>Symbol 2</strong></td>
<td><img src="image4.png" alt="Symbol 2 Example" /></td>
</tr>
<tr>
<td><strong>Symbol 3</strong></td>
<td><img src="image5.png" alt="Symbol 3 Example" /></td>
</tr>
</tbody>
</table>
7.18 Automatic hatch patterns in drawings

Use hatching on part faces, sections or additional drawing objects, such as circles and polygons, to show different materials. The hatch patterns are located in the hatch_types1.pat file in the ...\Tekla Structures\<version>\environments\<environment>\inp folder. You can also use hatch patterns on surface treatment.

You can also add custom hatch patterns in the hatch_types1.pat file, see http://teklastructures.support.tekla.com/en/support-articles/adding-custom-fill-patterns.

See also Automatic bolt settings in drawings on page 503
Bolt content and appearance properties in drawings on page 571

See also Adding automatic hatch patterns on drawing objects on page 507
Adding automatic hatch patterns on drawing objects

You can add hatch patterns on parts, cross sections and shapes in a drawing.

There are some limitations in the hatch pattern background color usage:

- Background color does not work in conjunction with hardware hatches.
- The background color does not have any effect if there is an automatic hatch available. The background color can only be changed if the automatic hatch is not defined for the material type.

To add an automatic hatch pattern on a part before creating a drawing:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click Part and go to the Fill tab.
5. Select the hatch pattern from the Type list.
   - To preview the patterns, click the ... button next to the Type list.
   - You can also select the hatch pattern by double-clicking it in the Hatch window. If you select Automatic, Tekla Structures uses the hatch patterns defined in the hatch pattern schema (hatch pattern properties) file (.htc). Each drawing type has its own schema file.
6. Define a color for the pattern in the Color box.
7. Define a background color for the hatch in the Background box.
   - You can define the background color only after selecting a hatch pattern first.
8. In Scale, select whether to use automatic or custom scaling and rotation for hatches.
   - If you select automatic scaling and rotation, Tekla Structures automatically scales the hatch pattern to suit the profile size, and you do not need to edit each drawing manually.
   - If you select Custom scaling and rotation:
     - Enter the scales in Scaling in direction x and Scaling in direction y, and select whether to Keep the x and y ratio.
• Enter the angle of rotation in the **Angle** box. Angle 0.0 is for horizontal and 90.0 for vertical.

9. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties.

10. Click **OK**.

11. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**Limitations**

Example: In the example below, the following hatch pattern options have been selected for sections:

- **Scale**: Custom
- **Scaling in x direction**: 0.25
- **Scaling in y direction**: 0.50
- **Keep ratio of x and y** is selected.
- **Angle**: 10.00

See also

- Automatic part and neighbor part settings in drawings on page 493
- Part and neighbor part properties in drawings on page 568
- Part and shape hatch pattern properties (.htc) on page 575
Automatic hatch patterns in drawings on page 506

XS_HATCH_SCALE_LIMIT
XS_HATCH_SPECIAL_COLOR_R
XS_HATCH_SEGMENTBUFFER_SIZE
XS_HATCH_SPECIAL_COLOR_ACI

Example: Insulation hatch patterns

You can use the following fill types to represent insulation:

These hatch types can be scaled and rotated.

<table>
<thead>
<tr>
<th>Hatch name</th>
<th>Pattern</th>
</tr>
</thead>
<tbody>
<tr>
<td>HARD_INS1</td>
<td><img src="image" alt="HARD_INS1 Pattern" /></td>
</tr>
<tr>
<td>SOFT_INS</td>
<td><img src="image" alt="SOFT_INS Pattern" /></td>
</tr>
<tr>
<td>SOFT_INS2</td>
<td><img src="image" alt="SOFT_INS2 Pattern" /></td>
</tr>
</tbody>
</table>

To preview the scaled and rotated patterns, click the ... button next to the Type box.

See also Automatic hatch patterns in drawings on page 506
7.19 Automatic surface treatment in drawings

You can add various types of surface treatment to steel and concrete parts in the Tekla Structures model and display them in drawings.

The properties of the hatch patterns to use for each surface treatment type are defined in the surfacing.htc file. Also the product_finishes.dat code file is needed listing all surface treatment codes that are used in drawings and reports, for example, TS1 for Tile Surface 1.

See also Adding automatic surface treatment in drawings on page 510
Surface treatment visibility and content properties in drawings on page 572
Surface treatment hatch pattern properties (surfacing.htc) on page 573
Adding surface treatment

Adding automatic surface treatment in drawings

You can define what is shown in a surface treatment and how the surface treatment is shown in drawings.

The hatch pattern Tekla Structures adds on the surface treatment depends on the type of the surface treatment that you selected in the Surface Treatment Properties dialog box in the model and the hatch properties defined in the surface treatment hatch pattern properties file surfacing.htc.

To add the automatic surface treatment before you create a drawing:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.
2. Load the properties that you want to change.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.
4. Click **Surface treatment**.

5. On the **Contents** tab, select the surface treatment representation, and whether to show the surface treatment pattern, hidden lines, and own hidden lines.

6. On the **Appearance** tab, select the color and type of visible and hidden lines.

7. Single-part, assembly and cast unit drawings: Click **Save** to save the view properties.

8. Click **OK**.

9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

**See also**  
Automatic surface treatment in drawings on page 509  
Surface treatment visibility and content properties in drawings on page 572  
Surface treatment hatch pattern properties (surfacing.htc) on page 573  
Automatic hatch patterns in drawings on page 506

### 7.20 Automatic weld settings in drawings

You can define automatic weld settings to be used in a drawing before you create a drawing. You can modify the settings after you have created the drawing.

**See also**  
Weld concepts on page 203  
Examples: Model welds in drawings on page 205  
Welding properties on page 586

**Setting automatic weld properties in drawings**

To set the automatic weld properties before creating a drawing:

1. Click **Drawings & Reports** --> **Drawing Settings** and select the drawing type.

2. Load the properties that you want to change.

3. Single-part and assembly drawings: Click **View creation**, select the view and the properties that you want to change, and click **View properties**.

4. Click **Weld**.

5. On the **Content** page, define the visibility settings.

6. Enter a weld size to filter welds of that size out of the drawing.
This is useful when you only want to show non-typical welds in a drawing.

To set whether the weld size is an exact or minimum value, use the advanced option XS_WELD_FILTER_TYPE.

To filter out a standard weld type, use the advanced option XS_OMITTED_WELD_TYPE.

7. On the Appearance tab, modify the color and line as required.

8. Single-part and assembly drawings: Click Save to save the view properties.

9. Click OK.

10. Click Save to save the drawing properties, then click OK and create the drawing.

See also  Welding properties on page 586
Model weld mark visibility and appearance properties in drawings on page 557

7.21 Automatic reinforcement and mesh settings in drawings

There are numerous ways of showing reinforcing bars and meshes in drawings. You can define automatic reinforcement and mesh settings before you create the drawing, and adjust the settings in an open drawing. In addition to modifying the properties available in the properties dialog box, you can also modify the bending schedules, rounding of bar dimensions, symbols in use, and reinforcement appearance in the rebar_config.inp settings file.

See also  Setting automatic reinforcement and reinforcement mesh properties on page 512
Example: Hiding reinforcing bar lines in drawings on page 513
Example: Reinforcement representations on page 514
Reinforcement/Neighbor reinforcement and mesh properties in drawings on page 577
Reinforcement settings for drawings (rebar_config.inp) on page 579
Part and neighbor part properties in drawings on page 568

Setting automatic reinforcement and reinforcement mesh properties

You can define what is shown in reinforcing bars and meshes and how they are shown in cast unit and general arrangement drawings. You can also do this for neighbor reinforcement.

To set automatic reinforcement and mesh properties before creating a drawing:

1. Click Drawings & Reports --> Drawing Settings and select the drawing type.

2. Load the properties that you want to change.
3. Single-part, assembly and cast unit drawings: Click View creation, select the view and the properties that you want to change, and click View properties.

4. Click Reinforcement (or Neighbor reinforcement).

5. On the Bar content tab, set the bar representation, bar end symbols, and the visibility of bars and lines.

6. On the Bar appearance tab, select the color and type of the visible lines and hidden lines.

7. On the Mesh content tab, set the mesh representation, mesh symbols, and the visibility of meshes, wires, bars and lines.

8. On the Mesh appearance tab, select the color and type of the visible lines and hidden lines.

9. Single-part, assembly and cast unit drawings: Click Save to save the view properties.

10. Click OK.

11. Click Save to save the drawing properties, then click OK and create the drawing.

---

The representation of reinforcing bars that point away from the drawing is changeable. You can customize reinforcing bar bent symbols (cross, circle, filled circle) by editing the symbol file bent.sym, which in the default environment is located in the folder ..\ProgramData\Tekla Structures\<version>\environments\common\symbols. Or, you can create a new symbol file in the same folder, for example, my_new_symbols.sym, and take it into use in the rebar_config.inp by entering the following string: BentSymbolFile=my_new_symbols.sym in the file.

---

See also

Automatic reinforcement and mesh settings in drawings on page 512
Reinforcement/Neighbor reinforcement and mesh properties in drawings on page 577
Reinforcement settings for drawings (rebar_config.inp) on page 579
### Example: Hiding reinforcing bar lines in drawings

You can hide reinforcement bar lines behind other reinforcing bars and behind parts in cast unit drawings.

Here are some examples of what reinforcing bars look like with different settings selected on the **Bar content** tab in **Reinforcement** or **Neighbor Reinforcement** properties.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hide lines behind parts is selected. The reinforcing bar lines are hidden behind other parts.</td>
<td><img src="B/2" alt="Diagram of reinforcing bar lines hidden behind parts" /></td>
</tr>
<tr>
<td>Hide lines behind other rebars is selected. The reinforcing bar lines are hidden behind other reinforcing bar lines.</td>
<td><img src="T16.L1310" alt="Diagram of reinforcing bar lines hidden behind other bars" /></td>
</tr>
</tbody>
</table>

See also [Setting automatic reinforcement and reinforcement mesh properties on page 512](#)  
[Automatic reinforcement and mesh settings in drawings on page 512](#)
Example: Reinforcement representations

Here are examples of how the reinforcement will look with the different representation options selected on the Bar content tab in Reinforcement or Neighbor Reinforcement properties.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>single line</td>
<td><img src="example1.png" alt="Example" /></td>
</tr>
<tr>
<td>double line</td>
<td><img src="example2.png" alt="Example" /></td>
</tr>
<tr>
<td>double lines with filled ends</td>
<td><img src="example3.png" alt="Example" /></td>
</tr>
<tr>
<td>filled line</td>
<td><img src="example4.png" alt="Example" /></td>
</tr>
<tr>
<td>stick</td>
<td><img src="example5.png" alt="Example" /></td>
</tr>
<tr>
<td>outline</td>
<td><img src="example6.png" alt="Example" /></td>
</tr>
</tbody>
</table>

See also
- Automatic reinforcement and mesh settings in drawings on page 512
- Reinforcement/Neighbor reinforcement and mesh properties in drawings on page 577
7.22 User-defined attributes in drawings

Many Tekla Structures dialog boxes contain user-defined attributes for various objects. The definitions of a user-defined attribute are unique, which means that a user-defined attribute cannot have different definitions for different object types.

In drawings, the user-defined attributes can be used in templates, Drawing List, and marks, for example. The user-defined attributes defined in the drawing are displayed when you click User-defined attributes in the drawing properties dialog box. You can show up to 20 user-defined attributes in the Drawing List. To check the ones that you have, click User-defined attributes in a drawing properties dialog box.

To define new user-defined attributes, create your own objects.inp file in the company, project or firm folder. After adding your own user-defined attributes, you need to use the Diagnose & Change Attribute Definitions tool to update the definitions in the model. The object.inp files are merged so that if there are user-defined attributes in any of the files, they are displayed in the user interface. Tekla Structures merges the files in a way that eliminates duplicate attributes. If Tekla Structures encounters the same attribute name in different objects.inp files, the attribute from the first read objects.inp file will be used.

Tekla Structures reads the objects.inp files from the following folders in the following order:

1. model folder
2. company folder
3. project folder
4. firm folder
5. system folder
6. inp folder

In order to show the new user-defined attribute in Template Editor, you need to add it in a customized contentattributes_userdefine.lst file and include the name of the customized file in the contentattributes.lst file.

Make a copy of these modified files as the Tekla Structures installation always overwrites these files.

See also

- Modifying automatic user-defined drawing attributes on page 516
- Creating new user-defined drawing attributes on page 517
- Adding user-defined attributes and template attributes in marks on page 480
- What is displayed in the Drawing List on page 104
- Switches for customizing print file names on page 293
- Objects.inp properties
Modifying automatic user-defined drawing attributes

To modify user-defined drawing attributes before creating a drawing:

1. Click **Drawings & Reports** --> **Drawing Settings** and select the drawing type.
2. Load the properties that you want to change.
3. Click **User-defined attributes**.
4. On the **Workflow** tab, enter project-specific information to be displayed in drawings and in the **Drawing List**.
5. On the **Parameters** tab, enter a user-defined **Comment** for drawings, projects, assemblies, parts, and so on.
6. Use the **User field 1** to **User field 8** on the **Parameters** tab to enter drawing-specific information.
7. On the **Title** tab, select if you want to use project-specific or drawing-specific information in the title block of the drawing.
   
   When you click **Use project settings**, you cannot enter any information in the title block fields.
8. If you selected **Use drawing settings**, the title block fields become available, and you can enter the necessary data in the fields.
9. Click **Save** to save the drawing properties, then click **OK** and create the drawing.

- You can control whether the modifications in user-defined attributes affect all selected drawings in the **Drawing List** at the same time, even if the drawings are of different types by using the advanced option **XS_DRAWING_UDAS_MODIFY_ALL_DRAWING_TYPES**.

See also

- Customizing user-defined attributes
- **XS_DRAWING_UDAS_MODIFY_ALL_DRAWING_TYPES**
- Location of certain files in hidden folders
- User-defined attributes in drawings on page 515
- Creating new user-defined drawing attributes on page 517

Creating new user-defined drawing attributes

If you want to add a new line in the user-defined drawing attributes dialog box and a new column in the **Drawing List**, you need to create your own **objects.inp** and add a new
user-defined attribute there. You also need to do this if you want the user-defined attribute to be available in the Template Editor.

Before you start, close Tekla Structures.

To create a new user-defined attribute:

1. **Open the objects.inp file located in ..\ProgramData\Tekla Structures \<version>\environments\common\inp.**
2. **Save the objects.inp file in your model, project or firm folder.**
3. **Delete all user-defined attribute definitions from the objects.inp file, except the property definitions in the beginning of the file that describe the properties, and the sections that define the new tab to different drawing types. Also leave one property definition in section User-defined attributes for objects that you can use as a template for the new property.**
4. **Enter the name of the tab page where you want the new user-defined attributes to be located and the attribute properties.**
   
   Do not enter the names of the tab pages that come with the installation, use a new one instead.
5. **To show the user-defined attribute in the Drawing List and in the user-defined attributes dialog box, set status_flag to yes.**

```plaintext
/* User defined attributes for objects */
/* Common drawing attributes*/
beam(2,"Beam")
{
    tab_page("My tab")
    {
        attribute("DESIGNED_B", "Designed B", string, "%s", yes, none, "0.0", "0.0")
        {
            value("", 0)
        }
        modify(1)
    }
}
```

6. **Define the drawing types where you want to use the new tab containing the new user-defined attribute.**
7. Save and close the file.

8. Update the definitions of the user-defined attributes:
   a. Click Tools --> Diagnose & Repair Model --> Diagnose & Change Attribute Definitions.
      The Diagnose & Change Attribute Definitions dialog box is displayed.

   b. If there are conflicts between your objects.inp and the default objects.inp, select the definition in the area on the right and click Change current settings to selected objects.inp settings.
      The definition of the user-defined attribute is updated in the model.

9. Select Drawings & Reports --> Drawing Settings and a drawing type.
   In this example, select General Arrangement Drawing.

10. Click User-defined attributes.
The user-defined drawing attributes dialog box of the general arrangement drawing shows the new tab.

11. Use Save as to save the properties for future use.
12. Click OK and create a general arrangement drawing.
13. Right-click the created drawing in the Drawing List and select User-defined Attributes.
14. Go to My tab and enter the name of the designer in the Designed By box.
15. Click Modify and close the dialog box.

The Drawing List contains the new user-defined attribute, and the name of the designer is displayed.

<table>
<thead>
<tr>
<th>Created</th>
<th>Modified</th>
<th>Size</th>
<th>Type</th>
<th>Mark</th>
<th>Name</th>
<th>Designed By</th>
</tr>
</thead>
<tbody>
<tr>
<td>18.04.2013</td>
<td>00.00.0000</td>
<td>830*584</td>
<td>G</td>
<td>[2]</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

See also User-defined attributes in drawings on page 515

7.23 Defining a firm folder for images and symbols

You can define a firm folder where Tekla Structures always searches for the images and symbols. When you store the images and symbols in this folder, you do not have to move
them from folder to folder when you install a new version of Tekla Structures. Installing a new version does not replace the files in the firm folder.

Define the firm folder in the options.ini file under the model folder using the advanced option XS_FIRM as a value. This advanced option makes the images and symbols available in all Tekla Structures versions.

You also need to define a folder for XS_FIRM: Click Tools --> Options --> Advanced Options and go to File Locations.

To define the firm folder for images and symbols:

1. Modify the options.ini file to include the advanced option DXK_SYMBOLPATH that points to the firm folder. Add the following line at the end of the options.ini file:

   `DXK_SYMBOLPATH=%%DXK_SYMBOLPATH%%;%%XS_FIRM%%`

   This line must always start with "DXK_SYMBOLPATH=%%DXK_SYMBOLPATH%%;".
   The advanced option DXK_SYMBOLPATH may contain multiple paths separated by semicolons.

2. In the Template Editor, click Options --> Preferences --> File Locations and enter the path to the firm folder also for Symbols, pictures.

See also Symbols in drawings on page 235

DXK_SYMBOLPATH

7.24 Defining customized line types

You can define your own line types, and use them wherever line type settings are available. The customized line types are handled the same way as other line types. The customized line types are defined in the TeklaStuctures.lin file in ..\ProgramData\Tekla Structures\<version>\environments\common\inp. By default, the most widely used line types are available in the file.

To define your own line types in the TeklaStuctures.lin file:

1. Start every line with the letter A to indicate the beginning of the line type pattern.

   You can use three different objects: dashes, dots and spaces to form a line.

2. Define the length of a dash (-) using positive numbers.

3. Define the length of a a space ( ) using negative numbers.

4. Define dots (.) using the number zero (0).

   The patterns must begin with a dash. They typically end with a space, although the space in the end is not required.

5. After you have defined the line type pattern, press Enter.
The TeklaStructures.lin.id file contains the names of the line types visible in the user interface and the unique IDs assigned for each line type. The value of the ID must be greater than 10, for example:

CENTER, 1000
BORDER, 1002
DASHDOT, 1003

You can use TeklaStructures.lin also in mapping the exported line types.

**Example**

Line type definition for DASHDOT: A, 12.7, -6.35, 0, -6.35 means that the pattern starts with a dash with the length of 12.7 units, followed by a space with the length of 6.35 units, then a dot, and then again a space with the length of 6.35 units. Then the first dash is drawn again.

```
---
- - -
---
- - -
- - -
- - -
---
- - -
```

If you add new customized line types, you need to add corresponding bitmaps to the ..\ProgramData\Tekla Structures\<version>\bitmaps folder, and name them dr_line_type_*.bmp, for example dr_line_type_CENTER.bmp.

**See also**

Drawing shape properties on page 587
There are a lot of settings in Tekla Structures that you mainly control in the properties dialog boxes. There are also some additional settings files that you need.

Click the links below to find out more:

- General arrangement drawing properties on page 523
- Single-part, assembly and cast unit drawing properties on page 526
- Layout properties on page 527
- View properties in drawings on page 529
- Section view properties on page 532
- Dimension and dimensioning properties on page 533
- Mark properties on page 550
- Mark elements on page 560
- Part and neighbor part properties in drawings on page 568
- Bolt content and appearance properties in drawings on page 571
- Surface treatment visibility and content properties in drawings on page 572
- Surface treatment hatch pattern properties (surfacing.htc) on page 573
- Part and shape hatch pattern properties (.htc) on page 575
- Reinforcement/Neighbor reinforcement and mesh properties in drawings on page 577
- Reinforcement settings for drawings (rebar_config.inp) on page 579
- Placement properties for annotation objects on page 586
- Welding properties on page 586
- Drawing shape properties on page 587
- Drawing grid properties on page 589
- Orientation settings on page 590
## 8.1 General arrangement drawing properties

Click **Drawings & Reports --> Drawing Settings --> General Arrangement Drawing**. You can modify the properties after creating the drawing by double-clicking the drawing background.

The options in the general arrangement drawing properties dialog box are described below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Name</strong></td>
<td>The name of the drawing. This name is shown in the Drawing List, and can be included in drawing and report templates.</td>
</tr>
<tr>
<td><strong>Title 1, Title 2, Title 3</strong></td>
<td>Titles are shown in the Drawing List and in drawing and report templates.</td>
</tr>
<tr>
<td><strong>Use detailed object level settings</strong></td>
<td>Set to Yes to use the detailed object level settings created in the Object level settings for general arrangement drawings dialog box.</td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td>Select the drawing layout and define drawing sizes. You can also select whether you want to list hidden objects in templates.</td>
</tr>
<tr>
<td><strong>View</strong></td>
<td>Define view properties: scale, neighbor part view extension, reflected view, opening and recess symbol, datum point elevation, part shortening, view label, and anchor bolt plan settings.</td>
</tr>
<tr>
<td><strong>Detail view</strong></td>
<td>Define detail view properties: view label, detail boundary and detail mark settings.</td>
</tr>
<tr>
<td><strong>Dimension</strong></td>
<td>Define dimension properties: dimension type, units, precision, format, placing, and appearance.</td>
</tr>
<tr>
<td><strong>Dimensioning</strong></td>
<td>Define dimensioning properties: grid dimension and part dimension settings.</td>
</tr>
<tr>
<td><strong>Part mark properties</strong></td>
<td>Define part mark properties: included elements and element settings, and mark visibility, mark frame, mark leader line and placing settings.</td>
</tr>
<tr>
<td><strong>Bolt mark</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Neighbor part mark</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Surface treatment mark</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Weld mark</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Reinforcement marks</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Connection mark</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Part</strong></td>
<td>Define part properties: part representation, hidden line, center line and reference line visibility, additional mark visibility, part appearance, and fill settings.</td>
</tr>
<tr>
<td><strong>Bolt</strong></td>
<td>Define bolt properties: bolt representation, bolt symbol content, bolt visibility, and bolt appearance settings.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Neighbor part</td>
<td>Define neighbor part properties: visibility, part representation, hidden line, center line and reference line visibility, additional mark visibility, and part appearance settings. You can also define bolt representation and bolt symbol content settings for neighbor parts.</td>
</tr>
<tr>
<td>Surface treatment</td>
<td>Define surface treatment properties: surface treatment visibility, pattern visibility, hidden lines visibility and surface treatment representation settings.</td>
</tr>
<tr>
<td>Weld</td>
<td>Define welding properties: weld visibility, weld size limit and weld appearance settings.</td>
</tr>
<tr>
<td>Reinforcement</td>
<td>Define reinforcement and mesh properties: bar and mesh representation and visibility, bar and mesh symbol, and bar and mesh appearance settings.</td>
</tr>
<tr>
<td>Reference objects</td>
<td>Define reference object visibility and appearance settings.</td>
</tr>
<tr>
<td>Grid</td>
<td>Define grid visibility and appearance settings.</td>
</tr>
<tr>
<td>Protection</td>
<td>Define protected areas to prevent text, marks or dimensions from being placed there.</td>
</tr>
<tr>
<td>Filter and Neighbor part filter</td>
<td>Create and modify part filters/neighbor part filters on drawing level.</td>
</tr>
<tr>
<td>User-defined attributes</td>
<td>Add information to a drawing. They are displayed in the Drawing List, and you can use them in report and drawing templates, marks, and as switches when customizing print file names.</td>
</tr>
</tbody>
</table>

See also

- Giving titles to drawings on page 115
- View properties in drawings on page 529
- Modifying detail properties on page 140
- Dimension and dimensioning properties on page 533
- Grid and overall dimensioning properties (GA drawings) on page 548
- Part dimensioning properties (GA drawings) on page 549
- Mark properties on page 550
- Part and neighbor part properties in drawings on page 568
- Surface treatment visibility and content properties in drawings on page 572
- Welding properties on page 586
- Reinforcement/Neighbor reinforcement and mesh properties in drawings on page 577
- Reference models in drawings on page 230
- Drawing grid properties on page 589
- Protected areas on page 344
8.2 Single-part, assembly and cast unit drawing properties

Click Drawings & Reports --&gt; Drawing Settings and select the drawing type. You can modify the properties after creating the drawing by double-clicking the drawing background.

The options in single-part, assembly and cast unit drawing properties dialog box are described below.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Define the name of the drawing that is shown in the Drawing List, and can be included in drawing and report templates.</td>
</tr>
<tr>
<td>Title 1, Title 2, Title 3</td>
<td>Define titles that are shown in the Drawing List and can be included in drawing and report templates.</td>
</tr>
<tr>
<td>Sheet number</td>
<td>Used for creating several drawings of the same part as multiple drawing sheets. The number of sheets is not limited.</td>
</tr>
<tr>
<td>Layout</td>
<td>Select the drawing layout, and define drawing sizes, autoscale, projection type, view alignment and part expansion settings. You can also select whether you want to list hidden objects in templates.</td>
</tr>
<tr>
<td>View creation</td>
<td>Define the drawing views to be created. From here you can move on to modifying the view properties for each view.</td>
</tr>
<tr>
<td>Section view</td>
<td>Define section view properties.</td>
</tr>
<tr>
<td>Detail view</td>
<td>Define the start number or letter of the detail view and detail symbol label.</td>
</tr>
<tr>
<td>Protection</td>
<td>Define protected areas to prevent text, marks or dimensions from being placed there.</td>
</tr>
<tr>
<td>User-defined attributes</td>
<td>Add additional information to a drawing. This information is displayed in the Drawing List, and you can use it in report and drawing templates, marks, and as switches when customizing print file names.</td>
</tr>
</tbody>
</table>

See also
- Giving titles to drawings on page 115
- Creating multiple drawing sheets using drawing properties on page 75
- Drawing size and drawing view scale on page 339
- View properties in drawings on page 529
- Section view properties on page 532
- Modifying detail properties on page 140
- Protected areas on page 344
8.3 **Layout properties**

Click **Drawings & Reports --> Drawing Settings** and select the drawing type. Then click **Layout**. You can modify the properties after creating the drawing by double-clicking the drawing background.

All options in all layout property panels and dialog boxes are described below. All the described options are not available for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Drawing size tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Layout</strong></td>
<td>Define the layout that you want to use.</td>
</tr>
<tr>
<td><strong>List hidden objects in templates</strong></td>
<td>Select <strong>Yes</strong> to list hidden objects in templates. <strong>No</strong> removes all information about the hidden parts, also from the total weight.</td>
</tr>
<tr>
<td><strong>Size definition mode</strong></td>
<td>Select <strong>Autosize</strong> if you want to let Tekla Structures find appropriate sizes and table layouts for drawings. Select <strong>Specified size</strong> to specify the exact size for the drawing. The drawing size should always be smaller than the actual paper size to accommodate printer margins.</td>
</tr>
<tr>
<td><strong>Autosize: Use</strong></td>
<td>The fixed sizes and calculated sizes are both defined in the <strong>Drawing layout properties</strong>:&lt;br&gt;&lt;br&gt;<strong>Fixed sizes</strong>: Use this when you want Tekla Structures to use fixed drawing sizes A2, A3, A4, etc.&lt;br&gt;&lt;br&gt;<strong>Calculated sizes</strong>: Use this when you want to define the rules that Tekla Structures follows when it tries to adjust the drawing size.&lt;br&gt;&lt;br&gt;<strong>Calculated/fixed sizes</strong>: Use this when you want Tekla Structures to select the smallest of the suitable sizes.</td>
</tr>
<tr>
<td><strong>Drawing size</strong></td>
<td>If you selected <strong>Specified size</strong>, define the drawing size here.</td>
</tr>
<tr>
<td><strong>Table layout</strong></td>
<td>If you selected <strong>Specified size</strong>, define the table layout to be used.</td>
</tr>
<tr>
<td><strong>Scale tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Autoscale</strong></td>
<td>Set <strong>Autoscale</strong> to <strong>Yes</strong> to let Tekla Structures automatically select the suitable scale for the drawing view.</td>
</tr>
<tr>
<td><strong>Main view scales</strong></td>
<td>When you use autoscaling, enter the denominators of main view and section view scales and separate them with spaces. For example, enter &quot;5 10 15 20&quot; for the scales 1/5, 1/10, 1/15, and 1/20</td>
</tr>
<tr>
<td><strong>Section view scales</strong></td>
<td></td>
</tr>
</tbody>
</table>
### Scale change mode

When you use autoscaling, set the scale change mode which defines the relationship between the scales of main and section views within a drawing:

- **main = section**: The scales of the main and section view are equal.
- **main < section**: Main view scales are smaller than section view scales.
- **main <= section**: Main view scales are smaller than or equal to section view scales.

### Preferred size

Enter the preferred size of the drawing, if you use both autosizing and autoscaling. Tekla Structures tries to find a drawing size where the drawing contents fit by first trying to use the exact scale and the smallest drawing size. If the contents do not fit, Tekla Structures increases the drawing size until it reaches the preferred size.

### Other tab

#### Projection type

Define how Tekla Structures places the projections of a part in cast unit, single-part, and assembly drawings. Projection type affects the order of the views in the drawing. The options are:

- **First angle**, also referred to as the European projection.
- **Third angle**, also referred to as the American projection.

#### Align section views with main view

Set to **Yes** to place the views next to the main view.

If you select **No**, Tekla Structures places the section and end views in any available location.

#### Expand shortened parts to fit

Set to **Yes** to stretch shortened views to fill up empty areas of the drawing.

#### Include single parts

Set to **Yes** to include in assembly drawings the single-part drawings of the individual parts that make the assembly. Setting this to **Yes**, activates the **Single-part attributes** option.

#### Single-part attributes

Define the desired single-part drawing properties to be used in the single-part view. To do this, set **Include single parts** to **Yes**.

---

**See also**
- Drawing size and drawing view scale on page 339
- Drawing layout on page 326
- Setting the view projection type on page 354
- Setting the location of end views and section views on page 379
8.4 View properties in drawings

Use the View Properties dialog box to view and modify the drawing view properties.

The table below describes all view level properties for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>View creation panel: Views tab</strong></td>
<td></td>
</tr>
</tbody>
</table>
| **View type on/off** | Defines the main views, section views and 3D views that you want to create.  
- If you select **off**, Tekla Structures does not create the view, but dimensions the parts in the available views. If you set all four main views off, Tekla Structures will still create a front view.  
- If you select **on**, Tekla Structures always creates the view, even if it was not necessary in order to show the dimensions. For section views, Tekla Structures creates one additional section view showing the middle of the main part. For end views, Tekla Structures creates end view from one end of the main part.  
- If you select **auto**, Tekla Structures creates the view if it is necessary in order to show the dimensions. For section views, Tekla Structures creates the necessary number of views to show all the dimensions. For end views, Tekla Structures also creates another end view from the other end of the main part, if there are dimensions at that end. |
<p>| <strong>View label</strong> | Shows the view label set in view properties. If the label is defined in view properties, you can change it here. You can always change the label of the main views. |
| <strong>View properties</strong> | Shows the current view properties for the view. You can select another view properties file from the list and modify the view properties by clicking <strong>View properties</strong>. |
| <strong>View creation panel: Attributes tab</strong> | These settings are drawing-specific. |
| <strong>Coordinate system</strong> | Sets the coordinate system of the drawing views. The options are: local, model, oriented, horizontal brace, vertical brace, and fixed. For more information, see Changing the coordinate system on page 357. |
| **Rotate coordinate system <strong>Around X, Around Y and Around Z</strong> | Rotates the view around the x, y, or z axis of the parts using the entered values. For more information, see Rotating parts in drawing views on page 359. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Unfolded</td>
<td>Yes shows and dimensions the bend lines in the drawing. For more information, see Unfolding polybeams in drawings on page 369.</td>
</tr>
<tr>
<td>Undeformed</td>
<td>Yes undeforms deformed parts and shows the developed (undeformed) shape of the deformed parts in drawings. For more information, see Undeforming deformed parts in drawings on page 370.</td>
</tr>
<tr>
<td>Recreate the drawing</td>
<td>Yes recreates the drawing.</td>
</tr>
<tr>
<td>View creation panel: Attributes 1 tab (Attributes in general arrangement drawings)</td>
<td></td>
</tr>
<tr>
<td>Scale</td>
<td>Sets the view scale.</td>
</tr>
<tr>
<td>Reflected view</td>
<td>Displays load bearing structures, such as columns and beams on a lower floor. Yes displays structures with a continuous line, and No displays them with a dashed line.</td>
</tr>
<tr>
<td>Rotation around (in 3D views)</td>
<td>Modify the view angle of 3D views. Enter the values for the angles in y and x directions. Rotation in a drawing view is around the local axis. Value 0.0 for both equals the front view.</td>
</tr>
<tr>
<td>Size</td>
<td>Fit by parts: Tekla Structures fits the view contents in the drawing view frame without leaving any unnecessary space. Define as distances: The x and y boxes define the view size along the x and y axes of the view. The depth boxes define the depth of the view relative to, and perpendicular to the view plane.</td>
</tr>
<tr>
<td>View extension for neighbor parts</td>
<td>Sets the distance from the drawing view to display neighboring parts. For more information, see Showing neighbor parts in views on page 364.</td>
</tr>
<tr>
<td>Use detailed object level settings</td>
<td>Allows you to create and apply object level settings. For more information, see Detailed object level settings on page 318</td>
</tr>
<tr>
<td>Place</td>
<td>Set the placing for the drawing view to be fixed or free:</td>
</tr>
<tr>
<td></td>
<td>• Fixed: Maintain the views in the same location during updates.</td>
</tr>
<tr>
<td></td>
<td>• Free: Let Tekla Structures find a suitable place for the view during updates.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Defining automatic free or fixed placement of drawing views on page 349.</td>
</tr>
<tr>
<td>View creation panel: Attributes 2 tab (Shortening in general arrangement drawings)</td>
<td></td>
</tr>
<tr>
<td>Undeformed</td>
<td>Yes undeforms deformed parts and shows the developed (undeformed) shape of the deformed parts in drawing views. For more information, see Undeforming deformed parts in drawings on page 370.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Shortening</strong></td>
<td>If parts are very long and do not include any details, you can shorten them:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cut parts Yes</strong> activates shortening. You can also select to cut <strong>Only in x direction</strong> or <strong>Only in y direction</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Minimum cut part length</strong> defines the minimum length of the shortened part to show.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Space between cut parts</strong> defines the distance between cut parts.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Cut skew parts: Yes</strong> cuts skew parts.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Shortening parts in drawing views on page 366.</td>
</tr>
<tr>
<td><strong>Show openings/recess symbol</strong></td>
<td><strong>Yes</strong> shows symbols in openings and recesses.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Showing part openings and recesses in drawings on page 372.</td>
</tr>
<tr>
<td><strong>Datum point for elevations</strong></td>
<td><strong>Specified</strong> uses the entered value.</td>
</tr>
<tr>
<td></td>
<td><strong>View plane</strong> measures reference points relative to the view plane.</td>
</tr>
<tr>
<td></td>
<td>For more information, see Adding elevation dimensions on page 414.</td>
</tr>
<tr>
<td><strong>Dimension creation method in this view</strong></td>
<td>Clones the dimensions separately for the selected view only. Using this option affects the creation of the dimensions during cloning and re-dimensioning of existing drawings.</td>
</tr>
<tr>
<td></td>
<td>For more information, see View-specific dimension cloning on page 97.</td>
</tr>
<tr>
<td><strong>Labels tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Text</strong></td>
<td>Defines the view label text. Enter text in fields A1 – A5, or click the ... buttons and select the label mark contents and appearance.</td>
</tr>
<tr>
<td></td>
<td>For more information about view labels, see Defining view labels and view label marks on page 352</td>
</tr>
<tr>
<td><strong>Symbol</strong></td>
<td>Defines a symbol to be used in the view label, and the color, size, and line length of the symbol.</td>
</tr>
<tr>
<td><strong>Label position</strong></td>
<td>Defines the vertical and horizontal position of the view label:</td>
</tr>
<tr>
<td></td>
<td>• <strong>Vertical</strong>: Select <strong>Above</strong> or <strong>Below</strong>.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Horizontal</strong>: Select <strong>Center by view frame</strong> or <strong>Center by restriction box</strong>.</td>
</tr>
<tr>
<td><strong>View direction marks</strong></td>
<td>Shows or hides the view direction marks and defines the mark height.</td>
</tr>
<tr>
<td><strong>Anchor bolt plan</strong></td>
<td><strong>Yes</strong> shows the general arrangement drawing as an anchor bolt plan.</td>
</tr>
<tr>
<td><strong>Show as anchor bolt plan</strong></td>
<td>For more information, see Creating anchor bolt plans using saved settings on page 59.</td>
</tr>
<tr>
<td><strong>Enlarged part view scale</strong></td>
<td>Defines the scale used in the enlarged part views.</td>
</tr>
</tbody>
</table>
Option | Description
---|---
Create detail views | Yes creates separate detail views. If you select No, Tekla Structures dimensions the anchor bolts in the enlarged view. Tekla Structures groups similar detail views so that similar details are drawn only once.
Detail view scale | Defines the scale used in the anchor bolt plan detail views.

See also
- Automatic drawing views on page 350
- Drawing size and drawing view scale on page 339
- Defining the views to create in single-part, assembly and cast unit drawings on page 350
- Defining automatic view settings for general arrangement drawings on page 351

### 8.5 Section view properties

When you create automatic section views, Tekla Structures creates section views and section marks using the current properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Attributes tab</td>
<td></td>
</tr>
<tr>
<td>Section depth</td>
<td>Defines the positive and negative distances of the section view when views are not combined.</td>
</tr>
<tr>
<td>Distance for combining cuts</td>
<td>Defines the distance range for combining cut views.</td>
</tr>
</tbody>
</table>
| Direction | Define the view direction of the section. The options are:  
- Right section  
- Middle section  
- Left section  
The available values are left or right. |
<p>| Cutting line | |
| Line | Length and offset of the cutting line. |
| Properties | Color of the cutting line. |
| Section mark | |
| Text | Defines the text on the section mark. Click the ... buttons next to the text boxes to open the Mark Contents dialog box. |
| Symbol: Color | Color of the section mark symbol. |
| Left symbol, Right symbol | Left and right section mark symbol. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Size of the section mark symbol.</td>
</tr>
<tr>
<td>x/y</td>
<td>Offset of the section mark symbol.</td>
</tr>
</tbody>
</table>

See also
- View properties in drawings on page 529
- Object protection and placement settings in drawings on page 343
- Automatic drawing views on page 350
- Defining the views to create in single-part, assembly and cast unit drawings on page 350
- Creating a section view on page 117

8.6 Dimension and dimensioning properties

In single-part, assembly and cast unit drawings, automatic dimensioning properties are set separately for each view you create in the Dimensioning Rule Properties dialog box. For Integrated dimensioning type, they are set in the Dimensioning Properties dialog box. In general arrangement drawings, dimensions can be set both on drawing and view level in the Dimension Properties and Dimensioning Properties dialog boxes.

See also
- Dimensioning rule properties on page 394
- General dimension properties on page 533
- Dimension format, precision and unit properties on page 535
- Dimension appearance properties on page 537
- Dimension mark and dimension tag properties on page 538
- General dimensioning properties on page 539
- Part dimensioning properties on page 544
- Position dimensioning properties on page 542
- Bolt dimensioning properties on page 545
- Dimension grouping properties on page 546
- Sub-assembly dimensioning properties on page 547
- Reinforcement dimensioning properties on page 548
- Grid and overall dimensioning properties (GA drawings) on page 548
- Part dimensioning properties (GA drawings) on page 549
General dimension properties

Use the **General** tab in the **Dimension Properties** dialog box to view and modify the format, type, unit, precision, extension line, grouping and placing settings of the dimensions.

The drawing level **Dimension Properties** dialog box and object level **Dimension Properties** dialog box contents differ. The table below contains all options for both dialog boxes.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Dimension types:</strong></td>
<td>Sets the dimension type for straight dimensions.</td>
</tr>
<tr>
<td><strong>Straight</strong></td>
<td></td>
</tr>
<tr>
<td><img src="image1.png" alt="image" /></td>
<td><strong>Relative:</strong> Point to point dimensions.</td>
</tr>
<tr>
<td><img src="image2.png" alt="image" /></td>
<td><strong>Absolute:</strong> Dimensions from a common start point.</td>
</tr>
<tr>
<td><img src="image3.png" alt="image" /></td>
<td><strong>Relative and absolute:</strong> Combination of point to point and common start point.</td>
</tr>
<tr>
<td><img src="image4.png" alt="image" /></td>
<td><strong>US absolute:</strong> Dimensions from a common start point, which include a running dimension mark (RD).</td>
</tr>
<tr>
<td><img src="image5.png" alt="image" /></td>
<td><strong>US absolute 2:</strong> Similar to <strong>US absolute</strong>, but it changes short dimensions to relative.</td>
</tr>
<tr>
<td><img src="image6.png" alt="image" /></td>
<td><strong>Absolute plus short relatives:</strong> Similar to <strong>Absolute</strong>, but it changes short dimensions to relative. Also called internal absolute. This option may show both dimensions, but it does not show relative dimensions when dimensions are long. This option shows the absolute dimensions inside the dimension lines.</td>
</tr>
<tr>
<td><img src="image7.png" alt="image" /></td>
<td><strong>Absolute plus all relatives above the absolutes:</strong> Similar to <strong>Relative and absolute</strong>, but it places the relative dimensions above the absolute.</td>
</tr>
<tr>
<td><strong>Dimension types: In x direction</strong></td>
<td>As above, but overrides the straight setting for horizontal dimensions. If you use the blank option, Tekla Structures uses the <strong>Straight</strong> option settings. The x direction usually means dimensions parallel to the drawing x axis.</td>
</tr>
<tr>
<td><strong>Angle</strong></td>
<td>Defines the appearance of angle dimensions.</td>
</tr>
<tr>
<td><img src="image9.png" alt="image" /> Shows the angle dimensions in degrees at angle vertex.</td>
<td></td>
</tr>
<tr>
<td><img src="image10.png" alt="image" /> Shows the angle dimensions using a triangle. You can also set the <strong>Triangle base length</strong> to control the base dimension shown for bevel dimensions.</td>
<td></td>
</tr>
<tr>
<td><img src="image11.png" alt="image" /> Shows the angle dimensions using a triangle with degrees.</td>
<td></td>
</tr>
<tr>
<td><strong>Triangle base length</strong></td>
<td>The base length of a triangle.</td>
</tr>
<tr>
<td><strong>Curved</strong></td>
<td>Defines whether to use angle units or length for curved dimensions. This setting can only be adjusted in drawing mode.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Short extension line</td>
<td>Defines whether Tekla Structures should create extension lines all of the same length or use the short extension line automatically if the dimension line falls on a grid line.</td>
</tr>
<tr>
<td>Units</td>
<td>Defines the units used in dimensioning.</td>
</tr>
<tr>
<td>Precision</td>
<td>Defines dimension precision: rounding, imperial units.</td>
</tr>
<tr>
<td>Format</td>
<td>Defines the number of decimals and their appearance.</td>
</tr>
<tr>
<td>Use grouping</td>
<td>Defines the appearance of large dimension values.</td>
</tr>
<tr>
<td>Combine equal dimensions</td>
<td>Combines equal dimensions. The choices are <strong>None</strong>, <strong>3*60</strong> or <strong>3*60=180</strong>. The accuracy of combining equal dimensions is 0.1.</td>
</tr>
<tr>
<td>Minimum number to combine</td>
<td>Defines the minimum number of dimensions to combine.</td>
</tr>
<tr>
<td>Dimension line spacing</td>
<td>Defines the space between parallel dimension lines. In manually created dimensions, this setting works only if dimension Placing is set to <strong>Free</strong>, see below.</td>
</tr>
<tr>
<td>Short dimensions</td>
<td>Defines the text location of short dimensions: between or outside the dimension lines.</td>
</tr>
<tr>
<td>Place</td>
<td><strong>Search margin</strong> is the farthest distance Tekla Structures uses when searching for an empty space for the dimension. <strong>Minimal distance</strong> is the closest distance Tekla Structures uses to search for an empty space for a dimension. <strong>Direction</strong> is the side on which Tekla Structures places dimensions (relative to the object being dimensioned). This option is available only for manual dimensions. <strong>Placing</strong> is the method used to place dimension. This option is available only for manual dimensions. The choices are: - <strong>Free</strong> lets Tekla Structures to decide the location and direction of the dimension based on the <strong>Direction</strong> settings. - <strong>Fixed</strong> allows you to place the dimension at any point.</td>
</tr>
</tbody>
</table>

See also Dimension format, precision and unit properties on page 535

XS_DIMENSION_DECIMAL_SEPARATOR

XS_ANGLE_DIMENSION_SYMBOL_SIZE_FACTOR
Dimension format, precision and unit properties

Use the **General** tab of the **Dimensions** dialog box to view and modify properties related to dimension format.

The integer values are provided for situations like when you need to use the value in an advanced option.

<table>
<thead>
<tr>
<th>Option</th>
<th>Integer value</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Format</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>###</td>
<td>0</td>
<td></td>
</tr>
<tr>
<td>###[.#]</td>
<td>1</td>
<td></td>
</tr>
<tr>
<td>###.#</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>###[.##]</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>###.##</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>###[.###]</td>
<td>5</td>
<td></td>
</tr>
<tr>
<td>###.###</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>### ##</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>## * /##.## *</td>
<td>8</td>
<td>This option is available only for straight dimensions.</td>
</tr>
<tr>
<td><strong>Precision</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>0.00</td>
<td>1</td>
<td>For defining precision with rounding. For example, with precision 0.33 the actual dimension 50.40 is shown as 50.33.</td>
</tr>
<tr>
<td>0.50</td>
<td>2</td>
<td></td>
</tr>
<tr>
<td>0.33</td>
<td>3</td>
<td></td>
</tr>
<tr>
<td>0.25</td>
<td>4</td>
<td></td>
</tr>
<tr>
<td>1/8</td>
<td>5</td>
<td>For imperial units</td>
</tr>
<tr>
<td>1/16</td>
<td>6</td>
<td></td>
</tr>
<tr>
<td>1/32</td>
<td>7</td>
<td></td>
</tr>
<tr>
<td>1/10</td>
<td>8</td>
<td>For defining precision without rounding</td>
</tr>
<tr>
<td>1/100</td>
<td>9</td>
<td></td>
</tr>
<tr>
<td>1/1000</td>
<td>10</td>
<td></td>
</tr>
<tr>
<td><strong>Units</strong></td>
<td></td>
<td></td>
</tr>
<tr>
<td>automatic</td>
<td></td>
<td>Uses the units defined in the model</td>
</tr>
<tr>
<td>mm</td>
<td></td>
<td>millimeters</td>
</tr>
<tr>
<td>cm</td>
<td></td>
<td>centimeters</td>
</tr>
<tr>
<td>m</td>
<td></td>
<td>meters</td>
</tr>
</tbody>
</table>
### Option | Integer value | Notes
--- | --- | ---
foot - inch | | feet and inches
| | Inches are converted into integer feet, and the remaining inches are shown in inches.
cm / m | | centimeters and meters
| | Dimensions under 100 cm are shown in centimeters, and dimensions above 100 cm are shown in meters. Millimeters are shown as superscript.
inch | | inches

See also General dimension properties on page 533

### Dimension appearance properties

Use the Appearance tab in the Dimension Properties dialog box to view and modify the settings affecting the dimension appearance.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Line, Arrow</td>
<td>The color of the dimension line. This controls the line weight in printed drawings.</td>
</tr>
<tr>
<td>Color</td>
<td>Controls the type of mark used with the dimension line.</td>
</tr>
<tr>
<td>Arrow shape</td>
<td>Controls the type of mark used with the dimension line in US Absolute dimensions.</td>
</tr>
<tr>
<td>US Absolute dimensions</td>
<td>Controls the type of mark used with the dimension line in level dimensions.</td>
</tr>
<tr>
<td>Level dimensions</td>
<td>Sets the height and the length of the arrowhead.</td>
</tr>
<tr>
<td>Text</td>
<td>Controls the color of the mark text. The color controls the line weight.</td>
</tr>
<tr>
<td>Color</td>
<td>Controls the height of the text used in the dimension marks in the drawing.</td>
</tr>
<tr>
<td>Height</td>
<td>Controls which font is used in the dimension mark.</td>
</tr>
<tr>
<td>Font</td>
<td>Defines a frame for the dimension mark.</td>
</tr>
<tr>
<td>Frame</td>
<td></td>
</tr>
</tbody>
</table>

Drawing settings 537 Dimension and dimensioning properties
### Place

Defines how the dimension mark is placed relative to the dimension line.

---

**See also**  Dimension and dimensioning properties on page 533

---

## Dimension mark and dimension tag properties

Use the **Marks** and **Tags** tabs in the **Dimension Properties** dialog box to view and modify the contents of dimension marks and tags in an open drawing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Marks tab</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Prefix</strong></td>
<td>Displays the selected text before the numeric value of the dimension. The prefix value cannot be plain numbers, and the prefix value cannot end with a number.</td>
</tr>
<tr>
<td><strong>Visibility of numeric value</strong></td>
<td>Defines whether the numeric value of the dimension is visible or hidden. If you hide the numeric value of the dimension, the prefix and postfix text will still be shown.</td>
</tr>
<tr>
<td><strong>Postfix</strong></td>
<td>Displays the selected text after the numeric value of the dimension. The postfix value cannot be plain numbers, and the postfix value cannot start with a number when the numeric value of the dimension is visible.</td>
</tr>
</tbody>
</table>
| **... buttons** | Define dimension mark contents by adding elements. You can also modify the mark appearance.  

- **Frame around elements:** **Type** and **Color** define the element frame type and color individually for each element.  

- **Add frame** allows you to add frames around elements. **Font:** **Color,** **Height** and **Font** define the font type, color, and height used in element texts individually for each element. Clicking **Select** gives more font choices.  

- **Units:** **Unit** and **Format** allow you to set the unit and format for length elements. Unit settings can be modified only when a length element is selected. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Plate side marks</td>
<td><strong>Specified</strong> creates plate side marks to plate dimension using the specified color, size and offset. Offset means the distance of the mark from the dimension line. The option <strong>Automatic</strong> is available only in intelligent drawings, that is when the advanced option <em>XS_INTELLIGENT_DRAWING_ALLOWED</em> is set to <em>TRUE</em>.</td>
</tr>
<tr>
<td>Exaggeration</td>
<td><strong>Specified</strong> exaggerates narrow dimensions. Select the <strong>Direction</strong>: <strong>Left/ Down, Right/Up or Both.</strong> Set the <strong>Origin, Width, Position and Height</strong>.</td>
</tr>
<tr>
<td>Tags tab</td>
<td></td>
</tr>
<tr>
<td>Tags area</td>
<td>Adds user-defined tags to dimension lines.</td>
</tr>
<tr>
<td>... buttons</td>
<td>Define dimension tag contents by adding elements. You can also modify the tag element appearance.</td>
</tr>
<tr>
<td></td>
<td><strong>Rotation --&gt; Perpendicular to dimension line</strong> rotates the tag.</td>
</tr>
<tr>
<td></td>
<td><strong>Rotation --&gt; Parallel to dimension line</strong> does not rotate the tag. This is the default value.</td>
</tr>
<tr>
<td></td>
<td><strong>Frame around elements</strong>: <strong>Type</strong> and <strong>Color</strong> define the element frame type and color individually for each element.</td>
</tr>
<tr>
<td></td>
<td><strong>Add frame</strong> allows you to add frames around elements. <strong>Font: Color, Height</strong> and <strong>Font</strong> define the font type, color, and height used in element texts individually for each element. Clicking <strong>Select</strong> gives more font choices. <strong>Units: Unit</strong> and <strong>Format</strong> allow you to set the unit and format for length elements. Unit settings can be modified only when a length element is selected.</td>
</tr>
<tr>
<td>Include part count in the tag</td>
<td><strong>Yes</strong> includes part count in the tag.</td>
</tr>
<tr>
<td>Exclude parts according to filter</td>
<td>Select a drawing view filter that removes desired content from the tag.</td>
</tr>
</tbody>
</table>

**See also**

- Adding manual dimensions on page 142
- Showing plate side marks on page 168
- Creating exaggerated dimensions on page 439
- Adding tags to dimensions on page 150
- Example: Filtering out dimension tag content on page 151
**General dimensioning properties**

Use the **General** tab in the **Dimensioning Properties** dialog box to view and modify the general settings of the dimensions.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Dimensioning type**         | **Standard** is used for almost all dimensioning.  
**Truss** meets the specific requirements needed to dimension truss drawings. It dimensions the position and length of the diagonals. The dimensioning is done only if the diagonals are secondary parts that are welded to upper and lower chords, which are main parts and not welded to any parts. If the truss welding is done some other way, standard dimensioning is used. |
| **Number of views:** Minimize (or Minimize number of views) | **Yes** minimizes the number of views that Tekla Structures creates.  
Also check the settings in the drawing **View properties** dialog box. |
| **Combine dimensions**        | Combines several single dimensions into one dimension line.  
In **Options**, select the combination level. The larger the number, the more Tekla Structures combines the dimensions.  
Option **4.5** uses a combination of option **5** for main part and option **4** for secondary parts.  
If the distance between two details is less than the defined **Minimum distance**, Tekla Structures combines the dimensions.  
The **Distance** means the distance within which Tekla Structures combines internal dimensions. |
| **Close dimensions**          | Completes dimension lines to include the entire part.  
**No** does not close dimensions  
In **X** only closes dimensions in the x direction and leaves others open  
All closes all dimensions  
This setting is not relevant to profile shape dimensions. |
| **Close dimensions:** Short dimensions | **Yes** closes short dimension(s).  
With **No**, the open dimension is the middle one rather than the short end dimension.  
When you leave short dimensions open, Tekla Structures leaves out the longer dimension line in dimension lines that contain two dimensions. If dimension lines contain three dimensions, Tekla Structures leaves out the middle one. This option does not affect dimension lines with more than three dimensions. |
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Placing: Forward offset</td>
<td>Defines the distance Tekla Structures uses to search for the base point of a dimension. If Tekla Structures does not find a base point (corner) within the Forward offset search distance, it uses an edge point. The Centered bolt setting affects on how the dimension is displayed.</td>
</tr>
<tr>
<td>Necessary internal dimensioning: Recognizable distance</td>
<td>Defines the limit for dimensioning asymmetry in secondary parts. In some cases it is important to look at the asymmetrical relationship of parts, so that an asymmetric secondary part is correctly connected to a main part. You can use Recognizable distance to have asymmetry reflected in dimensioning. If the asymmetry is smaller than the distance you enter here, Tekla Structures represents it using a dimension.</td>
</tr>
<tr>
<td>Part mark on dimension line</td>
<td>None creates no part mark on the dimension line.</td>
</tr>
<tr>
<td></td>
<td>Assembly overall dimensions creates a part mark on the assembly overall dimension line.</td>
</tr>
<tr>
<td></td>
<td>Extreme bolts creates a part mark on the dimension line between the outermost bolts.</td>
</tr>
<tr>
<td>Main dimension position</td>
<td>Defines the side on which Tekla Structures places the Assembly overall, Main part work point, and Knock-off dimensions.</td>
</tr>
<tr>
<td></td>
<td>Auto treats the main dimensions in the same way as other dimensions.</td>
</tr>
<tr>
<td></td>
<td>Above places the main dimensions above the part (or to the left for vertical parts).</td>
</tr>
<tr>
<td></td>
<td>Below places the main dimensions below the part.</td>
</tr>
<tr>
<td></td>
<td>Above places the skew position dimensions of the main part below the part and Below places them above.</td>
</tr>
<tr>
<td>Grid dimensions</td>
<td>Creates grid dimensions. The values are: None, Individual spans, Overall or Individual spans and overall.</td>
</tr>
<tr>
<td>Grid dimension position</td>
<td>Sets the grid dimension position. The values are: Main view – above, Main view – below, Top view – above, Top view – bottom, Bottom view – above, Bottom view – below, Back view – above, Back view – below, All views – above, or All views – below.</td>
</tr>
<tr>
<td>Dimension properties (available in view-specific dimensioning)</td>
<td></td>
</tr>
<tr>
<td>Straight dimensions</td>
<td>Sets the dimension type for straight dimensions using the settings in the properties file you select.</td>
</tr>
<tr>
<td>In X direction</td>
<td>Otherwise same settings as in straight dimensions but overrides the straight setting for horizontal dimensions. If you use the blank option, Tekla Structures uses the Straight dimensions option settings. The x direction usually means dimensions parallel to the drawing x axis.</td>
</tr>
<tr>
<td>Arrow shape: US Absolute dimensions</td>
<td>Controls the type of mark used with the dimension line in US Absolute dimensions.</td>
</tr>
<tr>
<td>Arrow shape: Level dimensions</td>
<td>Controls the type of mark used with the dimension line in level dimensions.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Angle dimensions</td>
<td>Sets the dimension type for angle dimensions using the settings in the</td>
</tr>
<tr>
<td></td>
<td>properties file you select.</td>
</tr>
<tr>
<td>Check dimensions</td>
<td>Sets the dimension type for check dimensions using the settings in the</td>
</tr>
<tr>
<td></td>
<td>properties file you select.</td>
</tr>
</tbody>
</table>

See also  
* Dimensioning using dimensioning type Integrated on page 411  
* Example: Combining dimensions on page 427  
* Example: Closing dimension on page 426  
* Example: Forward offset on page 430  
* Example: Recognizable distance on page 431  

**Position dimensioning properties**

Use the Position dimensions tab in the Dimensioning Properties dialog box to view and modify the settings for the position dimensions in single-part, assembly and cast unit drawings. Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Position bolts/parts to</td>
<td>Controls from where Tekla Structures creates the part/bolt position dimensions.</td>
</tr>
<tr>
<td>None</td>
<td>creates no position dimensions.</td>
</tr>
<tr>
<td>Main part</td>
<td>creates the dimensions from the main part reference line.</td>
</tr>
<tr>
<td>Working points</td>
<td>creates the dimensions between the work points, such as the intersections of main and neighbor part reference lines.</td>
</tr>
<tr>
<td>Embedded objects</td>
<td>Creates position dimensions for locating embedded objects in cast unit drawings. The embedded objects are custom components attached to the cast unit.</td>
</tr>
<tr>
<td>As secondary objects</td>
<td>dimensions embedded objects in cast unit drawings the same way as secondary parts.</td>
</tr>
<tr>
<td>By reference points</td>
<td>dimensions embedded objects to their reference point, which is the origin of the custom component.</td>
</tr>
<tr>
<td>Secondary part</td>
<td>Creates dimensions to bolt holes or edges of the secondary part.</td>
</tr>
<tr>
<td>None</td>
<td>creates no position dimensions for secondary parts.</td>
</tr>
<tr>
<td>By bolts</td>
<td>dimensions bolt hole locations in the secondary parts.</td>
</tr>
<tr>
<td>By parts</td>
<td>dimensions edges of secondary parts.</td>
</tr>
<tr>
<td>By both</td>
<td>dimensions bolt hole locations and edges of the secondary part.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Secondary part dimension direction</td>
<td>Aligns dimensions with the main or neighboring part. Only for skewed clip angles or shear plates.</td>
</tr>
<tr>
<td>Position from</td>
<td>Sets the start point for running dimensions. Only for skewed clip angles or shear plates bolted to a neighboring part.</td>
</tr>
<tr>
<td>Reversed direction for running dimensions</td>
<td>Yes changes the direction of running dimensions. With this option, you can set the zero point to the end of a member rather than to the start.</td>
</tr>
<tr>
<td>Main part bolt position</td>
<td>On creates dimensions to the bolt hole locations in the main part.</td>
</tr>
<tr>
<td>Main part skew position</td>
<td>Yes creates horizontal and vertical check dimensions representing the skew position of a brace. Created between the work points of the main part. Skew check dimensions are located in the front view. Their location depends on the Main dimension side setting selected on the General tab. When the main dimensions are above the part, the skew dimensions are below, and vice versa.</td>
</tr>
<tr>
<td>Skew position</td>
<td>Defines how Tekla Structures dimensions skewed secondary part positions.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> creates no dimensions for skewed secondary part positions.</td>
</tr>
<tr>
<td></td>
<td><strong>Angle</strong> creates an angle dimension for the secondary part.</td>
</tr>
<tr>
<td></td>
<td><strong>Dimensions</strong> creates dimensions for the skewed position of the secondary part.</td>
</tr>
<tr>
<td></td>
<td><strong>Both</strong> creates both the angle and the dimensions.</td>
</tr>
<tr>
<td>Centered part</td>
<td>Controls the dimensions of centrally-placed parts. These settings have an effect only if position dimensions are created.</td>
</tr>
<tr>
<td></td>
<td><strong>Internal</strong> dimensions the centered parts overall size.</td>
</tr>
<tr>
<td></td>
<td><strong>Position</strong> dimensions the part to the main part center lines.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong> creates no centered part dimensions.</td>
</tr>
<tr>
<td>Centered bolt</td>
<td>Controls the dimensions of centrally-placed bolt groups.</td>
</tr>
<tr>
<td></td>
<td><strong>Internal</strong> dimensions the centered bolts spread.</td>
</tr>
<tr>
<td></td>
<td><strong>Position</strong> dimensions the bolts to the main part center-lines.</td>
</tr>
<tr>
<td></td>
<td><strong>Centered bolt</strong> overrides the Secondary part bolt internal option for centered bolts. This only applies to bolts located centrally on the part.</td>
</tr>
<tr>
<td>Elevation dimension</td>
<td>On creates elevation dimensions.</td>
</tr>
<tr>
<td>Combine equal dimensions</td>
<td>Combines equal dimensions. The choices are <strong>None</strong>, 3<em>60 or 3</em>60=180.</td>
</tr>
<tr>
<td></td>
<td>The accuracy of combining equal dimensions is 0.1.</td>
</tr>
<tr>
<td>Minimum number to combine</td>
<td>Defines the minimum number of dimensions to combine.</td>
</tr>
</tbody>
</table>
**Part dimensioning properties**

Use the options on the **Part dimensioning** tab of the **Dimensioning Properties** dialog box to view and modify part dimensioning settings for single-part, assembly and cast unit drawings. Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| **Internal**               | Creates internal dimensions for secondary parts connected to the main part.  
None creates dimensions for secondary parts.  
Necessary creates only the dimensions that are necessary for assembling the parts.  
All creates all dimensions for the secondary parts. |
| **Main part overall dimensions** | Once creates one overall dimension for the main part.  
All creates overall dimensions for main parts in all views.  
None creates no overall dimensions for the main part.  
The **Assembly part overall dimension** settings have some effect on these options. |
| **Assembly part overall dimensions** | Length only creates overall dimensions for an entire assembly or cast unit in the x direction only.  
All creates overall dimensions for an assembly or cast unit in all directions.  
Off creates no overall dimensions for an assembly or a cast unit. |
| **Main part work points**  | On creates a check dimension between the outermost work points.                                                                 |
| **Main part shape (Shape dimensions)** | On creates dimensions to show the shape of a main part.  
By default, Tekla Structures automatically draws shape dimensions on both ends of a beam, even if the ends are symmetrical. |
| **Main part radius dimensions (Radius dimensions)** | On creates radius dimensions for curved chamfers and round holes in the main part.  
This option is available only if you have set **Main part shape dimensions** to On.  
Note that this option does not create radius dimensions for curved beams or polybeams with chamfers. |
<p>| <strong>Bevel dimensions</strong>       | On creates linear dimensions of a bevel.                                                                                                    |
| <strong>Bevel angle</strong>            | Creates an angle dimension and defines which side of the bevel to dimension. The choices are None, Angle of cut and Angle of beam. |</p>
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Knock off dimensions</td>
<td>On creates check dimensions from the edge of the main part to the work point.</td>
</tr>
<tr>
<td>Preferred dim side</td>
<td>Sets the preferred view (front or side) for part dimensions.</td>
</tr>
<tr>
<td>From the nearest floor level to part</td>
<td>On creates dimensions indicating the distance from the closest floor level to the bottom and/or top of the parts.</td>
</tr>
<tr>
<td>From grid to part center line</td>
<td>On creates dimensions showing the offset of a part from the grid to the part center line.</td>
</tr>
<tr>
<td>From grid to part ends</td>
<td>On creates dimensions showing the offset of a part from the grid to the near or far end of the part.</td>
</tr>
</tbody>
</table>

See also Dimensioning using dimensioning type Integrated on page 411
Example: Part dimensioning on page 418
XS_SINGLE_PART_SHAPE
XS_EQUAL_SHAPE_DIMENSIONS_TO_BOTH_ENDS_LIMIT
XS_CREATE_ROUND_HOLE_DIMENSIONS

Bolt dimensioning properties

Use the options on the Bolt dimensions tab of the Dimensioning Properties dialog box to select which bolt dimensions to create and how in single-part, assembly and cast unit drawings. The options include locating the bolts on the main and secondary parts, and in relation to the work points.

Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main part bolt internal dimensions</td>
<td>Creates internal dimensions for bolt groups in the main part.</td>
</tr>
<tr>
<td></td>
<td>None creates none of the internal bolt dimensions.</td>
</tr>
<tr>
<td></td>
<td>Internal creates bolt group internal dimensions (distances between bolts).</td>
</tr>
<tr>
<td></td>
<td>All creates edge distance and bolt group internal dimensions. Edge distance is the dimension from the outermost bolt to the part edge.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------------------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Main part bolt internal dimensions: Skewed bolt group</td>
<td>Indicates whether the dimensions are parallel to the part or the bolt group. The choices are <strong>No dimensions</strong>, <strong>In part direction</strong>, and <strong>In bolt group direction</strong>.</td>
</tr>
<tr>
<td>Secondary part bolt internal dimensions</td>
<td>Creates internal dimensions for bolt groups in the secondary part. The choices are <strong>None</strong>, <strong>Necessary</strong>, <strong>Internal</strong>, and <strong>All</strong>.</td>
</tr>
<tr>
<td>Secondary part bolt internal dimensions: Skewed bolt group</td>
<td>Aligns the bolt dimensions with the secondary part or bolt group. The choices are <strong>In part direction</strong>, <strong>No dimensions</strong>, and <strong>In bolt group direction</strong>.</td>
</tr>
<tr>
<td>Distance between extreme bolts: Extreme bolts</td>
<td>Creates check dimension between the outermost bolts. The choices are <strong>None</strong>, <strong>Main part</strong>, and <strong>Assembly</strong>.</td>
</tr>
<tr>
<td>Distance between extreme bolts: Extreme bolts to work points</td>
<td>Creates check dimensions from the outermost bolts to the work points. <strong>Yes</strong> creates the check dimensions.</td>
</tr>
<tr>
<td>Preferred dim side</td>
<td>Sets the preferred view (front or side) for bolt dimensions. <strong>[+]</strong> or <strong>[=]</strong></td>
</tr>
<tr>
<td>Combine bolt dimensions</td>
<td>Sets the format of the combined bolt group internal dimensions. You can combine bolt group internal dimensions and display them in the format <strong>3*60</strong> or <strong>3*60=180</strong>, or have single dimensions.</td>
</tr>
<tr>
<td>Minimum number to combine</td>
<td>Defines the minimum number of dimensions to combine.</td>
</tr>
</tbody>
</table>

**See also**  
Dimensioning using dimensioning type Integrated on page 411  
Example: Combining bolt group dimensions on page 429

**Dimension grouping properties**

Use the **Dimension grouping** tab in **Dimensioning Properties** dialog box to view and modify settings for dimension grouping in single-part, assembly and cast unit drawings. Note that the contents of the dialog box vary depending on the drawing type, and all the options listed below are not available for all drawing types.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Activate dimension grouping</td>
<td>Selects the objects for grouping.</td>
</tr>
<tr>
<td>Parts</td>
<td>Groups according to parts.</td>
</tr>
<tr>
<td>Bolts</td>
<td>Groups according to bolts.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Components</td>
<td>Groups according to components.</td>
</tr>
<tr>
<td>Cuts/Shapes</td>
<td>Groups according to cuts or shapes.</td>
</tr>
<tr>
<td>Automatic tagging</td>
<td>Defines how to display information in a dimension line.</td>
</tr>
<tr>
<td>Display tags</td>
<td>Displays tags.</td>
</tr>
<tr>
<td>Include part count in the tag</td>
<td>Includes part count in the tag.</td>
</tr>
<tr>
<td>Do not display marks for the grouped items</td>
<td>Does not display part marks for grouped items.</td>
</tr>
<tr>
<td>Available elements</td>
<td>Elements available to define identical conditions.</td>
</tr>
<tr>
<td>Add</td>
<td>Adds items to Selected elements list.</td>
</tr>
<tr>
<td>Remove</td>
<td>Removes items from Selected elements list.</td>
</tr>
<tr>
<td>Move up</td>
<td>Moves the element higher in the list.</td>
</tr>
<tr>
<td>Move down</td>
<td>Moves the element lower in the list.</td>
</tr>
<tr>
<td>Update grouping when model changes</td>
<td>Yes updates dimension grouping automatically when the model changes.</td>
</tr>
</tbody>
</table>

**Sub-assembly dimensioning properties**

Use the options on the Sub-assembly tab of the Assembly – Dimensioning Properties dialog box to view and modify which dimensions to create and how for sub-assemblies.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimension parts inside sub-assemblies</td>
<td>Defines whether to dimension parts inside sub-assemblies. Yes creates internal dimensions for parts inside sub-assemblies. No does not create internal dimensions for parts inside sub-assemblies.</td>
</tr>
<tr>
<td>Measure sub-assembly position from</td>
<td>Defines the position from which the sub-assembly is measured. None does not measure the sub-assembly position. Bolt measures the position of the sub-assembly from the bolts. If bolts are not included in the sub-assembly, or if it is not possible to measure the position from bolts, Tekla Structures measures the sub-assembly position from the reference point.</td>
</tr>
</tbody>
</table>
Option | Description
--- | ---
Extreme points | measures the position of the sub-assembly from the bounding box of the sub-assembly.
Reference point | measures the position of the sub-assembly from the reference point.

Reinforcement dimensioning properties

Use the Reinforcement dimensions tab in the Dimensioning Properties dialog box to view and modify the setting affecting the creation of reinforcement dimensions and how they are displayed.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Dimensions for reinforcing bar groups</td>
<td>On creates dimensions for reinforcing bar groups. This also activates the other selections on this tab.</td>
</tr>
<tr>
<td>Mark location</td>
<td>Sets the mark type and location.</td>
</tr>
<tr>
<td></td>
<td>Selecting the first choice in the list creates dimension marks.</td>
</tr>
<tr>
<td></td>
<td>Selecting one of the other options in the list creates tagged dimension marks. The location of the tag is indicated by the small rectangle in the option.</td>
</tr>
<tr>
<td>Edit mark contents</td>
<td>Opens the Dimension mark content dialog box where you can select what you want to include in the dimension mark.</td>
</tr>
<tr>
<td>Close dimension to binding geometry</td>
<td>Yes automatically adds closing dimensions to the edge of the part.</td>
</tr>
</tbody>
</table>

See also Dimensioning using dimensioning type Integrated on page 411

Grid and overall dimensioning properties (GA drawings)

Use the Grid tab in the General – Dimensioning Properties dialog box to view and modify settings for grid and overall dimensions in general arrangement drawings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grid line dimensions</td>
<td>On creates grid dimension lines.</td>
</tr>
<tr>
<td>Overall dimensions</td>
<td>On creates the overall dimensions.</td>
</tr>
</tbody>
</table>
### Part dimensioning properties (GA drawings)

Use the **Parts** tab in the **General – Dimensioning Properties** dialog box to view and modify settings for part dimensions in general arrangement drawings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Maximum leader line length: Outside dimensions</td>
<td>Controls how close the dimension lines are positioned to the parts they are dimensioning. Defines that the outside dimension lines take the maximum leader line length from the grid line.</td>
</tr>
<tr>
<td>Maximum leader line length: Inside dimensions</td>
<td>Controls how close the dimension lines are positioned to the parts they are dimensioning. Defines that the inside dimension lines take the maximum leader line length from the part reference point.</td>
</tr>
<tr>
<td>Include parts not entirely in view</td>
<td>On dimensions the parts partly outside the view. Off will not dimension these parts.</td>
</tr>
<tr>
<td>Maximum number of outside dimensions</td>
<td>Specifies the maximum number of dimension lines allowed outside the grid. When you dimension different objects on different dimension lines, using this setting helps you to create cleaner drawings. Once the desired maximum is reached, Tekla Structures creates the dimensions inside the grid.</td>
</tr>
<tr>
<td>Object group dimensioning rules</td>
<td>Specifies different object groups to be dimensioned on different dimension lines.</td>
</tr>
<tr>
<td>Object group</td>
<td>The object group to be dimensioned.</td>
</tr>
<tr>
<td>Positioning</td>
<td><strong>No dimensions</strong> does not create dimensions for the parts. <strong>Inside grid</strong> creates dimensions next to or near the parts being dimensioned. All part dimensions are placed inside the grid when the parts are inside the grid. The dimension will still be outside, even if you have selected <strong>Inside grid</strong> because of where the parts are in the end bay and the end being dimensioned to is next to the outside. <strong>Outside grid</strong> creates dimensions to parts and positions them outside the grid.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>--------</td>
<td>-------------</td>
</tr>
<tr>
<td>Either</td>
<td>Either creates dimensions to parts and positions them either inside or outside the grid depending on the part position and the setting of the option <strong>Maximum number of outside dimensions</strong>. You must use the <em>Either</em> option if you define the <strong>Maximum number of outside dimensions</strong>, so that Tekla Structures can position dimensions inside the grid when the maximum number of dimensions is reached outside the grid.</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Horizontal position</th>
<th><strong>Left side</strong> positions all dimensions to horizontal parts to the left of the grid. <strong>Right side</strong> positions all dimensions to horizontal parts to the right of the grid. <strong>Distributed to both sides</strong> positions all dimensions to horizontal parts to the grid nearest the part they are dimensioning.</th>
</tr>
</thead>
</table>

| Vertical position | **Above** positions all dimensions to vertical parts above the grid. **Below** positions all dimensions to vertical parts below the grid. **Distributed to both sides** positions all dimensions to vertical parts to the grid nearest the part they are dimensioning. |

**See also**
- Automatic dimensioning of general arrangement drawings on page 446
- Example: Part dimension positioning on page 452
- Example: Limiting the number of outside dimensions on page 451
- Example: Dimensioning parts partly outside the view on page 451
- Example: Using maximum leader line length options on page 450

### 8.7 Mark properties

You can adjust the mark appearance and contents before creating a drawing and also in an open drawing.

Click the links below to find out more:
- Mark appearance and merging properties on page 551
- Leader line types on page 553
- Positioning properties of view label, section and detail marks on page 554
- Mark appearance and merging properties on page 551
- Drawing weld mark properties on page 555
- Level mark properties on page 559
Mark appearance and merging properties

Use the General and Contents tabs in the Mark properties of different types of marks to view and modify the settings affecting the mark content and appearance. For reinforcement marks, the corresponding settings are located on the Contents and Appearance tabs.

Note that all the listed settings are not available for all marks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Contents tab:</strong></td>
<td></td>
</tr>
<tr>
<td>Frame around elements: Type and Color</td>
<td>Defines the element frame type and color for one or several elements element. To select all elements in the list to apply the same modification to all of them, hold down Shift and click the last element in the list. Add frame allows you to add frames around elements.</td>
</tr>
<tr>
<td>Font: Color, Height and Font</td>
<td>Defines the font type, color, and height used in element texts in one or several elements. To select all elements in the list to apply the same modification to all of them, hold down Shift and click the last element in the list. Clicking Select gives more font choices.</td>
</tr>
<tr>
<td>Units: Unit and Format</td>
<td>Change the unit and format for the length, height, spacing or diameter element that you have selected from the Elements in mark list.</td>
</tr>
<tr>
<td><strong>General or Appearance tab:</strong></td>
<td></td>
</tr>
<tr>
<td>Visible</td>
<td>In one view creates marks in one view only. In all views creates marks in all views.</td>
</tr>
<tr>
<td>In main parts</td>
<td>These options are for bolt marks. Visible displays bolt marks.</td>
</tr>
<tr>
<td>In secondary parts</td>
<td>Not visible does not display bolt marks.</td>
</tr>
<tr>
<td>In sub-assembly main parts</td>
<td></td>
</tr>
<tr>
<td>In sub-assembly secondary parts</td>
<td></td>
</tr>
<tr>
<td>Visibility in view</td>
<td>distributed distributes the marks in the view. Tekla Structures only creates marks that are not visible in the other views. always always creates marks in the view, irrespective the settings in other views. preferred acts as distributed, but the preferred view has a higher priority.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td></td>
<td>Select <strong>preferred</strong> to one view only in a drawing. If you set other views to <strong>distributed</strong>, the marks are located only in the view that has the setting <strong>Visibility in view</strong> set to <strong>preferred</strong>. <strong>none</strong> creates no marks.</td>
</tr>
<tr>
<td><strong>Parts out of view plane</strong></td>
<td>This option is available only in view level properties. <strong>Visible</strong> displays marks outside of the view in the drawing. <strong>Not visible</strong> displays no marks outside the view.</td>
</tr>
<tr>
<td><strong>Bolt size limit</strong></td>
<td>This option is for bolt marks. Filters standard-sized bolt marks out of drawings. Tekla Structures does not display bolt marks of the size you enter here. There are several variables that affect the <strong>Bolt size limit</strong>, see the <strong>See also</strong> list below.</td>
</tr>
<tr>
<td><strong>Merge marks</strong></td>
<td>This option is for part marks and surface treatment marks. <strong>On</strong> merges marks.</td>
</tr>
<tr>
<td><strong>Frame around mark: Type and Color</strong></td>
<td>Define the frame to be used around marks, and the color of the frame.</td>
</tr>
<tr>
<td><strong>Leader line: Type, Arrow and Use hidden lines for hidden parts.</strong></td>
<td>Define the leader line type and line arrow type, and select to hide leader lines for hidden parts.</td>
</tr>
<tr>
<td><strong>Place</strong></td>
<td><strong>Placing: free</strong> allows Tekla Structures to search for the first suitable location for the mark. <strong>Placing: fixed</strong> allows you to place the mark in any location. When you use the option fixed, the mark stays where it is even though you update the drawing, whereas with free, Tekla Structures tries to find the optimal place for the annotation object. <strong>Search margin</strong> is the distance within which Tekla Structures searches for a space to place a mark.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Minimal Distance</td>
<td>The minimum distance of the mark from the part.</td>
</tr>
<tr>
<td>Quarter</td>
<td>Defines the areas Tekla Structures searches for a space to place the mark.</td>
</tr>
</tbody>
</table>

Use the **Merging** tab in the **Cast Unit – Reinforcement Mark Properties** dialog box to view and modify the settings affecting the merging of the reinforcement marks in cast unit drawings.

<table>
<thead>
<tr>
<th>Option</th>
<th>Image</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Identical marks in same cast unit</td>
<td>![Image]</td>
<td>One leader line per row merges the marks and creates one leader line for a row of reinforcing bars.</td>
</tr>
<tr>
<td></td>
<td>![Image]</td>
<td>Parallel leader lines merges the marks and creates parallel leader lines.</td>
</tr>
<tr>
<td></td>
<td>![Image]</td>
<td>Leader lines to one point merges the marks and draws all leader lines to one point.</td>
</tr>
<tr>
<td></td>
<td>![Image]</td>
<td>No merge does not merge marks. Tekla Structures creates an individual leader line for each mark. If you select No merge, you still need to define the mark content for the marks that Tekla Structures automatically merges on the Merging tab.</td>
</tr>
<tr>
<td>Preferred merge direction</td>
<td>![Image]</td>
<td>Merge vertically merges the marks in the vertical direction of the drawing.</td>
</tr>
<tr>
<td></td>
<td>![Image]</td>
<td>Merge horizontally merges the marks in the horizontal direction of the drawing.</td>
</tr>
</tbody>
</table>

**See also**

- Automatic mark settings on page 461
- Adding automatic marks on page 462
- Defining view labels and view label marks on page 352
- Modifying section properties on page 138
- XS_OMITTED_DIAMETER_TYPE
- XS_OMITTED_BOLT_TYPE
- XS_OMITTED_BOLT_ASSEMBLY_TYPE
- Elements in merged reinforcement marks on page 565
- Merging reinforcement marks automatically on page 474
## Leader line types

You can use leader lines with text, symbols, associative notes and marks to make it clearer to which item it is related to.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Texts</td>
<td><img src="image1" alt="Text Example" /></td>
</tr>
<tr>
<td>Symbols</td>
<td><img src="image2" alt="Symbols Example" /></td>
</tr>
<tr>
<td>Level marks</td>
<td><img src="image3" alt="Level Marks Example" /></td>
</tr>
<tr>
<td>Revision marks</td>
<td><img src="image4" alt="Revision Marks Example" /></td>
</tr>
<tr>
<td>Part marks</td>
<td><img src="image5" alt="Part Marks Example" /></td>
</tr>
<tr>
<td>Associative note</td>
<td><img src="image6" alt="Associative Note Example" /></td>
</tr>
</tbody>
</table>

See also
- Adding associative notes on page 177
- Adding part marks on page 175
- Adding revision marks on page 192
- Adding symbols in drawings on page 238
- Adding text on page 186
Positioning properties of view label, section and detail marks

Use the Position tab in the Mark Contents dialog box in view properties to set the positioning options for view label marks, section marks and detail marks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show on</td>
<td>For section marks.</td>
</tr>
<tr>
<td></td>
<td>Defines if the section marks are shown at both ends of the cut line or at the left or right end.</td>
</tr>
<tr>
<td>Text position</td>
<td>Defines the position of the mark text in relation to the line or in relation to the symbol or symbol center line.</td>
</tr>
<tr>
<td></td>
<td>Horizontal offset sets the horizontal offset of the mark text from the line.</td>
</tr>
<tr>
<td></td>
<td>Vertical offset sets the vertical offset of the mark text from the line.</td>
</tr>
<tr>
<td>Text rotation</td>
<td>For section marks.</td>
</tr>
<tr>
<td></td>
<td>Defines the rotation of the mark text.</td>
</tr>
<tr>
<td>Alignment</td>
<td>For view label marks.</td>
</tr>
<tr>
<td></td>
<td>Defines if the view label mark is aligned to the center, right, or left.</td>
</tr>
</tbody>
</table>

See also Defining view labels and view label marks on page 352
Modifying section properties on page 138

Drawing weld mark properties

In Weld Mark Properties dialog box you can view and modify the properties of a weld mark that has been manually added in a drawing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix</td>
<td>a= design throat thickness, s= penetration throat thickness, or z= leg length</td>
</tr>
<tr>
<td>Size</td>
<td>The size of the weld.</td>
</tr>
<tr>
<td>Type</td>
<td>The type of the weld.</td>
</tr>
<tr>
<td>Angle</td>
<td>The angle of weld preparation, bevels, or groove.</td>
</tr>
<tr>
<td></td>
<td>Tekla Structures displays the angle between the weld type symbol and the fill type contour symbol.</td>
</tr>
<tr>
<td>Contour</td>
<td>The fill type contour of a weld can be:</td>
</tr>
<tr>
<td></td>
<td>• None</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Finish</strong></td>
<td>Tekla Structures displays the finish symbol above the weld type symbol in drawings. The options are:</td>
</tr>
<tr>
<td></td>
<td>• G (Grind)</td>
</tr>
<tr>
<td></td>
<td>• M (Machine)</td>
</tr>
<tr>
<td></td>
<td>• C (Chip)</td>
</tr>
<tr>
<td></td>
<td>• ∞ (Flush finished weld)</td>
</tr>
<tr>
<td></td>
<td>• (∞) (Smooth blended weld face)</td>
</tr>
<tr>
<td><strong>Length</strong></td>
<td>The length of a regular weld depends on the length of the connection between the welded parts. You can set the exact length of a polygon weld by, for example, defining the start and end points of the weld.</td>
</tr>
<tr>
<td><strong>Pitch</strong></td>
<td>The center-to-center spacing of welds for non-continuous welds. Pitch is shown in the weld mark if the value is greater than 0.0.</td>
</tr>
<tr>
<td></td>
<td>To create a non-continuous weld, define the center-to-center spacing and the pitch of the welds. Tekla Structures calculates the distance between the welds as the pitch minus the length of the weld.</td>
</tr>
<tr>
<td></td>
<td>By default, Tekla Structures uses the – character to separate weld length and pitch, for example, 50–100. To change the separator to @, for example, set the advanced option XS_WELD_LENGTH_CC_SEPARATOR_CHAR to @.</td>
</tr>
<tr>
<td><strong>Effective throat</strong></td>
<td>The weld size used in weld strength calculation.</td>
</tr>
<tr>
<td><strong>Root opening</strong></td>
<td>The space between the welded parts.</td>
</tr>
<tr>
<td><strong>Reference text</strong></td>
<td>Additional information to appear in the weld symbol. For example, information about the weld specification or process.</td>
</tr>
<tr>
<td><strong>Edge/Around</strong></td>
<td>Indicates whether only one edge or the entire perimeter of a face should be welded.</td>
</tr>
<tr>
<td></td>
<td>A circle in the weld symbol in drawings indicates the Around option has been used.</td>
</tr>
<tr>
<td><strong>Workshop/Site</strong></td>
<td>Indicates where the weld should be made.</td>
</tr>
<tr>
<td><strong>Stitch weld</strong></td>
<td>Set this option to Yes to create a staggered, intermittent weld.</td>
</tr>
<tr>
<td></td>
<td>Stitch welds are staggered on both sides of the welded part. Tekla Structures shows the weld type symbols as staggered in weld symbols.</td>
</tr>
<tr>
<td></td>
<td>If you set this option to No, a non- staggered intermittent weld is created. To show the pitch in a weld mark, set Pitch to a value greater than 0.0.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>--------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Placing</td>
<td></td>
</tr>
<tr>
<td>Search margin</td>
<td>is the farthest distance Tekla Structures uses when searching for an empty space for the weld mark.</td>
</tr>
<tr>
<td>Minimal distance</td>
<td>is the closest distance Tekla Structures uses to search for an empty space for a weld mark.</td>
</tr>
<tr>
<td>Quarter</td>
<td>defines the areas Tekla Structures searches for a space to place the weld marks.</td>
</tr>
<tr>
<td>Placing</td>
<td>is the method used to place welds marks:</td>
</tr>
<tr>
<td>• Free</td>
<td>lets Tekla Structures decide the location and direction of the dimension based on the Direction settings.</td>
</tr>
<tr>
<td>• Fixed</td>
<td>allows you to place the weld at any point.</td>
</tr>
</tbody>
</table>

See also  Adding weld marks on page 215

**Model weld mark visibility and appearance properties in drawings**

You can select which model weld marks are visible in drawings, the views where they are shown and the content that is displayed in weld marks. In assembly drawings, you can define the visibility of welds in sub-assemblies.

Use options in the Weld mark panel (or Welding Mark Properties dialog box in general arrangement drawings) to set the visibility and contents of model weld marks. All of the following options are not available in the object level dialog box in the drawing.

To set the automatic welding mark properties in single-part and assembly drawings:

- Click Drawings & Reports --> Drawing Settings and select a drawing type. Click View creation, select the view and the properties that you want to change, and click View properties. Then click Weld marks in the View Properties dialog box.

To set the automatic welding mark properties in general arrangement drawing:

- Click Drawings & Reports --> Drawing Settings and General Arrangement Drawing. Then click Weld marks.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Weld number</td>
<td>Yes shows the weld number.</td>
</tr>
<tr>
<td></td>
<td>Tekla Structures assigns a number to each weld as the weld is created. You can select whether to show or hide the weld number.</td>
</tr>
<tr>
<td>Visible in views</td>
<td>In one view shows the welds only in one view.</td>
</tr>
<tr>
<td></td>
<td>In all view shows the welds in all views.</td>
</tr>
<tr>
<td>Welds</td>
<td>Not visible displays no welds in the drawing.</td>
</tr>
<tr>
<td>Welds in sub-assemblies</td>
<td>Site weld visible displays only site welds in the drawing.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Workshop weld visible</td>
<td>displays only workshop welds in the drawing.</td>
</tr>
<tr>
<td>Both visible</td>
<td>displays both site welds and workshop welds in the drawing.</td>
</tr>
<tr>
<td>Weld size limit</td>
<td>Enter a weld size to filter welds of that size out of the drawing. This is useful when you only want to show non-typical welds in a drawing. To set whether the weld size is an exact or minimum value, use the advanced option XS_WELD_FILTER_TYPE. To filter out a standard weld type, use the advanced option XS_OMITTED_WELD_TYPE.</td>
</tr>
<tr>
<td>Above line, Below line and Other</td>
<td>If there is no check mark in the Visible column next to the following properties, the properties are not displayed in the weld mark: Prefix, Size, Type, Angle, Contour, Finish, Length, Pitch, Effective throat, Root opening, Reference text, Edge/Around, Workshop/Site.</td>
</tr>
<tr>
<td>Place</td>
<td>Search margin is the distance within which Tekla Structures searches for a space to place a mark. Quarter defines the areas Tekla Structures searches for a space for placing the level mark. Minimal Distance is the minimum distance of the mark from the part.</td>
</tr>
<tr>
<td>Text: Color</td>
<td>Sets the color of the text.</td>
</tr>
<tr>
<td>Text: Height</td>
<td>Sets the height of the text.</td>
</tr>
<tr>
<td>Text: Font</td>
<td>Sets the font of the text. Click Select to show more options.</td>
</tr>
<tr>
<td>Line: Type</td>
<td>Sets the type of the line.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Line: Color</td>
<td>Sets the color of the line.</td>
</tr>
</tbody>
</table>

See also  
Welds in drawings on page 203  
Examples: Model welds in drawings on page 205  
Modifying model weld mark visibility and appearance in a drawing on page 210  
XS_WELD_FILTER_TYPE  
XS_OMITTED_WELD_TYPE

### Level mark properties

Use the options on the Level mark properties dialog box to view and modify the level mark contents. To open the dialog box, click Annotating --> Properties --> Level Mark.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Prefix</td>
<td>Displays text before the mark.</td>
</tr>
<tr>
<td>Prefix for positive level</td>
<td>+ displays a + character in front of the value.</td>
</tr>
<tr>
<td>Visibility of numeric value</td>
<td>Defines if the numeric values are visible or hidden.</td>
</tr>
<tr>
<td>Postfix</td>
<td>Displays text after the mark.</td>
</tr>
<tr>
<td>Precision</td>
<td>Defines the precision of the level mark dimension.</td>
</tr>
<tr>
<td>Format</td>
<td>Defines the format of the level mark dimension.</td>
</tr>
<tr>
<td>Use grouping</td>
<td>Defines whether to use different grouping options to represent the level mark dimensions.</td>
</tr>
<tr>
<td>Units</td>
<td>Defines the units used in level mark dimensions. The available values are automatic, mm, cm, m, foot – inch and inch.</td>
</tr>
</tbody>
</table>

**Placing**

**Search margin** is the farthest distance Tekla Structures uses when searching for an empty space for the level mark.

**Minimal distance** is the closest distance Tekla Structures uses to search for an empty space for a level mark.

**Quarter** defines the areas Tekla Structures searches for a space to place the level marks.
Option | Description
--- | ---
 | Placing is the method used to place level marks:
  - **Free** lets Tekla Structures decide the location of the level mark.
  - **Fixed** allows you to place the level mark at any point.

See also  Adding level marks on page 176

### 8.8 Mark elements

The elements and options selected on the mark properties **Content** tab define the contents of the marks in drawings.

Click the links below to find out more:

- Common elements in marks on page 560
- Part mark elements on page 561
- Bolt mark elements on page 562
- Reinforcement and neighbor reinforcement mark elements on page 564
- Reinforcement and neighbor reinforcement mesh mark elements on page 564
- Elements in merged reinforcement marks on page 565
- Connection mark elements on page 566
- Surface treatment mark elements on page 566
- Section and detail mark elements on page 567
- View, section view and detail view label mark elements on page 567

#### Common elements in marks

Here is a list of elements that are available for most of the marks.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>User-defined attributes</td>
<td>Available for building object marks. Adds a user-defined attribute to the mark. You can also use template fields for user-defined attributes. In marks, you cannot use template attributes such as MODEL\ TOTAL that refer to the whole model. Marks only check the information from the object in the drawing and not from the whole model.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text</td>
<td>Opens a dialog box where you can enter text in the mark. The maximum number of characters is 255.</td>
</tr>
<tr>
<td>Symbol</td>
<td>Opens a dialog box where you can change the symbol file in use and select a symbol from the Tekla Structures symbol file to add to the mark.</td>
</tr>
<tr>
<td>&lt; &gt;</td>
<td>Adds spaces between mark elements.</td>
</tr>
<tr>
<td>&lt;--'</td>
<td>Adds a line feed between the elements to create multi-row marks. The default space between the lines depends on the text height and can be changed with the advanced option <code>XS_MARK_ELEMENT_SPACE_FACTOR</code>.</td>
</tr>
<tr>
<td>&lt;--</td>
<td>Adds a backspace between the desired elements to remove the default space between them. The default space between the elements depends on the text height and can be changed with the advanced option <code>XS_MARK_ELEMENT_SPACE_FACTOR</code>.</td>
</tr>
<tr>
<td>Template</td>
<td>Available for building object marks.</td>
</tr>
<tr>
<td></td>
<td>Adds in the mark a custom graphical template created with Template Editor. Opens a dialog box where you can select the template.</td>
</tr>
</tbody>
</table>

See also

Mark elements on page 560

Adding user-defined attributes and template attributes in marks on page 480

Adding templates in marks on page 484

Part mark elements

The following table lists all elements specific to part marks and neighbor part marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately.

You can define part mark options independently for main and secondary parts and for sub-assembly main and secondary parts.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Assembly position</td>
<td>Adds the prefix and position number of the assembly.</td>
</tr>
<tr>
<td>Part position</td>
<td>Adds the prefix and position number of the part.</td>
</tr>
<tr>
<td>Profile</td>
<td>Adds the profile name of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Material</td>
<td>Adds the material of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Name</td>
<td>Adds the name of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Class</td>
<td>Adds the class of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Finish</td>
<td>Adds the finish of part, assembly, or cast unit main part.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Size</td>
<td>Adds the size of the part or the assembly or cast unit main part.</td>
</tr>
<tr>
<td>Length</td>
<td>Adds the length of the part or assembly, or of the cast unit main part.</td>
</tr>
<tr>
<td>Camber</td>
<td>Adds the camber of the part or the assembly or cast unit main part (if this user-defined part attribute is set).</td>
</tr>
<tr>
<td>Fittings (NS/FS)</td>
<td>Displays the near side/far side marks in the part mark. (only available in front views).</td>
</tr>
<tr>
<td>Face direction</td>
<td>Displays main compass direction (North, East, South, West) of the face, where the mark is added. The direction can only be shown if • the face is vertical • the direction is the same for all assemblies with the same assembly position number In other cases, the element produces no text to mark. Furthermore, face direction is not shown for columns in general arrangement drawings, if you have set Mark always to center of column in GA drawings to Yes in Tools --&gt; Options --&gt; Options... --&gt; Orientation marks.</td>
</tr>
<tr>
<td>Gage of outstanding leg</td>
<td>Adds the hole gage. You can control the format of this option with the advance option XS_GAGE_OF_OUTSTANDING_LEG_STRING.</td>
</tr>
<tr>
<td>Center-to-center distance</td>
<td>Adds center-to-center distance in the mark. You can control the format of this option with the advanced options XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING and XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING.</td>
</tr>
</tbody>
</table>

See also  
Mark elements on page 560  
Common elements in marks on page 560  
XS_GAGE_OF_OUTSTANDING_LEG_STRING  
XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING  
XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING  
ASSEMBLY_BOTTOM_LEVEL  
ASSEMBLY_TOP_LEVEL  
TOP_LEVEL  
BOTTOM_LEVEL
# Bolt mark elements

Here is a list of the elements specific to part marks and neighbor part marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately.

You can define bolt mark options independently for site and shop bolts.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Bolt length</td>
<td>Adds the length of the bolt.</td>
</tr>
<tr>
<td>Bolt diameter</td>
<td>Adds the bolt diameter.</td>
</tr>
<tr>
<td>Hole diameter</td>
<td>Adds the hole diameter.</td>
</tr>
<tr>
<td>Material</td>
<td>Adds the bolt material grade.</td>
</tr>
<tr>
<td>Standard</td>
<td>Adds the bolt standard.</td>
</tr>
<tr>
<td>Short name</td>
<td>Adds the bolt’s short name. This can be the commercial name of a specific bolt, for example.</td>
</tr>
<tr>
<td>Full name</td>
<td>Adds the complete name of the bolt. This name is visible in the dialog box list.</td>
</tr>
<tr>
<td>Assembly type</td>
<td>Adds the bolt’s assembly type.</td>
</tr>
<tr>
<td>Number of bolts</td>
<td>Adds the quantity of bolts.</td>
</tr>
<tr>
<td>Slot length (x, y)</td>
<td>Adds the slot’s length in the x or y direction.</td>
</tr>
<tr>
<td>Slot length</td>
<td>Adds the slot’s length.</td>
</tr>
<tr>
<td>Slot height</td>
<td>Adds the slot’s height.</td>
</tr>
<tr>
<td>Size</td>
<td>Adds the hole size.</td>
</tr>
<tr>
<td>Countersunk</td>
<td>Adds countersink in the countersunk bolt marks.</td>
</tr>
<tr>
<td>Gage of outstanding leg</td>
<td>Adds hole gage. You can control the format of this element with the advanced option XS_GAGE_OF_OUTSTANDING_LEG_STRING.</td>
</tr>
<tr>
<td>Center-to-center distance</td>
<td>Adds center-to-center distance. You can control the format of this element with the advanced options XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING and XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING.</td>
</tr>
</tbody>
</table>

See also
- [Mark elements on page 560](#)
- [Common elements in marks on page 560](#)
- [Defining contents of bolt mark Size element using advanced options on page 487](#)
- [XS_GAGE_OF_OUTSTANDING_LEG_STRING](#)
- [XS_CENTER_TO_CENTER_DISTANCE_IN_ONE_PART_STRING](#)
- [XS_CENTER_TO_CENTER_DISTANCE_IN_TWO_PARTS_STRING](#)
Reinforcement and neighbor reinforcement mark elements

Here is a list of the elements you can include in all reinforcement and neighbor reinforcements marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately.

You can define mark options separately for single reinforcing bars, bar groups, and reinforcement meshes.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Adds the name of the bar or mesh.</td>
</tr>
<tr>
<td>Grade</td>
<td>Adds the material grade of the bar or mesh.</td>
</tr>
<tr>
<td>Diameter</td>
<td>Adds the nominal diameter of the bar.</td>
</tr>
<tr>
<td>Class</td>
<td>Adds the class of the bar or mesh.</td>
</tr>
<tr>
<td>Length</td>
<td>Adds the total length of the bar.</td>
</tr>
<tr>
<td>Number</td>
<td>Adds the quantity of the bars.</td>
</tr>
<tr>
<td>Position</td>
<td>Adds the reinforcement position number.</td>
</tr>
<tr>
<td>Shape</td>
<td>Adds the shape of the bar or mesh.</td>
</tr>
<tr>
<td>Weight</td>
<td>Adds the weight of the bar or mesh.</td>
</tr>
<tr>
<td>cc</td>
<td>Adds the center-to-center spacing of the bars. The options are:</td>
</tr>
<tr>
<td></td>
<td>• cc adds the spacing value if spacing does not vary</td>
</tr>
<tr>
<td></td>
<td>• cc min adds the smallest spacing value of the bar group if spacing varies</td>
</tr>
<tr>
<td></td>
<td>• cc max adds the largest spacing value of the bar group if spacing varies</td>
</tr>
<tr>
<td></td>
<td>• cc exact lists all spacing values of the bar group</td>
</tr>
<tr>
<td></td>
<td>• cc target lists all reinforcing bar target spacing values</td>
</tr>
<tr>
<td>Pullout picture</td>
<td>Adds a pullout picture of a bar to the mark.</td>
</tr>
</tbody>
</table>

See also
- Mark elements on page 560
- Common elements in marks on page 560
- Adding automatic marks on page 462
- Common elements in marks on page 560
- Adding pull-out pictures in reinforcement marks on page 489
- Elements in merged reinforcement marks on page 565
Reinforcement and neighbor reinforcement mesh mark elements

The following elements are specific to the reinforcement and neighbor reinforcement mesh marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Adds the nominal diameters of the mesh bars, dimensions of the mesh, and the spacings of the bars in the longitudinal and crossing directions.</td>
</tr>
<tr>
<td>Mesh length</td>
<td>Adds the length of the reinforcement mesh.</td>
</tr>
<tr>
<td>Mesh width</td>
<td>Adds the width of the reinforcement mesh.</td>
</tr>
<tr>
<td>cc</td>
<td>Use the same center-to-center options as for single bars. You can define this element individually for the longitudinal and crossing bars in the mesh.</td>
</tr>
<tr>
<td>Diameter longitudinal</td>
<td>Adds the diameter or size of the longitudinal bars.</td>
</tr>
<tr>
<td>Diameter cross</td>
<td>Adds the diameter or size of the crossing bars.</td>
</tr>
</tbody>
</table>

See also
- Mark elements on page 560
- Common elements in marks on page 560
- Adding automatic marks on page 462
- Reinforcement and neighbor reinforcement mark elements on page 564

Elements in merged reinforcement marks

Merged marks can contain the following elements:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Block prefix</td>
<td>Adds text or a value to the beginning of each repeated block. Opens a dialog box where you can enter the prefix. You can use the following variables as block prefixes: %NUMBER% includes the number of marks merged to the mark. %NUMBER_IN_PLANE% includes the number of marks merged in the plane of the drawing to the mark. %NUMBER_OUT_OF_PLANE% includes the number of marks merged in the depth direction of the drawing to the mark.</td>
</tr>
<tr>
<td>Single mark content</td>
<td>Adds the content of the single reinforcement mark selected on the Content tab to the mark.</td>
</tr>
<tr>
<td>Element</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Distance between groups</td>
<td>Adds the center-to-center distances between reinforcing bars or bar groups included in a merged mark.</td>
</tr>
<tr>
<td>Symbol separating blocks in mark</td>
<td>Adds a symbol between the blocks in the merged mark. Opens a dialog box where you can enter the symbol. The elements that appear before this element on the mark content list generate a block.</td>
</tr>
</tbody>
</table>

See also  
Mark elements on page 560  
Adding automatic marks on page 462  
Merging reinforcement marks automatically on page 474

Connection mark elements

Below is a list of elements specific to connection marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately:  
Common elements in marks on page 560.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Code</td>
<td>Adds the connection code. This is a user-defined code you give for the connection in the connection dialog box. The code can be either a text string or a number.</td>
</tr>
<tr>
<td>Name</td>
<td>Adds the connection name, for example, Tube_splice.</td>
</tr>
<tr>
<td>DSTV code</td>
<td>Adds the DSTV code.</td>
</tr>
<tr>
<td>Connection number</td>
<td>Adds the number of the connection.</td>
</tr>
<tr>
<td>Running number</td>
<td>Adds the connection running number. All connections are automatically numbered with a running number, for example, 85.</td>
</tr>
<tr>
<td>Group</td>
<td>Adds the connection group.</td>
</tr>
</tbody>
</table>
| Connection error    | Adds the connection error. The numbers correspond to the connection symbol colors:  
|                     | • 1 = green  
|                     | • 2 = yellow  
|                     | • 3 = red symbol                                                                                                                              |

See also  
Mark elements on page 560  
Adding automatic marks on page 462
### Surface treatment mark elements

Here is a list of elements specific to surface treatment marks. Some of the available elements are not listed here, because they are common to many types of marks, and listed separately.

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Name</td>
<td>Adds the name defined in the Name box in the Surface treatment properties dialog box.</td>
</tr>
<tr>
<td>Material</td>
<td>Adds the surface treatment material.</td>
</tr>
<tr>
<td>Class</td>
<td>Adds the class of the surface treatment.</td>
</tr>
<tr>
<td>Code</td>
<td>Adds the code of the surface treatment.</td>
</tr>
<tr>
<td>Surface treatment name</td>
<td>Adds the name selected from the Surface treatment name list in the Surface treatment properties dialog box.</td>
</tr>
</tbody>
</table>

### Section and detail mark elements

Below is a list of elements specific to section and detail marks:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Section name/Detail name</td>
<td>Adds the name of the section or the detail (A, B, C, and so on).</td>
</tr>
<tr>
<td>Drawing name</td>
<td>Adds the name of the current drawing.</td>
</tr>
<tr>
<td>Source drawing name</td>
<td>Adds the name of the drawing where the view is.</td>
</tr>
<tr>
<td>Source drawing name when moved</td>
<td>Adds the name of the drawing where the view is. This is shown only if the view is not in the same drawing as the section/detail mark.</td>
</tr>
</tbody>
</table>

### See also

- Mark elements on page 560
- Common elements in marks on page 560
- Adding automatic marks on page 462

- Mark elements on page 560
- Adding automatic marks on page 462
- Modifying section properties on page 138
- Mark appearance and merging properties on page 551
- Positioning properties of view label, section and detail marks on page 554
View, section view and detail view label mark elements

Here is a list of the elements specific to view, section view and detail view label marks:

<table>
<thead>
<tr>
<th>Element</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View name/Section name/Detail name</td>
<td>Adds the name of the view, section or the detail.</td>
</tr>
<tr>
<td>Scale</td>
<td>Adds the scale of the view.</td>
</tr>
<tr>
<td>Drawing name</td>
<td>Adds the name of the current drawing.</td>
</tr>
<tr>
<td>Source drawing name</td>
<td>Adds the name of the drawing where the view has originally been created.</td>
</tr>
<tr>
<td>Source drawing name when moved</td>
<td>Adds the name of the drawing where the view has originally been created. This is shown only when the view has been moved from its original drawing.</td>
</tr>
</tbody>
</table>

See also
- Mark elements on page 560
- Defining view labels and view label marks on page 352
- Mark appearance and merging properties on page 551
- Positioning properties of view label, section and detail marks on page 554

8.9 Part and neighbor part properties in drawings

Use the options in Part properties or Neighbor part properties to view and modify the part or neighbor part properties. In Neighbor part properties you can also control the visibility and appearance of neighbor part bolts.

All part properties do not contain all of the settings listed below.

Content tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Part representation</td>
<td><strong>Outline</strong> shows parts as solid objects.</td>
</tr>
<tr>
<td></td>
<td><strong>Exact</strong> shows parts as solid objects. This choice also draws the chamfers in the profile cross sections.</td>
</tr>
<tr>
<td></td>
<td><strong>Symbol</strong> draws parts as lines.</td>
</tr>
<tr>
<td></td>
<td><strong>Symbol with partial profile</strong> shows a partial profile of the part. The length of the partial profile is fixed to 1000 mm.</td>
</tr>
<tr>
<td></td>
<td><strong>Workshop form</strong> draws round tube profiles as wrap-around templates.</td>
</tr>
</tbody>
</table>

Mark appearance and merging properties on page 551
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bounding box</strong></td>
<td><strong>Base box</strong> draws parts as boxes surrounding the actual profiles. <strong>Base box</strong> shows parts as boxes and uses the ( h ) and ( b ) values from the profile catalog as box dimensions.</td>
</tr>
<tr>
<td><strong>Symbol offset</strong></td>
<td>Defines the distance of the end points of reference lines and center lines from the end points of the object.</td>
</tr>
<tr>
<td><strong>Inner contours</strong></td>
<td>Shows the inner contours of a tube.</td>
</tr>
<tr>
<td><strong>Hidden lines</strong></td>
<td>If the <strong>Hidden lines</strong> check box is selected, Tekla Structures shows hidden lines in secondary and neighbor parts.</td>
</tr>
<tr>
<td></td>
<td>If the <strong>Own hidden lines</strong> check box is selected, Tekla Structures shows hidden lines in main parts.</td>
</tr>
<tr>
<td><strong>Center line</strong></td>
<td>Select whether you want to show center lines.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Main part &gt; Beam, Plate or Polygon</strong> check box to show center lines in main parts.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Secondary part &gt; Beam, Plate or Polygon</strong> check box to show center lines in secondary parts.</td>
</tr>
<tr>
<td><strong>Reference lines</strong></td>
<td>Select whether you want to show reference lines.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Main part &gt; Beam, Plate or Polygon</strong> check box to show reference lines in main parts.</td>
</tr>
<tr>
<td></td>
<td>Select the <strong>Secondary part &gt; Beam, Plate or Polygon</strong> check box to show reference lines in secondary parts.</td>
</tr>
<tr>
<td><strong>Additional marks</strong></td>
<td>Select the following check boxes to show additional marks in drawings:</td>
</tr>
<tr>
<td></td>
<td>• Orientation marks</td>
</tr>
<tr>
<td></td>
<td>• Connecting side marks</td>
</tr>
<tr>
<td></td>
<td>• Pop-marks</td>
</tr>
<tr>
<td></td>
<td>• Edge chamfers</td>
</tr>
<tr>
<td><strong>Bolt representation</strong> (neighbor parts)</td>
<td>Select bolt representation. The options are <strong>Solid, Exact Solid, Symbol, Symbol 2, Symbol 3, DIN symbol, and User-defined symbol.</strong></td>
</tr>
<tr>
<td></td>
<td><strong>DIN symbol</strong> corresponds to German standards (DIN). The only DIN symbols you can control are:</td>
</tr>
<tr>
<td></td>
<td>• Symbol 24 for normal workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 25 for normal site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 26 for front countersunk site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 27 for back countersunk site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 28 for front countersunk workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 29 for back countersunk workshop bolts</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>• Symbol 30 for front countersunk holes</td>
<td></td>
</tr>
<tr>
<td>• Symbol 31 for back countersunk holes</td>
<td></td>
</tr>
<tr>
<td><strong>Symbol content (neighbor parts)</strong></td>
<td>Select whether to include <strong>hole</strong> or <strong>axis</strong> in the symbol.</td>
</tr>
</tbody>
</table>

Neighbor parts have a **Visibility** tab:

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Neighbor parts</td>
<td><strong>None</strong> does not show neighbor parts. <strong>Connected parts</strong> shows all parts connected to the model object. <strong>Connecting parts</strong> shows only the parts the model object is connected to. <strong>All components</strong> combines the <strong>Connected parts</strong> and the <strong>Connecting parts</strong> options. <strong>By extreme</strong> shows all parts within the boundaries of the main and secondary part.</td>
</tr>
<tr>
<td>Main/Secondary parts</td>
<td><strong>Main parts</strong> shows only neighbor parts that make the main part of an assembly or a cast unit. <strong>Secondary parts</strong> shows only neighbor parts that are secondary parts of an assembly or a cast unit. <strong>Both</strong> shows both main and secondary parts.</td>
</tr>
<tr>
<td>Skew parts</td>
<td><strong>Yes</strong> shows skew parts as neighbor parts in the drawing, <strong>No</strong> does not.</td>
</tr>
<tr>
<td>Bolts</td>
<td><strong>Yes</strong> shows the bolts in the neighbor parts, <strong>No</strong> does not.</td>
</tr>
</tbody>
</table>

The **Appearance** tab is similar in all of the properties of all kinds of building objects (parts, neighbor parts, bolts, welds, surface treatments, reinforcement, and meshes).

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visible lines</td>
<td>Sets the <strong>Color</strong> and <strong>Type</strong> of the visible lines.</td>
</tr>
<tr>
<td>Hidden lines, Center line</td>
<td>Sets the <strong>Color</strong> and <strong>Type</strong> of the hidden lines. Sets the <strong>Color</strong> of the center lines.</td>
</tr>
<tr>
<td>Reference lines</td>
<td>Sets the <strong>Color</strong> and <strong>Type</strong> of the reference lines.</td>
</tr>
<tr>
<td>Text: Color</td>
<td>Sets the <strong>Color</strong> of the text.</td>
</tr>
<tr>
<td>Text: Height</td>
<td>Sets the <strong>Height</strong> of the text.</td>
</tr>
<tr>
<td>Text: Font</td>
<td>Sets the <strong>Font</strong> of the text. Click <strong>Select</strong> to show more options.</td>
</tr>
<tr>
<td>Line: Type</td>
<td>Sets the <strong>Type</strong> of the line.</td>
</tr>
<tr>
<td>Line: Color</td>
<td>Sets the <strong>Color</strong> of the line.</td>
</tr>
</tbody>
</table>
### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Bolts: Color</strong></td>
<td>Sets the color of the bolts in neighbor parts.</td>
</tr>
</tbody>
</table>

Parts have a **Fill tab**:

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Type</strong></td>
<td>Defines the fill type. Clicking the button next to the list opens a preview of the hatch patterns.</td>
</tr>
<tr>
<td>Automatic</td>
<td>Automatic selects the fill type automatically from the hatch pattern schema files.</td>
</tr>
<tr>
<td>None</td>
<td>None uses no fill.</td>
</tr>
<tr>
<td><strong>Color</strong></td>
<td>Defines the color for the fill.</td>
</tr>
<tr>
<td>Automatic</td>
<td>Automatically selects the color.</td>
</tr>
<tr>
<td>Special</td>
<td>Special color is not converted to black in printouts.</td>
</tr>
<tr>
<td><strong>Background</strong></td>
<td>Defines the background color for the fill.</td>
</tr>
<tr>
<td>Automatic</td>
<td>Background color selection is disabled for hardware hatches.</td>
</tr>
<tr>
<td>Custom</td>
<td>Background color can be set for automatic hatches, but is effective only if automatic hatch is not defined for the material in the hatch pattern schema file.</td>
</tr>
<tr>
<td><strong>Scale</strong></td>
<td>Selects the scale and rotation.</td>
</tr>
<tr>
<td>Automatic</td>
<td>Scales and rotates the fill automatically.</td>
</tr>
<tr>
<td>Custom</td>
<td>Allows you to select scaling and rotation manually.</td>
</tr>
<tr>
<td>Scaling in direction x</td>
<td>Define the scales in x direction.</td>
</tr>
<tr>
<td>Scaling in direction y</td>
<td>Define the scales in y direction.</td>
</tr>
<tr>
<td>Keep ratio of x and y</td>
<td>Retains the relative proportions in the hatch pattern.</td>
</tr>
<tr>
<td>Angle</td>
<td>Rotates the fill. Angle 0.0 is for horizontal and 90.0 for vertical.</td>
</tr>
</tbody>
</table>

**See also**

- Setting automatic drawing part properties on page 494
- Setting automatic neighbor part properties on page 496

## 8.10 Bolt content and appearance properties in drawings

Use the options on the **Contents** tab and the **Appearance** tab of the Bolt Properties dialog box to view and modify the bolt content properties.

All bolt properties dialog boxes do not contain all of the settings listed below.
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Solid/symbol</td>
<td>The options are <strong>Solid</strong>, <strong>Exact Solid</strong>, <strong>Symbol</strong>, <strong>Symbol 2</strong>, <strong>Symbol 3</strong>, <strong>DIN symbol</strong>, and <strong>User-defined symbol</strong>.</td>
</tr>
<tr>
<td></td>
<td><strong>DIN symbol</strong> corresponds to German standards (DIN). The only DIN symbols you can control are:</td>
</tr>
<tr>
<td></td>
<td>• Symbol 24 for normal workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 25 for normal site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 26 for front countersunk site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 27 for back countersunk site bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 28 for front countersunk workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 29 for back countersunk workshop bolts</td>
</tr>
<tr>
<td></td>
<td>• Symbol 30 for front countersunk holes</td>
</tr>
<tr>
<td></td>
<td>• Symbol 31 for back countersunk holes</td>
</tr>
<tr>
<td></td>
<td><strong>User-defined symbol</strong> is a symbol that has been created in Symbol Editor.</td>
</tr>
<tr>
<td>Symbol content</td>
<td>Indicates whether to include the <strong>Hole</strong> and <strong>Axis</strong> symbols in the drawing.</td>
</tr>
<tr>
<td>Visibility</td>
<td>Control the visibility of bolts in main parts, secondary parts and sub-assemblies separately. <strong>Visible</strong> shows bolt group holes in main parts or secondary parts. <strong>Not visible</strong> hides them. In assembly drawings you can also define whether to show or hide bolt group holes in sub-assemblies.</td>
</tr>
<tr>
<td>Color</td>
<td>Change the bolt color.</td>
</tr>
</tbody>
</table>

See also

- Automatic bolt settings in drawings on page 503
- Part and neighbor part properties in drawings on page 568
- Setting automatic bolt properties in drawings on page 503
8.11 Surface treatment visibility and content properties in drawings

Use the options on the Contents tab of the Surface Treatment Properties dialog box to view and modify the surface treatment properties.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility</td>
<td><strong>Visible</strong> shows the surface treatment.</td>
</tr>
<tr>
<td></td>
<td><strong>Not visible</strong> does not show the surface treatment.</td>
</tr>
<tr>
<td>Representation</td>
<td>Defines the appearance of the surface treatment. The available options are <strong>Outline</strong>, <strong>Exact</strong>, <strong>Workshop form</strong>, <strong>Symbol</strong>, <strong>Bounding box</strong>, and <strong>Base box</strong>.</td>
</tr>
<tr>
<td>Show pattern</td>
<td>Defines whether the hatch pattern is shown.</td>
</tr>
<tr>
<td>Hidden lines</td>
<td>Defines whether hidden lines in secondary and neighboring parts are shown.</td>
</tr>
<tr>
<td>Own hidden lines</td>
<td>Defines whether hidden lines in main parts are shown.</td>
</tr>
</tbody>
</table>

See also
- Automatic surface treatment in drawings on page 509
- Surface treatment hatch pattern properties (surfacing.htc) on page 573
- Adding automatic surface treatment in drawings on page 510
- Modifying drawing properties of an existing drawing on page 313
- Part and neighbor part properties in drawings on page 568

8.12 Surface treatment hatch pattern properties (surfacing.htc)

The properties of the hatch patterns to use for each surface treatment type are defined in the surfacing.htc file, located in ..\Tekla Structures\<version>\environments\common\system. In addition to that, the surface treatment code file product_finishes.dat is needed. It is located in the same folder.

If you create your own surface treatment hatch patterns in your company, you store surfacing.htc and product_finishes.dat in the firm folder defined by the advanced option XS_FIRM.

Note:

When you edit a schema file, you must reopen the model to apply the changes.

The syntax of surfacing.htc file is:

Surfacing Type, Surfacing Code, Hatch name, Scale, [Color], [Automatic Scaling and Rotation]
Example:

1,MF,ANSI31,0.7  
1,SMF,ANSI32,0.7  
1,WT,ANSI33,0.7  
1,HT,ANSI34,0.7  
1,LSB,AR-SAND,0.7  
2,SM1,CROSS,1.0  
2,SM2,CHECKERED,1.0  
3,TS3,FBBRICKC,1.0  
4,FP,ANSI31,1.0  
4,UP,ANSI32,1.0

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
</table>
| Surface treatment type        | • 1 = concrete finish  
• 2 = special mix  
• 3 = tile surface  
• 4 = steel finish                                                                 |
| Surface treatment code        | This is the abbreviation used in drawings and reports, for example, MF for Magnesium Float. The product_finishes.dat file contains a full list of surface treatment codes. |
| Hatch name                    | You can check the hatch pattern names and related hatch patterns by going to the Fill tab in Part properties, selecting a hatch pattern from the Type list and clicking the ... button next to the list. The selected hatch pattern is marked with a red frame. |
| Scale                         | Scale is a numeric value that Tekla Structures uses to scale hatches.                                                                      |
| Color (optional)              | 0=black (default)  
1=white  
2=red  
3=green  
4=blue  
5=cyan  
6=yellow  
7=magenta |
The hatch color defines the line width for the printer. If you do not define a color for a hatch in the surfacing.htc file, Tekla Structures uses the color defined on the Appearance tab in surface treatment properties. The Visible lines color and type is used for the front of the surface treatment, and the Hidden lines for the back.

**Option** | **Description**
--- | ---
120 | Special (use this color for gray shade)

**Automatic Scaling and Rotation (optional)**

| 1=true |
| 0=false (default) |

See also  [Adding automatic surface treatment in drawings on page 510](#)

### 8.13 Part and shape hatch pattern properties (.htc)

The hatch patterns for material types and names are defined in a hatch schema file (in a .htc file). Different drawing types (general arrangement, assembly, single-part, and cast unit drawings) have their own schema files. These hatch patterns are used when you set Type to **Automatic** on the Fill page in the part or shape properties. The default schema files are located in the `..\Tekla Structures\<version>\environments\common\system` folder.

The name of the schema file Tekla Structures uses for each drawing type is defined on the Hatching page of the **Advance Options** dialog box:

- set XS_DRAWING_GA_HATCH_SCHEMA=general.htc
- set XS_DRAWING_ASSEMBLY_HATCH_SCHEMA=assembly.htc
- set XS_DRAWING_SINGLE_PART_HATCH_SCHEMA=single.htc
- set XS_DRAWING_CAST_UNIT_HATCH_SCHEMA=cast_unit.htc

The syntax of the schema file is:

**Material type, Material name, Hatch name, Scale, Color, Automatic scaling and rotation**

An example of the .htc file:
## Tekla Structures hatch schema file

---

### Purpose

This file is used to define the hatch patterns for different materials for Tekla Structures automatic hatching functionality. These settings will be used when the hatching option is set to "Automatic" in the drawing.

### Material Type, Material Name, Hatch name, Scale, Color, Automatic scaling and rotation

#### Available options

<table>
<thead>
<tr>
<th>Material Type</th>
<th>Material name</th>
<th>Hatch name</th>
<th>Scale</th>
<th>Color</th>
<th>Automatic scaling and rotation</th>
</tr>
</thead>
<tbody>
<tr>
<td>STEEL</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>CONCRETE</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>TIMBER</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MISCELLANEOUS</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

#### Color:

- BLACK: 0 (default)
- WHITE: 1
- RED: 2
- GREEN: 3
- CYAN: 4
- YELLOW: 5
- MAGENTA: 7

Special: 120 (use this color for gray shade)

#### Scale

Scale is a numeric value that Tekla Structures uses to scale hatches.

Colors:

- BLACK: 0 (default)
- WHITE: 1
- RED: 2
- GREEN: 3
- CYAN: 4
- YELLOW: 5
- MAGENTA: 7

Special: 120 (use this color for gray shade)

#### Automatic scaling and rotation:

- TRUE
- FALSE: 0 (default)

#### Instructions for use

- Material and hatch names are case sensitive.
- Automatic scaling and rotation option requires additional processing, so use it only when necessary.
- To adjust the gray shade for Special color 120, use the variables:
  - DC_HATCH_SPECIAL_COLOR
  - DC_HATCH_SPECIAL_COLOR_C

```plaintext
CONCRETE, hardware_SOLID, .120 (gray shade)
CONCRETE, CORR_0.2, 1 ('traditional' concrete)
CONCRETE, CORR_0.1 (small crosses)
MISCELLANEOUS, Insulation Hard_INS1, 1 (straight lines)
MISCELLANEOUS, Insulation Soft_INS1, 1 (rounded lines)
MISCELLANEOUS, Insulation Soft INS2, 1 (completely round)
```

---

### Option Description

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Material type</td>
<td>STEEL, CONCRETE, TIMBER, MISCELLANEOUS (case sensitive)</td>
</tr>
<tr>
<td>Material name</td>
<td>The material name defined for the part in part properties in the model.</td>
</tr>
<tr>
<td>Hatch name</td>
<td>To check the hatch pattern names and related hatch patterns go to the Fill tab in Part properties, select a hatch pattern from the Type list and click the ... button next to the list. Then click a pattern to see its name in the Type list. The selected hatch pattern is marked with a red frame. Hatch names are case sensitive.</td>
</tr>
<tr>
<td>Scale</td>
<td>Scale is a numeric value that Tekla Structures uses to scale hatches.</td>
</tr>
<tr>
<td>Color</td>
<td>0=black (default) 1=white 2=red 3=green</td>
</tr>
</tbody>
</table>
The hatch color defines the line width for the printer. If you do not define a color for a hatch in the schema file, Tekla Structures uses the default color black (0). To use the special color that is printed as color or grayscale, depending on the selected printer settings, set the color number in the .htc file to 120.

Automatic scaling and rotation defines whether you want to use automatic scaling and rotation.

1=true
0=false (default)

No hatching
If you do not want to use any hatch pattern for a material, leave the hatch name field blank in the schema file.

---

**8.14 Reinforcement/Neighbor reinforcement and mesh properties in drawings**

Use the options in the Reinforcement or Neighbor Reinforcement properties to check and modify the reinforcement and mesh visibility, appearance and content.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Visibility of all reinforcing bars</td>
<td>Visible shows the bars or meshes. Not visible does not show the bars or meshes</td>
</tr>
<tr>
<td>Visibility of all meshes</td>
<td>single line draws a single line with radiused bends. double lines draws an outline of the bar with radiused bends. double lines with filled ends draws an outline of the bar with radiused bends and filled bar ends. filled line draws a solid bar with radiused bends.</td>
</tr>
</tbody>
</table>

See also  
Adding automatic hatch patterns on drawing objects on page 507  
Part and neighbor part properties in drawings on page 568
<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Option</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>stick</td>
<td>draws a single line without radiused bends.</td>
</tr>
<tr>
<td>outline</td>
<td>shows the shape of the mesh using an outline rectangle or polygon, and a diagonal line. Applies only to reinforcement meshes.</td>
</tr>
<tr>
<td><strong>Visibility of reinforcing bars in group</strong></td>
<td><strong>all</strong> shows all bars in a group or mesh.</td>
</tr>
<tr>
<td>Visibility of longitudinal wires</td>
<td><strong>first bar</strong> shows only the first bar in the group or mesh.</td>
</tr>
<tr>
<td>Visibility of crossing bars</td>
<td><strong>last bar</strong> shows only the last bar in the group or mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>first and last bar</strong> shows the first and last bar in the group or mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>bar in the middle of group</strong> shows one bar in the middle of the group or mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>two bars in the middle of group</strong> shows two bars in the middle of the group or mesh.</td>
</tr>
<tr>
<td></td>
<td><strong>customized</strong> indicates that you have specified the location of the only visible reinforcing bar. Applies only to bar groups and meshes.</td>
</tr>
<tr>
<td>Hide lines behind parts</td>
<td>Hides the lines behind the part. This is useful, for example, with lifting anchors where the reinforcing bar is partly outside the part.</td>
</tr>
<tr>
<td>Hide lines behind other rebars</td>
<td>Hides the lines behind other reinforcement bar lines.</td>
</tr>
<tr>
<td>Symbol at straight end</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Applies only to reinforcing bars.</td>
</tr>
<tr>
<td>Symbol at hooked end</td>
<td></td>
</tr>
<tr>
<td></td>
<td>Applies only to reinforcing bars.</td>
</tr>
<tr>
<td>Mesh symbol</td>
<td>Defines the mesh symbol to be used. The mesh symbol appears in the middle of the diagonal line.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------</td>
<td>------------------------------------------------------------------</td>
</tr>
<tr>
<td>Mesh symbol size</td>
<td>Defines the size of the mesh symbol.</td>
</tr>
<tr>
<td>Visible lines</td>
<td>Defines the color and type of the visible lines.</td>
</tr>
<tr>
<td>Hidden lines</td>
<td>Defines the color and type of the hidden lines.</td>
</tr>
</tbody>
</table>

In addition to the properties in the **Reinforcement** properties, you can use some advanced options and the `rebar_config.inp` file to modify the appearance of the reinforcement:

- To increase the size of the bend and end symbols (in drawing units) use the advanced options `XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE` and `XS_REBAR_END_SYMBOL_MIN_SIZE` in **Tools --> Options --> Advanced Options --> Concrete Detailing**.

- Use the advanced option `XS_REBAR_REVERSE_END_SYMBOLS` in **Tools --> Options --> Advanced Options --> Concrete Detailing** to change the end symbols to a different direction.

- You can modify the reinforcing bar bending schedule, rounding of bar dimensions, symbols for meshes, strands, and unbonding, and appearance of reinforcement pull-outs in the `rebar_config.inp` file.

See also  
- Automatic reinforcement and mesh settings in drawings on page 512  
- Part and neighbor part properties in drawings on page 568  
- `XS_REBAR_BEND_MARK_SYMBOL_MIN_SIZE`  
- `XS_REBAR_END_SYMBOL_MIN_SIZE`  
- `XS_REBAR_REVERSE_END_SYMBOLS`  
- Reinforcement settings for drawings (rebar_config.inp) on page 579

### 8.15 Reinforcement settings for drawings (rebar_config.inp)

Tekla Structures uses the settings in the `rebar_config.inp` file in the `..\ProgramData\Tekla Structures\<version>\environments`
The <environment>\system folder to define the following reinforcement-related issues in drawings:

- Selected area-specific reinforcing bar bending schedule
- Rounding of bar dimensions
- Available symbols for meshes, strands, and unbonding
- Appearance of reinforcement pull-outs

The entries in the rebar_config.inp are listed and described below:

<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MergeOneFormat</td>
<td>No longer used. Define these properties in the drawing properties.</td>
</tr>
<tr>
<td>MergeTwoOrMoreFormats</td>
<td></td>
</tr>
<tr>
<td>MergeAndFormat</td>
<td></td>
</tr>
<tr>
<td>LeaderLinetype</td>
<td></td>
</tr>
<tr>
<td>DimensionMarkSpacingSeparator</td>
<td>=&quot;/&quot; Affects the separator in reinforcement marks.</td>
</tr>
<tr>
<td>ExactDimensionMarkSpacingSeparator</td>
<td>=&quot; + &quot; Separator between different exact spacing values in reinforcement marks.</td>
</tr>
<tr>
<td>ExactDimensionMarkPcsSeparator</td>
<td>=&quot;*&quot; Separator between the number of bars and their exact spacing value in reinforcement mark.</td>
</tr>
<tr>
<td>BendingAngleTolerance</td>
<td>Set a tolerance value for the angle. Angles that differ from the set tolerance value less than the tolerance are recognized and lead to a correct bending shape. Enter the tolerance value as a radians, not as a degree. The default value is 0.001 radians, which is 0.0573 in degrees. This applies to all bending shapes.</td>
</tr>
<tr>
<td>BentRebarTolerance</td>
<td>Set a tolerance value. Depending on the value, slightly curved reinforcing bars get straight shape. If reinforcing bar diameter is 20 mm and radius is 200 m then value 20/200000 = 0.0001. This variable defines correct curved reinforcing bar in case of long reinforcing bars to get a correct shape for the bar. This option is used in comparing the relation of the reinforcing bar diameter and radius. If the relation is smaller than BentRebarTolerance, the reinforcing bar is of bend_type_1, otherwise it is of bend_type_34.</td>
</tr>
<tr>
<td>Entry</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PullOutBendingRadiusAsMultiplier</td>
<td>Set to 1 to show the pullout bending radii using multiplier instead of mm.</td>
</tr>
<tr>
<td></td>
<td><img src="https://via.placeholder.com/150" alt="Diagram" /></td>
</tr>
<tr>
<td>GroupBarMark</td>
<td>No longer in use.</td>
</tr>
<tr>
<td>MarkingDimAttributes</td>
<td>No longer in use.</td>
</tr>
<tr>
<td>ScheduleCountry</td>
<td>Defines which bending schedule is used. Affects bending shapes in templates and reports. The available schedules are FIN, SWE, UK, US. When you number the model, the bending shape for the bar is given according to this information. For example, in the Default environment, the bending shapes are letters A, B, C, and so on.</td>
</tr>
<tr>
<td>ScheduleDimensionRoundingDirection</td>
<td>Options:</td>
</tr>
<tr>
<td>ScheduleTotalLengthRoundingDirection</td>
<td>• &quot;UP&quot;: rounds bar dimensions up</td>
</tr>
<tr>
<td>ScheduleDimensionRoundingAccuracy</td>
<td>• &quot;DOWN&quot;: rounds bar dimensions down</td>
</tr>
<tr>
<td></td>
<td>• &quot;NEAREST&quot;: rounds bar dimensions either up or down</td>
</tr>
<tr>
<td>ScheduleTotalLengthRoundingAccuracy</td>
<td>Sets the rounding accuracy for the total bar length. Default is 10 mm. Tekla Structures rounds individual bar dimensions up or down according to the option you select for ScheduleTotalLengthRoundingDirection.</td>
</tr>
<tr>
<td>BentSymbolFile</td>
<td>Points to the symbol file that contains the available reinforcing bar bent symbols. By default, points to the</td>
</tr>
<tr>
<td>Entry</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>file bent.sym, which in the default environment is located in the folder ..\ProgramData\Tekla Structures&lt;version&gt;\environments\common\symbols.</td>
<td>MeshSymbolFile Points to the mesh symbol file that contains the available mesh symbols. Affects the available reinforcement mesh symbols in drawings. By default, points to the mesh.sym file in the ...\Tekla Structures&lt;version&gt;\environments\common\symbols folder.</td>
</tr>
<tr>
<td>StrandSymbolFile</td>
<td>Points to the strand symbol file that contains the available strand symbols. Affects drawings. By default, points to the strand.sym file in the ...\Tekla Structures&lt;version&gt;\environments\common\symbols folder.</td>
</tr>
<tr>
<td>UnbondingSymbolFile</td>
<td>Points to the unbonding symbol file that contains the available unbonding symbols.</td>
</tr>
<tr>
<td>RebarMeshSize</td>
<td>Template for rebar mesh size.</td>
</tr>
<tr>
<td>PullOutDimensionFormat</td>
<td>Defines the format for displaying the dimensions. The format follows the dimension properties format. Options: 0 = ###, 1 = ###[#], 2 = ###., 3 = ###[,]#, 4 = ###., 5 = ###[,]##, 6 = ###.,##, 7 = ###.##, 8 = ###.###, 7 = ### #/#, 8 = #####.##.##</td>
</tr>
<tr>
<td>PullOutDimensionPrecision</td>
<td>Sets the level of precision. Options: 1, 2, 4, 6, 8, 16, and so on.</td>
</tr>
<tr>
<td>PullOutDimensionUnit</td>
<td>Defines the units to use. Options: 0 = auto, 1 = mm</td>
</tr>
<tr>
<td>Entry</td>
<td>Description</td>
</tr>
<tr>
<td>-------</td>
<td>-------------</td>
</tr>
<tr>
<td>• 2 = cm</td>
<td></td>
</tr>
<tr>
<td>• 3 = m</td>
<td></td>
</tr>
<tr>
<td>• 4 = inch</td>
<td></td>
</tr>
<tr>
<td>• 5 = foot and inch</td>
<td></td>
</tr>
</tbody>
</table>

**PullOutColor**

Sets the color for the pull-outs in reinforcement marks.

Options:

- 1 = black
- 2 = red
- 3 = bright green
- 4 = blue
- 5 = cyan
- 6 = yellow
- 7 = magenta
- 8 = brown
- 9 = green
- 10 = dark blue
- 11 = forest green
- 12 = orange
- 13 = gray

**PullOutVisibleLineType**

Sets the line type for reinforcing bar shape in pull-outs.

Options:

- 1 = _______
- 2 = ------
- 3 = ---
- 4 = ----
- 5 = --------
- 6 = ······
- 7 = ·······
<table>
<thead>
<tr>
<th>Entry</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>PullOutRepresentation</td>
<td>Sets the representation type. Options:</td>
</tr>
<tr>
<td></td>
<td>• 0 = single</td>
</tr>
<tr>
<td></td>
<td>• 1 = double</td>
</tr>
<tr>
<td></td>
<td>• 2 = filled</td>
</tr>
<tr>
<td></td>
<td>• 3 = stick</td>
</tr>
<tr>
<td>PullOutAngleColor</td>
<td>Sets the color for the angle in pull-outs. Options:</td>
</tr>
<tr>
<td></td>
<td>• 1 = black</td>
</tr>
<tr>
<td></td>
<td>• 2 = red</td>
</tr>
<tr>
<td></td>
<td>• 3 = green</td>
</tr>
<tr>
<td></td>
<td>• 4 = blue</td>
</tr>
<tr>
<td></td>
<td>• 5 = cyan</td>
</tr>
<tr>
<td></td>
<td>• 6 = yellow</td>
</tr>
<tr>
<td></td>
<td>• 7 = magenta</td>
</tr>
<tr>
<td></td>
<td>• 8 = brown</td>
</tr>
<tr>
<td></td>
<td>• 9 = green</td>
</tr>
<tr>
<td></td>
<td>• 10 = dark blue</td>
</tr>
<tr>
<td></td>
<td>• 11 = forest green</td>
</tr>
<tr>
<td></td>
<td>• 12 = orange</td>
</tr>
<tr>
<td></td>
<td>• 13 = gray</td>
</tr>
<tr>
<td>PullOutAngleLineType</td>
<td>Sets the line type for angle lines in pull-outs. Options:</td>
</tr>
<tr>
<td></td>
<td>• 1 = ——</td>
</tr>
<tr>
<td></td>
<td>• 2 = ———</td>
</tr>
<tr>
<td></td>
<td>• 3 = ———</td>
</tr>
<tr>
<td>Entry</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>PullOutLeaderLineMinLength</td>
<td>Sets a minimum length for the small leader lines that point to the dimension text. The default value is 10 mm. To switch leader lines off completely, use a large value.</td>
</tr>
<tr>
<td>PullOutShowDuplicateDims</td>
<td>Defines whether duplicate dimensions are showed multiple times for one bar.</td>
</tr>
<tr>
<td></td>
<td>Options:</td>
</tr>
<tr>
<td></td>
<td>• 0 = duplicate dimensions are not shown (default)</td>
</tr>
<tr>
<td></td>
<td>• 1 = equal and parallel dimensions are shown, but similar hook dimensions are not shown</td>
</tr>
<tr>
<td></td>
<td>• 2 = equal and parallel dimensions are not shown, but both hook dimensions are shown</td>
</tr>
<tr>
<td></td>
<td>• 3 = all dimensions are shown</td>
</tr>
<tr>
<td></td>
<td>• 4 = hook dimensions are not shown</td>
</tr>
<tr>
<td></td>
<td>• 5 = hook dimensions, or equal and parallel dimensions are not shown</td>
</tr>
<tr>
<td>PullOutShowUSHookDims</td>
<td>Defines if the US/NA style of dimension will be shown for hooks over 90 degrees.</td>
</tr>
<tr>
<td></td>
<td>Options:</td>
</tr>
<tr>
<td></td>
<td>• 0 = shows European hook dimension (= leg length, default)</td>
</tr>
<tr>
<td></td>
<td>• 1 = shows US hook dimension (= straight length) for hooks &gt;90 degrees</td>
</tr>
<tr>
<td></td>
<td>See the image below for the difference between the US/NA (A) and European (B) hook dimension.</td>
</tr>
</tbody>
</table>
8.16 Placement properties for annotation objects

Use the settings in the Placing dialog boxes for annotation objects and dimensions to control how the annotation objects are placed in a drawing.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search margin</td>
<td>Defines the distance within which Tekla Structures searches for a space to place a dimension, mark, weld mark or another annotation object.</td>
</tr>
<tr>
<td>Minimal distance</td>
<td>Defines the minimum distance of the mark, weld mark, dimension or another annotation object from the part.</td>
</tr>
<tr>
<td>Quarter</td>
<td>For marks and manually added annotation objects.</td>
</tr>
<tr>
<td></td>
<td>Defines the areas Tekla Structures searches for a space to place the mark or annotation object.</td>
</tr>
<tr>
<td></td>
<td>Weld placement depends on the welding direction. Welds can only be placed in certain sectors, so the Quarter options are not available. This option is available for manually added welds in the final drawing.</td>
</tr>
<tr>
<td>Placing</td>
<td><strong>free</strong> allows Tekla Structures to search for the first suitable location for the mark, dimension, weld or another annotation object. <strong>fixed</strong> allows you to place the mark, dimension, weld or another annotation object in any location.</td>
</tr>
<tr>
<td></td>
<td>When you use the option <strong>fixed</strong>, the annotation object stays where it is even though you update the drawing, whereas with <strong>free</strong>, Tekla Structures tries to find the optimal place for the annotation object.</td>
</tr>
<tr>
<td>Direction</td>
<td>Available only for manual dimensions.</td>
</tr>
<tr>
<td></td>
<td>Defines the side on which Tekla Structures places dimensions (relative to the object being dimensioned). This setting affects the Placing – free setting.</td>
</tr>
</tbody>
</table>

See also Object protection and placement settings in drawings on page 343
8.17 Welding properties

You can select which model welds are visible in drawings and drawing views, and set the weld color and line type.

- To set the automatic welding properties in single-part and assembly drawings: Click **Drawings & Reports --> Drawing Settings** and select the drawing type. Click **View creation**, select the view and the properties that you want to change, and click **View properties**. Now click **Weld** in the options tree.

- To set the automatic welding properties on drawing level in general arrangement drawing: Click **Drawings & Reports --> Drawing Settings** and select the drawing type. Click **Weld**.

- To modify the welding properties on drawing level in a general arrangement drawing: Double-click the drawing background and click **Weld**.

- To modify the welding properties on view level: Double-click the drawing view frame and click **Weld** in the **View Properties** dialog box.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Content: Visibility</td>
<td></td>
</tr>
<tr>
<td>Welds</td>
<td>Not visible does not display any welds in the selected view/drawing.</td>
</tr>
<tr>
<td></td>
<td>Site weld visible displays only site welds in the view/drawing.</td>
</tr>
<tr>
<td></td>
<td>Workshop weld visible displays only workshop welds in the view/drawing.</td>
</tr>
<tr>
<td></td>
<td>Both visible displays both site welds and workshop welds in the view/drawing.</td>
</tr>
<tr>
<td>Weld size limit</td>
<td>Enter a weld size to filter welds of that size out of the drawing.</td>
</tr>
<tr>
<td></td>
<td>This is useful when you only want to show non-typical welds in a drawing.</td>
</tr>
<tr>
<td></td>
<td>To set whether the weld size is an exact or minimum value, use the advanced option <strong>XS_WELD_FILTER_TYPE</strong>.</td>
</tr>
<tr>
<td></td>
<td>To filter out a standard weld type, use the advanced option <strong>XS_OMITTED_WELD_TYPE</strong>.</td>
</tr>
<tr>
<td>Appearance: Visible lines</td>
<td></td>
</tr>
<tr>
<td>Color</td>
<td>Sets the type of the weld line.</td>
</tr>
<tr>
<td>Type</td>
<td>Sets the color of the weld line.</td>
</tr>
</tbody>
</table>

Welds in drawings on page 203
Model weld mark visibility and appearance properties in drawings on page 557
8.18 Drawing shape properties

Use the properties dialog boxes of different shapes (lines, rectangles, polylines, polygons, arcs, circles) to view and modify the appearance of the shapes. The settings you have in the dialog box vary depending on the shape type. Some objects do not have all the settings listed below.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Line: Type</strong></td>
<td></td>
</tr>
<tr>
<td><strong>Line: Color</strong></td>
<td>Defines the color of the object lines.</td>
</tr>
</tbody>
</table>
| **Line: Bulge or Bulge for all lines.** | Values 0 - 1. The bulge factor defines the curvature of the curved segments of objects using the calculation:  
  Arc height = Line length * Bulge factor  
  Changing the bulge factor of a polyline or polygon modifies all the segments of that object. |
<p>| <strong>Line: Radius</strong>               | Defines the radius of arcs and circles.                                     |
| <strong>Arrow: Position</strong>            |                                                                             |
| <strong>Arrow: Type</strong>                |                                                                             |
| <strong>Arrow: Height</strong>              |                                                                             |
| <strong>Arrow: Length</strong>              |                                                                             |
| <strong>Fill: Type</strong>                 | Defines the fill type to be used in the object. Clicking Select to shows the available hatch types. |
| <strong>Fill: Color</strong>                | Defines the color of the fill.                                             |</p>
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Fill: Background</td>
<td>Defines the background color for the fill.</td>
</tr>
<tr>
<td>Scaling in direction x</td>
<td>Defines the fill scales in the x and y direction.</td>
</tr>
<tr>
<td>Scaling in direction y</td>
<td></td>
</tr>
<tr>
<td>Keep ratio of x and y</td>
<td></td>
</tr>
<tr>
<td>Angle</td>
<td>Rotates the fill. Angle 0.0 is for horizontal and 90.0 for vertical.</td>
</tr>
<tr>
<td>Offset</td>
<td>Moves the fill pattern inside the object to in the x and y direction by</td>
</tr>
<tr>
<td></td>
<td>the specified value.</td>
</tr>
</tbody>
</table>

See also  
Creating a shape in a drawing on page 194  
Automatic hatch patterns in drawings on page 506

8.19 Drawing grid properties

Use the Grid properties to view and modify the grid settings in drawings.

- To set the automatic grid properties in single-part and assembly drawings: Click Drawings & Reports --> Drawing Settings and select the drawing type. Click View creation, select the view and the properties that you want to change, and click View properties. Now click Grid in the options tree.

- To set the automatic grid properties on drawing level in general arrangement drawing: Click Drawings & Reports --> Drawing Settings and select the drawing type. Click Grid.

- To modify the grid properties on drawing level in a general arrangement drawing: Double-click the drawing background and click Grid.

- To modify the grid properties on view level: Double-click the drawing view frame and click Grid in the View Properties dialog box.

Additionally, for example XS_DRAWING_GRID_LABEL FRAME FIXED WIDTH, XS_DRAWING_GRID_LABEL FRAME LINE WIDTH FACTOR and XS_GRID_TEXT_FONT allow you to adjust the grid labels further.

<table>
<thead>
<tr>
<th>Option</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Grids</td>
<td>Visible shows the grids.</td>
</tr>
<tr>
<td></td>
<td>Not visible does not show the grids.</td>
</tr>
<tr>
<td></td>
<td>Visible in all views shows the grids in all drawing views. This option is</td>
</tr>
<tr>
<td></td>
<td>not available for general arrangement drawings.</td>
</tr>
<tr>
<td></td>
<td>Only grid labels visible shows only the grid label and a short section of</td>
</tr>
<tr>
<td></td>
<td>the grid line. The length of the displayed grid line depends on the value</td>
</tr>
<tr>
<td></td>
<td>entered in the Text placing.</td>
</tr>
<tr>
<td>Option</td>
<td>Description</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Text placing</td>
<td>Sets the side to show the grid labels and the length of the grid line extension (the distance between the end of the grid line and the text).</td>
</tr>
<tr>
<td>Text: Color, Height, Font and Frame</td>
<td>Defines the grid label text color, height, font and frame.</td>
</tr>
</tbody>
</table>

See also  
- Automatic grid settings in drawings on page 491  
- Setting automatic grid properties on page 493  
- XS_DRAWING_GRID_LABEL_FRAME_FIXED_WIDTH  
- XS_DRAWING_GRID_LABEL_FRAME_LINE_WIDTH_FACTOR  
- XS_GRID_TEXT_FONT

### 8.20 Orientation settings

Use the Orientation marks page in the Options dialog box to define some orientation and location settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Project north</td>
<td>Defines which direction is north in the model. Enter the value in degrees counter-clockwise from the global x axis.</td>
</tr>
<tr>
<td>Part viewing direction</td>
<td>Defines which direction parts are viewed from in drawings.</td>
</tr>
<tr>
<td>Beam skew limit</td>
<td>Tekla Structures uses limit angles to determine whether a part is a beam or a column when creating</td>
</tr>
<tr>
<td>Column skew limit</td>
<td></td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
</tr>
<tr>
<td>-------------------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td></td>
<td>orientation marks. Tekla Structures treats parts outside these limits as braces.</td>
</tr>
</tbody>
</table>
| ![Diagram](image.png)               | Parts skewed more than 80° are columns.  
|                                     | Parts skewed less than 10° are beams.                                                                                                                                                                      |
| Preferred location for mark         | Defines the location of part marks in drawings, to the left or right end of the part.                                                                                                                       |
| Mark always to center of column     | This setting only affects columns.  
|                                     | **Yes** places part marks in the center of columns in plan views. To indicate part orientation, include compass direction *(Face direction)* in the part mark instead.  
|                                     | **No** places part marks on the same flange in general arrangement and assembly drawings.                                                                                                                    |

**See also**  
Displaying compass direction in part marks on page 499  
Mark location on page 468
Disclaimer

© 2015 Tekla Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced Software. Use of the Software, and use of this Software Manual are governed by a License Agreement. Among other provisions, the License Agreement sets certain warranties for the Software and this Manual, disclaims other warranties, limits recoverable damages, defines permitted uses of the Software, and determines whether you are an authorized user of the Software. All information set forth in this manual is provided with the warranty set forth in the License Agreement. Please refer to the License Agreement for important obligations and applicable limitations and restrictions on your rights. Tekla does not guarantee that the text is free of technical inaccuracies or typographical errors. Tekla reserves the right to make changes and additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by international treaties. Unauthorized reproduction, display, modification, or distribution of this Manual, or any portion of it, may result in severe civil and criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tedds, Solve, Fastrak and Orion are either registered trademarks or trademarks of Tekla Corporation in the European Union, the United States, and/or other countries. More about Tekla trademarks: http://www.tekla.com/tekla-trademarks. Trimble is a registered trademark or trademark of Trimble Navigation Limited in the European Union, in the United States and/or other countries. More about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other product and company names mentioned in this Manual are or may be trademarks of their respective owners. By referring to a third-party product or brand, Tekla does not intend to suggest an affiliation with or endorsement by such third party and disclaims any such affiliation or endorsement, except where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights reserved.

EPM toolkit © 1995–2004 EPM Technology a.s., Oslo, Norway. All rights reserved.

Open CASCADE Technology © 2001–2014 Open CASCADE SA. All rights reserved.

FLY SDK – CAD SDK © 2012 VisualIntegrity™. All rights reserved.

Teigha © 2003–2014 Open Design Alliance. All rights reserved.

PolyBoolean C++ Library © 2001–2012 Complex A5 Co. Ltd. All rights reserved.
FlexNet Copyright © 2014 Flexera Software LLC. All Rights Reserved.

This product contains proprietary and confidential technology, information and creative works owned by Flexera Software LLC and its licensors, if any. Any use, copying, publication, distribution, display, modification, or transmission of such technology in whole or in part in any form or by any means without the prior express written permission of Flexera Software LLC is strictly prohibited. Except where expressly provided by Flexera Software LLC in writing, possession of this technology shall not be construed to confer any license or rights under any Flexera Software LLC intellectual property rights, whether by estoppel, implication, or otherwise.

To see the third party licenses, go to Tekla Structures, click Help --> About and click the Third party licenses button.

The elements of the software described in this Manual are protected by several patents and possibly pending patent applications in the European Union and/or other countries. For more information go to page http://www.tekla.com/tekla-patents.
Index

2
2D.......................................................................................... 18

3
3D.......................................................................................... 18
drawing views..................................................116,529
isometric drawings....................................................32
rotation of views..................................................... 529
3D
drawing views.......................................................... 123
3D views...............................................................................32

A
A1........................................................................................326
A2................................................................................302,326
A3....................................................................... 302,326,331
printing................................................................. 302,326,331
A4................................................................................302,326,331
printing................................................................. 288
absolute dimensions...................................................... 533
appearance................................................................439
orientation................................................................ 439
zero at start point.....................................................439

adding
associative notes......................................................... 177
bolt marks.................................................................. 175
closing dimensions.................................................... 170
connection marks...................................................... 175
dimension lines......................................................... 156
dimension points....................................................... 171
dimension points in anchor bolt plans............ 167
dimension tags.......................................................... 150
drawing views.......................................................... 117
dual dimensions....................................................... 153
foldmarks................................................................. 297
frames....................................................................... 297
hyperlinks................................................................. 190
level marks............................................................... 176
links to DWG/DXF files...........................................191
links to other drawings........................................ 189
links to text files...................................................... 188
manual dimensions................................................ 142
part marks................................................................. 175
predefined reinforcement dimensions.............. 155
reinforcement marks................................................ 175
revision marks.......................................................... 192
single-part views in assembly drawings..........129
surface treatment marks........................................ 175
symbols................................................................. 238
symbols in marks.................................................... 486
texts......................................................................... 186
weld marks............................................................... 215
AddSurfaceSymbols........................................................241
aligning dimension texts.......................................... 445
aligning
drawing objects....................................................... 255
drawing views............................................................136,379
alternative scales.........................................................341
anchor bolt plans.........................................................26,33,529
creating........................................................................59
dimensions......................................................................458
included objects...........................................................61
including assemblies...................................................62
including objects...........................................................61
anchor bolts.......................................................................35
angle...............................................................................587
angle dimensions...........................................................59
angle dimensions...........................................................533
annotation objects.........................................................98
annotation objects.........................................................98
114,175,186,193,215,343,346,347
associative.........................................................................17
independent.......................................................................17
modifying..........................................................................178
appearance.......................................................................568
of bolts..............................................................................503
of frames............................................................................465
of leader lines....................................................................465
of mark text.......................................................................465
of marks..............................................................................551
of model weld marks in drawings....................................557
of neighbor parts.............................................................496
of parts..............................................................................494
of reference models.........................................................230
of surface treatment..........................................................510
arcs..................................................................................194,587
dividing.............................................................................253
arranging
drawing objects..............................................................246
drawing views.................................................................137
arrows..............................................................................180
customizing.......................................................................184
in leader lines....................................................................184
in shapes............................................................................587
leader lines........................................................................184
assemblies
including in anchor bolt plans..........................................62
assembly drawings..........................................................39
view direction of beams and bracings...............................363
column view direction.......................................................363
creating............................................................................48,62,69
dimensioning.....................................................................544
example.............................................................................40
freezing..............................................................................275
including single-part drawings........................................355
rails.....................................................................................41
single-part views............................................................129
stairs...............................................................................40
assembly position...........................................................561
assembly type.....................................................................562
associative notes
leader lines.......................................................................184
associative annotation objects.................................175,215
associative notes.............................................................177
level marks.........................................................................176
modifying.........................................................................178
part marks..........................................................................175
updating............................................................................179
associative notes.............................................................17
adding..............................................................................177
in edge chamfers.............................................................222
associativity.......................................................................99
associative notes
ghost associativity symbol.............................................20
switching on/off...............................................................20
automatic
dimensions......................................................................381,433
marks.................................................................................461,462
autoscale..........................................................................341
autoscaling.......................................................................339,342
autosizing.........................................................................339,342
B
back drawing views......................................................123,529
back views.........................................................................350
bar class.............................................................................564
bar diameter.......................................................................564
bar length............................................................................564
bar marks............................................................................565
bar name.............................................................................564
bar quantity.........................................................................564
bar shape.............................................................................564
bar weight............................................................................564
base points.........................................................................184,467
beams
in cast unit drawings.......................................................43
view direction in drawings.................................................363
bent plates
unfolding............................................................................369
block prefix........................................................................565
596
C

calculated drawing sizes........................................ 326
calculated sizes................................................. 331
camber................................................................. 561
cast unit definition method
  By cast unit ID.................................................... 48,62
  By cast unit position............................................. 48,62
cast unit drawing
  freezing.................................................................. 275
cast unit drawings.................................................... 42
center lines............................................................. 564
center of gravity
  dimensioning........................................................ 162
center-to-center distance........................................ 420,561,562
chamber
  adding.................................................................. 222
chamfers
  in drawings................................................... 220,221,222,223,256
change symbols...................................................... 180
  removing............................................................. 180,181
change
  drawing revisions............................................... 278
check dimensions................................................. 416
circles................................................................. 194,587
class................................................................. 561
cloning models...................................................... 93
cloning template models........................................ 54
cloning templates.................................................. 80,85
cloning
  a drawing to a new sheet.................................... 100
  checking cloned drawings.................................. 98
  cloned objects.................................................. 98
  cloning templates............................................ 53,54,92,93
  dimensions....................................................... 97
  drawings......................................................... 91,94,96
  using cloning templates from other models......... 93
  when to clone.................................................. 91
closing dimensions............................................... 426
  adding.................................................................. 170
closing
drawings................................................................. 270
clouds................................................................. 180,194
COG, see center of gravity..................................... 162
colors
  changing pen number........................................ 265
  color table......................................................... 303
  in drawings...................................................... 247,261,262,264
  in printing........................................................ 303
  pen numbers...................................................... 265
  special colors.................................................. 264
columns
  in assembly drawings........................................ 363
  in cast unit drawings......................................... 43
combining
dimension lines................................................... 172
dimensions......................................................... 427,429,539
compass direction................................................ 499
connecting side
showing marks ........................................502
drawing ..................................................528
dimension lines ........................................172
connection marks ....................................462
modifying ..............................................178
connections
DSTV code ...........................................566
error .....................................................566
group ....................................................566
marks .....................................................566
name .....................................................566
number ..................................................566
running number ....................................566
content ...............................................568
contents
of bolts ...............................................503
of drawing parts ....................................494
of drawings ..........................................13
of marks .............................................560
of neighbor parts ..................................496
of surface treatment ...............................510
coordinate systems
changing ..............................................357
fixed .....................................................357
horizontal brace ..................................357
local .....................................................357
oriented ..............................................357
user coordinate system (UCS) ..................148
vertical brace .......................................357
copying
a drawing to a new sheet .........................100
drawing objects ....................................245
drawing views .......................................130
drawings .............................................130
with offset .........................................245
countersunk .........................................562
cover-up area .......................................194
cover-up areas .....................................198
cover-up line ........................................194
cover-up lines .....................................198
creating
drawings ............................................57
creating
anchor bolt plans ..................................59
cut lines .............................................259
drawings .............................................25, 48, 51, 62, 68, 75, 92, 101
drawings using menu commands ...........47
drawings using pop-up-menu commands ...47
drawings using toolbar commands .........47
empty drawings ....................................58
empty general arrangement drawings .......47
fillet .................................................255
general arrangement drawings ...............58
moment connection symbols .................239
revisions ............................................277
round chamfer in drawing .....................256
straight chamfer in drawing ...................256
curved section views ..............................120
custom presentations .........................201
customizing
line types ...........................................521
Master Drawing catalog .......................293
print file names ...................................293
cut lines
creating .............................................259
deleting .............................................261
managing .........................................259
updating ..........................................260
deck plans ..........................................30
deformed parts
undeforming .......................................370
deleting
cut lines .............................................261
drawing revisions ..................................278
drawings ............................................276
moment connection symbols .................241
unnecessary drawing files ....................269
detail boundary ....................................140
detail marks ........................................121
detail name .........................................567
elements .............................................567
modifying .........................................140
source drawing name ............................567
detail symbols ....................................140
detail views ........................................116
creating ............................................121
marks ...............................................140
moving to another drawing ..................130
name ...............................................567
start letter or number .........................123
view label mark elements .....................567
view labels ........................................121, 140
detailed object level settings.....
21,318,319,322,323,529
dimension lines............................................................156
  combining........................................................................172
  creating extensions....................................................436
  linking...........................................................................172
  unlinking.........................................................................172
dimension marks...........................................................166
dragging...........................................................................173
dimension points
  adding.............................................................................167,170,171
  removing...........................................................................171
dimension tags..................................................................166,538
  automatic tagging..........................................................413
  content.............................................................................150
  contents...........................................................................142
  elements...........................................................................142
  filtering content...........................................................151
  in dimensions...................................................................150
  removing default content.............................................150
  rotating.............................................................................150
dimensioning tool...............................................................401
dimensioning.................................................................411
dimensioning rule properties.............................................394
derivation edge shape..........................................................401
examples of view-level dimensioning..............................401
filter for holes and recesses.............................................409
filters............................................................................407,410
overall dimensions..........................................................401
precast.............................................................................166
precast.............................................................443,436,537
absolute...........................................................................439,533
adding.............................................................................142
adding dimension tags.....................................................150
anchor bolt plans..............................................................458
angle.............................................................................533
appearance.....................................................................166,436,537
automatic...........................................................................433
automatic tagging..............................................................413
bolt dimensioning..............................................................420
bolts..................................................................................545
center of gravity.................................................................162
check dimensions............................................................416
cloning...............................................................................97
closing.............................................................................426,539
combining.........................................................................427,429,539
contents...........................................................................142
coordinate system............................................................148
creating..............................................................................411
creation method...............................................................411
dimension format................................................................529
dimension lines..................................................................156,156,174
dimension marks...............................................................142,155
dimension points..................................................................167,171
dimension tags....................................................................142,155
dual dimensions..................................................................153
elements.............................................................................142
elevations.............................................................................414
enlarging.............................................................................439
exaggerate selected...........................................................166
exaggerating.........................................................................439
elevation examples.............................................................441,432,448,450,451,452,458
extension lines....................................................................437,533
filtering.............................................................................409
flipping outside dimensions.............................................169
formats.............................................................................533
forward offset.....................................................................430,539
general arrangement drawings...........................................448,447,548
grid dimensions..................................................................448
grouping.............................................................................413,533,546
in reinforcement...................................................................155
level....................................................................................533
limiting outside dimensions.............................................451
marks.............................................................................166,173,411,538
maximum leader line length.........................................166,173,540
minimizing views................................................................539
modifying.............................................................................166
object groups.......................................................................447
object groups in dimensioning.............................................447
overall dimensions............................................................447
part dimensions....................................................................418,452,549
parts in general arrangement drawings.............................148
parts partly outside the view.............................................451
placing.............................................................................343,348,533
plate side marks....................................................................168
plates..................................................................................442
position dimensions..........................................................421,436
position properties.............................................................542
positioning..........................................................................452,549
precision..............................................................................533
preferred dim side.............................................................431
prefix of radial dimensions.................................................441
profiles..............................................................................443
properties...........................................................................533,544
drawing templates
  preview images............................................................ 90
drawing view filters..................................................150,322,407
drawing view labels
  section views..................................................................138
drawing views............................................................15,116
  3D..................................................................................529
  3D views........................................................................123
  adding..........................................................................117
  aligning.........................................................................136
  arranging........................................................................130,137
  automatic........................................................................350
  back..............................................................................529
  back views....................................................................123
  bottom............................................................................529
  bottom views..................................................................123
  coordinate system......................................................529
copying...........................................................................130
creating.............. 117,120,121,123,124,125,126,350
deformed parts.....................................................370
detail views....................................................................121
direction marks..........................................................377,529
drawing templates............................................90,101
drawing size.....................................................339,341
drawings........................................................................101
drawings dimensions..................................................381
  adding texts..................................................................186
  anchor bolt plans....................................................33,59
  assembly drawing.......................................................39
  automatic drawing settings......................................307
  autoscaling..................................................................342
  autosizing.....................................................................342
  basic principles..........................................................18
  before creating..........................................................46
  cast unit drawings.....................................................42
  changing color..........................................................262
  checking cloned drawings.......................................98
  checking if parts have drawings...........................109
closing...........................................................................91,92,94
colors...........................................................................247,261
colors contents..........................................................13
  creating........... 25,48,51,57,58,62,68,75,92,101
colors creating general arrangement drawings........47
colors deleting............................................................276
colors drawing filters................................................319
colors Drawing List.....................................................104
colors drawing objects...............................................17
colors drawing size....................................................339,341
colors drawing templates...........................................90,101
colors drawing view scale........................................339,340,341
colors editing..............................................................114
colors filters...............................................................319,323
colors foldmarks..........................................................296
colors frames................................................................296,298
colors freezing.............................................................274
  general arrangement drawings................................26
colors grid lines..........................................................234
colors grids.................................................................233,234,491
  hiding and showing objects....................................247
  hyperlinks.................................................................190
  in drawings...............................................................15
  issuing.........................................................................275
keyboard shortcuts...........................................270
layouts.................................................................15,326,330,338
links to other drawings........................................189
locking........................................................................273
main features...............................................................13
managing........................................................................272
margins.........................................................................332
master drawings..............................................................77
modifying properties......................................................313,317
modifying properties before creating drawings..............312
multidrawings.................................................................45
multiple drawing sheets of the same part..............74
object properties.........................................................319,323
opening...........................................................................109,110
preview images...............................................................89
printing........................................................................287,288,291,293
printing to multiple sheets...............................................295
properties..........................................................................307,314,318,322,325
protection...........................................................................344,346
recreating..........................................................................315
reference models...............................................................230
removing..........................................................................80
renaming...........................................................................115
revisions..............................................................................276
rule sets.............................................................................68
saved settings.................................................................57,62
saving..............................................................................269
screen layout.................................................................14
searching.........................................................................108
selecting...........................................................................108
settings..........................................................................307,523
single-part drawings..........................................................34
snapshots..........................................................................111
spaces between views......................................................332
status information...........................................................105
status flags.........................................................................106
table layouts.................................................................332,333,334
tables...............................................................................329
text files...........................................................................188
three levels of modifying...................................................21
titles..................................................................................115
types...................................................................................26
unlocking...........................................................................273
updating..........................................................................19,272,316
user-defined attributes....................................................515,516
view filters..........................................................................323
views...............................................................................15,350
with black background.................................................261
wizards.............................................................................68
dual dimensions
adding automatically.......................................................433
adding manually.................................................................153
DWG and DXF files
adding in a drawing table layout.................................337
in drawings.......................................................................220,221,222,223
scaling options.................................................................191
DWG/DXF files.................................................................17,98,329
as drawing frames.............................................................298
E
edges..................................................................................121
edged chamfers...............................................................177,494
adding chamfer marks.....................................................222
in drawings.......................................................................220,221,222,223
editing
drawings...........................................................................114
elements
in bolt marks........................................................................487,562
in connection marks............................................................566
in detail view label marks........................................................567
in dimension marks.............................................................142
in dimension tags.................................................................142
in marks..............................................................................560
in merged reinforcement marks..........................................565
in neighbor reinforcement mesh marks..............................564
in part marks........................................................................561
in reinforcement marks........................................................564
in reinforcement mesh marks..............................................564
in section view label marks................................................567
in surface treatment marks................................................566
in view label marks.............................................................567
elevation views.................................................................116
elevations
datum point........................................................................529
dimensioning.....................................................................414
embeds..............................................................................35
end views..........................................................................350,529
aligning with main view...................................................379
view direction marks.........................................................377
enlarged views
adding dimension points..................................................167
enlarging
dimensions.........................................................................439
erection elevation drawings................................................31

602
erected elevation drawings, see general arrangement drawings
exaggerating dimensions.................................................. 439
exaggerating
  selected dimensions.................................................. 166
examples
  bolts in drawings........................................................ 504
cast unit drawings...................................................... 43,44
cloning drawings.......................................................... 96
dimensions in drawings............................................. 143,170,418,420,421,426,427,429,430,431,432,
  448,450,451,452,458
edge chamfers in drawings......................................... 223
hatch patterns............................................................ 509
part representation in drawings................................... 494
printing......................................................................... 288,289,290
welds in drawings....................................................... 205,216

expanding
  plug-ins....................................................................... 202
extension lines
  of dimensions................................................................ 437
extrema, see view boundaries.................................. 117,133
features
  in drawings..................................................................... 13
file names
  in printing...................................................................... 293
fillet
  creating........................................................................ 255
fills.......................................................... 506
filtering
  dimension tag content............................................. 151
drawing filters............................................................ 319
Drawing List contents.................................................. 107
using drawing filters in anchor bolt plans.................... 61
  view filters.................................................................. 323
filters
  examples in dimensioning........................................ 409,410
  excluding stirrups ..................................................... 411
  in dimensioning rules................................................ 407
  in drawings.................................................................. 319
  on view level............................................................. 323
finding
drawings...................................................................... 103
parts with drawings................................................... 109
finish........................................................................... 561
firm folder
  for images and symbols............................................. 520
fittings (NS/FS)............................................................... 561
fixed............................................................................. 142,215
fixed drawing sizes..................................................... 326
fixed sizes.................................................................... 330
flags
  in drawings............................................................... 105
flipping outside dimensions....................................... 169
folders
  in Master Drawing Catalog....................................... 86,87,89
folding printed drawings............................................ 296
foldmarks..................................................................... 296,297
format
  dimensions.................................................................. 478
  level attributes......................................................... 478
forward offset............................................................. 430,539
foundation plans........................................................... 59
frames........................................................................... 296,297
around marks.................................................................. 465
DWG/DXF files............................................................. 298
framing plans................................................................. 29
free............................................................................. 142
freezing
  and associativity...................................................... 275
  and cloning............................................................... 275
assembly drawings..................................................... 275
cast unit drawings..................................................... 275
drawings.................................................................. 274
effect on drawings..................................................... 275
general arrangement drawings.................................... 274
single part drawings................................................... 275
front drawing views..................................................... 123,363,529
front views................................................................. 350
GA drawings, see general arrangement drawings........ 26,148
gage of outstanding leg............................................. 420,561,562
general arrangement drawings................................... 26
  3D views...................................................................... 32
anchor bolt plans....................................................... 33
creating using menu, toolbar or pop-up menu
  commands..................................................................... 47
adding ................................................................. 336
adjusting drawing views .................................. 337
keyboard shortcuts
for drawings ..................................................... 270
for UCS ............................................................ 268
knock-off dimensions ....................................... 416

L
labels
  drawing view labels ......................................... 352
  grid labels in drawings ..................................... 234
section views .................................................... 117
landscape
  printing .................................................................. 288
layers
  reinforcing bars ................................................ 200
layouts .................................................................. 15,326
  adding key plans ................................................ 336
  creating ............................................................ 330
  selecting ........................................................... 338
  table layouts ...................................................... 327
leader lines .......................................................... 470
  associative notes ................................................ 184
  base point location .......................................... 184
  customizing arrows ........................................... 184
  for reinforcing bar group marks ....................... 469
  handle points .................................................. 254
  marks ................................................................ 184
  maximum leader line length ............................. 450
  modifying ....................................................... 254
  part marks ....................................................... 466
  types ................................................................ 469,553
length ................................................................... 561
lengthening parts ................................................. 366
lengthening
  shortened parts ................................................. 369
level attributes .................................................... 478
level dimensions .................................................. 533
level marks .......................................................... 98
  adding ............................................................. 176
  properties ......................................................... 559
levels
  drawing level .................................................... 21
  object level ...................................................... 21
  three levels of modifying drawings ................... 21
  view level ......................................................... 21
limiting outside dimensions ................................. 451

line extensions .................................................... 436
line thickness
  pen numbers .................................................... 265
line weight
  pen numbers .................................................... 265
line weights ........................................................ 303
  changing ........................................................... 265
  in printouts ....................................................... 265
lines .................................................................. 194,587
  customized line types ...................................... 521
  dividing ............................................................ 253
  extending .......................................................... 251
  shortening ........................................................ 251
  trimming ........................................................... 251
linking
  dimension lines ................................................ 172
  drawing views .................................................. 132
links ................................................................... 17
  hyperlinks ........................................................ 190
  modifying .......................................................... 193
  to DWG/DXF files ............................................. 191
  to other drawings ............................................. 189
  to text files ....................................................... 188
listing hidden parts ............................................. 250
location
  of beam marks ................................................ 468
  of bracing marks .............................................. 468
  of column marks ............................................. 468
  of end views .................................................... 379
  of marks ........................................................... 468,497
  of section views .............................................. 379
locking
  drawings .......................................................... 273

M
macros
  adding surface treatment symbols in drawings ....... 241
main views .......................................................... 116,350
managing
  cut lines ............................................................ 259
  drawings ........................................................... 272
  master drawings .............................................. 77
  moment connection symbols ............................ 239
manual dimensions ............................................ 142,143
margins ............................................................... 332
MarkDimensionFormat.dim .................................. 478
marks............................................................17,529
view label marks...........................................567
adding.........................................................462
adding symbols.............................................486
adding templates...........................................480,484
appearance....................................................551
automatic......................................................461,462
bolt marks.....................................................487,562
color.............................................................465
connection marks...........................................566
containing templates......................................481
contents........................................................560
detail marks....................................................567
detail view label marks....................................567
element unit settings.......................................476
elements.........................................................465,560,561
font...............................................................465
frames............................................................465
height..............................................................465
in dimensions...............................................538
in view labels...............................................352
leader line types............................................469
leader lines.....................................................184
level marks....................................................176,559
location..........................................................468,470,497
merged reinforcement marks..........................567
merging.........................................................183,471,473
model weld marks.........................................557
neighbor reinforcement.................................564
part marks......................................................175
placing..........................................................343
positioning.....................................................554
properties......................................................462,550
reinforcement..................................................564
reinforcement marks.......................................474,564
revision marks...............................................192
section marks...............................................567
section view label marks..................................567
settings..........................................................461
showing frames and leader lines......................475
surface treatment marks..................................566
text appearance..............................................465
updating..........................................................179
user-defined attributes....................................480
using templates.............................................483
view direction marks.......................................377
visibility..........................................................464
weld marks.....................................................205,215,555
Master Drawing Catalog...............................51,77
adding master drawings.................................77,78
applying object level settings..........................57
cloning templates..........................................80,85
copying drawings..........................................88
customizing.....................................................77
managing.........................................................77
managing folders............................................86,87
master drawing properties.............................81,82
preview images..............................................89,90
removing drawings.........................................80,89
rule set properties..........................................83
sample images.................................................89
searching..........................................................76
wizard files.....................................................83
master drawings..............................................77
adding.........................................................77,78
adding preview images......................................90
adding thumbnail images....................................90
cloning templates...........................................54,80
properties.......................................................81,82
removing.........................................................80
rule sets..........................................................56,78
saved settings..................................................54
searching..........................................................76
types...............................................................53
wizards............................................................57
material..........................................................562
material ..........................................................561
material grade..................................................564
maximum leader line length..........................450,549
maximum number of outside dimensions...........451
maximum position dimensions.........................436
merging
marks..........................................................183,471,473
part marks.......................................................471
reinforcement marks.....................................183,474
weld marks.....................................................183,218
mesh class.......................................................564
mesh diameter................................................564
mesh length.....................................................564
mesh name.......................................................564
mesh shape.......................................................564
mesh size.........................................................564
mesh weight.....................................................564
mesh width.......................................................564
mesh
creating a drawing view.................................126

606
in drawings.......................................................... 512
in neighbor parts............................................... 512
properties............................................................... 577
properties in drawings........................................... 512
minimizing views...................................................... 539
minimum position dimensions............................ 436
model objects......................................................... 18
  in drawings.......................................................... 195
model welds............................................................ 203, 511
dragging marks...................................................... 213
modifying appearance in drawings.......................... 213
visibility of marks in drawings.................................. 210
modifying
  annotation object properties.............................. 178
  building objects.................................................. 196
detail properties...................................................... 140
dimension properties.............................................. 166
drawing grid line properties................................ 234
drawing grid properties......................................... 234
drawing grids.......................................................... 493
Drawing List contents............................................. 107
drawing view properties......................................... 138
drawings................................................................. 21
  independent annotation objects........................... 193
leader line shape..................................................... 254
section properties............................................... 138
symbol properties.................................................. 238
wizard files............................................................ 83
moment connection symbols.................................... 235
creating................................................................. 239
deleting................................................................. 241
managing............................................................... 239
updating................................................................. 241
moving
drawing views......................................................... 135
drawing views to another drawing.......................... 130
end of dimension line............................................. 174
objects in drawings............................................... 243
multidrawings.......................................................... 45
creating................................................................. 49
creating empty multidrawings............................... 50
creating of selected parts...................................... 51
  of selected drawings multidrawings...................... 50
updating................................................................. 272
multiple drawing sheets of the same part................. 74, 75

N
name......................................................................... 561
named size............................................................... 302
names
drawings................................................................. 115
neighbor part marks............................................... 462
neighbor parts......................................................... 493
  in drawing views................................................ 364
  in drawings......................................................... 496
properties............................................................... 568
  view extension.................................................... 364, 529
neighbor reinforcement marks
elements............................................................... 564
north marks............................................................. 500
notes
  associative notes................................................ 177
  number of bars.................................................. 564
  number of bolts................................................ 562
  numbering.......................................................... 46

O
object groups.......................................................... 78
  in dimensioning................................................ 447, 549
object level settings.............................................. 21, 529
  applying in Master Drawing Catalog...................... 57
objects
  associative annotation objects.............................. 175
  building objects................................................ 195
cloned objects....................................................... 98
drawing objects..................................................... 17, 242
  independent annotation objects........................... 186
modifying in drawings............................................ 317
shapes................................................................. 194
offset........................................................................ 587
  forward offset................................................... 430, 539
opening
  Drawing List....................................................... 104
drawings............................................................... 103, 109, 110
openings and recesses
  showing in drawings........................................... 372
  showing in views............................................... 529
  showing symbols............................................... 373
orientation marks.................................................. 497
  showing............................................................ 500
orientation symbols.............................................. 500
orientation
of marks.............................................590
of parts........................................356,497,590
of plates.......................................361
overall dimensions..........................448

P

paper size........................................290,302
part marks
  adding............................................175
  compass direction..........................499
  containing templates......................481
  elements........................................561
  leader lines.................................184,466
  level attributes..............................478
  merging..........................................471
  modifying.......................................178
  showing frames and leader lines........475
  updating.........................................179
  using templates................................483
part position....................................561
parts
  representation in drawings................196
  additional markings in drawings........196
  color..............................................196
  compass direction..........................499
  connecting side marks......................502
  developed parts in drawings..............370
  dimensions........................................418,452,549
  fill options....................................196
  fills................................................507
  hatch patterns..................................507
  in drawings.....................................493,494
  lengthening....................................365
  lengthening in model.......................366
  lengthening shortened parts...............369
  line types........................................196
  orientation......................................356,497,500
  properties........................................356,497,590
  representation..................................494
  settings..........................................494
  shortening.....................................365
  shortening in model..........................366
  shortening view by view.......................197
patterns
  hatch patterns..................................506
PDF files
  creating..........................................291
  pdf
    printing.........................................281
  pen numbers....................................265,303
    changing........................................265
  placement settings..........................343,347,348
  placing
    annotation objects..........................343,347,586
    dimensions......................................343,347,348
    fixed.............................................142,215
    free...............................................142
    marks..............................................343,347
    views...............................................349
    welds.............................................343,347
  plan drawings..................................29,30
  plot files, see print files..................293
  plotter
    sending to......................................281
  plotting, see printing........................287,292,293
  plug-ins
    exploding...........................................202
  polybeams
    unfolding..........................................369
  polygons..........................................194,587
  polylines.........................................194,587
  portrait
    printing..........................................289
  position dimensions..........................421
    maximum...........................................436
    minimum..........................................436
  positioning properties
    section marks....................................554
    view label marks..................................554
  pour breaks
    showing in drawings..........................228
  pours
    in drawings......................................225
    modifying in drawings.........................229
    pour break symbol in drawings..............229
    pour breaks......................................225
    pour objects.....................................225
    showing in drawings..........................228
  preferred dim side..........................431
  preferred scale....................................341
preventing automatic drawing updates.................................316
preview images..............................................................89,90
creating...........................................................................89
in Master Drawing Catalog..............................................89,90
viewing..............................................................................90
print area \(h \times b\).................................................................303
print files...........................................................................293
printer..................................................................................281
Printer Catalog.................................................................299,300,301
printer drivers.................................................................299,305
printer instances...............................................................303,305
  Abode postscript printer instances..........................301
  adding...........................................................................299,300,301
  print-to-file instances...................................................300
  setting up.......................................................................299
printers..................................................................................299,300
printing..................................................................................293
to file..................................................................................293
  A3 on A4.........................................................................290
adding printer instances......................................................289
Color Table............................................................................265
colors....................................................................................303
drawings.................................................................................287
examples...........................................................................288,289,290
hints and tips........................................................................305
in landscape............................................................................288
in portrait...............................................................................289
line weight...........................................................................265
line weights.........................................................................265,303
multiple drawings..............................................................291
  on A3...............................................................................289
  on A4...............................................................................288
paper size.............................................................................302
pen numbers.........................................................................265,303
print area.............................................................................303
printer instances...............................................................303,309
settings..................................................................................303
single drawings....................................................................288
to file....................................................................................292,300
to multiple sheets...............................................................295
to paper printer....................................................................299
to PDF...................................................................................291,301
profile ..................................................................................561
profiles dimensions..............................................................443
projection type.......................................................................354
properties associative annotation objects..........................178
bolts.....................................................................................571
drawing properties...........................................................307,312,313,314
grids in drawings.................................................................589
marks.....................................................................................550
meshes..................................................................................577
parts......................................................................................568
reinforcement......................................................................577
surface treatment..................................................................572
symbol properties..................................................................238
protected areas.....................................................................344,346
pull-out pictures, see pullout pictures.................................564
pull-outs
  in reinforcement marks..................................................489
pullout pictures.....................................................................564,579

R
radial dimensions changing the prefix......................................441
rails.......................................................................................41
RebarClassifier.................................................................200
RebarLayeringMarker.........................................................200
rebars, see reinforcing bars...............................................158
rebar_config.inp....................................................................579
recognizable distances.........................................................431
recreating dimensions..............................................................154
drawings..................................................................................315
rectangles.............................................................................194,587
reference dimensions, see check dimensions......................416
reference lines.........................................................................196
reference models, see check dimensions..............................416
  hidden lines....................................................................231
in drawings...........................................................................230
reflected views.......................................................................529
refreshing associativity............................................................99
reinforcement marks.............................................................462
  adding pull-outs...............................................................489
  elements........................................................................564,565
leader line base points.......................................................467
leader line types.....................................................................470
location..................................................................................470
merging................................................................................183,474
modifying.............................................................................178
splitting................................................................................183
reinforcement mesh.............................................................512
creating a drawing view ........................................ 126
properties ................................................................ 577
properties in drawings ............................................ 512
reinforcement position ............................................ 564
reinforcement settings for drawings ......................... 579
reinforcement
adding dimensions .................................................... 155
closed dimensions .................................................. 432
dimension lines ....................................................... 155
dimension marks ..................................................... 155
dimension tags ......................................................... 155
dimensioning reinforcing bar groups ....................... 158
dimensions ................................................................ 432, 548
hiding lines in drawings ........................................... 513
in drawings ............................................................. 512
neighbor reinforcement ......................................... 512
properties ................................................................. 577
properties in drawings ............................................ 512
reinforcing bar layer information .............................. 200
representation options ............................................ 514
reinforcing bar group marks
leader line types ....................................................... 469
location .................................................................... 469
reinforcing bar groups
dimensioning ............................................................. 158
reinforcing bars
adjusting the location .............................................. 199
dimension lines ....................................................... 156
dimensioning bar groups ......................................... 158
hiding lines in drawings ........................................... 513
in drawings ............................................................. 199, 512
layer information ...................................................... 200
properties ................................................................. 577
relative dimensions ................................................. 533
removing
change symbols ....................................................... 180, 181
dimension points ..................................................... 171
dimension tag content ............................................ 151
drawings ................................................................. 89
unnecessary drawing files .................................... 269
renaming
drawings ................................................................. 115
representation options
for reinforcement ..................................................... 514
representation
of parts in drawings ................................................. 494
resetting
user coordinate system ........................................... 268
reshaping
drawing objects ....................................................... 243
resizing
drawing objects ....................................................... 243
drawing view boundaries ........................................ 133
restriction box, see view boundaries ......................... 133
revising drawings .................................................... 277
revising drawings, see revisions ............................... 276
revision marks ........................................................ 98
adding .................................................................... 192
arrows ..................................................................... 192
modifying ................................................................. 193
placing ..................................................................... 192
revision tables .......................................................... 329
revisions .................................................................. 276
attributes ................................................................. 279
changing ................................................................. 278
creating .................................................................... 277
deleting .................................................................... 278
rotating plates in drawing ......................................... 361
rotating
drawing views ......................................................... 137
parts in drawing views ............................................ 359
rule properties
in dimensioning ....................................................... 394
rule sets .................................................................. 53, 56, 68, 83
in Master Drawing Catalog .................................... 89, 90
modifying ................................................................. 83
rules
dimensioning rules ................................................ 447
sample images .......................................................... 89, 90
creating ................................................................. 89
in Master Drawing Catalog .................................... 89, 90
saved settings .......................................................... 53, 54, 57, 58, 62
in Master Drawing Catalog .................................... 77
modifying ................................................................. 82
saving
drawings ................................................................. 269
scale ........................................................................ 341
scales
in tables .................................................................. 334
of drawing views .................................................... 339, 340, 341
schema files ............................................................ 507, 575
screen layout
in drawings .............................................................. 14
table layouts........................................266,288
adding a DWG/DXF file.........................269
adding tables.......................................269
creating...............................................334
replacing tables....................................333
setting table scale................................334
setting table transparency.......................334
setting the location of tables..................334
tables....................................................266
adding in table layout............................333
DWG/DXF files......................................329
in drawing layouts...............................329
key plans..............................................329
modifying.............................................333
replacing.............................................333
revision tables......................................329
table layouts..........................................327,334
title blocks..........................................329
tags......................................................413
in dimensions........................................329
tags, see dimension tags..........................142,150,151,155,166
template attributes
  adding in marks....................................480
Template Editor....................................329,333,339,481,483
templates.............................................333,560
  as tables in drawing layouts..................329
cloning templates.................................92
in marks..............................................481,483,484
modifying tables....................................339
Table in drawing layouts..........................327
template layouts....................................327
template library.....................................101
text files...............................................17,98
adding in drawings................................188
text
  in marks..........................................465
  modifying........................................193
texts..................................................17,98,560
  dragging.........................................186
  in drawings......................................186
  using superscript................................188
thumbnail images
  in Master Drawing Catalog.....................90
thumbnails..........................................90
tips
  printing drawings..............................305
title blocks........................................329
V

view boundaries.......................................................... 117
resizing...................................................................... 133
view direction marks.................................................. 377
view extension for neighbor parts........................... 364
view extrema, see view boundaries.......................... 133
view filters................................................................... 318,323
view label marks
    positioning properties............................................ 554
view labels
    mark elements.......................................................... 567
    marks........................................................................ 352
    name.......................................................................... 567
view level properties............................................... 323
view properties
    defining for general arrangement drawings... 351
view restriction box, see view boundaries...............117
viewing direction
    beams and bracings............................................... 363
    columns in drawings............................................... 363
views along grid lines............................................. 116
views
    aligning................................................................... 136,379
    arranging drawing views...................................... 137
    assembly drawings................................................ 355
    cloning dimensions................................................. 97
    drawing name.......................................................... 567
    drawing views......................................................... 350
    fixed.......................................................................... 349
    frames........................................................................ 135
    free........................................................................... 349
    in drawings............................................................. 116,117,133,350
    key plan view.......................................................... 335
    label mark elements................................................ 567
    linking drawing views............................................. 132

W

weld marks.................................................................. 203,205,555
    adding......................................................................... 215
    dragging..................................................................... 213
    examples.................................................................... 216
    merging....................................................................... 218
    model weld mark visibility in drawings................ 557
    model weld mark appearance................................. 557
    modifying................................................................... 178
    modifying model weld properties........................... 203
    updating...................................................................... 179
weld numbers
    showing...................................................................... 557
weld symbols............................................................ 203,511
welds.......................................................................... 215
    automatic.................................................................... 511
    concepts..................................................................... 203
    drawing welds........................................................... 203
    examples.................................................................... 205
    in drawings.............................................................. 203,218,511
    mark properties in drawings..................................... 555
    model weld mark appearance................................. 557
    model weld mark visibility in drawings................ 557
    model weld marks..................................................... 210
    model welds............................................................... 203
    model welds in drawings......................................... 205
    modifying................................................................... 203,511
    modifying in drawings.............................................. 178
    modifying model weld objects in drawings.............. 213
    placing........................................................................ 343
    visibility of marks in drawings............................... 210
    weld marks.................................................................. 213,216
wizard files.............................................................. 83,84
wizards....................................................................... 53,57,68
work point..................................................................... 416
workshop drawings
assembly drawings.................................................... 39
single-part drawings.................................................. 34